The KStars Handbook

Lead Developer & Maintainer: Jasem Mutlaq
Original Author: Jason Harris
Core Developer: Akarsh Simha
Core Developer: Carsten Niehaus
Core Developer: Eric Dejouhanet
Core Developer: Heiko Evermann
Core Developer: Hy Murveit
Core Developer: James Bowlin
Core Developer: John Evans
Core Developer: Mark Holloman
Core Developer: Robert Lancaster
Core Developer: Pablo de Vicente
Core Developer: Thomas Kabelmann
Core Developer: Wolfgang Reissenberger
Contents

1 Introduction 12

2 A Quick Tour of the KStars Skymap 14
   2.1 The Setup Wizard .................................................. 14
   2.2 Have a Look Around ................................................. 15
   2.3 Objects in the Sky .................................................. 16
      2.3.1 The Popup Menu ............................................... 16
      2.3.2 Finding Objects ............................................... 17
      2.3.3 Centering and Tracking ...................................... 19
      2.3.4 Keyboard Actions ............................................. 19
   2.4 End of the Tour .................................................... 20

3 Configuring KStars 21
   3.1 Setting the Geographic Location ................................. 21
   3.2 Setting the Time ................................................... 22
   3.3 The Configure KStars Window ..................................... 22
   3.4 Catalogs ............................................................. 24
      3.4.1 The DSO Catalog Database .................................. 26
      3.4.2 The Catalog Management GUI ................................. 26
      3.4.3 Creating a new Catalog ...................................... 28
      3.4.4 Catalog Color Editor .......................................... 29
      3.4.5 Catalog Details Dialog ....................................... 29
         3.4.5.1 Adding/Editing Objects ................................. 30
         3.4.5.2 Importing CSV (and similar formats) .................. 31
   3.5 Solar System ....................................................... 33
   3.6 Satellites .......................................................... 34
   3.7 Supernovae ......................................................... 35
   3.8 Guides .............................................................. 36
   3.9 Terrain .............................................................. 37
   3.10 Image Overlays ..................................................... 38
   3.11 Colors ............................................................. 40
   3.12 FITS ............................................................... 41
The KStars Handbook

3.13 INDI ......................................................... 42
3.14 Ekos ......................................................... 42
3.15 Xplanet ....................................................... 43
3.16 Advanced .................................................... 44
3.17 Developer ................................................... 45
3.18 Customizing the Display ................................. 45
3.19 Adjusting orientation of the sky map .................. 47
3.20 HiPS Progressive Overlay ............................... 50

4 Command Reference ......................................... 52
  4.1 Menu Commands ........................................... 52
     4.1.1 File Menu ............................................. 52
     4.1.2 Time Menu ............................................ 52
     4.1.3 Pointing Menu ........................................ 53
     4.1.4 View Menu ............................................ 53
     4.1.5 Tools Menu ............................................ 54
     4.1.6 Data Menu ............................................ 55
     4.1.7 Observation Menu .................................... 56
     4.1.8 Settings Menu ........................................ 56
     4.1.9 Help Menu ............................................. 61
     4.1.10 Popup Menu .......................................... 61
  4.2 Keyboard Commands ........................................ 63
     4.2.1 Navigation Keys ....................................... 63
     4.2.2 Menu Shortcuts ....................................... 64
     4.2.3 Actions for the Selected Object .................... 65
     4.2.4 Tools Shortcuts ....................................... 65
  4.3 Mouse Commands ........................................... 66

5 Ekos ............................................................. 67
  5.1 Ekos Setup .................................................. 68
  5.2 User Interface ............................................... 69
  5.3 Profile Wizard ............................................. 71
  5.4 Profile Editor ............................................... 74
  5.5 Logs .......................................................... 75
  5.6 Capture ..................................................... 76
     5.6.1 CCD & Filter Wheel Group .......................... 76
     5.6.2 Capture Settings ...................................... 77
     5.6.2.1 Custom Properties ................................ 77
     5.6.3 File Settings ........................................... 78
     5.6.4 Limit Settings .......................................... 79
     5.6.5 Sequence Queue ....................................... 80
     5.6.6 FITS Viewer ........................................... 81
     5.6.7 Rotator Settings ...................................... 82
The KStars Handbook

5.8.10 PHD2 Support ......................................................... 134
5.8.11 Guiding Logs .......................................................... 135
5.9 Align ................................................................. 135
  5.9.1 Introduction .......................................................... 135
  5.9.2 Typical use .......................................................... 136
  5.9.3 Configure StellarSolver Options .................................... 137
  5.9.4 Configure StellarSolver External Programs ......................... 138
  5.9.5 Configure StellarSolver Scale and Position ......................... 138
  5.9.6 Configure StellarSolver Profiles .................................... 139
    5.9.6.1 Star-Extraction Parameters ..................................... 140
    5.9.6.2 Star-Filtering Parameters ..................................... 140
    5.9.6.3 Plate-Solving Parameters ..................................... 141
  5.9.7 Download Index Files ............................................... 141
    5.9.7.1 Automatic Download ........................................... 141
    5.9.7.2 Manual Download ............................................. 142
  5.9.8 Optionally get astrometry.net ...................................... 143
  5.9.9 How to Use? ....................................................... 144
  5.9.10 Alignment Settings ............................................... 145
  5.9.11 Polar Alignment .................................................. 145
    5.9.11.1 Plate Solve Correction Scheme ............................... 147
    5.9.11.2 Move Star Correction Scheme ............................... 149
5.10 Scheduler ............................................................. 150
  5.10.1 Introduction ....................................................... 150
  5.10.2 Scheduler Table ................................................... 150
  5.10.3 Scheduling Algorithm ............................................ 151
  5.10.4 Scheduler Files (.esl) ............................................ 151
  5.10.5 Settings .......................................................... 151
  5.10.6 Other options .................................................... 152
    5.10.6.1 Remember job progress ...................................... 152
    5.10.6.2 Group repeats .............................................. 153
    5.10.6.3 Repeat all jobs ............................................. 153
  5.10.7 Editing running jobs ............................................. 153
    5.10.7.1 Capture Sequence Editor .................................... 154
  5.10.8 Workflow ........................................................ 155
  5.10.9 Startup Procedure ............................................... 155
  5.10.10 Data Acquisition ............................................... 156
  5.10.11 Shutdown ........................................................ 156
  5.10.12 Weather Monitoring ............................................ 156
  5.10.13 Startup & Shutdown Scripts ..................................... 157
  5.10.14 Mosaic Planner ................................................ 158
5.11 Analyze .............................................................. 162
  5.11.1 Introduction ....................................................... 162
  5.11.2 Timeline .......................................................... 162
  5.11.3 Statistics ........................................................ 163
5.12 Ekos Tutorials ....................................................... 163
  5.12.1 Viewer ............................................................ 163
The KStars Handbook

6 FITS Viewer
6.1 Main Controls .................................................. 165
6.2 Features ................................................................. 169
6.3 FITS Viewer Solver .................................................. 171
6.4 Embedded FITS Viewer ............................................ 172
6.5 3D Star Profile & Data Visualization Tool ..................... 173

7 KStars Tools
7.1 Object Details Window .............................................. 177
7.2 The Astrocalculator ................................................... 178
7.2.1 Julian Day module ................................................. 179
7.2.2 Sidereal Time module ............................................. 180
7.2.3 Day Duration module ............................................. 181
7.2.4 Equinoxes and Solstices module ................................. 181
7.2.5 Equatorial/Galactic Coordinates module ...................... 182
7.2.6 Apparent Coordinates module .................................. 183
7.2.7 Horizontal Coordinates module ................................. 184
7.2.8 Ecliptic Coordinates module .................................. 184
7.2.9 Angular Distance module ....................................... 185
7.2.10 Geodetic Coordinates module .................................. 186
7.2.11 Planet Coordinates module .................................... 187
7.3 Altitude vs. Time Tool ............................................... 188
7.4 Simulate Eyepiece View .............................................. 190
7.5 What’s up Tonight? Tool .............................................. 191
7.6 The Script Builder Tool .............................................. 192
7.6.1 Introduction to the Script Builder ............................... 192
7.6.2 Using the Script Builder ......................................... 193
7.7 Solar System Viewer .................................................. 195
7.8 Jupiter Moons Tool .................................................... 196
7.9 Observation Planner .................................................. 196

8 Command-Line mode for Image Generation ......................... 205

9 Astronomical Device Control with INDI
9.1 INDI Setup ............................................................. 206
9.2 Telescope Setup ......................................................... 207
9.3 CCD and Video-Capture Setup ..................................... 210
9.4 Configure INDI .......................................................... 210
9.5 INDI Concepts .......................................................... 211
9.6 Remote Device Control .............................................. 212
9.6.1 Running an INDI server from the command line .......... 213
9.6.2 Secure Remote Operation ....................................... 214
9.7 INDI Frequently Asked Questions ................................ 214
# 10 Questions and Answers

## 11 The AstroInfo Project

11.1 AstroInfo: Table of Contents ......................................................... 219
11.2 Celestial Coordinate Systems ....................................................... 220
  11.2.1 The Equatorial Coordinate System ........................................ 220
  11.2.2 The Horizontal Coordinate System ....................................... 221
  11.2.3 The Ecliptic Coordinate System ........................................... 221
  11.2.4 The Galactic Coordinate System .......................................... 222
11.3 The Celestial Equator ................................................................. 222
11.4 The Celestial Poles ....................................................................... 222
11.5 The Celestial Sphere ...................................................................... 222
11.6 The Ecliptic .................................................................................. 223
11.7 The Equinoxes ............................................................................... 223
11.8 Geographic Coordinates ............................................................... 224
11.9 Great Circles .................................................................................. 224
11.10 The Horizon .................................................................................. 224
11.11 Hour Angle ................................................................................... 225
11.12 The Local Meridian ...................................................................... 225
11.13 Precession ..................................................................................... 225
11.14 The Zenith .................................................................................... 226
11.15 Epoch ............................................................................................ 226
11.16 Julian Day ..................................................................................... 226
11.17 Leap Years .................................................................................... 227
11.18 Sidereal Time ............................................................................... 228
11.19 Time Zones .................................................................................. 229
11.20 Universal Time ............................................................................. 229
11.21 Telescopes ..................................................................................... 229
  11.21.1 Aperture and Focal Ratio ....................................................... 230
  11.21.2 Aberrations ............................................................................ 230
  11.21.3 Magnification ........................................................................ 230
  11.21.4 Field of View ........................................................................ 230
  11.21.5 Types of Telescopes ............................................................... 231
  11.21.6 Optical Telescopes ................................................................. 231
  11.21.7 Observations in Other Wavelengths ....................................... 232
  11.21.8 Space-Based Observations ................................................... 232
11.22 Blackbody Radiation .................................................................... 233
11.23 Dark Matter .................................................................................. 234
11.24 Flux ............................................................................................... 235
11.25 Luminosity .................................................................................... 236
11.26 Parallax ........................................................................................ 237
## List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Stars Catalogs</td>
<td>25</td>
</tr>
<tr>
<td>3.2</td>
<td>Deep-sky objects Catalogs</td>
<td>25</td>
</tr>
<tr>
<td>5.1</td>
<td>Index Files</td>
<td>142</td>
</tr>
<tr>
<td>9.1</td>
<td>INDI State color code</td>
<td>211</td>
</tr>
</tbody>
</table>
Abstract

KStars is free, open source, cross-platform astronomy software. It provides the KStars skymap, a digital planetarium with overlays and simulation tools, the Ekos astrophotography suite which acts as a client for INDI device drivers, and the FITS Viewer which displays captured sky images.

• The KStars skymap provides an accurate graphical simulation of the night sky, from any location on Earth, at any date and time. The display includes up to 100 million stars, 13,000 deep-sky objects, all 8 planets, the Sun and Moon, and thousands of comets, asteroids, supernovae, and satellites.

For students and teachers, it supports adjustable simulation speeds in order to view phenomena that happen over long timescales, the KStars Astrocalculator to predict conjunctions, and many common astronomical calculations. For the amateur astronomer, it provides an observation planner, a sky calendar tool, and an FOV editor to calculate field of view of equipment and display them. Find out interesting objects in the ‘What’s up Tonight’ tool, plot altitude vs. time graphs for any object, print high-quality sky charts, and gain access to lots of information and resources to help you explore the universe! The HiPS all-sky progressive overlay provide stunning views from numerous surveys spanning the whole electromagnetic spectrum.

• Ekos is a complete astrophotography solution that provides everything needed for automated or manual deep-sky imaging. It can control all INDI devices including numerous telescopes, CCD and CMOS astronomy cameras, DSLRs, focusers, filters, rotators, domes and a lot more. Ekos supports highly accurate tracking using online and offline astrometry solvers, autofocus and autoguiding capabilities, and capture of single or multiple images using its powerful built-in scheduler. It integrates well with the skymap, and FITS Viewer. It also has tools for polar alignment and measuring optical aberrations.

• The FITS Viewer can display FITS and other format images, including those captured by Ekos. One can zoom and pan, view stretched versions of the images, see image histograms, plate-solve and find stars and coordinates in the images.
Chapter 1

Introduction

KStars lets you explore the night sky from the comfort of your computer chair. It provides an accurate graphical representation of the night sky for any date, from any location on Earth. The display includes 126,000 stars to 9th magnitude (100 million with addon catalogs), 13,000 deep-sky objects (Messier, NGC, and IC catalogs), all planets, the Sun and Moon, hundreds of comets and asteroids, the Milky Way, 88 constellations, and guide lines such as the celestial equator, the horizon and the ecliptic.

However, KStars is more than a simple night-sky simulator. The display provides a compelling interface to a number of tools with which you can learn more about astronomy and the night sky. There is a context-sensitive popup menu attached to each displayed object, which displays object-specific information and actions. Hundreds of objects provide links in their popup menus to informative web pages and beautiful images taken by the Hubble Space Telescope and other observatories.

From an object’s popup menu, you can open its Detailed Information Window, where you can examine positional data about the object, and query a huge treasury of online databases for professional-grade astronomical data and literature references about the object. You can even attach your own Internet links, images and text notes, making KStars a graphical front-end to your observing logs and your personal astronomical notebook.

Our Astrocalculator tool provides direct access to many of the algorithms the program uses behind the scenes, including coordinate converters and time calculators.

You can plan an observing session using our Altitude vs. Time tool, which will plot curves representing the Altitude as a function of time for any group of objects. If that is too much detail, we also provide a What’s up Tonight? tool that summarizes the objects that you will be able to see from your location on any given night. You can add your favorite objects to your observing wish-list using the Observation Planner tool, which allows you to plan your observation sessions professionally. To see how object appears in the eyepiece under different telescopes and field of views, use the Simulate Eyepiece View tool to render a simulated view of what you see.

KStars also provides a Solar System Viewer, which shows the current configuration of the major planets in our solar system. There is also a Jupiter Moons Tool which shows the positions of Jupiter’s four largest moons as a function of time.

Our primary goal is to make KStars an interactive educational tool for learning about astronomy and the night sky. To this end, the KStars Handbook includes the AstroInfo Project, a series of short, hyperlinked articles on astronomical topics that can be explored with KStars. In addition, KStars includes D-Bus functions that allow you to write complex scripts, making KStars a powerful ‘demo engine’ for classroom use or general illustration of astronomical topics. Furthermore, any 3rd party tool or language with support of D-Bus can be used to write powerful scripts using KStars D-Bus API.

Enable HiPS all-sky progressive overlay to fetch high-resolution images and display them directly in the sky map. You can select from numerous catalogs compiled from different earth and
space based missions. This features requires a fast internet connection in order to download the images. The images are cached locally to reduce bandwidth. You can optimize the caching options to best balance between disk space versus bandwidth.

KStars is also for astrophotographers. You can control telescopes and cameras using the elegant and powerful INDI protocol. Ekos supports many popular telescopes including Meade’s LX200 family and Celestron GPS. Many popular CCD, CMOS and DSLR astrophotography cameras, webcams, and computerized focusers are also supported. Simple slew/track commands are integrated directly into the skymap’s popup menu, and the INDI Control Panel provides full access to all of your telescope’s functions. INDI’s Client/Server architecture allows for seamless control of any number of local or remote telescopes using a single KStars session. For advanced users, KStars provides Ekos, a complete astrophotography suite for Linux, Mac and Windows. Ekos is based on a modular extensible framework to perform common astrophotography tasks. This includes highly accurate GOTOs using astrometry solver, ability to measure and correct polar alignment errors, auto-focus and auto-guide capabilities, and capture of single or stack of images with filter wheel, rotator and dome support. Complex jobs can be scheduled and run automatically with the Ekos scheduler, taking into account priority, altitude, terrain, moon and twilight constraints. You can view the progress of a night’s astrophotography session using the Ekos Analyze module, and view the images captured using the FITS Viewer. Ekos is described in Chapter 5.

We are very interested in your feedback; please report bugs or feature requests to the KStars development mailing list: kstars-devel AT kde.org. You can also use the automated bug reporting tool, accessible from the Help menu.

This documentation is licensed under the terms of the GNU Free Documentation License.
Chapter 2

A Quick Tour of the KStars Skymap

This chapter presents a guided tour of the KStars skymap, introducing many of its important features.

The above screenshot shows a typical view of the KStars program. You can see the sky display centered on Betelgeuse, the brightest star in the constellation Orion. Stars are displayed with realistic colors and relative brightnesses. In three corners of the sky display, there are on-screen text labels displaying data on the current time (‘LT: 3:08:30 AM EEST Wednesday, July 6, 2016’), the current Geographic Location (‘Bucharest, Romania’), and the current object in the center of the display (‘Focused on: Betelgeuse (alpha Orionis)’). Above the sky display, there are two toolbars. The main toolbar contains shortcuts for menu functions, as well as a time-step widget which controls how fast the simulation clock runs. The view toolbar contains buttons that toggle the display of different kinds of objects in the sky. At the bottom of the window, there is a status bar which displays the name of any object you click on, and the sky coordinates (both Right Ascension/Declination and Azimuth/Altitude) of the mouse cursor.

2.1 The Setup Wizard

The first time you run KStars, you will be presented with a Setup Wizard, which allows you to easily set your geographic location and download some extra data files. You can press the OK
button at any time to exit the Setup Wizard.

The second page of the Setup Wizard allows you to choose the starting geographic location, by selecting from the list of the 3400+ known locations on the right side of the window. The list of locations can be filtered to match the text you enter in the City filter, Province filter, and Country filter edit boxes. If your desired location is not present in the list, you can select a nearby city instead for now. Later on, you can add your precise location manually using the Set Geographic Location tool. Once you have selected a starting location, press the Next button.

The last page of the Setup Wizard allows you to download extra data that are not included with the standard distribution of KStars. Simply press the Download Extra Data... button to open the Get New Stuff tool. When you are all done, press the OK button in the Setup Wizard to start exploring KStars.

2.2 Have a Look Around

Now that we have the time and location set, let us have a look around. You can pan the display using the arrow keys. If you hold down the Shift key before panning, the scrolling speed is increased. The display can also be panned by clicking and dragging with the mouse. Note that while the display is scrolling, not all objects are displayed. This is done to cut down on the CPU load of recomputing object positions, which makes the scrolling smoother (you can configure what gets hidden while scrolling in the Configure - KStars window). There are several ways to change the magnification (or Zoom level) of the display:

1. Use the + and - keys.
2. Press the Zoom In / Zoom Out buttons in the toolbar.
3. Select the View → Zoom In / Zoom Out menu item.
4. Select the View → Zoom to Angular Size... menu item. This allows you to specify the field-of-view angle for the display, in degrees.
5. Use the scroll wheel on your mouse.
6. Drag the mouse up and down with the middle mouse button pressed.
7. Hold down Ctrl while dragging the mouse. This will allow you to define a rectangle in the map. When you release the mouse button, the display will zoom to match the rectangle.

Notice that as you zoom in, you can see fainter stars than at lower zoom settings.

Zoom out until you can see a green curve; this represents your local horizon. If you have not adjusted the default KStars configuration, the display will be solid green below the horizon, representing the solid ground of the Earth. There is also a white curve, which represents the celestial equator, and a brown curve, which represents the Ecliptic, the path that the Sun appears to follow across the sky over the course of a year. The Sun is always found somewhere along the Ecliptic, and the planets are never far from it.

You can configure KStars to draw or not the celestial equator and Ecliptic curves on the Sky Map using the Settings → Configure KStars... menu item. Select the Guides page and check/uncheck the Celestial equator and Ecliptic check boxes. You can also configure which colors KStars uses for drawing these curves, using the Colors page.
2.3 Objects in the Sky

KStars displays thousands of celestial objects: stars, planets, comets, asteroids, clusters, nebulae and galaxies. You can interact with displayed objects to perform actions on them or obtain more information about them. Clicking on an object will identify it in the status bar, and simply hovering the mouse cursor on an object will label it temporarily in the map. Double-clicking will recenter the display on the object and begin tracking it (so that it will remain centered as time passes). Right clicking an object opens the object’s popup menu, which provides more options.

2.3.1 The Popup Menu

Here is an example of the right click popup menu, for the Uranus:
The appearance of the popup menu depends somewhat on the kind of object you right-click on, but the basic structure is listed below. You can get more detailed information about the popup menu.

The top section contains some lines of information which are not selectable: the object’s names (“Uranus”), object type (“Solar system object”), and the constellation which contains the object (“Pisces”). The next three lines show the object’s rise, set, and transit times. If the rise and set times say “circumpolar”, it means that the object is always above the horizon for the present location.

The middle section contains actions which can be performed on the selected object, such as Center & Track, Details, and Attach Label. See the popup menu description for a full list and description of each action.

The bottom section contains links to images and/or informative webpages about the selected object. If you know of an additional URL with information or an image of the object, you can add a custom link to the object’s popup menu. Use the Details item in the popup menu to open the Object Details dialog. On the Links tab use the Add Link... button.

2.3.2 Finding Objects

You can search for named objects using the Find Object tool, which can be opened by clicking on the search icon in the toolbar, by selecting Pointing → Find Object... menu item, or by pressing Ctrl+F. The Find Object window is shown below:
The window contains a list of (almost, see Section 3.4) all the named objects that KStars is aware of. Many of the objects only have a numeric catalog name (for example, NGC 3077), but some objects have a common name as well (for example, Whirlpool Galaxy). You can filter the list by name and by object type. To filter by name, enter a string in the edit box at the top of the window; the list will then only contain names which start with that string. To filter by type, select a type from the combo box at the bottom of the window.

KStars provides another method for resolving the objects that are missing from any of its predefined catalogues, by using an internet connection. Thus, if you want to find an object that KStars is not aware of, you can easily do this by querying several professional astronomical databases as: SIMBAD, NED or VizieR. This can be done by entering the object’s name and then press the *or search the internet for Object Name* button. After your object is found, you can use it exactly as any object that is already loaded into KStars (i.e. adding it to the Observing WishList). If the object was not found in the online databases, then a warning dialogue will pop-up. Once you resolve an object by using this method, it is stored in KStars database, so if you close KStars and open it again, your object will still be there.

You can choose to enable or disable this feature by checking or unchecking the Resolve names not known to KStars using online services check box from Catalogs page, inside of Configure - KStars dialog (select the Settings → Configure KStars... menu item). If this checkbox is checked, when an object name unknown to KStars is entered in the Find Dialog, KStars will contact online services to learn about the desired object and then add it directly to KStars database. The objects acquired in this manner are stored in a fake catalog, called ‘_Internet_Resolved’. Thus, you can enable or disable the display of these objects by checking or unchecking the ‘_Internet_Resolved’ catalog from the catalogues list. Note that you can not delete this fake catalogue, as you can do with a custom catalogue. If this checkbox is unchecked, then the Find Object window will be exactly the same, excepting a minor change: the online searching button will no longer be visible.
To center the display on an object, highlight the desired object in the list, and press Ok. Note that if the object is below the horizon, the program will warn you that you may not see anything except the ground (you can make the ground invisible in the Guides settings page, or by pressing the Ground button in the View toolbar).

### 2.3.3 Centering and Tracking

KStars will automatically begin tracking on an object whenever one is centered in the display, either by using the Find Object window, by double-clicking on it, or by selecting Center & Track from its right-click popup menu. You can disengage tracking by panning the display, pressing the Stop Tracking icon in the Main toolbar, or selecting Pointing → Stop Tracking menu item.

**NOTE**

When tracking on a Solar System body, KStars will automatically attach an 'orbit trail', showing the path of the body across the sky. You will likely need to change the clock’s timestep to a large value (such as ‘1 day’) to see the trail.

### 2.3.4 Keyboard Actions

When you click on an object in the map, it becomes the selected object, and its name is identified in the statusbar. There are a number of quick key commands available which act on the selected object:

- C
  - Center and Track on the selected object.

- D
  - Show the Details window for the selected object.
L
Toggle a visible name label on the selected object.

O
Add the selected object to the Observing wish-list.

T
Toggle a visible curve on the sky, showing the path of the object across the sky (only applicable to Solar System bodies).

**NOTE**
By holding down the **Shift** key, you can perform these actions on the centered object, rather than the selected object.

### 2.4 End of the Tour

This concludes the tour of the KStars skymap, although we have only scratched the surface of the available features. KStars includes many useful astronomy tools, it can directly control your telescope, and it offers a wide variety of configuration and customization options. In addition, this Handbook includes the AstroInfo Project, a series of short, interlinked articles explaining some of the celestial and astrophysical concepts behind KStars.
Chapter 3

Configuring KStars

3.1 Setting the Geographic Location

Here is a screenshot of the Set Geographic Location window:

There is a list of over 3400 predefined cities available to choose from. You set your location by highlighting a city from this list. Each city is represented in the world map as a small dot, and when a city is highlighted in the list, a red crosshairs appears on its location in the map.

It is not practical to scroll through the full list of 3400 locations, looking for a specific city. To make searches easier, the list can be filtered by entering text in the boxes below the map. For example, in the screenshot, the text A appears in the City filter: box, while Te has been entered in the Province filter: box, and USA is in the Country filter: box. Note that all of the cities displayed in the list have city, province, and country names that begin with the entered filter strings, and that the message below the filter boxes indicates that 6 cities are matched by the filters. Also notice that the dots representing these six cities in the map have been colored white, while the unmatched cities remain gray.
The list can also be filtered by location in the map. Clicking anywhere in the world map will show only those cities within two degrees of the clicked location. At this time, you can search by name, or by location, but not both at once. In other words, when you click on the map, the name filters are ignored, and vice versa.

The longitude, latitude and time zone information for the currently-selected location are displayed in the boxes at the bottom of the window. If you feel that any of these values are inaccurate, you can modify them and press the + (Add City) button to record your custom version of the location. You can also define a completely new location by pressing the Clear Fields button, and entering the data for the new location. Note that all fields except the optional Province/Country: must be filled before the new location can be added to the list. KStars will automatically load your custom locations for all future sessions. Please note, at this point, the only way to remove a custom location is to remove the appropriate line from the file kstars/mycities.dat in your folder
qtpaths --paths GenericDataLocation.

If you add custom locations (or modify existing ones), please send us your mycities.dat file so that we can add your locations to the master list.

### 3.2 Setting the Time

When KStars starts up, the time is set to your computer’s system clock, and the KStars clock is running to keep up with the real time. If you want to stop the clock, select the Time → Stop Clock menu item, or simply click on the Stop Clock icon in the toolbar. You can make the clock run slower or faster than normal, or even make it run backward, using the time-step spinbox in the toolbar. This spinbox has two sets of up/down buttons. The first one will step through all 83 available time steps, one by one. The second one will skip to the next higher (or lower) unit of time, which allows you to make large timestep changes more quickly.

You can set the time and date by selecting the Time → Set Time... menu item, or by pressing the Time icon in the toolbar. The Set Time window uses a standard KDE Date Picker widget, coupled with a spinbox for setting the hours and minutes. If you want to re-synchronize the simulation clock back to the current CPU time, just select the Time → Set Time to Now menu item.

**NOTE**

KStars can accept very remote dates beyond the usual limits imposed by QDate. Currently, you can set the date between the years -100000 and +100000. We may extend this range even further in future releases. However, please be aware that the accuracy of the simulation becomes more and more degraded as more remote dates are examined. This is especially true for the positions of solar system bodies.

### 3.3 The Configure KStars Window

The Configure - KStars window allows you to modify a wide range of display options. You can access the window with the Configure toolbar icon, or by selecting the Settings → Configure KStars... menu item. The window is depicted below:
The KStars Handbook

The Configure - KStars window is divided into fourteen pages: Catalogs, Solar System, Satellites, Supernovae, Guides, Terrain, Image Overlays, Colors, FITS, INDI, Ekos, Xplanet, Advanced and Developer.

In the Catalogs page, you determine several properties concerning the display of the star and deep sky object catalogs.

In the Solar System page, you can specify whether the Sun, Moon, planets, comets and asteroids are displayed.

The Satellites page allows you to set the satellites view options.

The Supernovae page allows you to manage how supernovae are displayed by KStars.

The Guides page lets you toggle whether non-objects are displayed (i.e., constellation lines, constellation names, the Milky Way contour).

It is possible to choose a Sky culture: for the constellation lines and names on this page. The current version of KStars includes data for more than a dozen sky cultures.

The Terrain page allows you to set the terrain or landscape image and configure its speedup options.

The Image Overlays page allows you to add and manage your own images that will be displayed in the skymap.

The Colors page allows you to set the color scheme, and to define new custom color schemes. For detailed explanation of the options on the FITS page see the Configure FITS section.

For detailed explanation of the options on the INDI page see the Configure INDI section.

For detailed explanation of Ekos astrophotography suite, see the Ekos section of this manual.

The Xplanet page provides fine-grained control over Solar system planet surface renderer Xplanet (should be installed separately).

The Advanced page provides fine-grained control over the more subtle behaviors of KStars.

The Developer page allows you to enable or disable a few options mostly useful for developers or for folks looking to help debug issues. Currently these are enabling the saving of images during Ekos’s autofocus, guiding and alignment.
3.4 Catalogs

In the Catalogs page, you can configure which object catalogs are displayed by KStars, as well as how much information you would like to be included on the Sky Map. By default, KStars includes 300,000 named and unnamed stars up to magnitude 8. For Deep Sky Objects, the included catalog is the New General Catalog (NGC) including the Index Catalog (IC) and the Messier Catalog.

The New General Catalog of Nebulae and Clusters of Stars (abbreviated as NGC) is a catalog of ca 7,840 deep-sky objects.

The Index Catalog of Nebulae and Clusters of Stars (abbreviated as IC) serves as a supplement to the NGC, and contains an additional 5,386 objects, collectively known as the IC objects.

You can install new catalogs using KStars ‘Add-On Installer’. You can open it via the Data → Download New Data... menu item. You can choose from a list of catalogs, including (but not limited to):

- Steinicke NGC/IC Catalog: is a more complete NGC/IC catalog.
- Abell Planetary Nebulae Catalog: is a catalog of 86 planetary nebulae. The maximum magnitude is represented by Abell 47’s value of 19.5.
- Sharpless HII region Catalog: is the Sharpless (Sh2) catalog of HII regions (diffuse nebulae).
- Hickson Compact Groups: is a catalog consisting of 99 compact groups of galaxies.
- Tycho-2 Star Catalog: is a catalog of more than 2.5 million of the brightest stars. It contains stars with a magnitude value from 8.0 to 12.5.
- USNO NOMAD Catalog: is a catalog of about 100 million stars with magnitude from 12.5 to 16.5. Note that is requires Tycho-2 to be installed.

The following is a summary of catalogs in KStars:
The Stars section allows you to manage how stars are displayed in KStars. You can choose to see the stars or not by checking the Star catalogs checkbox. If you check it, then multiple options will be enabled. Thus, you can set how many stars are drawn on the map using the Star density: slider. You can also customize KStars to toggle star name and magnitudes. Star names are drawn next to bright stars. To display labels of fainter stars, increase the Label density: slider.

Below the stars section, the Deep-Sky Objects section controls the display of several non-stellar object catalogs. You can toggle the display of Deep Sky Objects and control the display of their names and magnitudes. By default, the list of deep-sky objects includes the Messier, NGC and IC catalogs. Addons catalogs are available via the Data → Download New Data... menu item where you can download catalogs provided by KStars team and the community through the catalog packaging repository. The DSO minimal zoom: slider controls the minimal zoom level for which the DSOs are shown. Increasing the minimal zoom level can lead to performance improvements when panning the skymap zoomed-out. The DSO cache percentage: slider regulates how much of the DSO master catalog is being kept in memory. If you experience memory issues with large catalogs, try lowering the percentage. The Label density: slider controls the perceived density of labels for the DSOs. If labels start to overlap and the skymap begins to look too crowded, try tuning this option. The Faint limit zoomed in/out: regulates up to which magnitude objects are shown on the skymap (higher magnitude is fainter). If Show objects of unknown magnitude is ticked, objects of unknown magnitude are always shown.

The following sections will detail how DSO catalogs work in KStars and how they’re managed.
3.4.1 The DSO Catalog Database

**NOTE**
This section aims at introducing the catalog database of KStars in simple but technical terms. It can be skipped without missing anything essential but helps understanding how to deal with and create (custom) catalogs.

DSO catalogs in KStars are just SQL (sqlite3) database tables. Each catalog is represented by its own table which contains all its objects and an entry in a catalog metadata table. Additionally, catalogs may be imported or exported from and into stand-alone database files.

Each object has the usual properties like name and coordinates but additionally features two IDs. The first ID is the unique identifier for the specific object and is calculated by hashing all the object fields along with the catalog id. Because objects can be contained in several catalogs each object has an additional object id (OID) that identifies the physical object and may be shared by several objects of different catalogs.

To speed up object lookup all enabled catalogs are merged into a master table. Each catalog has a priority number and if several objects with the same OID occur the one from the catalog with the highest priority is loaded. The objects from the master catalog are then drawn on the sky and generally available in KStars.

Currently, deduplication (the assignment of OIDs) is only supported by the tooling of the catalog packaging repository. The aim of this tool-chain is to reproducibly build catalogs in a homogeneous environment. Every catalog is implemented as a python module and provides standard methods to acquire data, parse it and find duplicates in other catalogs. All downloadable catalogs are implemented this way. If you’d like to make a catalog of your own available for KStars, it is recommended that you implement it as a package in the repository. The tooling provided there is so flexible, that it should work for you. For more information on how to do that see the catalog repository documentation. If you are not familiar with python programming you can request the addition of a catalog by opening a ticket in the repository or contacting the maintainers. KStars provides also provides means to create custom catalogs by manually entering data or importing CSV tables, but those are less flexible and offer no deduplication.

3.4.2 The Catalog Management GUI

The catalog management GUI is reached via the Data → Manage DSO Catalogs... menu item and is displayed below.
The KStars Handbook

The DSO catalog management interface.

On the left, a list of catalogs is displayed. In this list, you can read off key catalog properties, including whether a catalog is enabled, what its ID is and what its name is. The **Mutable** column signifies whether the catalog can be edited or not. Catalogs which have been downloaded from the catalog repository via the **Data → Download New Data...** menu item are usually immutable whereas user-created catalogs aren’t. You can always **Clone** a catalog to make it mutable.

The buttons in the upper right corner allow you to add catalogs to the database.

**Import Catalog...**

Import a catalog in the `.kscat` format from a file.

This is usually done to try out new versions of catalogs that haven’t yet been picked up by the usual download server.

With the buttons in the lower right corner, you can add, remove, modify and explore catalogs. Their actions always refer to the currently selected catalog (the highlighted row on the left).

**Create Catalog...**

Create a new catalog. See Section 3.4.3.

**Enable / Disable**

Enable or disable a catalog.

This is reflected in the skymap upon closing the catalog management GUI.

**Remove**

Remove a catalog from the catalog database.

This is reflected in the skymap upon closing the catalog management GUI.

**Export...**

Export a catalog into a `.kscat` file.

The resulting file can be imported with **Import Catalog...** button.
Clone...

Make an exact copy of the catalog and insert it into the database.
This is useful if you wish to make modifications to an immutable catalog.

**NOTE**
Note however that this is not the recommended way to alter catalogs that are provided by the catalog packaging repository i.e. the catalogs downloaded via the Data → Download New Data... menu item.

Colors

Open the catalog color editor (See Section 3.4.4.).

This will open a dialog which allows you to set the colors in which objects from the selected catalog will be displayed for each color scheme.

More...

Open the catalog details dialog. (See Section 3.4.5.)

In there, you can see the contents of the catalog, as well as some more meta information. Amongst other things, you can also edit its contents (if it is mutable).

### 3.4.3 Creating a new Catalog

This dialog reached through the catalog management GUI (see Section 3.4.2). The **ID:** field will be automatically chosen but can be changed. The **Color:** field configures in which color the objects of the catalog will be displayed. All the other values are optional or have sensible defaults. You can, of course, change these values at a later point.

Upon clicking **Ok** an empty catalog with the meta data entered into the dialog will be added to the database and can then be filled with objects. (See Section 3.4.5 and Section 3.4.5.2.)
3.4.4 Catalog Color Editor

This dialog reached through the catalog management GUI (see Section 3.4.2). Each button represents the color that objects will be drawn in for a specific color scheme. Clicking on a button will allow you to choose a color with a color picker. The button colors are initialized with the default colors from the catalog specification. The color “default” is the color which will be chosen for the catalog if there is no color set for a color scheme.

3.4.5 Catalog Details Dialog

This dialog reached through the catalog management GUI (see Section 3.4.2). In the top left corner, the catalog metadata is being displayed. On the right, a table of all objects in the catalog

29
is being shown. The search line above the table filters objects by name. Double-clicking a row opens the object details dialog (see Section 7.1).

Selecting a row enables the Object menu on the left. Selecting multiple rows performs the single-object action for each selected object.

Edit...
   Edit the catalog object. (See Section 3.4.1).

Remove
   Removes the object from the catalog.

Below the Object section, the general catalog options are situated.

Edit Catalog Meta...
   Edit the catalog metadata displayed in the top left. This opens the dialog described in Section 3.4.3.

Add Object...
   Add an object to the catalog. (See Section 3.4.5.1.)

Import CSV...
   Import objects from a tabular text format (csv, tsv, etc.) into the catalog. (See Section 3.4.5.2.)

3.4.5.1 Adding/Editing Objects

This dialog allows to create or edit a deep sky object (DSO). The Basics section contains fields that have to be filled in.

Name:
   The name of the object which will be displayed in the sky.
The KStars Handbook

Type:
The type of the object.

RA / Dec (J2000):
The coordinates of the object in degrees and with respect to the J2000 epoch.

Apparent magnitude:
The apparent magnitude of the object.

The Optional section contains data fields that are optional, is divided into two subsections. They are set to and can be left at their defaults.

The Size Info in Arcminutes subsection. The object is modeled as an ellipse which is described by its major and minor axis.

The Misc subsection.

Long name:
A longer, more descriptive name.

Usually, the long name is something like ‘Andromeda Galaxy’ for the object M31. It can contain alternative designations and names in other catalogs as well.

Catalog identifier:
A catalog internal identifier.

For example the screenshot above, the object originates from the OpenNGC catalog where each row is identified by ‘NGCXXXX’.

Flux:
The flux of the object. Only applies for radio sources.

Position angle (°):
If the object is extended, it must have some orientation in the sky. The position angle is the angle between its major axis and a straight line to the north pole.

3.4.5.2 Importing CSV (and similar formats)
The KStars Handbook

The screenshot above shows the CSV import dialog in its default state. In the **Input** section, you can configure the CSV parser. The **Comment prefix** is the character that signals commented-out lines in the input. The **Separator** should be adjusted to fit your input. Usually, it is ‘,’ or ‘;’ but other separators can occur. Finally, you can choose to skip a number of lines at the beginning of the file. **Select/Read** button lets you choose a CSV file to read with the above configuration. After that, the dialog will look as in the screenshot below.

In the top right you can choose whether coordinates are being expressed in degrees or hours/minutes/seconds. The **Mapping** section lets you map columns in the CSV file to data fields in KStars. Selecting **Ignore** assigns the default value for this field. Entering your own text will use this as the value for every object being read. The **Type Mapping** section maps strings to object types. You can add and remove mappings by clicking + or -. When you’re done mapping, you can test your settings by clicking **Preview** to read the first few objects from the CSV. If you are satisfied you can click **OK** to import the whole catalog or adjust your settings and preview again. As a reference, a mapping for the OpenNGC catalog is shown in the below screenshot.
3.5 Solar System

In the Solar System page, you can specify whether the Sun, Moon, planets, comets and asteroids are displayed, and whether the major bodies are drawn as colored circles or actual images. You can also toggle whether solar system bodies have name labels attached, and control how many of the comets and asteroids get name labels. There is an option to automatically attach a temporary ‘orbit trail’ whenever a solar system body is tracked, and another to toggle whether the color of the orbit trail fades into the background sky color.
3.6 Satellites

The Satellites page allows you to set the satellites view options. Firstly, you can see or hide the satellites on the skymap using Show satellites checkbox from the top View Options section. By default, satellites are drawn as small light red filled circles with an optional dark red name label next to them. You can enable or disable these labels by checking or not the Show labels checkbox. It is located below the Show satellites checkbox, within the View Options section.

The colors of the dots representing satellites and their name labels can be easily customized using the Colors page from the same Configure - KStars window. In addition, satellites can be drawn just like regular stars by checking the Draw satellites like stars checkbox. To display only the visible satellites from your current geographic location and time, select Show only visible satellites.

KStars can draw artificial satellites from many predefined groups. Thus, you can select to display a particular group, multiple groups or partially select subgroups. Under each group, a list of individual satellites is presented. To select all satellites from a group, you need to check the group checkbox. You can also select only the satellites of interest in each group. The satellites orbital elements can be updated via the internet by pressing the Update TLEs button. Another way for updating the satellites orbital elements is to use the Data → Updates → Update Satellites Orbital Elements menu item. If you know the name of a desired satellite then you can use the search satellites method that KStars provides. You need to enter the name of satellite in the Search satellites text box and the list will be reduced only to its best matches.

You can add new satellites to KStars default satellites set by editing the kstars/data/satellites.dat file. As each line of this file is a group of satellites, you need to add a new entry for your desired satellites group. An entry should have the following format: Group Name;local_filename;url. For example: Iridium;iridium.tle;https://celestrak.com/NORAD/elements/iridium.txt.
The KStars Handbook

3.7 Supernovae

The Supernovae page allows you to decide if the supernovae are displayed or not by checking the Show supernovae checkbox. By default, supernovae are drawn as small light orange ‘+’ mark. As for satellites, the color of supernovae can be easily customized using the Colors page.

You can set the magnitude limit for showing a supernova as well as magnitude limit for supernova alerts using the spin boxes control. The limiting magnitude is the faintest apparent magnitude of an skyobject that is visible with the naked-eye or a telescope.

The list of recent supernovae can be updated via the Data → Updates → Update Recent Supernovae data menu item.
3.8 Guides

The Guides page lets you toggle whether non-objects are displayed (i.e., constellation lines, constellation names, the Milky Way contour, the celestial equator, the ecliptic, the horizon line, and the opaque ground). You can also choose a sky culture, whether you would like to see Latin constellation names, IAU-standard three-letter abbreviations, or constellation names using your local language.
The **Terrain** page lets you configure whether the terrain (landscape) image will be shown on the skymap.

The user is responsible for creating a partially-transparent image, that is overlayed onto the skymap. This image should have transparent regions that the user creates to let the skymap show through, and opaque regions representing the trees, buildings, the landscape around the telescope. There is a particular format required, and this is a significant effort. There are many resources on the web that explain how this is done for **Stellium**. The details of image creation are the same.

Initially, the user captures a full sphere equirectangular projection image from approximately the same point-of-view as his/her telescope. This kind of image can be captured with the Google Camera App, or the Google YouTube App on iPhone, or likely many other camera apps. The user then needs to edit the resulting image so that the sky is erased/transparent, and save it as a PNG. Finally, the user needs to determine where North is in the image, so it can eventually be aligned with the skymap. Once all that is done, the sky map can simulate the local sky view including the local terrain.

Once the image is created, it is possible to upload it via the **Terrain** page and configure the azimuth correction value (in degrees) that allows the user to rotate the view so north in the sky map is aligned with the north in the image.

Moreover, some speedup options can be configured to achieve the best user experience when rendering the terrain on the sky map.

---

**Tip**

You can toggle the terrain overlay on and off using a keyboard shortcut **Ctrl-Shift-T** and the **View → Show Terrain** menu item.
Image overlays are custom images (typically .jpg) that are rendered onto the skymap over stars and other skymap items, but below the terrain. These images are added by you, the user, a sort of personal sky catalog. If configured properly, these personal images can be displayed almost perfectly aligned with other objects in the sky.

The **Image Overlays** page lets you configure whether image overlays will be shown on the skymap, and helps you add them to the system. The image at the start of this section shows the skymap with image overlays enabled and some image overlays loaded.
The KStars Handbook

Each time it starts up, KStars looks for new image overlay images in a special directory, parallel to the logs directory, named imageOverlays. On Linux this can be found in ~/.local/share/kstars/imageOverlays. The exact location for your system can be found by clicking the Overlay Directory button near the top of the Image Overlays config page shown at the top of this section.

To start, add your images to that directory. Ideally, for performance reasons these aren’t massive files, but probably images with widths 1000 or 2000 should be fine. To add additional images in the future, add them to the same directory and click the refresh button or restart KStars. To remove overlays, remove them from the directory and click the refresh button or restart KStars.

Start KStars once you have images in the imageOverlays directory. If you then go to the Image Overlays config page, you should see the new files listed in the table. The new images will show their status as Unprocessed. Only images whose status is OK are displayed on the SkyMap. That is because KStars needs to know the sky location, size, and orientation for these images before it can display them. To change the status to OK you need to plate-solve the images or add the required information manually—see below.

To prepare your images for display, you need to plate-solve the images (one time only). To do this, find an image in the table, click on its filename, and then click Solve below the table. The Solve button’s label should switch to Cancel during the solve, and then when completed successfully, the solved parameters are displayed in the table and the status is changed to OK. A successful plate-solve’s information is stored in the user database so that solving doesn’t need to be repeated. The solved image should from then on appear in its proper position in the SkyMap. You can plate-solve multiple images in a single operation by clicking on the first image’s filename, then holding down the Shift key and clicking on another filename. All the image files between the filenames should be selected. Then clicking Solve will attempt to solve them all. However, KStars will not attempt to plate-solve images whose status is OK, it will skip those images. (If you wish to re-plate-solve images with status OK, then manually change their status to Unprocessed and click Solve). It is possible that if you select several images, a few of them will not be successfully solved.

Plate solving these images can sometimes be difficult. That is because at this point the system has no information as to the scale or position to look, and thus it is a blind solve. To improve your chance for success, you can enter an approximate RA/DEC center sky position into the RA and DEC columns for the row you are trying to solve. You can also add an image scale, in arcseconds-per-pixel. You can add a default scale to the right of the Solve button in the box labeled Default a-px so that all solving attempts use this scale by default. You can also add a scale directly into the table-row-column, which would override the default. You can choose which StellarSolver profile the solver uses (these profiles can be edited in Ekos’ Align tab). Finally, you can adjust the solver’s Timeout in seconds.

If you have problematic images that won’t solve, you can still display them by manually entering the values (that the solver didn’t find) into the table. They are the RA, DEC, arcsecond-per-pixel, orientation angle, and east-to-the-right (or West-to-the-right) settings. Once you have done that, you can then change the status to OK and KStars will save these values to the user database as if they had been automatically solved.

There are a few more controls on the Image Overlays settings page. The Show image overlays checkbox at the top of the page enables or disables this feature—that is, toggles whether any image overlays are display on the SkyMap or not.

The Maximum image dimension: spinbox allows you to vary the maximum image dimension used for images. That is, if you place images that are, for example, 5000 pixels wide into the imageOverlays directory, but this input box’s value is 1000, then the 5000-pixel-images will be read in, but then downsampled to 1000-pixels-wide before display. This is done to reduce the memory footprint and cpu usage of this feature. It would be more efficient to add image files with the desired image width.

The Center SkyMap on selection checkbox allows you to easily navigate to the overlay images without directly manipulating the SkyMap. With this enabled, you select a row in the overlay table (i.e., by clicking on the filename field) and the skymap is moved to that image if the image’s status is OK. At that point you can move from one image to the next with Up and Down arrow keyboard commands.
3.11 Colors

The Colors page allows you to set the color scheme, and to define custom color schemes. The tab is split into two panels:

The left panel shows a list of all display items with adjustable colors. Click on any item to bring up a color selection window to adjust its color. Below the list is the Star color mode: dropdown box. By default, KStars draws stars with a realistic color tint according to the spectral type of the star. However, you may also choose to draw the stars as solid white, black or red circles. If you are using the realistic star colors, you can set the saturation level of the star colors with the Star color intensity: spinbox.

The right panel lists the defined color schemes. There are four predefined schemes: the Default Colors scheme, Star Chart, which uses black stars on a white background, Night Vision, which uses only shades of red in order to protect dark-adapted vision, and Moonless Night, a more realistic, dark theme. Additionally, you can save the current color settings as a custom scheme by clicking the Save As... button. It will prompt you for a name for the new scheme, and then your scheme will appear in the list in all future KStars sessions. To remove a custom scheme, simply highlight it in the list, and press the Remove button.
3.12 FITS

FITS (Flexible Image Transport System) is a popular open standard for storage, transmission and processing of digital data. For the details, one is referred to the corresponding Wikipedia article. This page allows you to configure presentation and processing of FITS data in KStars.

The left panel is for configuring FITS viewer itself.

Check the Use FITS viewer item if you want automatically display received images in the FITS Viewer.

The Single preview tab item is to display all captured FITS images in a single tab instead of multiple tabs per image. The Single window capture item is to display captured FITS images from all cameras in a single FITS Viewer window instead of a dedicated window to each camera. The Single window open item is to display opened FITS images in a single FITS Viewer window instead of a dedicated window to each file and the Independent window item is to make FITS Viewer window independent from KStars.

The right panel lists processing options. The Auto stretch item is to always apply auto stretch to images in FITS Viewer, Limited resources mode is to enable limited resource mode to turn off any resource-intensive operations, namely: Auto debayer (bayered images will not be debayered; only grayscale images are shown), Auto WCS (World Coordinate System data will not be processed; WCS maps sky coordinates to image coordinates; equatorial grid lines, object identification, and telescope slew within an image are disabled), and 3D cube (RGB images will not be processed; only grayscale images are shown). You can switch off some of these resource-greedy operations separately as well.
3.13 INDI

For detailed explanation of the options on the INDI page see the Configure INDI section.

3.14 Ekos

Ekos is an astrophotography suite, a complete astrophotography solution that can control all INDI devices including numerous telescopes, CCDs, DSLRs, focusers, filters, and a lot more.
Ekos supports highly accurate tracking using online and offline astrometry solver, autofocus and autoguiding capabilities, and capture of single or multiple images using the powerful built in sequence manager. For detailed explanation of Ekos, see the Ekos section of this manual.

3.15 Xplanet

Xplanet (should be installed separately) is a solar system planet surface renderer. This page allows you to configure presentation and processing of Xplanet data in KStars.
3.16 Advanced

The Advanced page provides fine-grained control over the more subtle behaviors of KStars.

The Correct for atmospheric refraction checkbox controls whether the positions of objects are corrected for the effects of the atmosphere. Because the atmosphere is a spherical shell, light from outer space is ‘bent’ as it passes through the atmosphere to our telescopes or eyes on the Earth’s surface. The effect is largest for objects near the horizon, and actually changes the predicted rise or set times of objects by a few minutes. In fact, when you ‘see’ a sunset, the Sun’s actual position is already well below the horizon; atmospheric refraction makes it seem as if the Sun is still in the sky. Note that atmospheric refraction is never applied if you are using Equatorial coordinates.

The Use animated slewing checkbox controls how the display changes when a new focus position is selected in the map. By default, you will see the sky drift or ‘slew’ to the new position; if you uncheck this option, then the display will instead ‘snap’ immediately to the new focus position.

If the Attach label to centered object checkbox is selected, then a name label will automatically be attached to an object when it is being tracked by the program. The label will be removed when the object is no longer being tracked. Note that you can also manually attach a persistent name label to any object with its popup menu.

There are three situations when KStars must redraw the sky display very rapidly: when a new focus position is selected (and Use animated slewing is checked), when the sky is dragged with the mouse, and when the time step is large. In these situations, the positions of all objects must be recomputed as rapidly as possible, which can put a large load on the CPU. If the CPU cannot keep up with the demand, then the display will seem sluggish or jerky. To mitigate this, KStars will hide certain objects during these rapid-redraw situations, as long as the Hide objects while moving checkbox is selected. The timestep threshold above which objects will be hidden is determined by the Also hide if time step larger than: timestep-spinbox. You can specify the objects that should be hidden in the Configure Hidden Objects section.
3.17 Developer

The Developer page provides a few checkboxes that can help debug issues with KStars. There are checkboxes for saving images in logging directories that might help debug issues. Of course, saving images can take up disk space and should be used judiciously.

The images that can be saved are

- all focus images,
- all guider images,
- all align images, and
- align images where the plate-solving failed.

The images are all saved in folders parallel to the main logging directory. They are in folders named guide, autofocus, align, and align/failed.

3.18 Customizing the Display

There are several ways to modify the display to your liking.

- Toggle whether the Info Boxes are drawn in the Settings → Info Boxes submenu. In addition, you can manipulate the three Info Boxes with the mouse. Each box has additional lines of data that are hidden by default. You can toggle whether these additional lines are visible by double-clicking a box to ‘shade’ it. Also, you can reposition a box by dragging it with the mouse. When a box hits a window edge, it will ‘stick’ to the edge when the window is resized.

- Toggle whether the Toolbars are drawn in the Settings → Toolbars Shown submenu. Like most KDE toolbars, they can also be dragged around and anchored on any window edge, or even detached from the window completely if they are unlocked.
• Select a different color scheme in the **Settings → Color Schemes** submenu. There are four predefined color schemes, and you can define your own in the **Configure - KStars** window.

• Choose an ‘FOV Symbol’ using the **Settings → FOV Symbols** submenu. **FOV** is an acronym for ‘field-of-view’. An FOV symbol is drawn at the center of the window to indicate where the display is pointing. Different symbols have different angular sizes; you can use a symbol to show what the view through a particular telescope would look like. For example, if you choose the ‘7x35 Binoculars’ FOV symbol, then a circle is drawn on the display that is 9.2 degrees in diameter; this is the field-of-view for 7x35 binoculars.

You can define your own FOV symbols (or modify the existing symbols) using the **Edit FOV Symbols...** menu item, which launches the FOV Editor:

The list of defined FOV symbols is displayed on the left. On the right are buttons for adding a new symbol, editing the highlighted symbol’s properties, and removing the highlighted symbol from the list. Note that you can even modify or remove the four predefined symbols (if you remove all symbols, the four defaults will be restored the next time you start KStars). Below these three buttons is a graphical preview display showing the highlighted symbol from the list. When the **New...** or **Edit...** button is pressed, the **New FOV Indicator** window is opened:
This window lets you modify the four properties that define a FOV symbol: name, size, shape, and color. The angular size for the symbol can either be entered directly in the Field of View edit box, or you can use the Eyepiece/Camera Tabs to calculate the field-of-view angle, given parameters of your telescope/eyepiece or telescope/camera setup. The five available shapes are: Square, Circle, Crosshairs, Bullseye and Semitransparent circle. Once you have specified all four parameters, press Ok, and the symbol will appear in the list of defined symbols. It will also be available from the Settings → FOV Symbols submenu.

### 3.19 Adjusting orientation of the sky map

You can tweak various settings to make the orientation of the sky map match the view through your optical instrument.

First, pick the coordinate system that matches your mount. For an equatorially mounted instrument, switch to the Equatorial Coordinate mode in the View menu or by pressing the Space key. The option to toggle the coordinate system should read **Switch to Horizontal View (Horizontal Coordinates)** when the current mode is Equatorial Coordinates. For an altazimuth-mounted instrument or naked-eye viewing, switch to Horizontal Coordinates, so that the option in the View menu reads **Switch to Star Globe View (Equatorial Coordinates)**. This sets the base coordinate system used to render the sky map, and also sets the reference for the orientation of the skymap: zenith or north.

If your instrument is using an erecting prism, typically used on Schmidt-Cassegrain and refracting type telescopes, the view through the eyepiece will be mirrored horizontally. You can have the sky map match this by checking the **Mirrored View** option under the View menu, or using the key combination Ctrl-Shift-M.

Next, to rotate the sky map freely, you can hold down the Shift key and drag the mouse on the sky map. A temporary overlay will appear showing the direction of north and zenith at the point, and displaying the angle they make with the vertical in a counterclockwise sense. The orientations of zenith and north will update as you rotate the sky map. Letting go of Shift or the mouse button will stop the rotation operation. As you pan the sky map or focus it on different objects, the rotation you set is retained as an offset from the reference direction. The reference direction is north when using Equatorial Coordinates and zenith when using Horizontal Coordinates. As
a reminder, the reference direction is solid and brighter in the temporary overlay. The temporary overlay also marks the East direction, which will be clockwise from north when mirrored and counter-clockwise when not mirrored. For the two common orientations of erect and inverted, the rotation can be set / reset using the View → Skymap Orientation submenu. Select North Down or Zenith Down as is applicable to set an orientation of 180 degrees.

If you are visually observing through an eyepiece of an instrument, you may need to do some more correction. For the common case of a large Dobsonian telescope (or more generally a Newtonian design mounted on an altazimuth mount), an additional systematic correction is of help. This correction applies because we stand erect while using the telescope irrespective of the angle the telescope tube is making with the ground. So as we move the telescope in altitude, an additional correction depending on the altitude of the object needs to be applied to make the sky map match the view through the eyepiece where the observer is standing erect. This correction is enabled by choosing the appropriate “Erect observer correction” option in the View → Skymap Orientation submenu. The correction depends on which side the telescope’s focuser is placed by the manufacturer. If when observing just above the horizon through the eyepiece, the sky is on the observer’s right side (and the mirror to the left), pick the Erect observer correction, right-handed option. Similarly, if the sky is to the left of the observer, choose the Erect observer correct, left-handed option. This correction only makes sense in Horizontal Coordinate mode and is disabled when using equatorial coordinates.

We now provide some examples of how to use these settings for various instruments:

• Naked-eye observing: Choose Horizontal Coordinates and a Zenith Up orientation under View → Skymap Orientation.

• Camera on an equatorially mounted telescope: Choose Equatorial Coordinates and adjust the orientation of the sky map so that it matches your camera. As your mount points to different regions of the sky, the orientation should be rendered correctly.

• Using binoculars: Same settings as Naked-eye observing

• Eyepiece of an altazimuth Schmidt-Cassegrain telescope with an erecting prism: Under the View menu, choose Mirrored View, and under the Skymap Orientation sub-menu, choose Zenith Up. Finally, tweak the rotation manually to match the eyepiece view according to the angle you are using for your erecting prism.

• Using a RACI finder scope on an altazimuth mounted telescope, looking straight down into it: Same settings as Naked-eye observing, except you may need to tweak the orientation manually once if you have it mounted at an angle

• Using a RACI finder scope on an altazimuth mounted telescope, looking through it from the side: In addition to the aforementioned, enable Erect observer correction for the appropriate side.

• Using a straight-through (inverted view) finder scope on an altazimuth mounted telescope: Choose Horizontal Coordinates and a sky-map orientation of Zenith Down in View → Skymap Orientation submenu

• Eyepiece of a Dobsonian telescope: Choose Horizontal Coordinates, and in the View → Skymap Orientation submenu, select Zenith Down and enable the erect observer correction, picking the left/right handed option as is appropriate for your telescope. Then adjust the orientation manually once to match your telescope eyepiece view, and it should henceforth track it correctly.

It is typical in visual astronomy to use at least three different instruments: the unaided eye, a finder scope, and the main telescope. The orientations of these three will have different settings and will need frequent modification of all the aforementioned options. To make it easy to adjust these settings together, KStars provides the Views feature. This feature is accessible through the View → Views menu and the options contained therein. The Arbitrary view is not a real view, but the option that gets selected when the sky-map orientation is modified manually through
the previously described options. The rest of the views are bona fide views. New views may be added, or the existing views may be edited, removed, or re-ordered using the View → Views → Edit Views... option. Choosing this brings up a window to manage the views:

To remove a view, simply select the view from the list and delete it using the Remove button. To reorder the views, use the mouse to drag the view you wish to move and drop it at its destination in-between two other entries. To edit a view, select the view from the list and click Edit... To create a new view, click the New... button. The Edit... and New... options bring up a view editor interface:

The Name field carries a unique name for the View. The Mount Type determines whether the reference direction used for orientation will be north or zenith. Typically, one would set this to the
type of mount used for the telescope. However, when using refractors and Schmidt-Cassegrain Telescopes (SCTs) with a rotatable diagonal, the observer will have a tendency to re-orient the eyepiece for comfort so that the eyepiece remains at a fixed angle with respect to the zenith. For this reason, it makes sense to choose Altazimuth mounting even when the telescope is actually on an equatorial mount. Choose Equatorial mounting when the focuser will not be re-oriented, such as when using a camera on an equatorially mounted telescope. For Newtonian telescopes that invert (i.e. rotate by 180 degrees but do not change the handedness) of the view, pick the Inverted option. This is also the correct option for straight-through refractors and finder scopes. When using a erecting prism diagonal, the prism erects the inverted image by flipping it up-down. This results overall in a left-right mirrored image. Thus for telescopes that use an erecting prism, pick Mirrored. A special kind of prism called an Amici roof prism not only erects the image vertically, but it also prevents left-right mirroring of the image. Finder scopes incorporating such a diagonal are normally called "Right-Angle Correct Image" or RACI finder scopes. Such diagonals may also be used on refractors and SCTs. When using such a prism that produces a correct image, choose the Correct option. The Mirrored on the vertical axis option is not encountered in typical astronomical instruments, but is provided for completeness. Two more factors need to be considered: one is the angle of the eyepiece with respect to the reference direction (north / zenith), and the other is the orientation of the observer’s head (and notion of the vertical) which we explained when describing the erect observer correction feature. These two aspects are configured using the single slider titled Eyepiece Angle. Two illustrations below the slider show the interpretation of this setting; on the left, as seen from the front as is more convenient for Newtonian telescopes, and on the right as is seen from the back, more convenient for refractors and Cassegrains. The observer naturally stands on the side that makes it more convenient to look through the eyepiece, so the erect observer correction is automatically adjusted accordingly. For eyepiece angles that are less than -1 degree on the slider, the Erect observer correction, right-handed option is applied. Similarly, for eyepiece angles that are greater than +1 degree, the Erect observer correction, left-handed is applied. At 0 degrees, no erect observer correction is applied. This correction is indicated by a silhouette of a person standing on the appropriate side of the telescope. In our convention, most mass-manufactured Dobsonians seem to have a correction around +45 degrees. Incidentally, this correction is also useful for finder scopes with diagonals. One may want to explicitly disable the erect observer correction even when the eyepiece angle is not zero. This is useful in case the view comes from a CCD camera that does not change angle with respect to the telescope body (unlike an observer’s head), or if the display showing KStars’ sky map is mounted on the telescope body itself. In this case the Display mounted on the telescope option can be checked. For the opposite effect, i.e. where the eyepiece angle is zero, but the observer is leaning to look through the eyepiece from one of the two sides, set the eyepiece angle to plus or minus 2 degrees to enable the erect observer correction; the minor difference will not be noticeable. Finally, one may want triggering of the view to also set the field-of-view of the sky map to some value, for example to set the FOV of a finder scope. In this case, the Also set the field of view check-box may be checked, and an approximate field-of-view to adjust may be specified. If this is not enabled, the zoom level of the sky map is not altered when this view is applied.

### 3.20 HiPS Progressive Overlay

KStars provides support for HiPS: Hierarchical Progressive Surveys. HiPS provides multi-resolution progressive surveys to be overlayed directly in client applications. It provides an immersive experience as you can explore the night sky dynamically. With over 200+ surveys across the whole electromagnetic spectrum from radio, infrared, visual, to even gamma rays, the user can pan and zoom progressively deeper into the data visually. It can be enabled from the View → HiPS All Sky Overlay submenu. Under the submenu, a list of enabled surveys are listed. Click on the survey of interest to activate it. You can only activate one-overlay at a time. After activating the survey, KStars shall begin downloading the data in the background and progressively overlay the images unto the sky map as they become ready. Zooming in usually requires another patch of images that should trigger another download cycle.
The above screenshot shows the DSS Color visual overlay in KStars.

**HiPS Settings...** menu item shows a dialog with the following pages:

- **Display**: Enable or disable **Show HiPS grid** and **Linear interpolation** checkboxes. The interpolation is enabled by default and should make the overlay appear smoother.

- **Cache**: Set the **Disk** and **Memory** cache size in MB. Increase cache size if you have abundant resources and want to reduce bandwidth required to download the images.

- **Sources**: Browse a list of HiPS sources and enable/disable them accordingly. When you select each source, a summary and a preview are downloaded that include information on the mission in addition to technical data on the survey.
Chapter 4

Command Reference

4.1 Menu Commands

4.1.1 File Menu

File → Open Image... (Ctrl+O)
Open an image in the FITS Viewer.

File → Save Sky Image...
Create image on disk from current display.

File → Run Script... (Ctrl+R)
Run the specified KStars script.

File → Printing Wizard...
Starts a wizard to configure capturing sky objects images using telescope and printing the results as a good looking printout for further use or catalogization.

File → Print... (Ctrl+P)
Send the current sky map to the printer (or to a PostScript®/PDF file).

File → Quit (Ctrl+Q)
Quit KStars.

4.1.2 Time Menu

Time → Set Time to Now (Ctrl+E)
Sync time to system clock.

Time → Set Time... (Ctrl+S)
Set time and date.

Time → Advance One Step Backward in Time (<)
Advance one step backward in time in the KStars simulation of the sky chart. The duration of the time step can be configured after pressing the little > button on the KStars toolbar.
4.1.3 Pointing Menu

Pointing → Zenith (Z)
Center the display at the Zenith point (straight up).

Pointing → North (N)
Center the display above the North point on the horizon.

Pointing → East (E)
Center the display above the East point on the horizon.

Pointing → South (S)
Center the display above the South point on the horizon.

Pointing → West (W)
Center the display above the West point on the horizon.

Pointing → Set Coordinates Manually... (Ctrl+M)
Center the display on specific sky coordinates.

Pointing → Find Object... (Ctrl+F)
Locate an object by name using the Find Object Window.

Pointing → Engage/Stop Tracking (Ctrl+T)
Toggle tracking on/off. While tracking, the display will remain centered on the current position or object.

4.1.4 View Menu

View → Zoom In (Ctrl++)
Zooms view in.

View → Zoom Out (Ctrl+-)
Zooms view out.

View → Default Zoom (Ctrl+Z)
Restore the default Zoom setting.

View → Zoom to Angular Size... (Ctrl+Shift+Z)
Zoom to specified field-of-view angle.

View → Full Screen Mode (Ctrl+Shift+F)
Toggle full-screen mode.
View → Switch to Star Globe View / Switch to Horizontal View (Space)
Toggle between the Horizontal and Equatorial Coordinate Systems.

View → Show Terrain (Ctrl+Shift+T)
Toggle the terrain image visibility.

View → Projection
A submenu that lists all projections.

Lambert Azimuthal Equal-area (F5)
Switch sky chart view to the Lambert azimuthal equal-area projection.

Azimuthal Equidistant (F6)
Switch sky chart view to the azimuthal equidistant projection.

Orthographic (F7)
Switch sky chart view to the orthographic projection.

Equirectangular (F8)
Switch sky chart view to the equirectangular projection.

Stereographic (F9)
Switch sky chart view to the stereographic projection.

Gnomonic (F10)
Switch sky chart view to the gnomonic projection.

View → HiPS All Sky Overlay
A submenu that lists the enabled surveys. Select the HiPS Settings... menu item for configure the HiPS sky overlays.

4.1.5 Tools Menu

Tools → Calculator (Ctrl+Shift+C)
Opens the AstroCalculator Tool, which provides full access to many of the mathematical functions used by KStars.

Tools → Devices
A submenu for control supported devices.

List your Equipment... (Ctrl+0)
Allows you to define your equipment characteristics for observation logs. The Configure Equipment window is divided into four tabs: Telescope, Eyepiece, Lens and Filter. You can add a new equipment by completing its characteristics and pressing Add New... button. You can also save or remove an equipment from the list.

Device Manager... (Ctrl+D)
Opens up the device manager, which allows you to start/shutdown device drivers and connect to remote INDI servers.

Custom Drivers...
A dialog to customize the drivers.

INDI Control Panel...
Opens up INDI Control Panel, which allows you to control all the features supported by a device.
Tools → Sky Calendar
Opens the Sky Calendar Tool, which allows you to plan observations of Solar System planets by giving graphical data on sets and rises of these objects.

Tools → Altitude vs. Time (Ctrl+A)
Opens the Altitude vs. Time Tool, which can plot curves representing the altitude of any object as a function of time. This is useful for planning observing sessions.

Tools → What’s up Tonight (Ctrl+U)
Opens the What’s up Tonight Tool, which presents a summary of the objects which are observable from your location on a given date.

Tools → What’s Interesting... (Ctrl+W)
Opens the What’s Interesting Tool, which allows you to be informed about the most interesting observations that can be made from your current location using the given equipment.

Tools → XPlanet Solar System Simulator (Ctrl+X)
This menu item will appear only if you have installed the XPlanet optional package.

Tools → Script Builder (Ctrl+B)
Opens the Script Builder Tool, which provides a GUI interface for building KStars D-Bus scripts.

Tools → Solar System (Ctrl+Y)
Opens the Solar System Viewer, which displays an overhead view of the solar system on the current simulation date.

Tools → Ekos (Ctrl+K)
Opens Ekos, a complete and powerful tool for astrophotography. With Ekos, you can align and guide your telescope, focus your CCD, and capture images using an easy intuitive interface.

Tools → Jupiter’s Moons (Ctrl+J)
Opens the Jupiter Moons Tool, which displays the positions of Jupiter’s four brightest moons as a function of time.

Tools → Flags
Opens the Flag manager Tool, which can be used to assign color labels and icons to the given positions on the sky chart.

4.1.6 Data Menu

Data → Download New Data... (Ctrl+N)
Open the Get Hot New Stuff dialog to download additional data for KStars.

Data → Manage DSO Catalogs
Open the DSO Catalogs dialog for manage the catalog database of KStars.

Data → Updates
This submenu can be used to update various object data, namely asteroids, comets and satellites orbital elements as well as recent supernovae data from the Internet. The data will be downloaded for the current user account only. If you use KStars from different account you should download them for every account separately.
KStars tries to download recent supernovae list automatically by default. You can switch the download off using Supernovae page of KStars Settings window.
4.1.7 Observation Menu

**Observation → Observation Planner (Ctrl+L)**

Open the Observation Planner tool.

**Observation → Execute the Session Plan... (Ctrl+2)**

Opens session plan wizard or execute the planned session.

**Observation → Polaris Hour Angle...**

Opens the Polaris Hour Angle tool.

4.1.8 Settings Menu

**Settings → Info Boxes**

A submenu that lists the different info boxes.

**Show Info Boxes**

Toggle display of all three Info Boxes:

- **Time Box**
- **Focus Box**
- **Location Box**

**Show Time Box**

Toggle display of the Time Info Box. By default, the Time Info Box is located in the top left side of the screen. You can change the position of Time Info Box by holding the left-click mouse button and dragging it to the new position.

**Show Focus Box**

Toggle display of the Focus Info Box. By default, the Focus Info Box is located in the top right side of the screen. You can change the position of Focus Info Box by holding the left-click mouse button and dragging it to the new position.

**Show Location Box**

Toggle display of the Location Info Box. By default, the Location Info Box is located in the bottom left side of the screen. You can change the position of Location Info Box by holding the left-click mouse button and dragging it to the new position.

**Settings → Toolbars Shown**

A submenu that lists the different toolbars.

**Main Toolbar**

Toggle display of the Main Toolbar. By default, the Main Toolbar provides useful shortcuts for controlling the sky map view (i.e. Zoom in and Zoom out) and for controlling KStars clock as well. You can Start / Stop the clock, advance one step backward / forward in time and also you can easily set the time step used by KStars’ clock. The time step is the rate at which time flows in the simulation. For setting the time step, you can use the spin box used for establishing the time step units and the spin box used for increasing / decreasing the time step value. Using the Main Toolbar you can quickly open the **Find Object, Set Time or Set Geographic Location** window. Main Toolbar can be configured using the Settings → Configure Toolbars... menu item.
The KStars Handbook

View Toolbar
Toggle display of the View Toolbar. View Toolbar controls which sky objects are drawn on KStars Sky Map (stars, deep sky objects, Solar system objects, supernovae or satellites) as well as what constellation information is included (constellation lines, constellation names, constellation art or constellation boundaries). It also provides icon shortcuts for: showing milky way (drawn with dark grey color), showing equatorial/horizontal coordinate grid and for showing the green opaque ground. Note that when the horizon is switched off, refraction effects are temporarily disabled. View Toolbar can be configured using the Settings → Configure Toolbars... menu item.

INDI Toolbar
Toggle display of the INDI Toolbar. By default, INDI Toolbar contains five shortcut icons:

- 📚 Toggle Ekos
- 🎓 Toggle INDI Control Panel
- 🌅 Toggle FITS Viewer
- 📡 Toggle Sensor FOV
- ⛰️ Toggle Lock Telescope Center

INDI Toolbar can be configured using the Settings → Configure Toolbars... menu item.

Telescope Toolbar
Toggle display of the Telescope Toolbar. By default, Telescope Toolbar contains seven shortcut icons:

- ⛭ Toggle Mount Control Panel
- ⚙️ Toggle Telescope Tracking
- 🔬 Slew telescope to the focused object
- 🔬 Sync telescope to the focused object
- 🚛 Park telescope
- 🚚 Unpark telescope
- ⏳️ Abort telescope motions

Telescope Toolbar can be configured using the Settings → Configure Toolbars... menu item.

Dome Toolbar
Toggle display of the Dome Toolbar. By default, Dome Toolbar contains two shortcut icons:
Dome Toolbar can be configured using the **Settings → Configure Toolbars...** menu item.

**Settings → Statusbar**
A submenu that lists the different statusbars.

**Show Statusbar**
Toggle display of the Statusbar. It is located in the bottom of KStars window.

**Show Az/Alt Field**
Toggle display of the mouse cursor’s horizontal coordinates in the statusbar.
The KStars Handbook

Show RA/Dec Field
Toggle display of the mouse cursor’s equatorial coordinates in the statusbar.

Show J2000.0 RA/Dec Field
Toggle display of the mouse cursor’s equatorial J2000 coordinates in the statusbar.

Settings → Themes
Lists the available Theme items.

Settings → Color Schemes
This submenu contains all of the defined color schemes: Classic, Star Chart, Night Vision and Moonless Night. It can also include your custom color schemes. Select any item to set that color scheme.

Settings → FOV Symbols
This submenu lists the available field-of-view (FOV) Symbols. The FOV Symbol is drawn at the center of the display. You may choose one or more from the list of predefined symbols (7x35 Binoculars, Telrad, One Degree, HST WFPC2 or 30m at 1.3cm) by checking their specific checkbox, or you may use no symbol by unchecking all the items from the symbols list. You can also define your own symbols (or modify existing symbols) using the Edit FOV Symbols... menu item.

Settings → Artificial Horizon...
If you select this submenu, then Artificial Horizon Manager will be opened. Artificial Horizon Manager is used to define on the skymap one or more regions that are blocked from view from your current location (i.e. tall trees or building). The window is split in two sections: in the left side is the Regions section while in the right side is the Points section. You can add a new region by pressing the + (Add Region) button or you can remove a region by selecting it in the regions list and then pressing the - (Remove Region) button. In order to draw a region you need to define a list of points that encompasses the blocked area. You can add a new point by pressing the + (Add Point) button from the right Points section. You can also remove a highlighted point from the list of points or you can clear all the points. There are two ways to add a new point to a selected region: manually by entering the point’s coordinates or by selecting the point from the skymap after clicking Select Points button. Note that each point is described by a set of horizontal coordinates: Az (Azimuth) and Alt (Altitude). If you want to modify a point’s coordinates, just double click on its Az/Alt text box value and enter the new value. First and Last points must be on the horizon. Polygons must be closed to be considered valid regions. Artificial Horizon Manager provides a easy way to rename your regions. By default, regions are named as: ‘Region ’ plus an index (i.e. ‘Region 1’ or ‘Region 2’). For renaming a region, just double click on its name and then you will be invited to complete a new region name. You can also control which regions are enabled or disabled for marking on the map by a simple click on the checkbox in front of each region. After you defined your desired regions you can apply them by pressing the Apply button. If you want to use these regions again, in further astronomy sessions, you can save them such that next time when you will open KStars they will be automatically marked on the skymap.

Settings → Manage Observer... (Ctrl+1)
Selecting this will open Manage Observers window that enables you to register a number of observers which are using KStars on this computer. You can add a new entry to observers list by completing the mandatory fields: Name: and Surname: and then pressing the + (Add observer) button. Note that Contact: field is optional, KStars allowing you to add a new observer even though Contact: text box is empty. You can also remove an observer from the list using - (Remove observer) button.

Settings → Geographic... (Ctrl+G)
Select a new geographic location.
The KStars Handbook

Settings → Configure Keyboard Shortcuts...

Open the Configure Shortcuts window which allows you to modify KStars shortcuts. You can use KStars default shortcuts scheme or define your own shortcuts scheme. In order to add a new custom shortcut to an action, you need to click on action’s name and then press the Custom: checkbox. Then click on the button next to Custom: checkbox and enter the shortcut you would like to use in KStars. You can also remove a shortcut by pressing the Delete button after you select an action from the list. KStars helps you to find an action by providing its search method; just enter the name of the action and the list will be reduced to its best matches. For example, I will give you a brief example on how to use KStars Configure Shortcuts feature:

- Firstly, open the Configure Shortcuts window from the Settings menu.
- Then select the action you would like to add a shortcut (i.e. Artificial Horizon). You can use the search method provided by KStars. Just type ‘art’ in the search text box and the list will be reduced to only four actions. The Artificial Horizon is the first action in the list.
- Now that you find your desired action, you can add a new shortcut by clicking on its name. After you click on the action name, press the Custom checkbox. There is a button next to Custom checkbox used for adding new shortcuts. By default, if an action has no custom shortcut, the ‘None’ tag will be assigned to this button. Press this button and then add your custom shortcut. For example, for Artificial Horizon, you can use Ctrl+H shortcut. Hold the Ctrl key and press H. Your shortcut be automatically saved, thus you can use it next time when you open KStars.

Settings → Configure KStars...

Modify configuration options.

Settings → Startup Wizard...

Shows the Setup Wizard dialog. It is the same window that you saw when you ran KStars for the very first time. KStars Setup Wizard will help you set up some basic options, such as your location on Earth. The first page of Setup Wizard is a welcome page and if you press Next button, you will get the Choose Your Home Location page. Here you can select your exact home location or a city near your home location if your accurate location is not present in KStars cities database. Browsing the entire list is not so efficient and thus, KStars provides you a easy-to-use method for selecting your desired city in a short time. You may filter the list of cities by the name of your city, province and country. By giving more details about your location, the list’s size will reduced only to its best matches. When you highlight a city in the cities list, the Longitude: and Latitude: boxes will be updated, containing the accurate information of your selected location. When you hit the Next button, you will get the last page of KStars Setup Wizard: ‘Download Extra Data Files’ page. Here you may download optional data files via the Internet, in order to enhance KStars, such as Messier object images, or a more complete NGC/IC catalog. Press the Download Extra Data... button to proceed. After you pressed this button, the Get Hot New Stuff dialog will appear. It is KStars Add-On Installer, which will help you to manage what extra information you added to KStars. Firstly, you can choose how the add-ons list is displayed, by pressing the Details view mode or Icons view mode button. You may also order the list by various criteria like: newest, rating, most downloads or installed. This can be easily done by selecting an option using the radio button. You can also make searches using the Search: text box. Regarding the list of add-ons, you may perform several actions by selecting an add-on from the list: you can install or uninstall an add-on using the Install / Uninstall button, you can open the Details window using the Details button or you can rate an add-on by giving a number of gold stars, up to five stars. If you want to send an email to the author of an add-on, you are able to do that by clicking on his e-mail address. Then, your default e-mail application will guide you through the sending process. After you managed your KStars add-ons, then you can close the window by pressing the Close button. You can also use the Download Extra Data Files tool later, by selecting the Data → Download New Data... menu item.
Additionally KStars has the common KDE Settings menu items, for more information read the sections about the Settings Menu of the KDE Fundamentals.

### 4.1.9 Help Menu

KStars has the common KDE Help menu items, for more information read the section about the Help Menu of the KDE Fundamentals.

### 4.1.10 Popup Menu

The right click popup menu is context-sensitive, meaning its content varies depending on what kind of object you click on. We list all possible popup menu items here, with the relevant object type [in brackets].

- **Identification and quick info:** The top several lines are devoted to the name(s) of the object, its type and the constellation in which it lies. The magnitude is shown with the superscript ‘m’ if it is available. For stars, the Spectral Type is also shown here. For deep-sky objects, the dimensions, if known, are shown in arcminutes (eg: 6’×3’) and the source catalog is also shown.

- **Rise, Transit, and Set times for the object on the current simulation date are shown on the next three lines.**

- **Center & Track:** Center the display on this location, and engage tracking. Equivalent to double-clicking.

- **Add flag...** Open KStars ‘Flag manager’ window. Here you can manage your flags and use some of KStars features. When ‘Flag manager’ window is open for a selected object, Right ascension and Declination text boxes will be automatically filled with the coordinate values of the selected object on the Sky Map. Besides these two text boxes, you can set the Epoch, add a Label, set the Label color or even add an Icon. To add custom icons, just add images in `qtpaths --paths GenericDataLocation/kstars/`. File names must begin with the ‘flag’ keyword. For example, the file ‘flagSmall_red_cross.gif’ will be shown as Small red cross in the combo box. After you set up the information of the new flag, you can add it to the flags list using the Add button. You may also change flags details (i.e. RA/Dec, label or icon) and then save the new ones by pressing the Save changes button. Using the Flag manager, you can easily center an object in Map or in Telescope, by pressing Center in Map or Center in Telescope button. In order to delete a value from the list, just select it in the list and then press Delete button. Your flags are saved after you close current session and thus you will be able to see them everytime you will use KStars again.

- **Angular Distance To...** Enter “angular distance mode”. In this mode, a dotted line is drawn from the first target object to the current mouse position. When you click with the right mouse button on a second object, this will display the angular distance between the two objects near the second object. You can press the Esc key to exit angular distance mode without measuring an angle.

- **Starhop from here to:** will enable you to find a path between two points in the sky. Star hopping is a technique that uses bright stars as a guide for finding fainter objects. So if
you have a bright star, you can use it as a reference to find a fainter object. Starting from your reference star, KStars will find a route to the destination, traversing a sequence of stars/patterns of stars. The object for which you called Starhop from here to tool will be your starting point. When your starting point is established, a dotted line will appear, allowing you to decide which will be your end point. You have to move the mouse cursor to your destination object position and right click on it. Then, a dialog box will pop up, requiring you to set the FOV used for star hopping. For selecting a FOV, you need to make a choice from the FOV combo box list of values. The values you can choose include default FOV values (7x35 Binoculars, Telrad, One Degree, HST WFPC2 and 30m at 1.3cm) plus your customized FOVs. After you selected the FOV, KStars will find a route for you. Thus, the dialog box will contain a list of object used in the starhop. If KStars did not manage to find a route, then an error dialog box will be displayed, giving you a helping hand. When the Star-Hopper algorithm ends, the dialog box will contain a list of objects used in starhop route. For every object from the list, you can perform a set of actions: you can ask for details using the Details button, center selected object in the map using Center on map button or you can go to next star by pressing the Next button. Note that when go to next star, it will be automatically centered on the map. Also, Star-Hopper tool provides directions to star hop for every object of the list.

[All]
Details: Open the Object Details window for this object.

[All]
Attach Label: Attach a permanent name label to the object. If the object already has a label attached, this item will read Remove Label.

[All]
Add to Observing WishList: Add the selected object to Observation Planner’s Wish List. You can see the Wish List, by selecting the Observation → Observation Planner menu item. If the object is already in the Observing WishList, then this item will become Remove Label.

[Solar system objects]
Add Trail: Add a trail to current Solar system object. A star trail is the continuous path created by the star in the night sky due to the rotation of the Earth. If the object already has a trail, this item will become Remove Trail.

[All]
Simulate eyepiece view: Eyepiece View feature renders the view through the eyepiece of various telescope types. Firstly, an input dialog is shown, which asks you to select one of the visible FOVs to use as a FOV for the eyepiece view. The user also has the option of trying to determine it from the image (accurate if image has metadata, otherwise it will be random). After you set the FOV, the “Eyepiece Field View” window will pop up. You can easily rotate the view using the “Rotation” slider. You can also flip and invert the view to help match the view through a telescope/camera. "Eyepiece view” tool can help you locate many objects with ease, instead of trying to work with relative positions and relative orientations. This is an important advantage, especially when you are star hopping. Note that for getting best results, time must be synced with current time in KStars, and KStars must be in horizontal coordinates mode.

[Solar system objects]
Image Resources: gives a list of image links for current Solar system object. The images are displayed in KStars Image Viewer tool. Image Viewer tool allows you to invert the colors and save the image in your computer.

[Solar system objects]
Information Resources: gives a list of documentation links for current Solar system object. The links are opened in your default browser.
[All objects without Solar system objects]
Show SDSS Image: download a SDSS (Sloan Digital Sky Survey) image of the object from the Internet, and display it in the Image Viewer tool.

[All objects without Solar system objects]
Show DSS Image: download a DSS (Digitized Sky Survey) image of the object from the Internet, and display it in the Image Viewer tool.

4.2 Keyboard Commands

4.2.1 Navigation Keys

Arrow Keys
Use the arrow keys to pan the display. Holding down the Shift key doubles the scrolling speed.

+ / -
Zoom In/Out.

Ctrl+Z
Restore the default Zoom setting.

Ctrl+Shift+Z
Zoom to specified field-of-view angle.

0–9
Center Display on a major Solar System body:
• 0: Sun
• 1: Mercury
• 2: Venus
• 3: Moon
• 4: Mars
• 5: Jupiter
• 6: Saturn
• 7: Uranus
• 8: Neptune
• 9: Pluto

Z
Center the display at the Zenith Point (straight up).

N
Center the display above the North point on the horizon.

E
Center the display above the East point on the horizon.

S
Center the display above the South point on the horizon.

W
Center the display above the West point on the horizon.
Ctrl+T  
  Toggle tracking mode.

<  
  Advance the simulation clock backwards by one time step.

>  
  Advance the simulation clock forwards by one time step.

### 4.2.2 Menu Shortcuts

**Ctrl+N**  
Download extra data.

**Ctrl+O**  
Open a FITS image in the FITS Editor.

**Ctrl+I**  
Export sky image to a file.

**Ctrl+L**  
Run a KStars Observation Planner.

**Ctrl+R**  
Run a KStars D-Bus script.

**Ctrl+P**  
Print the current sky map.

**Ctrl+Q**  
Quit KStars.

**Ctrl+E**  
Sync the simulation clock with the current system time.

**Ctrl+S**  
Set the simulation clock to a specified Time and Date.

**Ctrl+Shift+F**  
Toggle full-screen mode.

**Ctrl+0**  
Define equipment (telescope, eyepiece, lens and filter) characteristics for observation logs.

**Ctrl+1**  
Add a new observer item for your observation logs.

**Space**  
Toggle between the Horizontal and Equatorial Coordinate Systems.

**F1**  
Open the KStars Handbook.

**F5**  
Switch sky chart view to the Lambert azimuthal equal-area projection.

**F6**  
Switch sky chart view to the azimuthal equidistant projection.
F7

Switch sky chart view to the **orthographic** projection.

F8

Switch sky chart view to the **equirectangular** projection.

F9

Switch sky chart view to the **stereographic** projection.

F10

Switch sky chart view to the **gnomonic** projection.

### 4.2.3 Actions for the Selected Object

Each of the following keystrokes performs an action on the *selected object*. The selected object is the last object which was clicked on (identified in the status bar). Alternatively, if you hold down the **Shift** key, then the action is performed on the centered object instead.

**C**

Center and Track on the selected object.

**D**

Open the Details window for the selected object.

**L**

Toggle a name label for the selected object.

**O**

Add the selected object to the observing list.

**P**

Open the selected object’s popup menu.

**T**

Toggle a trail on the selected object (solar system bodies only).

### 4.2.4 Tools Shortcuts

**Ctrl+F**

Open the **Find Object window**, for specifying a sky object on which to center.

**Ctrl+M**

Open the **Set Coordinates Manually** tool, for specifying RA/Dec or Az/Alt coordinates on which to center. The tool defaults to **J2000 epoch** for the RA/Dec.

**L**

Start an Angular Distance measurement at the current mouse cursor position. The angular distance between start and end points is displayed at the endpoint.

**Ctrl+G**

Open the **Set Geographic Location** window.

**Ctrl+C**

Open the **AstroCalculator**.
Ctrl+A
Open the Altitude vs. Time tool.

Ctrl+U
Open the What’s up Tonight? tool.

Ctrl+W
Open the ‘What’s Interesting’ tool.

Ctrl+B
Open the Script Builder tool.

Ctrl+Y
Open the Solar System Viewer.

Ctrl+J
Open the Jupiter Moons tool.

4.3 Mouse Commands

Moving the mouse
The sky coordinates (Az/Alt, RA/Dec and J2000.0 RA/Dec) of the mouse cursor are updated in the status bar. The status bar is located in the right bottom corner of the screen. The status bar can be customized by selecting Settings → Statusbar submenu. Here you may choose what coordinates systems KStars will display in the status bar. Furthermore, you can hide the status bar by unchecking the Show Statusbar checkbox.

“Hovering” the mouse
A temporary name label is attached to the object nearest to the mouse cursor.

Left-clicking
The object nearest the mouse click is identified in the status bar.

Double-clicking
Center and track on the location or object nearest the mouse click. Double-clicking on an Info Box will ‘shade’ it to show/hide extra information.

Right-clicking
Open the popup menu for the location or object nearest the mouse cursor.

Scrolling the mouse wheel
Zoom the display in or out. If you do not have a mouse wheel, you can hold the middle mouse button and drag vertically.

Click-and-dragging

Dragging the sky map
Pan the display, following the drag motion.

Ctrl+dragging the sky map
Define a rectangle in the map. When the mouse button is released, the display is zoomed in to match the field-of-view to the bounds of the rectangle.

Dragging an Info Box
The Info Box is repositioned in the map. Info Boxes will ‘stick’ to window edges, so that they remain on the edge when the window is resized.
Ekos is an advanced cross-platform (Windows®, Mac® OS, Linux®) observatory control and automation tool with a particular focus on Astrophotography. It is based on a modular extensible framework to perform common astrophotography tasks. This includes highly accurate GOTOs using astrometry solver, ability to measure and correct polar alignment errors, auto-focus & autoguide capabilities, and capture of single or stack of images with filter wheel support. Ekos is shipped with KStars.

https://www.youtube.com/embed/un2KVJY3Yis

Ekos introductory video

Features:

- Control your telescope, Camera (& DSLRs), filter wheel, focuser, guider, adaptive optics unit, and any INDI-compatible auxiliary device from Ekos.
- Built-in native autoguiding with support for automatic dithering between exposures and support for Adaptive Optics devices in addition to traditional guiders.
- Extremely accurate GOTOs using astrometry.net solver (both Online and Offline solvers supported).
- Load & Slew: Load a FITS image, slew to solved coordinates, and center the mount on the exact image coordinates in order to get the same desired frame.
- Measure & Correct Polar Alignment errors using astrometry.net solver.
- Easy to use Polar Alignment Assistant tool. A very quick and reliable tool to polar align your German Equatorial Mount!
- Capture and record video streams in SER format.
- Completely automated scheduler to control all your observatory equipment, select the best targets for imaging given current conditions and constraints, monitor weather conditions, and capture your data while you are away!
- Smart Dark Library: All your dark frames with different binning/temperature/frame settings are saved for future use. Ekos re-uses dark frames intelligently without taking unnecessary captures. You can configure how long you want to reuse all the dark frames.
- Define multiple driver profiles for local and remote setups. Switch among them easily.
- Auto and manual focus modes using Half-Flux-Radius (HFR) method.
- Automated unattended meridian flip. Ekos performs post meridian flip alignment, calibration, focusing, and guiding to resume the capture session.
The KStars Handbook

- Automatic focus between exposures when a user-configurable HFR limit is exceeded.
- Powerful sequence queue for batch capture of images with optional prefixes, timestamps, filter wheel selection, and much more!
- Export and import sequence queue sets as Ekos Sequence Queue (.esq) files.
- Center the telescope anywhere in a captured FITS image or any FITS with World Coordinate System (WCS) header.
- Automatic flat field capture, just set the desired ADU and let Ekos does the rest!
- Automatic abort and resumption of exposure tasks if guiding errors exceed a user-configurable value.
- Support for dome slewing.
- Complete integration with KStars Observation Planner and SkyMap.
- Fully scriptable via D-Bus.
- Integrate with all INDI native devices.

5.1 Ekos Setup

Ekos is a part of KStars. KStars/Ekos is already included with your StellarMate gadget. It is also available for Linux, Mac OS, and Windows if you want to install on your primary machine. After you run KStars on your PC or on StellarMate (Either directly via HDMI or via VNC), Ekos can be accessed from the Tools menu or via the Ekos on the main toolbar, or by a keyboard shortcut (Ctrl-K). In addition to the Ekos window, KStars provides a more detailed INDI Control Panel where you can directly set and control the device parameters.

When running Ekos, it is not necessary to start INDI Server via StellarMate Web Manager as Ekos manages that transparently.
5.2 User Interface

Ekos Astrophotography Tool is organized into several Modules. A module is a set of functions and tasks for a particular step in astrophotography and/or data acquisition. Currently, the following modules are included with Ekos:

- Setup & Summary Module
- Scheduler Module
- Capture Module
- Focus Module
- Alignment Module
- Guide Module
- Mount Module

Each module has its own tab and icon in the graphical user interface as illustrated in the screenshot below:
Summary & Setup Module

As its name suggests, this is where you will create and manage your equipment profile, and connect to your devices. It also provides a summary view where the capture progress along with the focus & guide operations is displayed in a compact format to convey the most important information relevant to the user.

Scheduler Module

After mastering Ekos, users are encouraged to learn how to use the Scheduler module since it facilitates the complete observation process greatly. It enables you to select multiple targets, specify which conditions and requirements to be met, and what frames are required for capture. Afterwards the scheduler intelligently calculates the best observation time for each object and then proceed to control the complete observatory from startup to shutdown.

Capture Module

This is the primary module for camera & filter wheel control. Create imaging sequences, capture previews, and watch video streams. It supports rotator control and can automatically capture flat frames in a number of scenarios.

Focus Module

Measure the sharpness of your images in the focus module by calculating Half-Flux-Radius. The lower the HFR, the sharper the image becomes. You can run the focus module with or without a focuser. With an electronic focuser, you can run an autofocus operation where Ekos iterates and calculates the optical focus position.

Guide Module

To achieve long exposure astrophotography, guiding is necessary to ensure the image is locked and stabilized for the complete duration of the exposure duration. Deviations from the frame with time can lead to blurry images and star trails. In the guide module, it can automatically select a suitable guide star and then lock the mount to always keep that star in its position. If the guide module detects any deviation from this locked position, it sends correction pulses to the mount to bring it back to the original position.
Mount Module

Mount control can be either done via the Sky Map interactively or via the Mount Control Panel in the mount module. Configure telescope properties (focal length & aperture) for both your primary imaging telescope and guide scope. However, it is recommended to select the telescopes in the equipment profile and not change the values directly in the mount module.

5.3 Profile Wizard

The Profile Wizard is a handy tool to setup your equipment for the first time. It should popup automatically the first time you run KStars. Follow the guided instructions to setup your first equipment profile.

Greeting Page

The first greeting screen contains some links to learn more about Ekos & INDI. Click Next to continue.

Equipment Location Page

Next, you will be presented with the equipment location page. Your selection depends on where your equipment is connected to:

- **Equipment is attached to this device**: Select this option if Ekos is running on your StellarMate (via HDMI or VNC), device (Windows®/Linux®) or Mac® OS.
- **Equipment is attached to a remote device**: Select this option if Ekos is running on your device (Windows®/Linux®) or Mac® OS, and your equipment is connected to a remote computer.
- **Equipment is attached to StellarMate**: Select this option if Ekos is running on your device (Windows®/Linux®) or Mac® OS, and your equipment is connected to StellarMate.
Click **Next** to continue.

**Remote Connection Page**

In case selected the 2nd option in the last step, you shall be presented with the Remote Connect Page, here you will enter the hostname or IP address of the StellarMate unit. You can get the hostname from the StellarMate mobile App. Alternatively, you can construct the hostname from StellarMate HotSpot SSID. You should see the SSID when you search for WiFi networks nearby. For example, suppose the SSID is `stellarmate`. The hostname should be `stellarmate.local`. That is, if you remove the underscore, and append `.local`, then you will get the unit hostname. You can always use the StellarMate App to change the unit default hostname to the name of your choice.
For the INDI Manager question, always select Yes since StellarMate Web Manager is running by default on the unit. Click Next to continue.

Profile Creation Page

Now you get to name your equipment profile. Afterwards select which guider application to use. The Internal Guider is the only officially supported selection in StellarMate. You may opt to select PHD2/LinGuider but the details are out of the scope of this documentation. If additional services are desired, check the ones you want to run.

In the example above, we select Remote Astrometry, WatchDog, and SkySafari drivers. The detailed explanations for each is provided in the tooltip when you over them. Once done, click Create Profile button. You should now be presented with the Profile Editor.
5.4 Profile Editor

Profiles

You can define profiles for your equipment and their connection mode using the Profile Editor. Ekos comes pre-installed with the Simulators profile which can be used to start simulator devices for demonstration purposes:

- **Connection Mode**: Ekos can be started either locally or remotely. Local mode is when Ekos is running in the same machine as INDI server, i.e. all the devices are connected directly to the machine. If you run INDI server on a remote machine (for example, on a Raspberry Pi), you need to set the INDI server host and port.

- **Auto Connect**: Check this option to enable automatic connection to all your devices after INDI server is started. If unchecked, INDI devices are created but not automatically connected. This is useful when you want to make changes to the driver (e.g. change baud rate or IP address or any other settings) before you connect to it.

- **Port Selector**: Check this option to enable Port Selector. When creating a new profile, it is checked by default. Port Selector is used to select initial serial and network communication parameters for the devices in the equipment profile. After connecting to equipment for the first time, the Port Selector popup is displayed where the communication parameters can be set before establishing connection. Once connected, the Port Selector option is turned off. It can be toggled to checked in the profile editor to enable it back.

- **Site Info**: Optionally, you can check the Site Info checkbox and Ekos will load the current city and timezone whenever is Ekos is started with this profile. This can be useful when connecting to the remote geographic site so that Ekos is in sync location and time wise.

- **Guiding**: Select which Guide application you want to use for guiding. By default, the Ekos internal Guide Module is utilized. External guiders include PHD2 and LinGuider.

- **INDI Web Manager**: StellarMate Web Manager is a web-based tool to start and stop INDI drivers. You should always check this option when connecting remotely to a StellarMate unit.
The KStars Handbook

- **Device Selection**: Select your devices from each category. Please note that if you have a CCD with a guide head, you can leave the guider drop-down menu blank as Ekos will auto-detect the guide head from the CCD camera. Similarly, if your CCD includes embedded filter wheel support, then you do **not** need to specify the filter wheel device in the filter drop-down menu.

- **Scripts**: Adjust pre-driver and post-driver delays and scripts for each driver. A rule can be defined for each driver in case there is a need to introduce delays before and/or after starting a particular driver. The fields before the driver selection dropdown are to be executed before the driver is started, whereas the fields after the driver selection dropdown are to be executed after the driver started. The script field, if specified, should include the full path to an executable script with the appropriate permissions. All drivers configured in the scripts editor would be started first and in order before the rest of the equipment profile drivers.

![Profile Scripts Editor — KStars](https://example.com/profile_scripts_editor.png)

### Start & Stop INDI

Start and Stop INDI services. Once INDI server is established, INDI Control Panel will be displayed. Here you can change some driver options such as which port the device is connected to etc.

### Connect & Disconnect Devices

Connect to INDI server. Based on the devices connected, Ekos modules (CCD, Focus, Guide, etc.) will be established and available to use.

Once you are ready, click **Start INDI** to establish INDI server and connection to your equipment. Ekos shall create the various module icons (Mount, Capture, Focus, etc.) as the connection is established with the device.

### 5.5 Logs

Logging is a very important tool in order to diagnose any issues with either INDI drivers or Ekos. Before submitting any support request, the log must be attached in order to help diagnose the exact issue. Depending on the exact problem, you may need to enable logging for the feature or drivers that exhibit issues. Enabling logging for everything is not recommended as it will produce too much data that would be useful to diagnose the issue and could result in missing the root cause all other. So only enable the necessary logs.

The following short video explains how to use the Logging feature to submit logs.


**Logging feature**
5.6 Capture

The Capture Module is your primary image and video acquisition module in Ekos. It enables you to capture single (Preview), multiple images (Sequence Queue), or record SER videos along with a selection of filter wheel and rotator, if available.

5.6.1 CCD & Filter Wheel Group

Select the desired CCD/DSLR and Filter Wheel (if available) for capture. Set CCD temperature and filter settings.

- **CCD**: Select the active CCD camera. If your camera has a guide head, you can select it from here as well.
- **FW**: Select the active Filter Wheel device. If your camera has a built-in filter wheel, the device would be the same as the camera.
- **Cooler**: Toggle Cooler On/Off. Set the desired temperature, if your camera is equipped with a cooler. Check the option to force temperature setting before any capture. Capture process is only started after the measured temperature is within requested temperature tolerance. The default tolerance is 0.1 degrees Celsius but can be adjusted in Capture options under Ekos configuration.
5.6.2 Capture Settings

Set all capture parameters as detailed below. Once set, you can capture a preview by click on Preview or add a job to the sequence queue.

- **Exposure**: Specify exposure duration in seconds.
- **Filter**: Specify the desired filter.
- **Count**: Number of images to capture
- **Delay**: Delay in seconds between image captures.
- **Type**: Specify the type of desired CCD frame. Options are Light, Dark, Bias, and Flat frames.
- **ISO**: For DSLR cameras, specify the ISO value.
- **Format**: Specify capture save format. For all CCDs, only FITS option is available. For DSLR cameras, you can an additional option to save in Native format (e.g. RAW or JPEG).
- **Custom Properties**: Set extended properties available in the camera to the job settings.
- **Calibration**: For Dark & Flat frames, you can set additional options explained in the Calibration Frames section below.
- **Frame**: Specify the left (X), top (Y), width (W), and height (H) of the desired CCD frame. If you changed the frame dimensions, you can reset it to default values by clicking on the reset button.
- **Binning**: Specify horizontal (X) and vertical (Y) binning.

5.6.2.1 Custom Properties

Many cameras offer additional properties that cannot be directly set in the capture settings using the common control. The capture controls described above represent the most common settings shared among different cameras, but each camera is unique and may offer its own extended
properties. While you can use INDI Control Panel to set any property in the driver; it is important to be able to set such property for each job in the sequence. When you click Custom Properties, a dialog is shown divided into Available Properties and Job Properties. When you move an Available Properties to the Job Property list, its current value can be recorded once you click Apply. When you add a job to the Sequence Queue, the properties values selected in the Job Properties list shall be recorded and saved.

The following video explains this concept is more detail with a live example:

https://www.stellarmate.com/images/fss/videos/custom_properties.mp4

Custom Properties feature

5.6.3 File Settings

Settings for specifying where captured images are saved to, and how to generate unique file names in addition to upload mode settings.

- **Target**: The name of the celestial target to be captured e.g. M42. Can be preloaded by the Scheduler Module and by selection with KStars.

- **Format**: The Format string defines the path and filename of the captured images by the use of placeholder tags that are filled in with the selected item of data at save time. A tag is identified by the % character. All tags have a single letter short form, and a self descriptive long form.

  Arbitrary text may also be included within the Format string, except the % and \ characters. The / path character can be used to define arbitrary directories.

  Note: Tags are case sensitive in both their short and long forms.

  Available placeholder tags:

  - %f or %filename: The name of the sequence .esq file, without extension.
  - %D or %Datetime: The current time and date when the file is saved. Only use this tag in the filename portion of the format, not in the path portion.
  - %T or %Type: The frame type e.g. ‘Light’, ‘Bias’, ‘Dark’, ‘Flat’...
  - %e or %exposure: The exposure duration in seconds.
  - %F or %Filter: The active filter name.
  - %t or %target: The Target name.
  - %seq or %sequence*: The image sequence identifier where * is the number of digits used (1-9). This tag is mandatory and must be the last element in the format.

- **Directory Browse Button**: Opens a browse dialog to allow selection of the directory location used in the Format string. Use when first defining a Capture job.

- **Preview**: Shows a preview of the resulting filename according to the Format string and other job settings.

  Placeholder tags that are specified by the sequence .seq file can only be displayed once the sequence file has been saved.

  The Datetime tag is previewed with the current system time and will be replaced by the time at point of image save.

  The sequence tag is always previewed as image 1 in the sequence and will be automatically incremented when the job is in progress.
The KStars Handbook

- **Upload**: Select how captured images are uploaded:
  1. **Client**: Captured images are only uploaded to Ekos and saved to the local directory specified above.
  2. **Local**: Captured images are only saved locally on the remote computer.
  3. **Both**: Captured images are saved on the remote device and uploaded to Ekos.

When selecting **Local** or **Both**, you must specify the remote directory where the remote images are saved to. By default, all captured images are uploaded to Ekos.

- **Remote**: When selecting either **Local** or **Both** modes above, you must specify the remote directory where remote images are saved to.

- **Preview**: Shows a preview of the resulting filename according the provided path job settings. The file name format for saving remotely is pre-defined, placeholder tags may not be used. The file sequence number is always previewed as image 1 in the sequence and will be automatically incremented when the job is in progress.

### 5.6.4 Limit Settings

Limit settings are applicable to all the images in the sequence queue. When a limit is exceeded, Ekos shall command the appropriate action to remedy the situation as explained below.

- **Guiding Deviation**: If checked, it enforces a limit of maximum allowable guiding deviation for the exposure, if autoguiding is used. If the guiding deviation exceeds this limit in arcseconds, it aborts the exposure sequence. It will automatically resume the exposure sequence again once the guiding deviation goes below this limit.

- **Autofocus if HFR >**: If autofocus is enabled in the focus module and at least one autofocus operation was completed successfully, you can set the maximum acceptable HFR value. If this option is enabled then between consecutive exposures, the HFR value is recalculated, and if found to exceed the maximum acceptable HFR value, then an autofocus operation is automatically triggered. If the autofocus operation is completed successfully, the sequence queue resumes, otherwise, the job is aborted.

- **Meridian Flip**: If supported by the mount, set the hour angle limit (in hours) before a meridian flip is commanded. For example, if you set the meridian flip duration to 0.1 hours, Ekos shall wait until the mount passes the meridian by 0.1 hours (6 minutes), then it commands the mount to perform a meridian flip. After the meridian flip is complete, Ekos re-aligns using astrometry.net (if the alignment was used) and resumes guiding (if it was started before) and then resumes the capture process automatically.
5.6.5 Sequence Queue

Sequence Queue is the primary hub of the Ekos Capture Module. This is where you can plan and execute jobs using the sequence queue built-in powerful editor. To add a job, simply select all the parameters from the capture and file settings as indicated above. Once you selected your desired parameters, click on the add button in the sequence queue to add it to the queue.

You can add as many jobs as desired. While it is not strictly necessary, it is preferable to add the dark and flat jobs after the light frames. Once you are done adding jobs, simply click Start Sequence to begin executing the jobs. A job state changes from Idle to In Progress and finally to Complete once it is done. The Sequence Queue automatically starts the next job. If a job is aborted, it may be resumed again. To pause a sequence, click the pause button and the sequence will be stopped after the current capture is complete. To reset the status of all the jobs, simply click the reset button . Please beware that all image progress counts are reset as well. To preview an image in KStars FITS Viewer, click the Preview button.

Sequence queues can be saved as an XML file with extension .esq (Ekos Sequence Queue). To load a sequence queue, click the open document button . Please note that it will replace any current sequence queues in Ekos.

**IMPORTANT**

**Job Progress:** Ekos is designed to execute and resume the sequence over multiple nights if required. Therefore, if **Remember Job Progress** option is enabled in Ekos Options, Ekos shall scan the file system to count how many images are already completed and will resume the sequence from where it was left off. If this default behavior is not desired, simply turn off **Remember Job Progress** under options.

To edit a job, double click it. You will notice the add button now changed to check mark.
button. Make your changes on the left-hand side of the CCD module and once done, click on the check mark button. To cancel a job edit, click anywhere on the empty space within the sequence queue table.

**IMPORTANT**

**Editing running jobs:** When Capture is running, or when the Scheduler is running, you cannot edit the sequence queue or a .esq file on disk using the Capture tab. However, the scheduler tab does have a Capture Sequence Editor tool that can be used to edit .esl files on disk, or create new ones.

If your camera supports live video feed, then you can click the **Live Video** button to start streaming. The video stream window enables recording and subframing of the video stream. For more information, check the video below:

https://www.youtube.com/embed/qRsAqTL4ZZI

**Recording feature**

The live view also provides a graphical overlay tool to aid in collimation. This is toggled on/off by the crosshair button.

**Collimation overlay**

The overlay options button opens a dialog that allows arbitrary and flexible creation of ellipses (including circles), rectangles and lines, as well as anchor points which act as global drawing offsets. Each defined element has its own size, offset, repetition, thickness and color (including transparency).

**Collimation overlay options**

### 5.6.6 FITS Viewer

Captured images are displayed in KStars FITS Viewer, and also in the summary screen. Set options related to how the images are displayed in the viewer.
• **Auto Dark**: You can capture an image and auto dark subtract it by checking this option. Note that this option is only applicable when using **Preview**, you cannot use it in batch mode sequence queue.

• **Effects**: Image enhancement filter to be applied to the image after capture.

### 5.6.7 Rotator Settings

Field Rotators are supported in INDI & Ekos. The rotator angle is the raw angle reported by the rotator and is not necessary the **Position Angle**. A Position Angle of zero indicates that the frame top (indicated by small arrow) is pointing **directly** at the pole. The position angle is expressed as E of N (East of North), so 90 degrees PA indicates the frame **top** points 90 degrees away (counterclockwise) from the pole. Check **examples** for various PAs.

To calibrate the Position Angle (PA), capture and solve an image in the **Ekos Align module**. An **offset** and a **multiplier** are applied to the raw angle to produce the position angle. The Ekos Rotator dialog permits direct control of the raw angle and also the PA. The offset and multiplier can be changed manually to synchronize the rotator’s raw angle with the actual PA. Check **Sync FOV to PA** to rotate the current Field of View (FOV) indicator on the Sky Map with the PA value as you change it in the dialog.

https://www.youtube.com/embed/V_hRPMlPjmA

**Rotator settings**

Each capture job may be assigned different rotator angles, but be aware that this would cause guiding to abort as it would lose track of the guide star when rotating. Therefore, for most sequences, the rotator angle is kept the same for all capture jobs.
5.6.8 Calibration Frames

For Flat Field frames, you can set calibration options in order to automate the process. The calibration options are designed to facilitate automatic unattended flat field frame capture. It can also be used for dark and bias frames if desired. If your camera is equipped with a mechanical shutter, then it is not necessary to set calibration settings unless you want to close the dust cover to ensure no light at all passes through the optical tube. For flat fields, you must specify the flat field light source, and then specify the duration of the flat field frame. The duration can be either manual or based on ADU calculations.

1. Flat Field Source
   - **Manual**: The flat light source is manual.
   - **Dust Cover with Built-In Flat Light**: If using a dust cover with built-in light source (e.g., FlipFlat). For dark and bias frames, close the dust cap before proceeding. For flat frames, close the dust cap and turn on the light source.
   - **Dust Cover with External Flat Light**: If using a dust cover with an external flat light source. For dark and bias frames, close the dust cap before proceeding. For flat frames, open the dust cap and turn on the light source. The external flat light source location is presumed to be the parking location.
   - **Wall**: Light source is a panel on the observatory wall. Specify the Azimuth and Altitude coordinates of the panel and the mount shall slew there before capturing the flat field frames. If the light panel is controllable from INDI, Ekos shall turn it on/off as required.
   - **Dawn/Dusk**: Currently unsupported.

2. Flat Field Duration
   - **Manual**: Duration is as specified in the Sequence Queue.
   - **ADU**: Duration is variable until specified ADU is met.

Before the calibration capture process is started, you can request Ekos to park the mount and/or dome. Depending on your flat source selection above, Ekos will use the appropriate flat light source before starting flat frames capture. If ADU is specified, Ekos begins by capturing a couple of preview images to establish the curve required to achieve the desired ADU count. Once an appropriate value is calculated, another capture is taken and ADU is recounted until a satisfactory value is achieved.
5.6.9 Exposure Calculator

The exposure calculator is an implementation of a calculation process presented by Dr. Robin Glover in 2019. This calculation process seeks to establish a sub-exposure time which considers two sources of noise in an image: camera read noise, and noise from background sky brightness (light pollution). The effects of camera thermal noise on images is not considered in this calculation. (Note: Since his presentation in 2019, Dr. Glover has enhanced his calculation process to incorporate the effects of sensor quantum efficiency, and sensor pixel size. At this time, the KStars implementation lacks those features.)

The concept in Dr. Glover’s calculation is to provide a sufficiently long exposure so that the effects of camera read-noise are overwhelmed by the signal coming from the target, but not so long an exposure that the effects of light pollution rise to levels which would overwhelm the signal from the target.

The implementation of this process does not consider the strength (magnitude or flux) of the intended target, nor does it consider other factors which may cause an astrophotographer to choose an alternate sub-exposure time. These other factors may include: the storage requirements and extended post-processing time for a large number of short exposures, the impacts of external factors that might occur in very long exposures, such as tracking / guiding performance, changes in weather conditions which may disrupt seeing conditions, intrusions from air traffic or passing satellites.

Approaches to imaging can vary greatly in the selection of exposure times, and number of sub-exposures used for integration. A well accepted approach for imaging deep-sky objects utilizes long exposures, requires good guiding, good to excellent seeing conditions, and would typically employ filtering to reduce the effects of light pollution. At the other extreme are approaches such as speckle imaging techniques (commonly ‘lucky imaging’), which utilize many hundreds to many thousands of extremely short exposures in an attempt to eliminate the effects of light pollution, poor seeing conditions, and poor guiding. Choices made for values of certain inputs to the exposure calculator will vary depending upon which imaging approach is being employed.

1. Exposure Calculator Inputs

- **Sky Quality**: The **Sky Quality selector** sets the measurement of the magnitude per square arc-second of the background sky.
The range for Sky Quality is from 22 for the darkest skies, to 16 for the brightest (most light-polluted) skies. The magnitude scale is non-linear; it is a logarithmic scale based on the 5th root of 100. So 5 steps on the scale represent a change in brightness by a factor of 100. (A Sky Quality of 17 is 100 times as bright as a Sky Quality of 22. Each full integer step on the scale is a change by a factor of approximately 2.512).

Wikipedia Sky Brightness Wikipedia Light Pollution

All light scattered in the background sky is considered to be light pollution regardless of its source, so the effects of moonlight should be considered as “natural” light pollution. But weather conditions can also impact Sky Quality, as humidity or cloud cover can reflect and scatter any source of light through the atmosphere.

A Sky Quality Meter (SQM) can provide the most accurate reading of sky quality if used during an imaging session, but an estimated value from sky quality surveys may also be found on the web at sites such as www.lightpollutionmap.info or www.clearoutside.com. But these on-line sources for estimated light pollution generally do not account for the effects of moonlight or local weather conditions. So the values from light pollution web sites should only be considered as a “best case scenario” for a cloudless night during a new moon.

If a light pollution map value is used for the input value of SQM, but imaging will be performed with a partial moon, then a decrease in the input of the SQM value should be applied in the calculator. Moonlight can be overwhelming; at a location where a light pollution map showed an SQM value of 19.63. An SQM reading was made on a night with a waxing crescent, shortly before half-moon, (moon age 5.4, and KStars moon magnitude = -10). The SQM reading at zenith showed the sky to be much brighter with measured value of 18.48. A reading taken on a night with a waxing gibbous, shortly before a full moon, (moon age 12.4, and KStars moon magnitude = -12). The SQM reading at zenith showed a measured SQM value of 15.95.

The value of Sky Quality has a drastic impact on the calculated exposure because of the logarithmic scale involved. An image taken from a location with heavy light pollution (a low sky quality value), especially when filtering is not applied, may result in a very short exposure time to prevent light pollution from overwhelming the target signal. An image taken from a location with very little light pollution (a high Sky Quality value) may result in a sub-exposure time of several hours.

- **Focal Ratio**: The selector for **Focal Ratio** sets the value from the optical train, which is needed for the evaluation of light gathering capability.

  The value of the focal ratio of the optic has a direct effect on the exposure calculation. A lower focal ratio is considered to be a “faster optic” as it has a greater light gathering capability than an optic with a longer focal ratio. So the exposure calculation will be reduced when a lower focal ratio is used, and increased when a higher focal ratio is used.

  The user might consider making a slight adjustment to the input value of the focal ratio to compensate for the efficiency or for obstructions in the optic.

  For example, two optics of the same focal ratio, a refractor (with no obstruction) and a reflector (with a secondary mirror obstruction) would be treated as equivalent optics in the computations. One way that a user might compensate for this would be to make an adjustment to the focal ratio input value to compensate for the efficiency of the optic. A refractor is generally considered to have an efficiency of about 94%, a reflector is generally considered to have an efficiency of about 78%.

  An effective / adjusted focal ratio value for a refractor = Optic Focal Ratio / 0.94
  An effective / adjusted focal ratio value for a reflector = Optic Focal Ratio / 0.78

  These adjustments slightly increase the focal ratio, and therefore slightly reduce the computed light gathering capability considered in the calculation.

- **Filter Bandwidth**: The selector for **Filter Bandwidth** sets the value for the bandwidth (in nanometers), and should be reduced from the default value of 300 when a filter is included in the optical train. The inclusion of filters in the optic train will greatly effect the exposure calculation. The value ranges from 300, for imaging without any filter, down to 2.8 for an extreme narrow-band filter.

  Filters fall generally into two categories: single band, or multi-band. The bandwidth for a single band filter should be relatively easy to determine or estimate. Generally a Red,
Green or Blue filter is considered to have a bandwidth of 100 nanometers. Documentation of narrow-band filters will frequently state the bandwidth (usually in the range of 3 to 12 nm). But the bandwidth of multi-band astronomy filters, such as light-pollution filters, or filters specifically designed for use on nebulae may be more difficult to determine as their transmission profiles can be far more complex.

Even within the bands that filters are intended to pass, filters are not 100% efficient. So a user of the calculator might wish to slightly reduce the value of the filter bandwidth to compensate for this. Example: if a filter is presumed to have a bandwidth of 100 nm but its transmission efficiency is only 92%, then a value of 92 might better represent this filter, and result in a slightly more accurate exposure calculation.

The value of the filter bandwidth has an inverse effect on the exposure calculation. An unfiltered exposure would use the max value of 300 for the filter bandwidth (representing visible spectrum of 300 nanometers), and will produce the shortest exposure time calculation. An extreme narrow-band filter, (for example a 3 nanometer bandwidth), will produce the longest exposure time.

• **Camera**: The exposure calculation requires a value for the read noise of the camera. Camera read noise is an electronic noise that occurs at the completion of an exposure as the camera is measuring the analog voltage values of the pixels and converting these measurements into digital values. Read noise is not effected by the length of an exposure. Camera sensors are one of two types: “Charge Coupled Device” (CCD) or “Complementary Metal-Oxide Semiconductor” (CMOS). For the exposure calculation the main difference between these sensor types is that CCD sensors do not have a variable gain setting that would impact the read noise; so a CCD sensor will have a single constant value for its read noise. A CMOS sensor does have a variable gain (or ISO value), and changes to that setting usually result in a change to the read noise.

The exposure calculator relies upon the selection of a camera data file so that it can access an appropriate read noise value for use in the calculation. The camera selection drop down allows the user to select an appropriate camera data file. For a CCD camera the file will only hold a single read noise value, but for a CMOS camera the file includes a table (or a few tables) of values which relate the gain or ISO value to a read noise value. Do not be confused by “CCD” appearing in the names of many dedicated astrophotography cameras, most of these cameras are using CMOS sensors.

The camera data files provided in KStars contain values which are transcribed from manufacturers technical documentation. But actual read noise values for a camera may vary from the published data; so a user may which to utilize a tool that can determine the read noise values for their specific camera. Dr. Glover provides a sensor analysis tool in his MS-Windows based product SharpCap SharpCap Sensor Analysis The specific data from such a tool can be used to create a customized camera data file for use with the KStars exposure calculator.

• **Read Mode**: Some cameras manufactured by QHY have the capability to function in multiple modes. These modes alter the read noise values, so the camera data files for these cameras include multiple read noise tables. When using one of these multi-mode cameras the Read Mode dropdown will become enabled, and allow the user to select the read mode table that would correspond to the mode in which the camera will be operated for imaging.

• **Exposure Time Graph**: The calculator will present a graph of the potential exposure times determined from the inputs. In the case of CMOS based cameras, this graph will resemble the underlying read noise data from the camera, but is transformed into an exposure time over the range of possible gain or ISO values. In the case of CCD based cameras, the graph will be a simple bar, because the read noise of a CCD sensor is invariable.

• **Gain / ISO Selection**: For cameras with CMOS sensors, a Gain or ISO value can be selected. A Gain control will appear for cameras that allow a gain selection, and an ISO selection drop down will appear for DSLR cameras. Adjusting the gain / ISO value will move a selection indicator laterally along the exposure time graph to show how the selected gain value will effect the calculated exposure time.
CMOS based cameras tend to have high read noise at low gain / ISO values, and the read noise diminishes as the Gain / ISO value is increased. So a user might be tempted to select a higher gain value in an attempt to reduce the amount of read noise. But the camera full well capacity would typically be highest when gain / ISO values are lowest. A greater full well capacity provides a greater dynamic range in the image.

Selection of a gain / ISO value would be dependent upon the imaging technique being employed. When a long exposure is desired (as with ‘typical’ DSO imaging), then a low gain / ISO value would usually be preferred to achieve a greater dynamic range in the image. But if a speckle technique (‘lucky imaging’) is being used, the exposure times would be so low that reducing read noise becomes critical, in such a case the user would likely prioritize a low read noise in the sub-exposures, and will likely need to select a high gain/ISO value.

Some cameras may show a smooth progressive curve in the read-noise over the range of gain values, other cameras may have very pronounced steps (and other anomalies) in their read-noise. These pronounced steps are usually the result of electronic mode switching within the camera. In cases where the graph shows a pronounced step, the user may wish to select a gain value which is at the bottom of that step. This may provide a reduced read noise, and result in a shorter exposure without a significant loss in dynamic range when compared to an image shot at a gain selection that is at the top of that step. But caution is needed when selecting a gain near a “step” on the graph. Some posts on forums indicate that the read-noise data provided by manufacturer documentation may not be exact. The actual “switch” in read-noise may be at a slightly higher or lower gain value, so it is recommended to avoid selecting a gain value that is at a step in read noise.

When using data from camera manufacturer documentation, avoid selecting a gain near a step.

Instead, shift the gain selection away from the step.
• **Noise Increase %**: The ‘Noise Increase %’ selector controls a factor used in Dr Glover’s equation. This value will alter the relative balance between the two sources of noise in the sub-exposure. As a general rule, Dr Glover had recommended using a value of 5%, but lowering it to 2% when the computed exposure time is considered to be too short. The perspective of the “increase” is a relative increase in read-noise compared to noise from light pollution. It may seem counter-intuitive, but raising the value of ‘Noise Increase %’ will reduce the exposure time, reducing the noise from light pollution (and reducing the target signal), so the ‘increase’ means a relative increase in the effect of the read noise compared with the pollution noise. Lowering the value of ‘Noise Increase %’ will increase the exposure time, and will allow more noise from light pollution, (and more target signal), into the exposure. This effectively reduces the relative impact of read-noise.

In this implementation of the calculator, the value for the ‘Noise Increase %’ can be set to in a very broad range to allow a user a greater range for experimentation. But a user should recognize that large changes to this value can have undesired consequences. Forcing an exposure time down may cause the exposure to carry a relatively heavy burden from read noise, and would reduce the quality of the sub-exposure, (the ratio of exposure time to total noise will fall). As a result a significantly higher number of exposures for integration would be needed to achieve an acceptable level of quality. Forcing an exposure time up to long exposure might cause the exposure to have excessive noise from light pollution.

The value selected for the ‘noise increase %’ is also one which is dependent upon the imaging technique being employed. When a speckle technique (‘lucky imaging’) is being employed, the user will likely need to force the exposure time down to an extremely short duration (sub-second exposures are standard with this technique). So the user may need to drastically raise the value of ‘noise increase %’ to reduce the time of the sub-exposure down to the durations demanded by this technique.

2. **Exposure Calculator Results**

• **Exposure Time (sec)**: The calculated duration of an exposure.

• **Pollution Electrons**: The calculated number of light pollution electrons per pixel impacting the exposure.

• **Shot Noise**: The calculated noise from light pollution impacting the exposure.

• **Total Noise**: The calculated noise from both light pollution and image sensor read noise impacting the exposure.
The KStars Handbook

3. Stacking / Image Integration Information

The value of image stacking is that as images are stacked, the accumulation of exposure time and the data that represents the target signal is increased proportionally with the added number of images being integrated, but the increase in noise is disproportionately lower. As a result, the quality of integrated images can be seen as curve which starts with a good “yield” when the first few sub-exposures are integrated, but this curve has diminishing returns as the number of sub-exposures being integrated is increased.

Ideally a desired signal to noise ratio (SNR) would be used for the measure of the level of quality of an image, but the exposure calculator does not possess an ability to recognize the strength of the signal from an intended imaging target, so it cannot calculate an estimated signal to noise ratio. So the level of quality to be specified in the stacking calculation is the integration time in seconds divided by the calculated noise in the integrated image, (a “Time/Noise Ratio”). For the purposes of the calculation, the “Time/Noise Ratio” can be considered as a partial analog to a signal to noise ratio. But the user must recognize that a specified time to noise ratio is not an absolute measure of the quality of all integrated images from all targets because a signal strength (magnitude or flux) is not part of this calculation.

- **Table**: A table provides details for stacking based upon the number of hours planned for imaging.
  
  The table provides a quick reference for finding the approximate number of sub-exposures that might be completed for a given number of hours in an imaging session. But some functions that consume time are not included in this time calculation. For example, USB based cameras typically take some time for data transmission, or if the user has selected automatic dithering, additional time will be consumed in the imaging process, which is not included in this time calculation.
  
  The far right column of the table shows the calculated time/noise ratio of the integrated (stacked) image that would be produced.

- **Graph**: An interactive graph allows the user to visualize the relative change in potential quality for integrated images with various counts of sub-exposures applied in image stacking. This graph can be navigated through the adjustment of the time/noise ratio value; adjusting this value will recompute the quantity of sub-exposures required for the integrated image to achieve that specified time/noise ratio.

  In the selection of a Time/Noise ratio for the calculation of the count of stacked exposures, the user might want consider the incremental change to the potential quality of the image from an additional sub-exposure. To help a user assess the value of increasing the number of sub-exposures for integration; the tool includes a calculation of the slope for the selected point on the time/noise curve (the user interface uses a delta symbol to present this value). This delta value represents the change in potential quality that will result from the addition or subtraction of a single sub-exposure.

  As one should expect, at the low-end of exposure counts (when a low value for the Time/Noise Ratio is input), the delta value will be relatively high, so the addition of one image will provide a relatively large improvement to the integrated image. But as a user increases the value for the Time/Noise Ratio, more images will be included for integration, and the delta value will fall, indicating that there is less to be gained from adding more sub-exposures.

  The default value for the time / noise ratio is set to 80. This value should not be construed in any way as an optimal value; it was simply chosen as a somewhat average value. A
user should consider a few factors when adjusting the value of the time / noise ratio: 1) the strength of the target object, 2) the time / noise ratio of the calculated sub-exposure, 3) the limitations of time for imaging and processing, and limitations of storage capacity for the images.

For a strong target, (example, Orion Nebula with magnitude 4), would provide a relatively strong signal. On such a target, the value for the Time/Noise Ratio might be reduced and the computation of sub-exposures, may still produce an image with a very good signal to noise ratio. A much weaker target (example, Thor’s Helmet, magnitude 11), might require a higher time/noise ratio to compensate for the relatively weak target signal.

Depending on the various inputs and imaging conditions, the potential quality of a sub-exposure can vary greatly. In poor sky quality with little or no filtering, the computed sub-exposure time will naturally be short to avoid an overwhelming noise from light pollution, and the exposure time relative to the computed noise will be low (a low time/noise ratio). To achieve a high quality integrated image from low time/noise ratio sub-exposures may require thousands sub-exposures. If the user is concerned about imaging and processing time or storage capacity; then a higher time/noise ratio would needed to reduce the quantity of sub-exposures. Conversely, when input conditions result in a sub-exposure with a long exposure time relative to the computed noise (as with narrow-band imaging), the result may be a sub-exposure with a very high time/noise ratio. In such cases the default value of 80, might result in very few sub-exposures for the integration. But the delta value will be quite high, indicating that raising the time-noise ratio will greatly improve the potential quality of the integrated image.

Part of the value of using a Time/Noise ratio as the input for the calculation of the required number of sub-exposures is that it should tend to compensate for the differences in relative noise for sub-exposures of various lengths. A shorter sub-exposure would have a lower time/noise ratio, so it has less capacity to improve an integrated image. Therefore, a disproportionately higher number of short exposures are needed to achieve a given time/noise ratio in an integrated image.

As an example, consider the calculation of the number of sub-exposures required when two sub-exposures times were compared: a 300 second sub-exposure vs a 30 second sub-exposure. The 300 second sub-exposure had a calculated noise of 22.1, resulting in a sub-exposure time/noise ratio of 13.6. When the ‘noise increase %’ is raised to force the exposure time down to 30 seconds, we see a calculated noise of 9.47, resulting in a much lower sub-exposure time/noise ratio of 3.2. The 300 second exposure is of significantly higher potential quality than the 30 second exposure. We will demand the default time/noise ratio of 80 for integration in both of these cases.

For an integration using the 300 second sub-exposures we find that 34 sub-exposures are required to achieve a time/noise ratio of 80. So a total integration time of 2.83 hours is required.
For an integration using the 30 second sub-exposures we find that 637 sub-exposures would be required to achieve a time/noise ratio of 80. So a total integration time of 5.31 hours is required with these shorter exposures to achieve the same time/noise ratio in the integrated image.

### 5.6.10 Video Tutorials

https://www.youtube.com/embed/Gz07j7VPnpc

*Capture*
5.7 Focus

5.7.1 Theory Of Operation

In order to focus an image, Ekos needs to establish a numerical method for gauging how good your focus is. It’s easy when you look at an image and can see it as unfocused, as the human eye is very good at detecting that, but how can Ekos possibly know that?

The most tried and tested method is Half-Flux-Radius (HFR), which is a measure of the width in pixels counting from the center of the star until the accumulated intensity is half of the total flux of the star. As you move closer to the point of optimum focus, so the HFR gets smaller, reaching a minimum at the point of focus before increasing as you start to move away from focus. HFR has been used on lots of different types of equipment and has proved to be stable in a wide range of circumstances.

In addition to HFR, Ekos supports other focus measures, including an adjusted HFR measure, FWHM, Number of Stars and Fourier Power. It is recommended to start with HFR and when the user has become proficient in focusing their equipment, to try the other measures.

After Ekos processes an image, it selects either a single star and starts measuring its HFR, or it selects a set of stars matching the criteria that have been set and calculates an average HFR. It can automatically select stars, or you can select a single star manually. It is recommended to allow Ekos to select a set of stars.

Ekos supports 4 different focus algorithms: Linear 1 Pass, Linear, Iterative, Polynomial. Linear 1 Pass is the recommended algorithm.
• **Linear 1 Pass:** In the Linear 1 Pass algorithm, Ekos establishes a V-Curve and fits a curve to the data to find the focus solution. It then moves to the calculated minimum. Key features include:
  - The algorithm compensates for focuser backlash.
  - The algorithm is fast, taking 1 pass to identify optimum focus.
  - The algorithm uses more sophisticated curve fitting to pinpoint the optimum focus position.
  - The algorithm is highly configurable with user control over many parameters like step size, number of steps and how to deal with outliers in the datapoints.

Providing the focuser behaves in a repeatable way, i.e. when commanded to go to position X, it always goes to the same position, then this algorithm will be the best to use.

• **Linear:** In the Linear algorithm, Ekos steps outward from its starting point then moves inward taking regular datapoints through the point of optimum focus and then further inward, to draw a V-Curve. It then fits a quadratic curve to the datapoints and calculates the point of optimum focus. It then moves out again past the point of optimum focus, halves the stepsize and moves in again for a second pass. It looks to follow the curve from the first pass and find the minimum HFR. Due to randomness in the HFR measurements it uses the % tolerance to help decide when it has found a solution. Key features include:
  - The algorithm compensates for focuser backlash.
  - The algorithm is slow, taking 2 passes to identify optimum focus.
  - The algorithm uses curve fitting to pinpoint the optimum focus position in pass 1, but then uses % Tolerance to try to stop as close as possible to this HFR on pass 2.
  - The algorithm is highly configurable with user control over many parameters like step size and number of steps.

If the focuser behaves in an inconsistent way, i.e. when commanded to go to position X, there is variability in the position it goes to, then this algorithm will be the best to use as it has some built in tolerance for this variability.

• **Iterative:** In the Iterative algorithm, Ekos operates iteratively by moving in discrete steps, decided initially by the user-configurable step size and later by the slope of the V-Curve, to get closer to the optimal focus position where it then changes gears and performs smaller, finer moves to reach the optimal focus. The focus process stops when the measured HFR is within the configurable tolerance of the minimum recorded HFR in the process. In other words, whenever the process starts searching for a solution within a narrowly limited range, it checks if the current HFR is within % difference compared to the minimum HFR recorded, and if this condition is met then the Autofocus process is considered successful. The default value is set to 1% and is sufficient for most situations. The Step options specify the number of initial ticks the focuser has to move. If the image is severely out of focus, we set the step size high (i.e. greater than 250). On the other hand, if the focus is close to optimal focus, we set the step size to a more reasonable range (less than 50). It takes trial and error to find the best starting tick, but Ekos only uses that for the first focus motion, as all subsequent motions depend on the V-Curve slope calculations. Key features include:
  - The algorithm relies on the focuser having well controlled backlash.
  - The algorithm can be fast using a minimum number of steps.
  - The algorithm works on a “good enough” paradigm whereby it stops when the HFR is within % Tolerance of the perceived minimum.

• **Polynomial:** In the Polynomial algorithm, the process starts off in Iterative mode, but once we cross to the other side of the V-Curve (once HFR values start increasing again after decreasing for a while), then Ekos performs quadratic curve fitting to find a solution that predicts the minimum possible HFR position. Key features include:
  - The algorithm relies on the focuser having well controlled backlash.
  - The algorithm can be fast using a minimum number of steps.
  - The algorithm uses curve fitting to pinpoint the optimum focus position.
5.7.2 Optical Train Group

The Optical Train group displays the currently selected Optical Train. By default this will be the primary imaging train, but other trains can be selected. The group consists of:

- **Train**: The Optical Train currently in use by the Focus tab. Hover the mouse over this field for a more detailed description of the selected train.

- **Edit Button**: Brings up the Optical Train dialog to view and potentially change the optical trains.

Focus parameters are saved per Optical Train automatically and so multiple trains can be setup to manage different configurations with different parameters.

When a new Optical Train is created, Focus will attempt to default parameters from other, similar Optical Trains. The attributes that must match for this are the Focuser and the scope type. If this is the first train for the selected Focuser and scope type then default parameters are created.

It is recommended to use the **Focus Advisor** tool on new Optical Trains to set parameters appropriately.

5.7.3 Focuser Group

All INDI-compatible focusers are supported. It is recommended to use **absolute** focusers for the best results since their absolute position is known on power up. In INDI, the focuser zero position is when the drawtube is **fully retracted**. When focusing **outwards**, the focuser position increases, while it decreases when focusing **inwards**. The following focuser types are supported:

- **Absolute**: Absolute Position Focusers such as RoboFocus, MoonLite, ASI ZWO
- **Relative**: Relative Position Focusers.
- **Time Based**: Time based focusers with no position feedback that adjust focus position by moving for a certain amount of time.

The **Focuser** field contains the focuser in the attached Optical Train.

For absolute and relative focusers, the step size is in units of **ticks** and for simple, or time based, focusers, the step size is in **milliseconds**. The **In** and **Out** buttons can then be used to move the focuser by the number of ticks defined in the **Initial Step Size** field in the Mechanics tab.

The Steps fields has 2 parts:

- **Left Hand Steps**: Current focuser position. This is output only and is updated as the focuser moves to reflect the current position.
- **Right Hand Steps**: This is input and allows the user to enter a desired position. When the **Goto** button is pressed, the focuser is moved from its current position to the position indicated in this field.
On startup, the Left Hand Steps will show the current focuser position. The Right Hand Steps field is defaulted from the Optical Train saved settings. This is useful, for example, if you have several Optical Trains that use the same focuser but solve at different positions. In this case, the Right Hand Steps will contain the last persisted value for this field for the selected Optical Train. So, after swapping equipment and selecting the Optical Train, if the user presses the Goto button then the focuser will be moved to a good place to start focusing from.

The **Goto Focus Position** button moves the focuser to the position in the righthand Steps field.

The **Stop Focuser Motion** button stops the in-progress focuser motion.

The **Auto Focus** button starts an Autofocus run. The **Stop** button is used to stop the run.

The **Capture Image** button will take a frame based on the current settings in the Camera & Filter Wheel Group. The **Start Framing** button will start repeatedly capturing frames until the **Stop** button is pressed.

Some of the focus algorithms will attempt to cope with being started away from the point of optimum focus, but for predictable results, it is best to start from a position of being approximately in focus. For first time setup, Start Framing can be used along with the In and Out buttons to adjust the focus position to roughly minimize the HFR of the stars in the captured images. When Framing is used in this way, the V-Curve graph changes to show a time series of frames and their associated HFRs. This makes the framing process much easier to perform.

If you are completely new to astronomy, it is always a good idea to get familiar with your equipment in daylight. This includes getting the approximate focus position on a distant object. This will provide a good starting position for focusing on stars when nighttime comes.

### 5.7.4 Camera & Filter Wheel Group

This section of parameters deals with the Camera and Filter settings to use when focusing.

The top row of controls allows CCD parameters to be set.

- **Exp**: The exposure time in seconds.
- The **Toggle Full Screen** button pops the window displaying the focus frame out to a separate window. Pressing it again returns it within the focus window.
- The **Show in FITS Viewer** button pops-up a separate FITS Viewer window to display the focus frame, in addition to the focus frame displayed within the focus window.
- The **Live Video** button brings up the associated popup.

The next row of controls allows Camera parameters to be set. Choose a value from the binning dropdown and then set either the camera gain or ISO.

- **Binning**: Increasing the binning will change the image scale as well as resulting in brighter pixels. It is generally only worth binning above 1x1 if your image scale is oversampled where the increase in image scale does not lead to a loss of resolution. If you wish to increase star brightness try increasing the exposure and / or gain. If you are unsure bin 1x1.
• **Gain**: Set the Gain for the Camera being used to focus. The value needs to be high enough to give a clear star pattern but not so high as to create too much noise to interfere with the focus operation. Some experimentation will be required to find an optimum value. If you are unsure where to start try unity gain for your camera and adjust from there.

• **ISO**: Set the ISO for the Camera being used to focus. Some experimentation will be required to find an optimum value.

The third row of controls deals with the Temperature Source and Filter, if there is one:

• **TS**: Select the temperature source from the dropdown. Underneath are displayed the current temperature from the selected temperature source and the change in temperature between when the last successful Autofocus run completed and the current temperature. It is common practice to redo focus after significant temperature changes that alter the telescope’s focus point.

• **Filter**: Select the filter to use.
  To start focusing it will probably be easier to select the filter that allows the most light through, for example the Lum filter. Click the filter icon to launch the Filter Settings popup. This allows a number of parameters to be set per filter to be used during an Autofocus run.

• **Reset** button will reset the focusing subframe to full frame.

### 5.7.5 Tools Group

Focus Tools Group

This section describes the focus tools that are currently available.

• The **Aberration Inspector** button starts an Aberration Inspector run. The **Stop** button can be used to stop the run.

• The **CFZ** button launches the Critical Focus Zone tool.

• The **Advisor** button launches the Focus Advisor tool.

• The **Force AF** checkbox can be used when a sequence is active either in Capture or the Scheduler. When checked, an Autofocus will be triggered at the completion of the currently active subframe.

### 5.7.6 Focus Options

Focus Options

Parameters to configure Focus are accessed by pressing the **Options...** button. This launches the Options dialog with three panes:

• **Settings**: These are general Focus settings.

• **Process**: Parameters associated with the Autofocus process.

• **Mechanics**: Parameters associated with the focuser mechanics.

The parameters are stored for each Optical Train. This allows different configurations to be stored for different equipment. Parameters are stored when they are changed, so on startup the last used configuration for the selected Optical Train is loaded.
5.7.6.1 Focus Settings

General section parameters:

- **Auto Select Star**: This setting is only relevant if **Sub Frame** is selected. In this case if **Auto Select Star** is selected then Ekos will select the star to use for focus; otherwise the user will have to manually select the star using FitsViewer.

- **Suspend Guiding**: Set this option to suspend guiding during an Autofocus run. The purpose of this is to prevent guiding from having problems with defocused stars during the focus process where, for example, the guide scope is attached to the main telescope using an OAG.

- **Dark Frame**: Check this option to perform dark-frame subtraction. This option can be useful in noisy images, where a pretaken dark is subtracted from the focus image before further processing.
  
  If hot pixels are causing problems with focus, select Dark Frames and either setup a regular Master Dark frame or a Defect Map.
  
  Dark frames are used by Focus, Alignment and Guiding. See the Dark Library feature within the Capture Module for more details on how to setup Dark Frames.

- **Full Field**: Select to use the full field of the camera. In this mode, focus will automatically select multiple stars for use in an Autofocus run. The alternative to this is **Sub Frame**.

- **Sub Frame**: Select to use a single star for the Autofocus process. The alternative to this is **Full Field** where multiple stars will be used by Autofocus. Depending on the setting of **Auto Select Star** either the user or Ekos will select the star.

- **Box**: Sets the box size used to enclose the focus star when using **Sub Frame**. Increase if you have very large stars. For Bahtinov focus the box size can be increased even more to better enclose the Bahtinov diffraction pattern.

- **Display Units**: Select the units for display on the Autofocus V-Curve when HFR or FWHM is selected. **Pixels** and **Arc Seconds** are supported.

- **Guide Settle**: This option is used in conjunction with **Suspend Guiding**. It allows any vibrations in the optical train to settle by waiting this many seconds after the Autofocus process has completed, before restarting guiding.

Mask Section Parameters:

These controls relate to **Masking Options** to be used when in **Full Field** mode. The effect of Masking Options can be seen in the **FITS Viewer**.

- **Use all stars for focusing**: Select this option if all stars of the field should be considered for focusing.
• **Ring Mask**: This option provides two input fields that together define a doughnut over the FOV of the camera. Stars falling outside of the doughnut are discounted from processing. Setting an inner value above 0% causes stars in the centre of the FOV to be discarded. This could be useful to avoid using stars in the target of the image (for example a galaxy) for focusing purposes. Setting an outer value below 100% causes stars in the edges of the FOV to be discarded during focusing. This could be useful if you do not have a flat field out to the edges of your FOV.

• **Mosaic Mask**: A 3x3 mosaic is composed with tiles from the image center, its corners and from the edges. This option is useful if you want to inspect the optics performance - you might know this from the PixInsight Aberration Inspector script. The tile size can be configured in percent of the frame width, with the spacer value specifying the space between the tiles. There are four use-cases for the Mosaic Mask:
  
  – Checking focus in all parts of the sensor: The mask allows an easy visual inspection and comparisons of stars in the center, corners and edges of the sensor. This is especially useful for optics that show aberration if the focus is not 100% met.
  
  – Correcting image tilt: especially large sensors are very sensitive to incorrect distance and tilting of the sensor. In such cases, the image shows aberration, especially in the image corners. If all corners show the same effect, the distance needs to be corrected. If the aberrations in the corners differ, this is typically the result of a tilted sensor.
  
  – Collimating Newtonians: inspecting frames in a defocused state is typically used for collimating Newtonians. See, for example, Tommy Nawratil’s The Photonewton Collimation Primer for more details.
  
  – Running the Aberration Inspector tool.

Adaptive Focus Parameters:

The next set of controls relate to **Adaptive Focus**. The idea here is to keep the telescope focused by adapting the focuser position based on changes in environmental conditions without having to perform a full Autofocus run. See the Adaptive Focus section for more details.

For example, as temperature changes during an imaging session so the focus point will change. By sampling the temperature between subframes it is possible to firstly calculate the change in temperature and then to convert this to a number of ticks of focuser movement to apply between subframes.

In order to use **Adaptive Focus** it is necessary to setup some data for your system. In particular you need to tell Ekos how many ticks (and in which direction) to move the focuser when the environmental conditions change. This is covered in the Filter Settings popup. The popup is launched by clicking the filter icon ⬇️. The following controls are available:

• **Adaptive Focus**: Select this option to activate Adaptive Focus.

• **Min Move**: The minimum Adaptive Focus movement allowed.

• **Adapt Start Pos**: Check to allow Adaptive Focus to calculate the start position for an Autofocus run. The starting position is the last good solve position for the selected filter, adapted for environmental changes.

  For example, if the current focuser position is 1000, temperature = 4C, and if the Red filter is selected (last good focus position for Red is 990 @ 5C and Ekos is configured to move +3 Ticks / C). Then, if Adapt Start Pos is off, Autofocus will start at 1000. If Adapt Start Pos is on, Autofocus will start at 990 + (5 - 4) * 3 = 993.

  This feature is useful to ensure that Autofocus starts from close to the focus point which will mean a more symmetric V-curve. It is particularly useful when changing between filters which have large differences in focus points.
It is possible to use this feature on its own without Adaptive Focus. Just set the checkbox and leave the ticks per degree C set to zero. This way the Autofocus start position will be filter dependent and will start each Autofocus run at the focus point of the last successful Autofocus run for that filter.

- **Max Total Move**: The maximum total focuser movement that Adaptive Focus is allowed in the observing session. The purpose of this is as a “dead man’s handle” on Adaptive Focus in case it runs away. For example, if the temperature source fails and returns bad temperature readings whilst the equipment is unattended, this could result in Adaptive Focus attempting to make large focuser movements.

If the Max Total Move is reached then **Adaptive Focus** is unchecked until manually re-checked by the user.

### 5.7.6.2 Focus Process

Focus Process Parameters:

- **Detection**: Select star detection algorithm. Each algorithm has its strengths and weaknesses. It is recommended to use SEP, unless you have a specialized use. The following are available:
  - **SEP**: Source Extraction and Photometry built in library. This is the default value.
  - **Centroid**: An extraction method based on estimating star mass around signal peaks.
  - **Gradient**: A single source extraction model based on the Sobel filter.
  - **Threshold**: A single source detection algorithm based on pixel values.
  - **Bahtinov**: This detection method can be used when using a Bahtinov mask for focusing. First take an image, then select the star to focus on. A new image will be taken and the diffraction pattern will be analysed. Three lines will be displayed on the diffraction pattern showing how well the pattern is recognized and how good the image is in focus. When the pattern is not well recognized, the **Num. of rows** parameter can be adjusted to improve recognition. The line with the circles at each end is a magnified indicator for the focus. The shorter the line, the better the image is in focus.

- **SEP Profile**: If the star detection algorithm is set to **SEP**, then choose a parameter profile to use with the algorithm. The following are recommended:
  - **1-Focus-Default**: for scopes that do not have a central obstruction such as a refractor.
  - **1-Focus-Default-Donut**: for scopes that have a central obstruction such as a Newtonian, SCT, RASA, Ritchey-Cretien, etc.

- **Algorithm**: Select the Autofocus process algorithm:
The KStars Handbook

- **Linear 1 Pass**: This is the recommended algorithm. In this algorithm, Ekos establishes a V-Curve and fits a curve to the data to find the focus solution. It then moves to the calculated solution. This algorithm supports the older style Quadratic curve type as well as the newer Levenberg-Marquardt Solver for Hyperbolic and Parabolic curves. It will also weight the datapoints in the curve fitting process if Use Weights is checked and run a refinement process if Refine Curve Fit is selected.

- **Linear**: This algorithm builds a V-Curve with approximately Out step Multiple steps on each side of the minimum. Having built the V-Curve it then fits a quadratic equation to the curve (parabolic shape) and uses this to calculate the focuser position giving the minimum HFR. Having identified the minimum it then performs a 2nd pass halving the step size, recreating the curve from the 1st pass. It attempts to stop within Tolerance of the minimum HFR calculated during the 1st pass.

- **Iterative**: Moves focuser by discreet steps initially decided by the step size. Once a curve slope is calculated, further step sizes are calculated to reach an optimal solution. The algorithm stops when the measured HFR is within Tolerance of the minimum HFR recorded in the procedure.

- **Polynomial**: Starts with the iterative method. Upon crossing to the other side of the V-Curve, polynomial fitting coefficients along with possible minimum solution are calculated. This algorithm can be faster than a purely iterative approach given a good data set.

- **Curve Fit**: The type of curve to fit to the datapoints.
  - **Hyperbola**: Fits a Hyperbola using a non-linear least squares algorithm supplied by GSL (GNU Science Library). See Levenberg-Marquardt Solver for more details. This is the recommended option.
  - **Parabola**: Fits a Parabola using a non-linear least squares algorithm supplied by GSL (GNU Science Library). See Levenberg-Marquardt Solver for more details.
  - **Quadratic**: Uses a quadratic equation using a linear style least squares algorithm supplied by GSL (GNU Science Library). This is, in effect, a parabolic curve. It is no longer recommended to use this curve.

- **Measure**: Select Measure to use in the focus process. The following are available:
  - **HFR**: Half Flux Radius (HFR) is the recommended measure. When a star is detected, Ekos will calculate the HFR for the star. This is the radius of an imaginary circle, centered on the star center, that encloses half the star’s total flux. The point of best focus corresponds to the minimum HFR.
  
  - **HFR Adj**: This feature uses a brightness adjusted HFR calculation to take account of the fact that the HFR for brighter stars is larger than for smaller stars. The algorithm adjusts the value of the measured HFR, usually upwards, so the HFRs obtained by the HFR Adj method will be higher than the measured HFR values. This does not mean that you are getting worse results by using HFR Adj, simply that the measure is different. When using this Measure it is usual to get smaller error bars on the datapoints when Use Weights is selected. The point of best focus corresponds to the minimum adjusted HFR.
  
  - **FWHM**: This feature fits a Gaussian surface to each star and uses that to calculate the Full Width Half Maximum (FWHM) of the star. The FWHM is the width of an circle (or ellipse) centered on the star center reaching the edge of the star at half its maximum intensity. The point of best focus corresponds to the minimum FWHM. Expect the FWHM to be approximately twice the HFR of a star.
  
  - **# Stars**: This feature calculates the number of stars in the image and uses this number as the focus measure. The idea is that as you move nearer focus so more stars become detectable. The advantage of this Measure is that it is very simple and does not require algorithms to calculate HFRs or FWHMs. The point of best focus corresponds to a maximum number of stars.
– Fourier: Fourier takes a Fourier transform of the image and calculates the image power in frequency space. The assumption is that for an astronomical image of stars and background, the stars will be gaussians. Under a Fourier transform, a gaussian transforms to another gaussian; but wider stars transform to narrower gaussians in frequency space, and vice-versa. So, at focus, summing up the contents in frequency space, which is in effect a measure of power, will be a maximum.

This follows the main idea suggested by Tan and Schulz in their paper: A Fourier method for the determination of focus for telescopes with stars. Please note that this paper makes other processing suggestions beyond the idea of using Fourier Transforms that are not included within Ekos.

This is a relatively new method in the Astro Community, and does not require star detection. Tan and Schulz report good results with both amateur and professional telescopes.

• PSF: If Measure is set to FWHM, then the PSF widget can be selected for use in fitting a surface to the star. At present just Gaussian is supported.

• Use Weights: This is only available with the Linear 1 Pass focus algorithm and Curve Fits of Hyperbola and Parabola. It requires Full Field to be selected. The option calculates the standard deviation of star Measure and uses the square of this (mathematically the variance) as a weighting in the curve fitting process. The advantage of this is that datapoints with less reliable data and therefore larger HFR standard deviations will be given less weight than more reliable datapoints. If this option is unchecked, and for all other curve fitting where the option is not allowed, all datapoints are given equal weight in the curve fitting process.

The standard deviation is drawn on the V-Curve for each datapoint as an error bar.

It is recommended to check this option.

See the Levenberg-Marquardt Solver for more details.

• R² Limit: This is only available with the Linear 1 Pass focus algorithm and Curve Fits of Hyperbola and Parabola. As part of the Linear 1 Pass algorithm, the degree to which the curve fits the datapoints, or Coefficient of Determination, R², is calculated. This option allows a minimum acceptable value of R² to be defined that is compared to the value obtained from the curve fitting process. If the minimum value has not been achieved then Autofocus will rerun. Only one rerun will be performed and even if the minimum R² has not been met the second time, the Autofocus run will still be deemed successful.

Experiment to find an appropriate value but a good starting point would be 0.8 or 0.9

• Refine Curve Fit: This option is only available with the Linear 1 Pass focus algorithm and Curve Fits of Hyperbola and Parabola. If this option is checked then at the end of the sweep of datapoints, Ekos fits a curve and measures the R². It then applies Peirce’s Criterion based on Gould’s methodology for outlier identification. See Peirce’s Criterion for details incl Peirce’s original paper and Gould’s paper which are both referenced in the notes. If Peirce’s Criterion detects 1 or more outliers then another curve fit is attempted with the outliers removed. Again the R² is calculated and compared with the original curve fit R². If the R² is better, then the latest run is used, if not, the original curve fit (with the outliers included) is used.

Outliers are clearly marked on the V-Curve with an X through the datapoint.

It is recommended to check this option.

• Average over: Number of frames to capture at each datapoint. It is usually sensible to start with 1 but increasing this will result in an averaging process for the star Measure selected.

• Average HFR check: Similar idea to Average Over but in this case it is the HFR Check datapoint that is averaged over the selected number of frames. In addition, if the Algorithm is Linear 1 Pass then the last datapoint of an Autofocus run, which is the in-focus datapoint, is also averaged over this number of frames. Set a value of 1 to start. This can be increased if there are issues with HFR Check Autofocus runs being triggered by outlying datapoints when the HFR Check runs.
Donut Buster: This is an experimental feature and should be used with caution. The intention of Donut Buster is to improve focusing for telescopes with central obstructions that create donut shaped stars when defocused, e.g. Newtonians, SCTs, RASAs, Ritchey-Cretiens, etc.

Donut Buster is only available for Linear 1 Pass, walks of Fixed and CFZ Shuffle, curves fits of Hyperbola and Parabola, and focus measures of: HFR, HFR Adj and FWHM.

When Donut Buster is checked, intermittent curve fitting is suspended and is only activated at the end of the focus sweep. This allows donut buster to better process edge datapoints that may be affected by donuts.

The following sub-options are available within Donut Buster:

- **Time Dilation x**: This feature scales the exposure time during Autofocus from the value entered in the Exposure field for the furthest datapoints from focus. Datapoints near focus are taken with an unscaled exposure. For example, if Focus is setup with an Exposure of 2s and Time Dilation x is set to 4, then when Autofocus moves out to take its first datapoint, an exposure of 2s * 4 = 8s is used. On each successive datapoint the exposure is reduced down to 2s around the point of optimum focus. As the focuser moves through focus, so the exposure is scaled upwards to 8s for the last datapoint.

  The purpose of this feature is to increase the brightness of out of focus datapoints which will be dimmer than in-focus datapoints and therefore harder for star detection to resolve from the background noise.

- **Outlier Rejection**: This is a factor to scale the aggressiveness of the outlier rejection algorithm when Refine Curve Fit is checked. The higher the value the more outliers will be excluded from the curve fitting process. The default value is 0.2.

- **Scan for Start Position**: Check this option to have Focus scan around the current focuser position to find an approximate optimum focus position. The purpose of this is to ensure that Autofocus starts near to the focus position. The following sub-options are available:
  - **Num Datapoints**: The number of datapoints to use in each scan. 5 is a good place to start.
  - **Initial Step size x**: A multiplicative factor to apply to the Initial Step size for use in the Scan for Start Position. Default is 1.0.

If Detection is set to Threshold then the following additional field is available:

- **Threshold**: This contains a percentage value used for star detection using the Threshold detection algorithm. Increase to restrict the centroid to bright cores. Decrease to enclose fuzzy stars.

If Detection is set to Bahtinov then the following additional widgets are available:

- **Num. of rows**: The number of lines displayed on screen when using a Bahtinov mask.
- **Sigma**: The sigma of the gaussian blur applied to the image before applying Bahtinov edge detection.
- **Kernel Size**: The kernel size of the gaussian blur applied to the image before applying Bahtinov edge detection.

If Algorithm is set to Linear or Iterative then the following additional widget is available:

- **Tolerance**: The tolerance percentage value is used to help decide when the Autofocus process stops. During the Autofocus process, HFR values are recorded, and once the focuser is close to an optimal position, it starts measuring HFRs against the minimum recorded HFR in the session and stops whenever a measured HFR value is within % difference of the minimum recorded HFR. Decrease the value to narrow the optimal focus point solution radius. Increase to expand solution radius.

**WARNING**

Setting the Tolerance value too low might result in a repetitive loop and would most likely result in a failed Autofocus process.
Focus Mechanics Parameters:

- **Walk**: This specifies the way Autofocus will “walk” inwards through its sweep to produce the V-Curve from which the focus solution will be calculated. The following are available:
  - **Classic**: This is the recommended setting. The inward sweep follows a series of steps of equal size (Initial Step Size). The algorithm includes logic to determine when to stop that makes the exact number of steps unpredictable but it will be about 2 * (Out Step Multiple) + 1.
    - This Walk is tolerant of curve fitting failures in the last step where it will take a further step and try again to solve. It is also somewhat tolerant of not being started near to focus so is a good choice for the initial Autofocus run.
    - Because of the “tolerance” of this Walk to less than perfect setup it is a conservative option to choose, but comes at the expense of extra steps and therefore extra time in the Autofocus process.
  - **Fixed Steps**: This feature is available in the Linear 1 Pass Algorithm. It is quite similar to Classic but Fixed Steps is used to control the total number of steps taken.
    - This algorithm is more predictable than Classic in that it takes a definite number of steps (so will be faster), but is less tolerant of issues curve fitting the last data point and needs to be started near to focus.
    - When selected, the Out Steps Multiple is replaced by Fixed Steps:

- **CFZ Shuffle**: This feature is available in the Linear 1 Pass Algorithm. It is a variation on Fixed Steps so the comments on that Walk are applicable here as well.
  - The difference between CFZ Shuffle and Fixed Steps is that near the center of the sweep (which should be around the Critical Focus Zone (CFZ)) the algorithm takes steps of half the specified size.
The KStars Handbook

- **Focuser Settle**: The number of seconds to wait, after moving the focuser, before starting the next capture. The purpose is to stop any vibrations in the optical train from affecting the next frame.

- **Initial Step size**: This sets the step size to be used by various focus algorithms. For absolute and relative focusers this is the number of ticks; for timer based focusers this is the number of milliseconds.

- **Out Step Multiple**: Used by the Linear and Linear 1 Pass focus algorithms in the Classic walk, this parameter specifies the initial number of outward steps the focuser takes at the start of an Autofocus run.

- **Number Steps**: Used by the Linear 1 Pass algorithm in the Fixed Steps and CFZ Shuffle walks, this parameter specifies the total number of steps the focuser takes to create the V-Curve in an Autofocus run.

- **Max Travel**: Puts bounds on the amount of travel from the current focuser position that is permitted by the Autofocus algorithms. The purpose is to protect the focuser from travelling too far and potentially damaging itself. On the other hand, the value needs to be big enough to allow sufficient focuser motion to permit the auto focus runs to complete.

- **Max Step Size**: Used by the Iterative algorithm to limit the maximum step size that can be used.

- **Driver Backlash**: See the section on Backlash. There are 2 schemes that can be used:
  - Set **Driver Backlash** to 0 to switch it off and deal with Backlash elsewhere.
  - Set **Driver Backlash** > 0 to use Driver Backlash to manage Backlash in the device driver.
    Note that this field is only editable if the device driver supports Backlash.
    This is the same data field that is displayed in the Indi Control Panel for the focuser device. It can be set in either place.

- **AF Overscan**: See the section on Backlash. There are 2 schemes that can be used:
  - Set **AF Overscan** to 0 to switch it off and deal with Backlash elsewhere.
  - Set **AF Overscan** > 0 to have the Focus module manage Backlash.

- **AF Overscan Delay**: Delay between the completion of the outward move of an Overscan, and the inward move. Generally most focusers work well with no delay.

- **Capture Timeout**: The amount of time in seconds to wait for a captured image to be received before declaring a timeout. This should only be triggered if there are problems with the camera during the Focus process so set this to a high enough value that it will not occur during normal operation.

- **Motion Timeout**: The amount of time in seconds to wait for the focuser to move to the requested position before declaring a timeout. This should only be triggered if there are problems with the focuser during the Focus process so set this to a high enough value that it will not occur during normal operation.

### 5.7.7 Focus Critical Focus Zone (CFZ)

![Focus CFZ Algorithm](#)

<table>
<thead>
<tr>
<th>Algorithm</th>
<th>Classic</th>
<th>CFZ = 4.88 t λ f⁴</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance</td>
<td>1.00</td>
<td>Display: Reset To OT</td>
</tr>
<tr>
<td>Wavelength (λ):</td>
<td>525 nm</td>
<td>Aperture (A): 100 mm</td>
</tr>
<tr>
<td>Focal ratio (f):</td>
<td>5.50</td>
<td>CFZ: 78 μm</td>
</tr>
<tr>
<td>Step size</td>
<td>5.000 μm</td>
<td>CFZ: 16 steps</td>
</tr>
<tr>
<td>CFZ camera</td>
<td>3 steps</td>
<td>Final CFZ: 16 steps</td>
</tr>
</tbody>
</table>

Close
Focus CFZ Parameters:

- **Algorithm:** This specifies the Critical Focus Zone (CFZ) algorithm. The purpose of this is to calculate the CFZ for the equipment attached in the Optical Train. It is not necessary to use this functionality in order to successfully focus, but it provides useful information if correctly configured.

  It requires some knowledge to configure it correctly. There is plenty of information available on the internet.

  The idea of the CFZ dialog is that it starts with data from the Optical Train used in the Focus tab and uses that to calculate the CFZ. The user can adjust parameters to do "what-if" scenarios to see how it affects the CFZ. Clicking the **Reset to OT** button resets any adjusted parameters to the Optical Train values.

  If the **Display** box is checked then the CFZ is drawn on the V-Curve after Autofocus successfully completes.

  ![V-Curve Diagram](image)

  It is necessary to specify the **Step Size** parameter which specifies in microns how far one tick moves the focal plane. For refractors there is usually a 1-to-1 relationship between moving the focuser which moves the telescope draw-tube mechanism and the focal plane movement. For other types of telescope the relationship is likely to be more complex. Refer to details of your telescope / manufacturer for this information.

  The following algorithms are available:

  - **Classic:** This is the recommended setting. The equation used is displayed in the top right of the dialog and is the equation most commonly seen on the internet. The equation comes from a linear optics treatment using the Airy Disc and is acknowledged to have limitations. For this reason it includes a "tolerance" factor that can be adjusted by the user. For example, in the often quoted "In Perfect Focus” article by Don Goldman and Barry Megdal in Sky & Telescope 2010 they suggest setting $t=1/3$.

  - **Wavefront:** The equation used is displayed in the top right of the dialog. The equation comes from a wavefront approach to the CFZ. Again, it has limitations and again, for this reason it includes a "tolerance" factor that can be adjusted by the user.

  - **Gold:** This method is based on work done by Gold Astro and presented [here](#).

  ![Gold Algorithm Table](image)
• **Tolerance**: This is used by Classic and Wavefront algorithms and is a scaling factor between 0 and 1. For the Classic algorithm, Goldman and Megdal suggest 1/3. For the Wavefront algorithm, some have suggested 1/3 or even 1/10.

• **Tolerance (τ)**: This is used by the Gold algorithm and is a focus tolerance as a percentage of total seeing. The Gold website suggests 3-5% for a good focuser or 1-2% for a top quality focuser. See the Gold Astro website for more details.

• **Display**: Check this box to display the calculated CFZ on the V-Curve after a successful Auto-focus run. It is displayed as a yellow moustache.

• **Reset to OT**: Press this button to reset any parameters to values defaulted from the currently connected Optical Train.

• **Wavelength (λ)**: This is the light wavelength to use. It is defaulted from the currently used filter. Remember to set this up in Filter Settings for your filters.

• **Aperture (A)**: This is the aperture of the telescope in mm. It is defaulted from the currently connected Optical Train.

• **Focal Ratio (f)**: This is the focal ratio of the telescope. It is defaulted from the currently connected Optical Train.

• **FWHM (θ)**: This is used by the Gold Algorithm and is the total seeing. This is the combined contribution of the diffraction limit of your telescope and the astronomical seeing. The Gold Astro website describes how you might approximate the total once you have values for the individual contributions.

• **CFZ**: This is calculated CFZ in microns and in ticks.

• **Step Size**: This must be input by the user (as it cannot be calculated by Ekos). It relates how far 1 tick moves the focal plane in microns.

  For a refractor this is how far the drawtube moves when the focuser is moved by 1 tick. You might be able to get this value from the specification of your focuser (how many ticks for a complete revolution of your focuser) and the thread pitch of your telescope drawtube along with any gearing involved.

  Alternatively, you can measure how far the drawtube moves from end to end (be careful not to force the drawtube) with a set of calipers or a ruler. By subtracting the furthest “in” position (in ticks) from the furthest “out” position (in ticks) you have how many ticks moved the drawtube the distance you measured. From this you can calculate the distance in microns a single tick moves the drawtube.

  Other types of telescope will have other ways to adjust the focal plane, for example, by moving the primary or secondary mirrors. You will need to either get the Step Size from the documentation for your equipment or work out how to measure it in a way that are consistent with that described above.

• **CFZ Camera**: The pixel size of the camera attached via the Optical Train may have a limiting effect on the CFZ. So an equivalent CFZ for the attached camera is calculated assuming a Nyquist 2* limit.
5.7.8 Focus Advisor

This is the Focus Advisor dialog. It is a feature to assist with management of focus parameters. The purpose of Focus Advisor is to help people struggling to use the Focus module within Ekos. The Focus module is functionally rich and contains a lot of parameters that need to be set self-consistently to achieve good results. Focus Advisor is designed to help with basic parameter setup that should achieve focus. It is not designed to achieve the best possible focus for your equipment; you will have to experiment with your setup to achieve that. But Focus Advisor provides a place to start that experimentation.

So Focus Advisor is aimed towards the less experienced users.

If Focus Advisor does not appear to give good results on your setup why not start a discussion on the forum so it can be enhanced to give better results in the future. This way it will build over time to be more useful.

When you click on Focus Advisor it works out a series of parameter recommendations based on the Optical Train you are using in Focus.

At the top of the dialog it displays information about the connected Optical Train. Then it displays 6 lines relating to various sets of parameters used within Focus. Against each line is a checkbox to update the associated Focus fields with Focus Advisor’s recommendations.

Focus parameters are broken into the following groupings:

- **Step Size**: This is the suggested focus step size to use. This is a critical parameter. It can be defaulted from the Critical Focus Zone (CFZ) dialog if you know how to set that up. Alternatively, if you know a reasonable value for your equipment from other sources you can just enter that.

- **Camera & Filter Wheel Parameters**: This sets the parameters in the CCD & Filter Wheel section of the Focus screen. By hovering the mouse over this label you can see in the tooltip what values Focus Advisor is recommending.

- **Settings Parameters**: This sets the parameters in Focus Settings. By hovering the mouse over this label you can see in the tooltip what values Focus Advisor is recommending.

- **Process Parameters**: This sets the parameters in Focus Process. By hovering the mouse over this label you can see in the tooltip what values Focus Advisor is recommending.

- **Mechanics Parameters**: This sets the parameters in Focus Mechanics. By hovering the mouse over this label you can see in the tooltip what values Focus Advisor is recommending.

- **SEP Parameters**: This sets the SEP parameter profile appropriate for the scope type attached in the selected Optical Train. By hovering the mouse over this label you can see in the tooltip what values Focus Advisor is recommending.

- **Help**: Press this button to get help on using Focus Advisor.

- **Update Params**: Press this button to accept the Focus Advisor recommendations and update the Focus parameters where the associated **Update** checkbox is checked.
Click the filter icon from either Capture or Focus to open the filter settings dialog. This popup allows the user to configure data associated with each filter, and used for various functions within the system.

Focusing with different filters can be done in one of three ways within Ekos.

- **Direct Autofocus**: When Capture changes to this filter it is possible to automatically refocus this filter. The exposure to use for the selected filter is taken from the Exposure field. This allows, for example, narrowband filters to use a longer exposure than broadband filters during Autofocus. Check Auto Focus to use the filter in this way.

- **Autofocus on Lock Filter**: It is possible to specify a Lock filter to use when it is required to focus this filter. For example, if the Ha filter is used and an Autofocus run required, it is possible to run Autofocus using the Lum filter and then, when complete, adjust the focus position by an Offset value corresponding to the predetermined focus difference between the Lum and Ha filters (100 ticks in this example). This is useful when, for example, it is difficult to focus some filters directly without excessively long exposure times. Note that this locked filter approach may also be used in the Alignment Module whenever it performs a capture for astrometry.

To use a filter in this way, check Auto Focus, specify the Lock Filter to use and make sure that the Offsets for this filter and the Lock Filter are set.

- **Use Offsets**: It is possible to use filter offsets to adjust focus when swapping between filters, without running Autofocus. This requires some setup work ahead of time but has the advantage of reducing the number of Autofocus runs and therefore reducing the time spent autofocusing.

In order to use this feature it is necessary to work out the relative focus position between all filters that you wish to use this functionality for. For example, if Lum and Red have the same focus position (they are parfocal) but Green focuses 300 ticks further out than Lum (or Red) then setup Offsets for Lum, Red and Green as 0, 0, 300 as shown above. If a sequence is created to take 10 subframes of Lum, then 10 Red, then 10 Green, then at the start, since Lum has Auto Focus checked, an Autofocus will be run on Lum and the 10 subs taken. Capture will then switch filters to Red. Since Red has Auto Focus unchecked no Autofocus will happen and Ekos will look to the Offsets between Red and Lum. In this case 0 - 0 = 0. So the focus will not be moved and Capture will take 10 subs of Red. Then Capture will swap from Red to Green. Again, Green has Auto Focus unchecked no Autofocus will happen and Ekos will look to the Offsets between Green and Red. In this case 300 - 0 = 300. So Focus will adjust the focus position by +300 (move the focuser out by 300 ticks). Capture will then take the 10 Green subs.

To use a filter in this way, uncheck Auto Focus and make sure that the Offsets for this filter and all other filters that can precede this filter in a sequence are set.

The Offsets can either be worked out by running Autofocus with different filters and manually calculating the relative offsets and entering them into the table or by using the Build Offsets tool.
Configure settings for each filter in the table:

1. **Filter**: Filter Name.
2. **Exposure**: Set exposure time (in seconds) to be used when performing Autofocus on this filter. By default, it is set to 1 second.
3. **Offset**: Set relative offsets. Ekos will command a focus offset change if there is a difference between the current and target filter offsets. For example, given the values in the example image, if the current filter is set to Red and next filter is Green, then Ekos shall command the focuser to Focus In by +300 ticks. Relative positive focus offsets denote Focus Out while negative values denote Focus In.
4. **Auto Focus**: Check this option to perform AutoFocus whenever the filter is changed to this filter.
5. **Lock Filter**: Set which filter should be set and locked when performing autofocus for this filter. "--" indicates no Lock Filter. It is not allowed to next filters more than 1 deep, i.e. Red cannot be locked to Blue which is itself locked to Green. A filter cannot be locked to itself.
6. **Last AF Solution**: The last successful Autofocus position. Under normal operation Ekos will automatically update this field.
7. **Last AF Temp (C)**: The temperature of the Last AF Solution. Under normal operation Ekos will automatically update this field.
8. **Last AF Alt (Alt)**: The altitude of the Last AF Solution. Under normal operation Ekos will automatically update this field.
9. **Ticks / C**: The number of ticks to move the focuser when the temperature changes by 1C. For example, if focus moves out by 5 ticks when temperature increases by 1C, set this field to 5. If focus moves in by 5 ticks when temperature increases by 1C, set this field to -5.
10. **Ticks / Alt**: The number of ticks to move the focuser when the altitude changes by 1Alt. For example, if focus moves out by 0.5 tick when altitude increases by 1Alt, set this field to 0.5. If focus moves in by 0.5 tick when altitude increases by 1Alt, set this field to -0.5.
11. **Wavelength**: The center of the passband of the filter in nanometers. This is used in some Critical Focus Zone (CFZ) calculations in Focus.

In addition to the data table, the following controls are available at the bottom of the popup:

- **Build Offsets**: Press the Build Offsets button to launch the Build Offsets popup.
- **Capture flats at the same focus as lights**: When checked, flats will be taken at the Last AF Solution focuser position.

Let’s take an example. If we have a capture sequence starting with Lum -> Red -> Green -> Blue -> Sii -> Ha -> Oiii using the setup in the Filter Settings popup:

- **Lum**: The Lum filter is configured to Autofocus initially so an Autofocus run is performed, then the Lum sequence runs.
- **Red**: The Red filter is not configured for Autofocus and has an Offset of 0. So when the Red sequence starts, there is no Autofocus run and the relative Offset between Lum and Red is 0, so the focuser is not moved.
- **Green**: The Green filter is not configured for Autofocus and has an Offset of 300. So when the Green sequence starts, there is no Autofocus run and the relative Offset between Red and Green is 300 - 0 = +300, so the focuser moves out by 300.
• Blue: The Blue filter is not configured for Autofocus and has an Offset of 0. So when the Blue sequence starts, there is no Autofocus run and the relative Offset between Green and Blue is 0 - 300 = -300, so the focuser moves in by 300.

• Sii: The Sii filter is configured for Autofocus, is locked to Lum and has an Offset of 0. So when the Sii sequence starts, there is an Autofocus run on Lum and the relative Offset between Lum and Sii is 0 - 0 = 0, so the focuser moves to the Lum Autofocus run solution.

• Ha: The Ha filter is configured for Autofocus, is locked to Lum and has an Offset of 100. So when the Ha sequence starts, there is an Autofocus run on Lum and the relative Offset between Lum and Ha is 100 - 0 = +100, so the focuser moves to the Lum Autofocus run solution then out by 100.

• Oiii: The Oiii filter is configured for Autofocus, is locked to Lum and has an Offset of -100. So when the Oiii sequence starts, there is an Autofocus run on Lum and the relative Offset between Lum and Oiii is -100 - 0 = -100, so the focuser moves to the Lum Autofocus run solution then in by 100.

5.7.10 Build Offsets

Click the Build Offsets button on the Filter Settings popup to launch the Build Offsets tool. Filter Offsets can either be entered manually into the table in the Filter Settings popup or this tool can be used to assist in creating them.

Note: This utility should not be run during an imaging session as it takes exclusive control of the Focus process whilst it is running.

To start with, configure settings for each filter in the table in the Filter Settings popup and then launch Build Filter Offsets. The popup is launched with a table of data with the following columns.

• Filter: Filter Name. The first filter has an ‘*’ after the filter name, “Lum *” in the above example. This means that Lum is the reference filter against which offsets for other filters will be measured. Double click another Filter Name to make that filter the reference filter.

• Offset: The current offset.

• Lock Filter: The current Lock filter.

• # Focus Runs: The number of focus runs for this filter. The default is 5. To exclude a filter from the process set this field to zero. Note, the reference filter must have at least 1 run.

When the # Focus Runs have been configured press the Run button to start the automated process.

Press the Stop button to stop the process at any time.

Toggle the Adapt Focus checkbox at any point in the processing to switch between measured Autofocus results and results after Adaptive Focus adjustments have been applied. See the Adaptive Focus section for more details on what Adaptive Focus is.
Let’s take an example where we have 7 filters: Lum, Red, Green, Blue, Sii, Ha and Oiii. The 8th slot in the filter wheel is marked as Blank. The process has completed 5 runs for all filters, 0 for Blank (effectively excluding Blank from the process). In this case 8 extra columns have been created in the table.

- **AF Run 1-5**: The maximum # Focus Runs selected by the user is 5, so 5 columns have been created, 1 for each AF run solution.
- **Average**: The average (mean) of the AF solutions.
- **New Offset**: The offset calculated from the Lum filter. E.g. for Sii 36731 - 36743 = -12
- **Save**: Check to save the offset for this filter when the **Save** button is pressed. The default is to check these boxes but unchecking allows a value to be ignored whilst saving other filters.

At this stage, it is recommended to review the AF runs to make sure they are all good. For example, lets assume we are unhappy with the 2nd AF run on Oiii. In this case we could either:

- **Edit AF Run 2** and set the value to whatever value we want.
- **Edit the New Offset column** and set the value directly (bypassing the logic to calculate it).
- **Discard the AF Run 2** by setting the value to 0 (see below). In this case, the Average and New Offset for Oiii is recalculated based on AF Runs 1, 3, 4, 5. In the example below the new Average and New Offsets are calculated and displayed.

After reviewing the results, the user can press:

- **Save**: All filters where the **Save** checkbox is checked will have the New Offset value saved in Filter Offsets for use during the next imaging session.
- **Close**: The Build Filter Offsets tool is closed without saving any data.

If the **Adapt Focus** box is checked, the AF Runs are updated for Adaptive Focus. See the Adaptive Focus section for more details on the theory of Adaptive Focus. The first AF run (in this example AF Run 1 on Lum) is the basis for the Adaptations. So the temperature and altitude of AF Run 1
on Lum is used as the basis for all the other AF Runs and the data is adapted back to what the AF solution would have been, had it been run at the temperature and altitude of AF Run 1 on Lum.

In this example, Adaptive Focus is setup for Altitude adjustments on the Red filter only in Filter Settings. So the Adapted AF Run values are the same as the unadapted values for all the other filters.

**Build Filter Offsets**

If you hover the mouse over an AF Run it will show a tooltip Adaptive Focus Explainer. In the example, the mouse is hovering over AF Run 1 on Red. The 1st row of the Explainer shows the measured Autofocus result for that run (36683), adaptations for Temperature (0.0C) and Altitude (0.2 degrees Alt). The 2nd row of the Explainer shows the Adaptations: 206 total, 0 temperature, 205.9 altitude. The 3rd row shows the Adapted Position of 36889.

The user can toggle between Adapt Focus or raw values. Whichever values are displayed in the grid will be the values that are saved.

Here are some tips for using this utility:

- **Start by making sure the area of the sky you are running Build Filter Offsets on works well for Autofocus.** Aiming high in the sky will result in shooting through less atmosphere with smaller, tighter stars. Make sure there are enough stars in the frame. Avoid Meridian Flips during the process. Track the same area during the process so each run is using more or less the same set of stars. Although the facility to use Adapt Focus is available to adjust for environmental changes such as temperature and altitude try to minimise these changes over the course of running the utility by selecting an appropriate area of the sky.

- **Make sure your equipment is in thermal equilibrium before starting.** Calculate roughly how long the utility will take which is the total number of AF runs * time for a single AF run. Try to make sure that the conditions will remain as consistent as possible during this time, e.g. there is enough time before dawn, the moon won’t affect focusing of some images more than others, the target won’t drop below your horizon during the process, etc.

- **Configure the utility for # Focus Runs (5 is a good start), reference filter (e.g. Lum) and Adapt Focus setting.** Run the utility to completion.

- **Review the results.** For each filter review each AF run looking for outliers. For each outlier decide what to do, e.g. remove from processing by setting to 0. If there are filters for which you are unhappy with the results, uncheck the Save checkbox for those filters.

- **When happy, press Save to save the filter offsets to Filter Settings for future use.**

**5.7.11 Focus Display**
The focus display, displays a FITS viewer window onto the frame taken during the focus process. If **Ring Mask** is selected, then the mask is drawn on the image. All the stars detected by Ekos based on the selected parameters, have their HFR value displayed next to the associated star (unless Measure is set to FWHM).

If **Mosaic Mask** has been selected then the FITS viewer displays the mosaic 3x3 grid showing the center, edges and sides as configured in the Mosaic Mask options.

![Mosaic Mask Image](image)

The window supports the following FITS viewer options (at the top of the window):

- **Zoom In** and **Zoom Out**.
- **Default Zoom** and **Zoom to Fit**.
- **Toggle Stretch**: Toggle screen stretch on or off.
- **Toggle Crosshairs**: Toggle crosshairs on or off.
- **Toggle Gridlines**: Toggle pixel gridlines on or off.
- **Toggle Stars**: Toggle star detection on or off.
- **View Star Profile**: Launches the View Star Profile dialog.

### 5.7.12 V-Curve

![V-Curve Image](image)

The V-Curve displays focuser position (x-axis) versus focus Measure, e.g. Half-Flux-Radius (HFR) (y-axis). Each datapoint is drawn on the graph and represented by a circle with a number representing the datapoint. How many datapoints are taken and how the focuser moves is determined by the parameters chosen.

For certain algorithms, Ekos will also draw a curve of best fit through the datapoints. If **Use Weights** is selected then error bars are indicated on each datapoint that correspond to the standard deviation in measured value.

The units of the y-axis depend on the selected focus Measure. For example, for HFR, the y-axis will either be in Pixels or Arc seconds depending on how **Display Units** is set.
If **Refine Curve Fit** is selected, Focus will check for and potentially exclude outlying datapoints. In this case datapoints 1, 5 and 7 were excluded.

Under the V-Curve a number of parameters are displayed:

- **HFR**: Displays the star HFR for the most recent datapoint if relevant.
- **FWHM**: Displays the star FWHM for the most recent datapoint if relevant.
- **Stars**: The number of stars used for the most recent datapoint.
- **Iteration**: The number of datapoints taken so far.
- **Relative Profile...**: Invokes the Relative Profile popup.
- **Clear Data**: Resets the V-Curve graph by clearing the displayed data.

Here is a V-Curve when Measure is set to HFR Adj:

![V-Curve](image1.png)

Here is a V-Curve when Measure is set to FWHM:

![V-Curve](image2.png)

Here is a V-Curve when Measure is set to # Stars. In this case the Critical Focus Zone (CFZ) **Display** checkbox has been checked so the CFZ is displayed as well:

![V-Curve](image3.png)

Here is a V-Curve when Measure is set to Fourier:

![V-Curve](image4.png)

When Framing, the graph format changes to that of a “time series” where horizontal axis denotes the frame number. This is to aid you in the framing process as you can see how Measure, in this case HFR, changes between frames.
This is very useful, for example, when trying to get the system into approximate focus before starting an Autofocus run. In this case Framing is started and the Step In and Step Out buttons used to adjust focus and the effect on the V-Curve observed.

5.7.13 Relative Profile

The relative profile is a graph that displays the relative HFR values plotted against each other. Lower HFR values correspond to narrower shapes and vice-versa. The solid red curve is the profile of the current HFR value, while the dotted green curve is for the previous HFR value. Finally, the magenta curve denotes the first measured HFR. This enables you to judge how well the Autofocus process improved the relative focus quality.

5.7.14 How to Setup for an Autofocus Run

The exact settings that work best for a given astronomical setup need to be worked out by the user using trial and error. A good place to start is the Focus Advisor section. Run Focus Advisor and accept its recommendations. It uses the Linear 1 Pass algorithm:

- Setup Backlash. See the Backlash section for more details.
- Initial Step Size. This is a critical parameter. You may have an idea from other people with a similar setup. If not you can try setting it from the Critical Focus Zone (CFZ) for your equipment. See the CFZ section for more details.
- Start near to focus by manually finding focus. Use the Start Framing option and manually adjust the focus to get to approximate focus.
- Make sure you are finding enough stars. Increasing the exposure usually finds more stars (but makes the focus process longer).

Run Autofocus. This is the sort of V-Curve you are after:
In contrast, the next picture shows an Initial Step Size that has been set too low. The HFR varies from about 0.78 to 0.72. Which gives a max / min just over 1. The other clue that this is a poor setup is that the Error Bar range is very large compared to HFR movement which means that the curve solver is drawing a curve through a lot of noise, which means the results will not be very accurate.

### 5.7.15 Focuser Backlash

Backlash in the focuser setup is due to a combination of backlash in the electronic focuser itself (e.g. in the gearing mechanism), in the binding of the electronic focuser to the telescope drawtube, and in the telescope drawtube’s mechanism. Thus, each setup will have its own backlash characteristic even if the same focuser is used.

It is important to have a clear strategy for dealing with Backlash and to setup Focus appropriately for the chosen strategy. It is best to have backlash managed in one place to avoid conflicts. Whilst it is possible to have backlash managed in multiple places (this has been done successfully) it is not recommended in general because it can lead to conflicts between software components and the focuser.

There are several ways to measure backlash in ticks. Consult the documentation on your focuser or use the internet including the Indi Forum.

There are several things to consider when working out how to deal with backlash:

- **No Backlash**: If you are fortunate enough to have a setup with no backlash then it would make sense to set **Driver Backlash** and **AF Overscan** off (set to zero).

- **Backlash Managed by Focuser**: If your focuser had the ability to manage backlash itself then you can use this facility and turn **Driver Backlash** and **AF Overscan** off (set to zero). Alternatively, if it’s possible, you could turn off the focuser’s backlash facility and use either the Device Driver or AF Overscan to manage backlash.

- **Backlash Managed by Device Driver**: If your device driver has the ability to manage backlash then you can use this facility and turn off **AF Overscan** (set to zero). Alternatively, you could turn off the device driver’s backlash facility and set **AF Overscan**.

  To know whether the device driver supports backlash, check the **Driver Backlash** field. If it is enabled and you can set values then the driver supports Backlash. If the field is disabled then the driver does not support Backlash.

- **AF Overscan**: The Focus module can manage Backlash itself by over scanning outward motions by the value in the **AF Overscan** field. For example, if **AF Overscan** is set to 40 then whenever Focus moves the focuser outwards, it does this as a 2-step process. Firstly it moves the focuser 40 ticks past where it wants to end up; secondly it moves back in by 40 ticks.
The advantage of **AF Overscan** is that you do not need to know Backlash exactly, you just need to set the **AF Overscan** \textasciitilde{} backlash. So, for example, if you measure backlash as around 60 ticks then you could set **AF Overscan** to 80.

**AF Overscan** is also useful where Backlash is not exactly predictable. For example, if Backlash measurements yield slightly different values, e.g. 61, 60, 59 ticks then by using **AF Overscan** this inconsistency can be effectively neutralised. Were you to use **Focuser Backlash** you would probably average the readings and set the value to 60. Sometimes this will correctly take up all the backlash; sometimes it will be a little short; and sometimes it will over correct.

All focuser movements managed by Focus will have **AF Overscan** applied, including Step Out, Goto, Autofocus runs, Adaptive Focus movements, Adapt Start Pos movements and Take flats at the same position as lights.

### 5.7.16 Adaptive Focus

Ekos supports the concept of Adaptive Focus (AF). Without AF, a typical imaging plan would start with an Autofocus run then a sequence of subframes, then an Autofocus run, etc. The Autofocus runs would be triggered by a number of factors such as time, filter change, temperature change, etc. So basically as a sequence runs subframes are being taken slightly away from optimum focus until a threshold (e.g. temperature change) triggers an Autofocus run.

The idea of AF is to adjust focus as environmental factors change to try to take each subframe as close as possible to optimum focus. Ideally, the effect of Adaptive Focus is like performing an Autofocus run before each subframe but without the overhead of actually doing the run.

AF works as a complement to the various triggers for Autofocus that are available in Ekos now. So it is not necessary to change the Autofocus triggers when starting to use AF. Indeed, at the start, it is not recommended to relax Autofocus conditions when using AF. However, over time, as confidence grows in AF it would be possible to do less Autofocusing (and therefore more imaging). But either way, each subframe should be more in focus when using AF, providing it is setup correctly.

So how do you know if AF would be useful for your setup or not? Perhaps the simplest way would be to examine subframes just after an Autofocus and compare them with subframes just before the next Autofocus. Can you see a difference in focus? If you have a setup where the focus point is tolerant of environmental changes between Autofocus runs then AF may not add anything to your images; if however you have a setup that is sensitive to environmental changes and the frequency of Autofocus runs is a compromise between quality and imaging time then AF ought to improve the quality of your subframes.

AF currently supports two environmental dimensions: Temperature and Altitude (of the imaged target):
• Temperature. All the components of the imaging system will be affected by changes in ambient temperature. The most obvious will be the telescope tube. Typically this will expand as temperature increases and contract as it decreases. This will affect the focus point. But also the optical path the light from the imaged target takes through the atmosphere and through the imaging components of the telescope will be affected by temperature and therefore will affect the focus point.

It is necessary to have a reliable source of temperature information available to the focus module in order to use the temperature feature of AF.

Where the temperature source is located is, of course, up to the user. Given the changes in temperature effect many components it is not obvious where the best location would be. Some experimentation may be required to get the best results but as a guide, the source should be near the imaging train but not near any heating effect of electrical equipment that would say, heat the temperature source but not the optical train. Consistency of location is likely to be important.

• Altitude. Some users have reported that the focus point changes with the altitude of the target. This effect is likely to be smaller than the temperature effect and may be negligible for some setups.

To use AF you need to work out firstly whether you want to adapt for Temperature, Altitude or both. If you are new to AF it is recommended to start with Temperature and once you have that working, determine whether your setup would benefit from adding Altitude.

The first step is to workout the Ticks / C and/or Ticks / Alt for your equipment. To do this there is an existing utility in Ekos whereby when Focus logging is enabled, in addition to adding focus messages to the debug log, every time an Autofocus run completes, information is written to a text file in a directory called focuslogs located in the same place as the debug logs directory. The files are called “autofocus-(datetime).txt”. The data written are: date, time, position, temperature, filter, HFR, altitude. This data will need to be analysed outside of Ekos to determine the Ticks / C and if required the Ticks / Alt.

Here is an example of a “autofocus-(datetime).txt” file:

Currently Ekos supports a simple linear relationship between temperature, or altitude, and ticks. In the future, if there is demand, more sophisticated relationships could be supported. A linear relationship will deliver the majority of the benefit of AF and is fairly straight-forward to administer. More complex relationships could be more accurate but come with more complex administration. Note also that more complex focus point vs temperature relationships will likely be more or less linear for small changes in temperature.

A way to get a value for Ticks / C would be to take the data from the autofocus-(datetime).txt files from a few nights of observing into a spreadsheet and graph focus position against temperature for each filter. Review the data and remove any outliers and plot a line of best fit. Use the line to get Ticks / C. If you intend to adapt for altitude as well as temperature, then it would be better to use a set of data at similar altitude when calibrating temperature. Then it’s possible to calculate the effect of Temperature and remove this from the data when calculating the effect of Altitude.

You will need to ensure that your focus position is repeatable at the same temperature and altitude and that there is no slipping of the focuser or uncompensated backlash. In addition, when calibrating it is better to avoid changing the optical train in a way that could change the focus
position. If this is unavoidable and if the change affected the focus position then you will need to appropriately adjust the historical focus data so they can be compared.

A simple approach is to start with a small amount of data, say 1 night and use this to calculate, say the Ticks / degree C. Run with this and adjust it over time as you collect more data. A way to check how well AF is performing would be to use Analyze to review how AF had moved the focus over 1 hour. If things are spot on, then where ever AF had positioned the focuser after 1 hour would match the Autofocus result. Where there is a discrepancy, it will be because of randomness in the Autofocus result and miscalibration in the AF Ticks / C. By doing this regularly you will build knowledge of your equipment and be able to fine tune AF. Below is a screenshot of Analyze configured for Focus where you can see how Focus position changes throughout the imaging session:

Once you have your data you can configure it in the Filter Settings popup. Then in Focus, switch on Adaptive Focus in Focus Settings. At this point, when you run a sequence, Ekos will check after each subframe whether it needs to adapt the focuser position. If so, Focus will do that and then Capture will continue with the next Subframe.

The screenshot at the top of this section shows an example. Ticks / C is set to 9. Autofocus ran and it solved at 36580 at 10C. Then a simple sequence of 5 subframes was run. The temperature was firstly set to 9C then to 8C. After each subframe completed, Ekos performed an adaptive focus run and where there was a temperature change it calculates the number of ticks to move the focuser. In this example, the focuser was moved inward by 9 ticks on 2 separate occasions, starting at 36580, before moving to 36571 and then to 36562 as shown on the Focus Tab in the Current Position widget and in the message box.

The Adaptive Focus concept has been built into the Build Offsets tool.

5.7.17 Coefficient of Determination, R²

The Coefficient of Determination, or R², is calculated in order to give a measure of how well the fitted curve matches the datapoints. More information is available here. This feature that is available for the Linear 1 Pass focus algorithm. In essence, R² gives a value between 0 and 1, with 1 meaning a perfect fit where all datapoints sit on the curve, and 0 meaning that there is no correlation between the datapoints and the curve. The user should experiment with their equipment to see what values they can obtain, but as a guide, a value above, say 0.9 would be a good fit.

There is an option to set an “R² Limit” in Focus Settings that is compared to the calculated R² after the auto focus run has completed. If the limit value has not been achieved, then the auto focus is rerun.
Setting an R² Limit could be useful for unattended observation if the focus run produces a bad result for a 1-off reason. Obviously if the reason is not transitory then rerunning will not improve anything.

If the R² Limit is not achieved and the focus process is rerun, and again fails to achieve the R² Limit, then the focus run is marked as successful to avoid the process getting stuck rerunning auto focus forever.

This feature is turned off by setting the R² Limit to 0.

### 5.7.18 Levenberg–Marquardt Solver

The Levenberg-Marquardt (LM) algorithm is used to solve non-linear least squares problems. The GNU Science Library provides an implementation of the solver. These resources provide more details:

- [https://en.wikipedia.org/wiki/Levenberg-Marquardt_algorithm](https://en.wikipedia.org/wiki/Levenberg-Marquardt_algorithm)

The Levenberg-Marquardt algorithm is a non-linear least-squares solver and thus suitable for many different equations. The basic idea is to adjust the equation \( y = f(x, P) \) so that the computed \( y \) values are as close as possible to the \( y \) values of the datapoints provided, so that the resultant curve fits the data as best as it can. \( P \) is a set of parameters that are varied by the solver in order to find the best fit. The solver measures how far away the curve is at each data point, squares the result and adds them all up. This is the number to be minimized, let’s call it \( S \). The solver is supplied with an initial guess for the parameters, \( P \). It calculates \( S \), makes an adjustment to \( P \) and calculates a new \( S_1 \). Provided \( S_1 < S \) then we are moving in the right direction. It iterates through the procedure until:

- the delta in \( S \) is less than a supplied limit (convergence has been reached), or
- the maximum number of iterations has been reached, or
- the solver encountered an error.

The solver is capable of solving either an unweighted or weighted set of datapoints. In essence, an unweighted set of data gives equal weight to each datapoint when trying to fit a curve. An alternative is to weight each datapoint with a measure that corresponds to how accurate the measurement of the datapoint actually is. In our case this is the variance of star HFRs associated with the datapoint. The variance is the standard deviation squared.

Currently the solver is used to fit either a parabolic or a hyperbolic curve.
The Aberration Inspector is a tool that makes use of Autofocus to analyze backfocus and sensor tilt in the connected optical train.

To run Aberration Inspector press the Aberration Inspector button. See Focus Tools for more details. The following criteria must be met in order for the button to be active and the tool to work:

- The focuser must be an absolute focuser.
- The focus algorithm must be Linear 1 Pass.
- A mosaic mask must be applied.
- Focuser step size needs to be setup. It is the number of microns the focal plane moves for 1 focuser tick. This is setup in the CFZ dialog. See the CFZ section for more details.

When the Inspector button is pressed, AutoFocus will run, but in addition, for each datapoint, extra information is captured for later use by Aberration Inspector. Once Autofocus completes, the Aberration Inspector dialog is displayed.

To initially setup to use the tool it is recommended to do the following:

- Point to a part of the sky where Autofocus solves well. Typically this would be high in the sky away from any obstacles. Choose somewhere with lots of stars such as the Milky Way. The reason this is more important for Aberration Inspector than Autofocus is that focus analysis needs to be performed for each tile in the mosaic. Therefore, it is important that each tile has enough stars to perform accurate Autofocus.
- Run Autofocus a couple of times to ensure it is solving correctly and that you have a good set of stars in each mosaic tile. Whilst most focus parameters can be used it is recommended to use the parameters that work best for Autofocus with your equipment. The reason for this is that Aberration Inspector needs be focus solve each mosaic tile and not just the sensor as a whole.
• A mosaic mask must be applied. Some experimentation will be required to set this up optimally for your equipment. The configuration parameter to adjust is the tile size which is the size of tile as a percentage of sensor width. The higher the percentage, the bigger each tile, e.g. for a 4:3 sensor using a tile size of 25% means each tile is 8% of the sensor’s area. Using a tile size of 10% means each tile is 1% of the sensor’s area. The bigger the area the more stars will be present and the better the focus algorithm will solve. However, the purpose of the Aberration Inspector is to provide information on aberrations (backfocus and tilt) across the sensor, so ideally the information for each tile would be specific to as small an area as possible.

The sweet spot for tile size is as small a value as possible that still contains enough stars to solve well in each tile.

The Aberration Inspector can be used in conjunction with a device to adjust tilt and / or backfocus. The method to do this is an iterative approach, like for example, collimating a telescope. The steps are:

• Run the Aberration Inspector and obtain results.

• Inspect the results and make sure they are good, e.g. number of stars in each tile is sufficient and the $R^2$ is acceptable for all relevant tiles.

• Adjust tilt and / or backfocus using your device, based on Aberration Inspector results.

• Re-run Aberration Inspector. It will launch another dialog. Check results as before. If the tilt and / or backfocus is getting better then the adjustment was made in the correct sense; if not reverse the sense and retry. Use the feedback from the previous adjustment for the next adjustment.

Repeat the above process until the limit of sensitivity of the equipment is reached.

Note the amount of adjustment, e.g. how far to turn bolts, and the sense, clockwise or counter-clockwise, will vary by equipment and must be discovered by the user by trial and error. Always follow the recommendations of the tilt / backfocus device manufacturer.

Each time Aberration Inspector is run it launches a new dialog with the run number appended to the title. This way several runs can be performed and the results compared. Note, however, that the dialog holds a lot of data (roughly 10x the amount of a standard Autofocus run). The system resources associated with this are released when the dialog is closed. For this reason on lower powered machines, once the tool has been used, it is recommended to close all Aberration Inspector dialogs before imaging.

The following sections describe the sections of the Aberration Inspector dialog.

5.7.19.1 Aberration Inspector V-Curve

At the top of the dialog are some controls, followed by the V-Curve. The controls are:

• Tiles: Three options are available:
  – All: All 9 tiles are displayed.
  – Centre and outer corners: The centre and 4 corner tiles are displayed.
  – Centre and inner diamond: The centre and 4 inner diamond tiles are displayed.
The KStars Handbook

- **Labels**: Checkbox toggles focus point labels on the V-Curve.
- **CFZ**: Checkbox toggles whether the CFZ moustache is displayed on the V-Curve.
- **Optimise Tile Centres**: If unchecked, the geometrical centre of the tile is used; if checked, the centre of the tile is calculated as an average of the star positions within the tile. Whilst theoretically more accurate to check this option, it is likely to have a significant impact only if the number of stars is small.
- **Close**: Close the Aberration Inspector dialog.

The V-Curve is similar to the V-Curve on the main Focus tab, except each tile is represented by its own curve. The number of curves is determined by the setting of the Tiles combobox. The x-axis displays the focuser position and the y-axis the measure (e.g. HFR) used by Autofocus. Each curve has its own colour and 2 character identifier as displayed in the legend.

Hover the mouse over a curve minimum to see more information about that curve.

5.7.19.2 Aberration Inspector Table

<table>
<thead>
<tr>
<th>Tile</th>
<th>Description</th>
<th>Solution</th>
<th>Delta (ticks)</th>
<th>Delta (μm)</th>
<th>Num Stars</th>
<th>R²</th>
<th>Exclude</th>
</tr>
</thead>
<tbody>
<tr>
<td>TL</td>
<td>Top Left</td>
<td>50011</td>
<td>6</td>
<td>30</td>
<td>37 / 74</td>
<td>0.99</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>Top Right</td>
<td>49967</td>
<td>-18</td>
<td>-90</td>
<td>31 / 57</td>
<td>0.99</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Centre</td>
<td>50000</td>
<td>0</td>
<td>0</td>
<td>29 / 58</td>
<td>0.99</td>
<td></td>
</tr>
<tr>
<td>BL</td>
<td>Bottom Left</td>
<td>50004</td>
<td>-1</td>
<td>-5</td>
<td>26 / 43</td>
<td>0.99</td>
<td></td>
</tr>
<tr>
<td>BR</td>
<td>Bottom Right</td>
<td>49981</td>
<td>-24</td>
<td>-120</td>
<td>26 / 64</td>
<td>0.99</td>
<td></td>
</tr>
</tbody>
</table>

The table displays information pertinent to each tile as selected by the Tiles setting.

A tooltip like graphic is displayed when the mouse is hovered over either of the leftmost 2 columns. The graphic displays a picture of the sensor scaled to the dimensions of the sensor. Overlayed on the sensor are the tiles as selected by the Tiles setting. The tiles are scaled appropriately for the tile settings. Each tile is labelled with the Tile Name and the tile corresponding to the row that the mouse is hovering over, is highlighted in the colour of that tile.

The following columns are displayed:

- **Tile**: The 1 or 2 character name of the tile, e.g. TL = Top Left, C = Centre, etc.
- **Description**: Tile Description, e.g. Top Left, Centre, etc.
- **Solution**: The focus solution. This matches the solution on the V_Curve.
- **Delta (ticks)**: This is the delta of the solution for the current table row from the solution of the Centre tile. The Delta of the Centre row will, of course, be zero.
- **Delta (μm)**: This is Delta (ticks) converted to microns using the step size in microns as specified in the CFZ Focus tab.
- **Num Stars**: This shows the min / max number of stars detected during the Autofocus run. Usually, the minimum number would be a far out of focus datapoint and the max number would be the in focus datapoint.
- **R²**: R-squared of the curve fit for this tile. See Coefficient of Determination for more details.
• **Exclude:** Checkbox to include / exclude this tile in calculations. By default, if a tile has been curve fitted it will be included; if a tile was not curve fitted then it will be excluded. In addition, the user may decide that a particular tile may contain poor quality data, for example the R² is low; or the number of stars is low. In this case the Exclude can be checked and this row will be excluded from calculations. Note that by excluding some rows, some calculations may not be performed. If the Centre tile is excluded, no calculations can be performed.

Note that whilst it’s possible to exclude tiles and still get calculated values, if the data is poor quality then it is recommended to rerun Aberration Inspector rather than persist with poor quality data.

The recommended approach is to check the table for quality data and once achieved, move onto analysing the **Aberration Inspector Results.**

### 5.7.19.3 Aberration Inspector Results

| Backfocus Δ: | 46μm. Move sensor away from flattener |
| Left-Right Tilt: | -118μm / -6.90% |
| Top-Bottom Tilt: | -33μm / -0.37% |
| Total Tilt: | 122μm / 0.87% |

The calculation results are displayed in this section, based on the data displayed in the table:

- **Backfocus Δ:** This is the value of the Backfocus delta. The nearer to perfect backfocus, the lower the backfocus delta. Note that the Backfocus delta gives a clue as to how far out the Backfocus is, in terms of scale and direction, but is not the amount by which the sensor needs to be moved. The relationship between backfocus Delta and how far to move the sensor will vary with the equipment used, and needs to be worked out by the user.

  The field gives the sense of the backfocus movement required to improve backfocus: either move the sensor nearer to the field flattener (telescope) or move it further away.

- **Left-Right Tilt:** Gives the Left to Right tilt in microns and as a percentage.

- **Top-Bottom Tilt:** Gives the Top to Bottom tilt in microns and as a percentage.

- **Total Tilt:** The diagonal tilt in microns and as a percentage.

The smaller the backfocus delta the nearer the sensor is to perfect backfocus. If the field flattener does not flatten the field all the way to the edges of the sensor then this will be visible by switching the Tiles option between "Centre and outer corners" and "Centre and inner diamond". If the backfocus delta results are consistent when the Tiles option is changed then this indicates that the field flattener is working to the corners of the sensor.

There will always be some backfocus delta at least because of noise in the observation data. The important thing is that when in focus, stars are circular in all parts of the sensor.

The smaller the tilt percentages, the nearer the sensor is to being flat to the plane of light from the flattener / telescope. As with backfocus delta, there is always going to be some noise in the data, which will present as tilt. The important thing is that when in focus the star sizes are consistent across all parts of the sensor.

Because of the nature of the backfocus delta and tilt calculations, one will affect the other so it will probably be better to try and adjust both together, in small increments, rather than trying to perfect one in isolation, before adjusting the other.
5.7.19.4 Aberration Inspector 3D Graphic

The 3D graphic displays the sensor tilted as per the Aberration Inspector Results. To help visualise the Petzval surface (see Petzval Field Curvature for more details) of light coming out of the telescope and incident on the sensor the surface is also modelled. The higher the backfocus error, the more curved the Petzval surface.

The graphic can be zoomed and rotated using gestures. To zoom use pinch. To rotate use touch-and-move.

The graphic has a Simulation Mode that allows backfocus and tilt to be adjusted by the sliders. The effect on the sensor’s tilt and Petzval surface is displayed in the graphic.

The following options are available for the graphic:

- **Selection**: The following options are available:
  - None: No selection is possible.
  - Item: A datapoint may be selected and data values are displayed.
  - Slice: A 2D slice through the 3D graphic is displayed.

- **Theme**: A number of colour themes are available.

- **Labels**: Checkbox to show / hide tile labels on the graphic.

- **Sensor**: Checkbox to show / hide the sensor.

- **Petzval Wire**: Checkbox to show / hide the Petzval surface as a graphic wire.

- **Petzval Surface**: Checkbox to show / hide the Petzval surface.

- **Sim Mode**: Checkbox to toggle Simulation Mode on / off. When off, the graphic displays the sensor and Petzval surface based on the calculated results of the Aberration Inspector run. When on, the sliders for Backfocus, Left-to-Right tilt and Top-to-Bottom tilt are activated, and these can be dragged by the user to adjust the graphic. Hover the mouse over each slider to see the tooltips describing what each slider does.

The 3D graphic is not essential to using Aberration Inspector. All relevant information is displayed in the Table and Results sections of the dialog. Its purpose is to aid the user in understanding Aberration Inspector and to orient themselves with the information the tool provides.
5.8 Guide

5.8.1 Introduction

The Ekos Guide Module performs autoguiding using either the powerful built-in guider, or at your option, external guiding via PHD2 or lin_guidner. Using the internal guiding, guider camera frames are captured and sent to Ekos for analysis. Depending on the deviations of the stars from their lock positions, guiding pulses corrections are sent to your mount’s RA and DEC axes motors. Most of the GUI options in the Guide Module are well documented so just hover your mouse over an item and a tooltip will popup with helpful information.
5.8.2 Setup

To perform guiding, you need (one time) to select a Guider in the Profile Editor for the profile you will be using. In the profile editor, choose Internal for the Ekos internal guider, or PHD2.

To perform guiding, you also need to set up your guiding optical train. This 2nd optical train is almost always different from the one you are using with capture/align/focus. See the image above for an example guider optical train configuration. Note that the telescope chosen is the guiding scope, which may be the same as your main telescope if you are using an OAG (off-axis-guiding) or ONAG guiding scheme. The camera selected is, of course, your guiding camera. The Guide Via should be your mount, assuming you are sending guide pulses directly to your mount, or the name of the ST4 device (e.g. your camera) should you be using ST4 guide pulses.

Please look at the main guider page shown at the start of this Guider section. There are many parameters that also can be adjusted, some of which are listed below.
• **Exposure**: On the main guiding page you can adjust the guiding exposure time. After the guide-camera completes the exposure, the guide algorithm computes and sends the guide pulses to the mount, then it waits a user-configurable delay, and then begins its next exposure.

• **Binning**: Pixel binning for the guide image. It usually makes sense to bin the pixels 2x2. The algorithms can still find sub-pixel star positions and send proper guide pulses to the mount.

• **Box**: This only is applicable to guide algorithms other than MultiStar, and MultiStar is the recommended guiding scheme. Size of the box enclosing the guide star. Select a suitable size that is neither too large or too small for the selected star.

• **Directions**: Typically you want to keep all the directions boxes checked. Unchecking them will disable guiding in those directions. For instance it is possible to disable DEC guiding in the North direction.

• **Dark**: Check this to enable dark-frame corrections to your guiding image. See below.

• **Clear Calibration**: Check this to delete your calibration data. See the calibration section below.

• **Subframe, AutoStar**: These only apply to guide algorithms other than MultiStar, and MultiStar is the recommended guiding scheme.

### 5.8.3 Calibration

Autoguiding is a two-step process: Calibration & Guiding. Calibration is needed for the scheme to understand the camera’s orientation, relative to the RA and DEC axes, and also the effects of guide pulses (e.g. how much a 100ms RA guide pulse will typically move the RA axis). Once it estimates these values, the guider can correct the mount’s position effectively. You can see calibrated values for those parameters in the above image in the “Calibrated Values” section.

Similar to other guiders, we recommend that you carefully calibrate once, and then only re-calibrate when necessary. It is necessary to re-calibrate when the camera is moved (e.g. rotate) relative to the mount. It should not be necessary to calibrate every time you slew the mount. You should calibrate when pointing near the Meridian and along the Celestial Equator (probably just
West of it). Guiding (and guide calibration) is problematic near the pole—it probably won’t work. This slide show contains good advice on how to calibrate the Internal Guider and/or PHD2.

The important options on the calibration options page (above) are:

- **Pulse Size**: should be large enough to move your image a few pixels.

- **Re-using Calibration**: There are two checkboxes related to keeping your calibration. We recommend checking “Store and re-use guide calibration when possible”, and un-checking “Reset Guide Calibration After Each Mount Slew”.

- **Reverse DEC...**: It is also important to check or un-check (it is mount dependent) “Reverse DEC on pier-side change when re-using calibration”. To find out the right setting for your mount, you need to successfully calibrate on one pier side, make sure guiding is working well on that side, then switch to the other side. Guide for a minute or two. If DEC runs away, then you probably have the wrong setting for the “Reverse DEC...” checkbox.

- **Max Move, Iterations**: We recommend you keep iterations large (e.g. 10) and Max Move large (e.g. 20+ pixels). This way you should get a good estimate of the guiding calibration parameters. Calibration should be something you do rarely, so it is best to take a little extra time and get right.

To (re)calibrate, clear your calibration on the main guiding page, and then simply click on the Guide button. Note that if calibration was already completed successfully before, and you didn’t clear the calibration, and you are re-using calibrations, then the autoguiding process will begin immediately, otherwise, it will start the calibration process.

Ekos begins the calibration process by sending pulses to move the mount in RA and DEC. It pulses out the RA axis, then pulses it back in. After that it moves a little in DEC to clear and backlash that might exist, and then pulses out and back in for DEC. To view this graphically, click on the “Calibration Plot” subtab on the main guiding page.

### 5.8.3.1 Calibration Failures

Calibration can fail for a variety of reasons. To improve the chances of success, try the tips below.

- **Bad sky conditions.** If your sky condition are not great, it may not be worth fighting guiding/calibration.

- **Guide camera focus.**

- **Leave algorithm to the default value (SEP MultiStar) in the Guide Option tab.**

- **Try the “Guide-Default” SEP star-detection parameters (in the Guide Option tab) and adjust them if necessary.**

- **Better Polar Alignment**: This is critical to the success of any astrophotography session. Use the Ekos Polar Alignment procedure in the Align module.

- **Set binning to 2x2**: Binning improves SNR and is often very important to the success of the calibration and guiding procedures.

- **Take dark frames to reduce noise.**
5.8.4 Guiding

Once the calibration process is completed successfully, guiding begins automatically. The guiding performance is displayed in the **Drift Graphics** region where **Green** reflects deviations in RA and **Blue** deviations in DEC. The colors of the RA/DEC lines can be changed in **KStars color scheme** in KStars settings dialog. The vertical axis denotes the deviation in arcsecs from the lock position and the horizontal axis denotes time. You can hover over the line to get the exact deviation at this particular point in time. You can also zoom and drag/pan the graph to inspect a specific region of the graph. Another convenient place to examine guiding performance is in the Analyze tab.

Ekos can utilize multiple algorithms to determine the drift from the (original) lock position, but by far the most accurate is the (default) SEP MultiStar algorithm. It uses the detected position of many stars (in the above settings, up to 50) to determine its best estimate for the current drift. It is dependent on accurate star detection. Thus, it may be important to adjust star-detection parameters. Start with the default Guide-Default SEP profile, and optionally edit its parameters if you feel stars are not being detected accurately.

Here are some of the parameters you may want to adjust. Again, good advice in choosing parameters is available on the internet, e.g. from the above slideshow.

- **Aggressiveness.** How quickly you want the guider to correct the error. Values of 0.5 or 0.6 are usually best (i.e. correcting about half the observed error). Unintuitively, it seems that correcting 100% of the error can cause poor performance as the guider will often oscillate with overcorrections.

- **Algorithm.** We strongly recommend you use the most up-to-date algorithm: SEP MultiStar. Pretty much the only reason not to would be if you can’t get your SEP star-detection to perform adequately.

- **SEP Profile.** Start with Guide-Default, though you may choose others if you have very large or small stars (in terms of number of pixels in diameter).
5.8.5 Dithering

To enable automatic dithering between frames, make sure to check the Dither checkbox. By default, Ekos should dither (i.e. move) the guiding box by up to 3 pixels after every N frames captured in Ekos Capture Module. The motion duration and direction are randomized. Since the guiding performance can oscillate immediately after dithering, you can set the appropriate Settle duration to wait after dither is complete before resuming the capture process. In rare cases where the dithering process can get stuck in an endless loop, set the appropriate Timeout to abort the process. But even if dithering fails, you can select whether this failure should terminate the autoguiding process or not. Toggle Abort Autoguide on failure to select the desired behavior.

Dithering does not result in a long wander from the original target position. Ekos keeps track of the original and current target positions, and moves the target back towards the original target should the position have drifted too far.

One-pulse dithering is an interesting quicker option which sends a pulse to dither, but does not verify that the dither reached its desired location. It is possible that the dithering for any given dither isn’t as much as desired, but the overall effect should be good.

Non-guide dithering is also supported. This is useful when no guide camera is available or when performing short exposures. In this case, the mount can be commanded to dither in a random direction for up to the pulse specified in the Non-Guide Dither Pulse option.
5.8.6 Drift Graphics

The drift graphics is a very useful tool to monitor the guiding performance. It is a 2D plot of guiding deviations and corrections. By default, only the guiding deviations in RA and DE are displayed. The horizontal axis is the time in seconds since the autoguiding process was started while the vertical axis plots the guiding drift/deviation in arcsecs for each axis. Guiding corrections (pulses) can also be plotted in the same graph and you can enable them by checking the Corr checkbox below each Axis. The corrections are plotted as shaded areas in the background with the same color as that of the axis.

You can pan and zoom the plot, and when hovering the mouse over the graph, a tooltip is displayed containing information about this specific point in time. It contains the guiding drift and any corrections made, in addition to the local time, this event was recorded. A vertical slider to the right of the image can be used to adjust the height of the secondary Y-axis for pulses corrections.

The Trace horizontal slider at the bottom can be used to scroll through the guide history. Alternatively, you can click the Max checkbox to lock the graph onto the latest point so that the drift graphics autoscrolls. The buttons to the right of the slider are used for autoscaling the graphs, exporting the guide data to a CSV file, clearing all the guide data, and for scaling the target in the Drift Plot. Furthermore, the guide graph includes a label to indicate when a dither occurred so the user knows guiding was not bad at those points.

The colors of each axis can be customized in KStars Settings color scheme.

5.8.7 Drift Plot

A bulls-eye scatter plot can be used to gauge the accuracy of the overall guiding performance. It is composed of three concentric rings of varying radii with the central green ring having a default radius of 2 arcsecs. The last RMS value is plotted as with its color reflecting which concentric ring it falls within. You can change the radius of the innermost green circle by adjusting the drift plot accuracy.
5.8.8 Guiding with GPG

With GPG guiding, the internal guider uses predictive and adaptive guiding for the RA axis. This adaptively models the periodic error of the mount, and adds its predicted contribution to each guide pulse.

The main settings to consider are Major Period and Estimate Period. If you know the worm period for your mount, perhaps by examining this table, then uncheck Estimate Period and enter your known Major Period. If not, then check Estimate Period. Intra-frame dark guiding can be used to spread out the GPG prediction. For instance, if you guide at 5s, you can set the dark guiding interval to 1s and its prediction is pulsed every second, but the guiding drift correction would be sent every 5s. In this way, it outputs the predicted corrections much faster than the guide camera exposure rate, effectively performing periodic error correction and allowing longer guide camera exposures. All the other parameters are best left to defaults.

5.8.9 Dark Frames

Dark frames can be helpful to reduce noise in your guide frames. If you choose to use this option, then it is recommended that you take dark frames before you begin your calibration or guiding procedure. To take a dark frame, check the Dark checkbox and then click Capture. For the first time this is performed, Ekos will ask you about your camera shutter. If your camera does not have a shutter, then Ekos will warn you anytime you take a dark frame to cover your camera/telescope before proceeding with the capture. On the other hand, if the camera already includes a shutter, then Ekos will directly proceed with taking the dark frame. All dark frames are automatically saved to Ekos Dark Frame Library. By default, the Dark Library keeps reusing dark frames for 30 days after which it will capture new dark frames. This value is configurable and can be adjusted in Ekos settings in the KStars settings dialog.
It is recommended to take dark frames covering several binning and exposure values so that they may be reused transparently by Ekos whenever needed.

5.8.10 PHD2 Support

You can opt to select external PHD2 application to perform guiding instead of the built-in guider.

If PHD2 is selected, the Connect and Disconnect buttons are enabled to allow you to establish a connection with the PHD2 server. You can control PHD2 exposure and DEC guide settings.
When clicking **Guide**, PHD2 should perform all the required actions to start the guiding process. **PHD2 must be started and configured before Ekos.**

After launching PHD2, select your INDI equipment and set their options. From Ekos, connect to PHD2 by clicking the **Connect** button. On startup, Ekos will attempt to automatically connect to PHD2. Once the connection is established, you may begin the guiding immediately by click on the **Guide** button. PHD2 performs calibration if necessary. If dithering is selected, PHD2 is commanded to dither given the offset pixels indicated, and once guiding is settled and stable, the capture process in Ekos resumes.

### 5.8.11 Guiding Logs

Ekos’ internal guider saves a CSV guide log in PHD2 format data that can be useful for analysis of the mount’s performance. In Linux this is stored under `~/.local/share/kstars/guidelogs/`. This log is only available when using Ekos’ internal guider. It should be compatible with PHD2’s guide log viewer.

### 5.9 Align

#### 5.9.1 Introduction

The Ekos Alignment Module enables highly accurate GOTOs and can measure and correct polar alignment errors. This is possible thanks to third-party plate-solving technology. The main plate-solving software used is the StellarSolver package, which itself makes use of the offline (and online) astrometry.net, ASTAP and Watney solvers. Ekos begins by capturing an image of a star field, feeding that image to the chosen solver (e.g. see astrometry.net, StellarSolver or ASTAP), and gets in return the central coordinates (RA, DEC), scale, and orientation of the image. The solver essentially performs pattern recognition against a catalog of millions of stars. Once the coordinates are determined, the true pointing of the telescope is known.

Often, there is a discrepancy between where the telescope thinks it is looking at and where it is truly pointing. The magnitude of this discrepancy can range from a few arcminutes to a couple
of degrees. Ekos can correct the discrepancy by syncing to the new coordinates, and then slewing
the mount to the desired target originally requested.

Ekos also provides a Polar Alignment Assistant Tool to correct polar alignment errors. It takes
three images, slewing between the images, and calculates the offset between the mount axis
and polar axis. It feeds back to the user the altitude and azimuth adjustments needed to align
these axes. These images are typically taken near the celestial pole (close to Polaris for Northern
Hemisphere) but can work well taken from anywhere, usually starting near the meridian and
slewing either East or West.

At a minimum, you need a CCD/Webcam and a telescope that supports Slew & Sync commands.
Most popular commercial telescope nowadays support such commands.

5.9.2 Typical use

Using Ekos Alignment Module, aligning your mount using the controller’s 1, 2, or 3 star align-
ment is not strictly necessary, though for some mounts it is recommended to perform a rough 1
or 2 star alignment before using Ekos alignment module. If you are using EQMod, you can start
using Ekos alignment module right away. A typical workflow for GOTO alignment involves the
following steps:

1. Start KStars and Ekos and connect to INDI.
2. Unpark your mount from its home position (usually the NCP for equatorial mounts).
3. Slew to a nearby bright star using the slew telescope command in the SkyMap using the
   Slew the telescope to the mouse-pointer position command.
4. Select Slew to Target in the Solver Action on the Align page.
5. After slew is complete, click Capture & Solve on the Align page.

Align will capture an image and try to solve it. If the solver is successful, Ekos will send a sync
command to the mount and then slew to the star. The results are displayed in the Solution Re-
sults tab along with a bullseye diagram that shows the offset the reported telescope coordinates
(i.e. where the telescope thinks it is looking vs. its actual pointing position in the sky as deter-
mined by the solver). Align will stop if it is within the desired error tolerance, otherwise it will
repeat the Slew/Capture/Solve/Sync process until it is within tolerance.

Each time the solver is executed and returns successful results, Ekos can run on the following
actions:

- **Sync**: Syncs the telescope coordinates to the solution coordinates.
- **Slew to Target**: Syncs the telescope coordinates to the solution coordinates and then slew to
  the target.
- **Nothing**: Just solve the image and display the solution coordinates.
5.9.3 Configure StellarSolver Options

To use the solvers, you must first configure the StellarSolver options. The above page is displayed when clicking on the **Options** button on the lower right of the Align page, then selecting the **StellarSolver Options** tab. Start with the **Builtin method for solver Source Extraction method** so that each solver uses its preferred star-extraction code. For **Solving Method** we recommend choosing **Internal Solver** to use StellarSolver’s copy of the Astrometry.net code, or choose **Local ASTAP** if you prefer that. The online astrometry solver is accurate, but can take a long time to solve because of all the data transfer required. For **Options Profile**, start with the **1-Default** profile.

There are two other minor options. **WCS** or World-Coordinate-System is a system for embedding equatorial coordinate information within the image. When you view a solved image, you can hover it and view the coordinate for each pixel. You can also click anywhere in the image and command to the telescope to slew there. It is highly recommended to keep this option on. **Overlay** overlays captured images unto the sky map of KStars.
5.9.4 Configure StellarSolver External Programs

This is only required if you choose one of the external programs for your Solving Method. If you choose Internal Solver, then it is not necessary.

You will need to make sure the paths are correct for the solver you choose. The top menu item select to load one of the default sets usually configures the boxes correctly.

5.9.5 Configure StellarSolver Scale and Position
The KStars Handbook

This page tells Ekos whether you want to constrain your plate-solving search by scale or position. Scale can be the image width in degrees (\(dw\)), the image width in arc-minutes (\(aw\)), or the pixel width in arc-seconds (\(app\)). All should work, but arc-seconds per pixel is recommended. Typically you want to use this constraint for faster solving, so we recommend you check this box. The system doesn’t require that the scale be exactly right—it allows deviations of 10-20%. However, frequently issues related to solving are due to an inaccurate scale being used. Therefore, if you have plate-solving problems, you may want to uncheck Use Scale until those issues are resolved. This will likely result in longer solving times. Auto-update will automatically fill the scale box with the scale found in the most-recent successful solve.

The RA and DEC positions are usually filled in from the position the telescope thinks it is pointing. Naturally, the system doesn’t require an exactly correct positional constraint—afterall the purpose of plate-solving is to find that position. The maximum distance in degrees from the specified position to the actual position is given by the Radius field. Plate-solving will fail if the specified position is further away. Typically you want to enable Use Position for faster solving, so we recommend you check this box. However, frequently issues related to solving are due to using a poor positional estimate (e.g. the telescope is significantly misaligned). Therefore, if you have plate-solving problems, you may want to uncheck Use Position until those issues are resolved. As mentioned, this will result in longer solving times. Auto-update will fill the position box with the position found in the most-recent successful solve. However, a slew will update the position to the position where the telescope thinks it is pointing after the slew.

### 5.9.6 Configure StellarSolver Profiles

You can choose an Options Profile on the StellarSolver Options tab. Profiles are simply collections of parameters to configure the performance of the star-extraction and plate-solving system inside of StellarSolver. The 1-Default profile is the recommended one to start with. There are a few other possible profiles such as Large Scale Solving, Small Scale Solving, and Single Thread Solving.

In the Align Options Profile Editor tab you can view and edit profiles. There are many parameters, most of which you need not change to solve issues. There are 3 types of parameters.
The top section labelled **SExtractor Parameters** (with column headings **Extraction Parameters**, **Deblending Params**, and **Photometry Params**) are star extraction parameters--that is those that help find stars in your image.

The second section labelled **Star Filtering Parameters** filters/reduces the number of stars extracted before sending the list to either the plate-solver (when aligning or polar-aligning), or to autofocus or the internal guider (when just a list of stars is needed).

The third section labelled Astrometry Parameters adjusts the performance of plate solving.

All the input fields have tooltips that are displayed if you hover your mouse over the input box. You can make changes to the values and save the profile if you like, or restore the profile’s original values.

### 5.9.6.1 Star-Extraction Parameters

The column headings are links to the Sextractor manual which is the main source for these parameters. View those links to find details on all the parameters. We will touch upon some of the parameters you might consider adjusting. However, it’s probably best not to get into the weeds of modifying most of these values.

- **Thresh Multiple** and **Thresh Offset** relate to how sensitive the system will be to pixel values. The level of the background is multiplied by **Thresh Multiple** and then **Thresh Offset** is added to that. If a pixel’s value exceeds the result, then it may be used to detect a star. Therefore, lower values (especially for multiple) may cause even dim pixels to be detected as stars. Higher values will reduce the number of stars detected.

- **Min Area** is the minimum area for a star detection--area is in square pixels where all pixels have higher-than-threshold pixel values. If you are detecting small noise spikes as stars, you might want to increase this. If you are not detecting desired smaller real stars, perhaps your **Min Area** is too high.

- **Conv FWHM** should be adjusted to roughly the seeing in your area in pixels. The image is smoothed by this amount before star detection is initiated.

### 5.9.6.2 Star-Filtering Parameters

This filtering is done for the sake of speed mostly, as well as for removing clipped stars, or very elliptical objects which might be galaxies. We will touch upon some of the parameters you might consider adjusting. Zero values for these parameters disable the filter. However, once again it’s probably best not to get into the weeds of modifying most of these values.

- **Initial Keep** and **Stars Keep #** relates to the number of stars returned by the system. The system will initially run its detection algorithm and find some number of possible detections. It will filter that list, keeping only the **Initial Keep** brightest stars. It will then run the rest of the filtering, including computing the HFR of all those stars and finally only return a list of **Stars Keep #** stars. None of the uses (alignment, autofocus, guiding) of StellarSolver require thousands of stars to be able to do their job, and the more stars processed the slower the operation. An initial list of 1000 stars and a few hundred returned stars should be sufficient for most applications.

- **Max Size** and **Min Size** filter stars by their sizes (pixel diameters), and are similar in usage to **Min Area** above.

- **Max Ellipse** specifies how elliptical a star can be before being removed. 2 would mean the larger axis could be twice as large as the smaller axis.

- **Cut Brightest** and **Cut Dimmest** remove the X% brightest or dimmest stars from consideration. **Sat Limit** removes stars whose pixel values exceed that percentage of the maximum pixel value--to remove saturated stars.
5.9.6.3 Plate-Solving Parameters

These plate-solving parameters mostly relate to computation resources.

- **Search Radius** is the distance from the position estimate in degrees that may be searched if **Use Position** is checked.
- **Maximum Time** is the maximum number of seconds that the plate-solving will run before it times out.

5.9.7 Download Index Files

Index files are required if you choose the **Internal Solver** or **Local Astrometry Solving Method**. For offline (and remote) solvers, index files are necessary for the solver to work. The complete collection of index files is huge (over 30 GB), but you only need to download what is necessary for your equipment setup. Index files are sorted by the Field-Of-View (FOV) range they cover. There are two methods to fetch the necessary index files: The new download support in Align module, and the old manual way.

5.9.7.1 Automatic Download

Automatic download is only available for Ekos users on Linux® & Mac® OS. For Windows® users, please download ANSVR solver.

To access the download page, click the **Options** button in the Align module and then select **Astrometry Index Files** tab. The page displays the current FOV of your current setup and below it a list of available and installed index files. Three icons are used to designate the importance of index files given your current setup as follows:

- 🚀 **Required**
You must download all the required files, and if you have plenty of hard drive space left, you can also download the recommended indexes. If an index file is installed, the checkmark shall be checked, otherwise check it to download the relevant index file. Please only download one file at a time, especially for larger files. You might be prompted to enter the administrator password (default in StellarMate is `smate`) to install the files. Once you installed all the required files, you can begin using the offline astrometry.net solver immediately.

### 5.9.7.2 Manual Download

You need to download and install the necessary index files suitable for your telescope+CCD field of view (FOV). You need to install index files covering 100% to 10% of your FOV. For example, if your FOV is 60 arcminutes, you need to install index files covering skymarks from 6 arcminutes (10%) to 60 arcminutes (100%). There are many online tools to calculate FOVs, such as Starizona Field of View Calculator.

<table>
<thead>
<tr>
<th>Index Filename</th>
<th>FOV (arcminutes)</th>
<th>Debian Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>index-4219.fits</td>
<td>1400 - 2000</td>
<td>astrometry-data-4208-4219</td>
</tr>
<tr>
<td>index-4218.fits</td>
<td>1000 - 1400</td>
<td></td>
</tr>
<tr>
<td>index-4217.fits</td>
<td>680 - 1000</td>
<td></td>
</tr>
<tr>
<td>index-4216.fits</td>
<td>480 - 680</td>
<td></td>
</tr>
<tr>
<td>index-4215.fits</td>
<td>340 - 480</td>
<td></td>
</tr>
<tr>
<td>index-4214.fits</td>
<td>240 - 340</td>
<td></td>
</tr>
<tr>
<td>index-4213.fits</td>
<td>170 - 240</td>
<td></td>
</tr>
<tr>
<td>index-4212.fits</td>
<td>120 - 170</td>
<td></td>
</tr>
<tr>
<td>index-4211.fits</td>
<td>85 - 120</td>
<td></td>
</tr>
<tr>
<td>index-4210.fits</td>
<td>60 - 85</td>
<td></td>
</tr>
<tr>
<td>index-4209.fits</td>
<td>42 - 60</td>
<td></td>
</tr>
<tr>
<td>index-4208.fits</td>
<td>30 - 42</td>
<td></td>
</tr>
<tr>
<td>index-4207/*.fits</td>
<td>22 - 30</td>
<td>astrometry-data-4207</td>
</tr>
<tr>
<td>index-4206/*.fits</td>
<td>16 - 22</td>
<td>astrometry-data-4206</td>
</tr>
<tr>
<td>index-4205/*.fits</td>
<td>11 - 16</td>
<td>astrometry-data-4205</td>
</tr>
<tr>
<td>index-4204/*.fits</td>
<td>8 - 11</td>
<td>astrometry-data-4204</td>
</tr>
<tr>
<td>index-4203/*.fits</td>
<td>5.6 - 8.0</td>
<td>astrometry-data-4203</td>
</tr>
<tr>
<td>index-4202/*.fits</td>
<td>4.0 - 5.6</td>
<td>astrometry-data-4202</td>
</tr>
<tr>
<td>index-4201/*.fits</td>
<td>2.8 - 4.0</td>
<td>astrometry-data-4201-1astrometry-data-4201-2astrometry-data-4201-3astrometry-data-4201-4</td>
</tr>
</tbody>
</table>

Table 5.1: Index Files

The Debian packages are suitable for any Debian-based distribution (Ubuntu, Mint, etc.). If you downloaded the Debian Packages above for your FOV range, you can install them from your favorite package manager, or via the following command:
sudo dpkg -i astrometry-data-*.deb

On the other hand, if you downloaded the FITS index files directly, copy them to /usr/share/as
trometry directory.

**NOTE**
It is recommended to use a download manager as such DownThemAll! for Firefox to download the Debian packages as browsers’ built-in download manager may have problems with download large packages.

5.9.8 Optionally get astrometry.net

This is only required if you choose the **Local Astrometry** option for **Source Extraction Method** which is no longer recommended.

**NOTE**
Astrometry.net is already shipped with StellarMate so there is no need to install it. Index files from 16 arcminutes and above (4206 to 4019) are included with StellarMate. For any additional index files, you need to install them as necessary. To use Astrometry in StellarMate from a remote Ekos on Linux®, Windows®, Mac® OS, make sure to select **Remote** option in Ekos Alignment Module. Furthermore, make sure that the **Astrometry** driver is selected in your equipment profile.

**Windows®**

To use astrometry.net under Windows®, you need to download and install the **ANSVR Local Astrometry.net solver**. The ANSVR mimics the astrometry.net online server on your local computer; thus the internet not required for any astrometry queries.

After installing the ANSVR server and downloading the appropriate index files for your setup, make sure ANSVR server is up and running and then go to Ekos Alignment options where you can simply change the **API URL** to use the ANSVR server as illustrated below:
In Ekos Align module, you must set the solver type to **Online** so that it uses the local ANSVR server for all astrometry queries. Then you can use the align module as you would normally do.

Remember as indicated above that StellarMate already includes astrometry.net. Therefore, if you would like to use StellarMate remotely to solve your images, simply change solver type to **Remote** and ensure that your equipment profile includes **Astrometry** driver which can be selected under the **Auxiliary** dropdown. This is applicable to all operating systems and not just Windows®.

**Mac® OS**

Astrometry.net is already included with KStars for Mac® OS, so no need to install it.

**Linux®**

Astrometry.net is already included with KStars bleeding version. But if astrometry is not installed, then you can install it by running the following command under Ubuntu™:

```
sudo apt-get install astrometry.net
```

### 5.9.9 How to Use?

Ekos Align Module offers multiple functions to aid you in achieving accurate GOTOs. For some mounts it is useful to start your session with your mount in home position with the telescope tube looking directly at the celestial pole. For users in Northern Hemisphere, point the telescope as close as possible to Polaris. It is not necessary to perform 2 or 3 star alignments, but it can be useful for some mount types. Make sure your camera is focused.

At the top left of the Align page you can find two solver commands, and two actions to take given the solver solution.

- **Capture & Solve**: Capture an image and determine exactly where in the sky the telescope is pointing. The astrometry results include the equatorial coordinates (RA & DEC) of the center of the captured image and the pixel scale and field rotation. Depending on the Solver Action settings, the results can be used to Sync the mount or Sync and then Slew to the target location. For example, suppose you slewed the mount to Vega then used Capture & Solve. If the actual telescope location is different from Vega, it will be first synced to the solved coordinate and then Ekos shall command the mount to slew to Vega. After slew is complete, the Alignment module will repeat Capture & Solve process again until the error between reported and actual position falls below the accuracy thresholds (30 arcseconds by default).

- **Load & Slew**: Load a FITS or JPEG file, solve it, and then slew to it.

---

**WARNING**

*Never* solve an image at or near the celestial pole (unless Ekos Polar Alignment Assistant Tool is used). Slew at least 20 degrees away from the celestial pole before solving the first image. Solving very close to the poles will make your mount pointing worse, so avoid it.
5.9.10 Alignment Settings

Before you begin the alignment process, select the desired optical train. You can explore astrometry.net options that are passed to the astrometry.net solver each time an image is captured:

- **Accuracy**: Acceptable difference between the desired target position and the solved coordinates from the captured image. If the difference exceeds this many arc-seconds, then the system will continue to capture, solve and slew until the solved position is close enough to the target position.
- **Train**: Select the Optical Train which will be used to capture the image to be aligned. It is also used to compute the image scale.
- **Exposure**: Exposure duration in seconds.
- **Bin**: The binning of the image before solving.
- **Gain/ISO**: The camera gain or ISO.
- **Filter/Use Current**: The filter to use when capturing the image. *Use Current* uses whatever filter is currently active.
- **Dark**: Whether to use the dark-image subtraction scheme before analyzing the captured image.

5.9.11 Polar Alignment

When setting up a German Equatorial Mount (GEM) for imaging, a critical aspect of capturing long-exposure images is to ensure proper polar alignment. A GEM mount has two axes: Right Ascension (RA) axis and Declination (DE) axis. Ideally, the RA axis should be aligned with the celestial sphere polar axis. A mount’s job is to track the star’s motion around the sky, from the moment they rise at the eastern horizon, all the way up across the median, and westward until they set.

https://www.stellarmate.com/images/videos/polar_align.webm

*Polar Alignment Assistant*

In long exposure imaging, a camera is attached to the telescope where the image sensor captures incoming photons from a particular area in the sky. The incident photons have to strike the same photo-site over and over again if we are to gather a clear and crisp image. Of course, actual photons do not behave in this way: optics, atmosphere, seeing quality all scatter and refract photons in one way or another. Furthermore, photons do not arrive uniformly but follow a Poisson distribution. For point-like sources like stars, a point spread function describes how photons are spatially distributed across the pixels. Nevertheless, the *overall* idea we want to keep the source photons hitting the same pixels. Otherwise, we might end up with an image plagued with various trail artifacts.
Since mounts are not perfect, they cannot perfectly keep track of object as it transits across the sky. This can stem from many factors, one of which is the misalignment of the mount’s Right Ascension axis with respect to the celestial pole axis. Polar alignment removes one of the biggest sources of tracking errors in the mount, but other sources of error still play a factor. If properly aligned, some mounts can track an object for a few minutes with the only deviation of 1-2 arcsec RMS.

However, unless you have a top of the line mount, then you’d probably want to use an autoguider to keep the same star locked in the same position over time. Despite all of this, if the axis of the mount is not properly aligned with the celestial pole, then even a mechanically-perfect mount would lose tracking with time. Tracking errors are proportional to the magnitude of the misalignment. It is therefore very important for long exposure imaging to get the mount polar aligned to reduce any residual errors as it spans across the sky.

Before starting the process, point the mount as close as possible to the celestial pole with the counterweights down. If you are living in the Northern Hemisphere, point it as close as possible to Polaris. If Polaris is not visible (e.g. blocked by trees or buildings) you may point elsewhere, preferably near the Meridian. Make sure there is at least 30-60 degrees of sky viewable in an arc East or West of the Meridian from the position you choose. Select the direction of free sky, the number of degrees for each of two slews, the mount slew speed, and whether the mount will be slewing automatically (recommended) or manually.

The tool works by capturing and solving three images. After capturing each, the mount rotates by the fixed amount you entered and another image is captured and solved. If you choose manual, you will need to slew the mount by roughly the angle chosen.
The images below show the workflow when the Plate Solve correction technique is used. The image below shows a display after the 3 measurement images are captured and solved. It shows an error of almost 18’ in altitude and that the mount’s axis needs to be moved up. Similarly it shows an azimuth error of almost 15’ and that the axis needs to be moved to the right (as viewed from behind the telescope).

If your error is low enough (e.g. less than an arc-minute) then you don’t need to make any adjustments. Simply press stop and you’re done.
If you will be making corrections to your mount’s axis, you should select the adjustment approach (we’re using Plate Solve in this example), and how often the system should recapture images to re-measure the polar alignment error. The refresh interval should be frequent, but it doesn’t make sense to make it faster that your CPU can capture and plate-solve the images. We’re using 2s in this example. Then press the Refresh button to begin the correction process.

The system will capture images, and re-estimate the polar alignment error after each image. You can try to reduce the error by adjusting the Altitude and Azimuth correction knobs on your mount. The image below shows the screen after the altitude error has been almost zeroed. See the difference between the Measured Error row, which shows the originally measured error after the original 3 captures, and the Updated Error row which shows the current error estimate.

Below the user has also adjust Azimuth to reduce the error further. Now the error is very low and the process is done. The user should press the stop button.
5.9.11.2 Move Star Correction Scheme

We also have an alternative schemes for correcting polar alignment. Two variations are Move Star & Calc Error and Move Star. When you select this scheme, the system place a yellow/green/violet triangle on the screen. The triangle can be moved by clicking near a star, and the yellow/violet corner is moved to that star. In this scheme the user corrects polar alignment by first adjusting the mount’s azimuth knob so that the selected star moves along the yellow side of the triangle. Once the star is near the next vertex, the azimuth knob should be adjusted so that the star moves along the green side of the triangle. Once the star is moved to the green/violet vertex, the mount is polar aligned, and the user can click stop.

The difference between Move Star & Calc Error and Move Star is that in the former, the system attempts to track the star the user has selected, and places a circle around that star. In that scheme it also attempts to update the Updated Err row. If the star tracking isn’t reliable, simply ignore it or use the Move Star scheme and move the star by-eye until it’s close to the final target. An example of using this technique is shown in this video: https://www.youtube.com/watch?v=iOp7hrxw0oU
5.10 Scheduler

5.10.1 Introduction

The Ekos Scheduler is an important component of your imaging workflow. It connects to INDI, starts and stops all the other Ekos modules, schedules jobs according to their constraints and priorities, monitors those jobs as they execute, and then safely brings down the system when jobs are done, or before dawn. Whether you are running multi-day imaging sessions for multiple targets, or simply trying to image a single target for a few hours, it is advisable to have the Scheduler control your imaging sessions.

5.10.2 Scheduler Table

The heart of the Scheduler is a table displaying the list of Scheduler jobs the user wants to run. Associated with each jobs are attributes (mostly described in the settings section below). The attributes describe the name of the job, where the telescope should be pointed when imaging that job, a description of what types of images should be captured, constraints about when the jobs should run (e.g. altitude, twilight, moon, landscape blockages, etc.), things that need to be done before and after the job is run, and strategies for dealing with errors.

You can add, delete, modify or change the order of rows in the Scheduler table.

- You can add a Scheduler job row into the table by clicking the + control above the table, if all required attributes are filled out (name, position, and sequence file).
- If you click on a row, you can then click the - control above the table to delete that row.
- If you click on a row, you can then click the ^ or v controls to move those rows up or down in the job list.
- If you double click on a row, the attributes of that job are filled in to the various settings on the Scheduler page. You can then change one or more of those attributes, and then click the checkmark above the table (after your double-click, the + became a checkmark), and the new attributes are assigned to that job.
5.10.3 Scheduling Algorithm

The Scheduler table (above) lists jobs in order of priority, with higher jobs (on lower-numbered rows) having higher priority than jobs further down the list (with higher-numbered rows).

The Scheduler regularly plans (and re-plans) which jobs should be run, and when. It can start executing a given job, and then later preempt that job for a new one. It can become idle if no jobs can be run (e.g. in daylight), and sleep until such a time that it becomes active again. Its aim is to keep the equipment as busy as possible, while respecting the scheduler-table’s priorities. Here’s how it works.

When the scheduler starts (or when it replans, which it does every second while active), it looks through the entire list of jobs, starting at the highest priority job, and working its way down to the lowest priority one if necessary. When it finds a job that can run, it starts that job, possibly preempting the currently running job. A jobs can run if its constraints are met, e.g. the target is not blocked by the local terrain, it meets the minimum altitude constraint, it has not already completed all the desired imaging, ...

The algorithm shows its projected next start times and stop times for all job in the Scheduler table. It also shows its estimate of times jobs will run during the next 48 hours in the log panel at the bottom of the window. See the screenshot of the scheduler window at the top of this section.

The scheduling algorithm described in the above paragraph is known as the Greedy Scheduling algorithm. It is the recommended one to use. In previous versions of Ekos, there was another “Classic scheduling algorithm” which is no longer in Ekos. That scheme could not preempt running jobs, and thus did not make as much use of the equipment as the Greedy Algorithm.

There is a checkbox option in the scheduler options menu called Use greedy scheduling which defaults to being checked. The system works as described above when it is checked. When it is unchecked the scheduler is prevented from scheduling lower priority jobs when uncompleted higher priority jobs cannot run. This results in less efficient use of the system, but may give you more control over scheduling.

5.10.4 Scheduler Files (.esl)

The scheduler table with its list of jobs and attributes can be saved onto disk and read back in. It writes an .esl file. Controls for writing the current Scheduler table to disk, and reading back other .esl files are located above the table to the right.

5.10.5 Settings

Ekos Scheduler provides a simple interface to aid the user in setting the conditions and constraints required for an Scheduler job. You must select the Target, its coordinates, and the Sequence before you can add a job to the Scheduler.

Each Scheduler job is composed of the following:

- **Target name and coordinates**: Select target from the Find Dialog or Add it from Observation Planner. You can also enter a custom name. Coordinates can also be copied from the SkyMap using the button just to the right of the coordinates.

- **Optional PA**: The position angle (or image rotation) can be specified for systems with camera rotation hardware.

- **Optional FITS File**: If a FITS file is specified, the astrometry solver solves the file and use the central RA/DEC as the target coordinates.

- **Sequence file**: The sequence file is constructed in the Ekos Capture Module. It has a list of capture specifications, where each spec details the number of images to capture, which filter to use, the exposure length, the gain, file naming details, temperature settings, prefixes, download directory, etc.
**Profile**: Select which equipment profile to utilize when starting Ekos. If Ekos & INDI are already started and online, this selection is ignored.

**Steps**: The user selects what steps should be taken at the start of the job. The possibilities are: (1) Start mount tracking, (2) autofocus, (3) run a plate solving alignment, (4) start the auto-guider. One or more can be chosen.

**Startup Conditions**: Conditions that must be met before the Scheduler job is started. Currently, the user may select to start as soon as possible, ASAP, or when the target is near or past culmination, or at a specific time.

**Constraints**: These are conditions that must be met at all times during the Scheduler job execution process. These include minimum target altitude, minimum moon separation, twilight observation, artificial horizon altitude constraints, and weather monitoring.

**Completion Conditions**: Conditions that trigger completion of the Scheduler job. The default selection is to simply mark the Scheduler job as complete once the sequence process is complete. Additional conditions enable the user to repeat the sequence process a number of times or indefinitely, or up until a specific time.

### 5.10.6 Other options

There are several other options to control how the Scheduler behaves. These are found in the general KStars Settings menu, shown below, in its Ekos tab and Scheduler sub-tab.

#### 5.10.6.1 Remember job progress

Among the settings shown above, one important one is known as Remember job progress. When this box is checked and a job is running, the Scheduler looks at the job’s images already captured on disk, and doesn’t re-capture the ones that are already there. The benefit is that if a job is restarted, or re-run another night, or if multiple jobs are being run together, stopping and starting when they are runnable, then jobs re-start right where they left off. This works well with the Repeat until terminated job-completion option. If Remember job progress is unchecked, jobs...
would restart from the start of their sequence specification each time, which probably isn't what
you want. Unfortunately, if the images are not stored on the same computer that Ekos is running
on, then this feature doesn’t work and the jobs restart from their beginning.

A possibly confusing side-effect of Remember job progress is that if you’ve run a job using the
(default) Sequence Completion finish condition, and it has captured all its images, and now you
want to run the job again, the Scheduler won’t schedule the job because it believes that all the
images have already been captured. You’d either need to move those images elsewhere on disk,
or change the finish condition to Repeat for N Times, or Repeat Until Terminated.

5.10.6.2 Group repeats

This feature allows you to run two or more scheduler jobs at roughly the same priority, such
that if they were both runnable, they would progress at roughly the same rate. This may be
applicable, for example, to jobs imaging the multiple tiles in a mosaic, but is generally applicable
to any set of jobs.

Normally the (Greedy) scheduler’s job priority is set by the row the job is listed in the Scheduler’s
job table. Jobs on rows closer to the top run with higher priority than jobs lower down. Thus,
if a job on row 2 (Job2) uses Repeat Until Terminated, and that job’s running constraints are
satisfied, a lower down job (e.g. Job3) will not be scheduled to run.

If you wish to alternate jobs, you can assign each of the jobs the same group name, and give the
jobs one of the repeating finish conditions (e.g. Repeat for N times, or Repeat Until Terminated).
With that setup, jobs in the same group will cede to each other if they have completed more 'Re-
peat Iterations' than the other job. So, if Job2 with group "MyGroup" completes its 2nd iteration,
and Job3 with the same group name has only completed 0 or 1 iterations, when the time comes
to schedule Job2, Job3 will run instead.

Practically speaking, imagine you had a 6-panel mosaic you wanted to alternate. You might
give all of those jobs the same group name, make them all e.g. "Repeat for 5 times". Then, they
would run in lock-step. The cadence of job switching would be controlled by the length of the
sequence file assigned to each of those jobs. You wouldn’t want to make the cadence too short
(e.g. capturing one 2-minute image), as there is overhead in switching jobs. For instance, starting
jobs may involved aligning, starting guiding, and even focusing.

5.10.6.3 Repeat all jobs

There is a checkbox and number input right below the Scheduler jobs table that allows you to
repeat the entire schedule N times. This can be used to alternate a few jobs. You can just list the
jobs on the scheduler, set it to repeat N times, and the jobs will repeat. However, this change is
incompatible with 'Remember job progress (above) and unavailable if Remember Job Progress is
checked. (Note: Remember Job Progress is recommended.)

5.10.7 Editing running jobs

It is possible to edit the scheduler’s job table, and attributes of individual jobs, while the scheduler
is running. As always, you double click on a job, change the desired attributes, and click the
checkbox to finalize the change. If you edit the running job it will be restarted (i.e. the startup
steps (slew, focus, align, guide) will be re-done. You can also move jobs up and down in priority,
add new jobs, or deleted existing ones. You cannot delete the running job.

One important attribute of scheduler jobs is their sequence file (.esq) which controls the capture
module while the job is running. For example, it sets number of captures, filters used, gain/ISO,
etc. The .esq is normally created and edited in the capture tab, but that cannot be done while the
scheduler is running. If you desire to make changes to a .esq file while the scheduler is running,
or create a new one, the scheduler provides a tool called the Capture Sequence Editor.
5.10.7.1 Capture Sequence Editor

The Capture Sequence Editor is a tool to create and edit capture sequence files (.esq) which can be started by clicking the edit (pencil) icon just above the scheduler table. A screenshot is shown below.

The editor is very similar in use and layout to the capture tab--though it is missing all the controls to actually capture image. You edit jobs the same way you do in capture, and load or save sequence queues the same way too (though there are additional Load and Save-To buttons provided in the editor).

**IMPORTANT**

It is important to understand that capture sequences rely to some extent on the filterwheel and camera being used (e.g. the filter names, the possible ISO values, ...). The Capture Sequence Editor, which is not connected to the device drivers, does not have direct access to this information. Instead, the editor uses the values from the last time the capture tab connected to its devices. Thus, it may not make sense to try and create a .esq file for a different camera or filterwheel than the last one connected-to. You may need to wait until your scheduler job is completed and edit that .esq directly in the capture tab.

It is also recommended that you don’t overwrite .esq files when scheduler jobs are currently using those same files. (It is OK if the scheduler is running, but not running that job.) This can get the scheduler and capture modules out of sync, as they read the files at different times. Instead, you can save to a different filename and then edit the scheduler job to use the new .esq filename.
5.10.8 Workflow

The description above only tackles the Data Acquisition stage of the observatory workflow. The overall procedure typically utilized in an observatory can be summarized in three primary stages:

1. Startup
2. Data Acquisition (including preprocessing and storage)
3. Shutdown

5.10.9 Startup Procedure

Startup procedure is unique to each observatory but may include:

- Turning on power to equipment
- Running safety/sanity checks
- Checking weather conditions
- Turning off light
- Fan/Light control
- Unparking dome
- Unparking mount
- etc.

Ekos Scheduler only initiates the startup procedure once the startup time for the first Scheduler job is close (default lead time is 5 minutes before startup time). Once the startup procedure is completed successfully, the scheduler picks the Scheduler job target and starts the sequence process. If a startup script is specified, it shall be executed first.
5.10.10 Data Acquisition

Depending on the user selection, the typical workflow proceeds as follows:

- Slew mount to target. If a FITS file was specified, it first solves the files and slew to the file coordinates.
- Auto-focus target. The autofocus process automatically selects the best star in the frame and runs the autofocus algorithm against it.
- Perform plate solving, sync mount, and slew to target coordinates.
- Perform post-alignment focusing since the frame might have moved during the plate solving process.
- Perform calibration and start auto-guiding: The calibration process automatically selects the best guide star, performs calibration, and starts the autoguide process.
- Load the sequence file in the Capture module and start the imaging process.
- Coordinate module issues, such as failures in guiding or alignment. They may result in Scheduler job suspensions and rescheduling.
- Note--some of the inter-module interactions are initiated by the modules themselves, but are monitored by the Scheduler. These include meridian flips, autofocus runs initiated by temperature change or timer expiration, and minimum guiding deviation requirements for capture.

5.10.11 Shutdown

Once the Scheduler job is completed successfully, the scheduler selects the next Scheduler job. If no job can be scheduled at this time, the mount is parked until a next job can run. Furthermore, if the next job is not due for a user-configurable time limit, the scheduler performs a preemptive shutdown to preserve resources and performs the startup procedure again when the target is due.

If an unrecoverable error occurs, the observatory initiates shutdown procedure. If there is a shutdown script, it will be executed last.

The following video demonstrates an earlier version of the scheduler, but the basic principles still apply today:

https://www.youtube.com/embed/v8vIXD1kois

Ekos Scheduler

5.10.12 Weather Monitoring

Another critical feature of any remotely operated robotic observatory is weather monitoring. For weather updates, Ekos relies on the selected INDI weather driver to continuously monitor the weather conditions. For simplicity sake, the weather conditions can be summed in three states:

1. Ok: Weather conditions are clear and optimal for imaging.
2. Warning: Weather conditions are not clear, seeing is subpar, or partially obstructed and not suitable for imaging. Any further imaging process is suspended until the weather improves. Warning weather status does not pose any danger to the observatory equipment so the observatory is kept operational. The exact behavior to take under Warning status can be configured.
3. Alert: Weather conditions are detrimental to the observatory safety and shutdown must be initiated as soon as possible.
5.10.13 Startup & Shutdown Scripts

Due to the uniqueness of each observatory, Ekos enables the user to select startup and shutdown scripts. The scripts take care of any necessary procedures that must take place on startup and shutdown stages. On startup, Ekos executes the startup scripts and only proceeds to the remainder of the startup procedure (unpark dome/unpark mount) if the script completes successfully. Conversely, the shutdown procedure begins with parking the mount & dome before executing the shutdown script as the final procedure.

Startup and shutdown scripts can be written any language that can be executed on the local machine. It must return 0 to report success, any other exist value is considered an error indicator. The script’s standard output is also directed to Ekos logger window. The following is an sample demo startup script in Python:

```python
#!/usr/bin/env python
# -*- coding : utf-8 -*-

import os
import time
import sys

print "Turning on observatory equipment..."
sys.stdout.flush()

sleep(5)

print "Checking safety switches..."
sys.stdout.flush()

sleep(5)

print "All systems are GO"
sys.stdout.flush()

exit(0)
```

The startup and shutdown scripts must be executable in order for Ekos to invoke them (e.g. use `chmod +x startup_script.py` to mark the script as executable). Ekos Scheduler enables truly simple robotic operation without the need of any human intervention in any step of the process. Without human presence, it becomes increasingly critical to gracefully recover from failures in any stage of the observation run. Using Plasma notifications, the user can configure audible alarms and email notifications for the various events in the Scheduler.
Hubble-like super wide field images of galaxies and nebulae are truly awe-inspiring, and while it takes great skills to obtain such images and process them; many notable names in the field of astrophotography employ gear that is not vastly different from yours or mine. I emphasize vastly because some do indeed have impressive equipment and dedicated observatories worth tens of thousands of dollars. Nevertheless, many amateurs can obtain stellar wide-field images by combining smaller images into a single grand mosaic.

We are often limited by our camera+telescope Field of View (FOV). By increasing FOV by means of a focal reducer or a shorter tube, we gain a larger sky coverage at the expense of spatial resolution. At the same time, many attractive wide-field targets span multiple FOVs across the sky. Without any changes to your astrophotography gear, it is possible to create a super mosaic image stitched together from several smaller images. There are two major steps to accomplish a super mosaic image:

1. Capture multiple images spanning the target with some overlap between images. The overlap is necessary to enable the processing software from aligning and joining the sub-images.

2. Process the images and stitch them into a super mosaic image.

The 2nd step is handled by image processing applications such as PixInsight, among others, and will not be the topic of discussion here. The first step can be accomplished in Ekos Scheduler where it creates a mosaic suitable for your equipment and in accordance with the desired field of view. Not only Ekos creates the mosaic panels for your target, but it also constructs the corresponding observatory jobs required to capture all the images. This greatly facilitates the logistics of capturing many images with different filters and calibration frames across a wide area of the sky.

The Mosaic Planner in the Ekos Scheduler will create multiple Scheduler jobs based on a central target. To toggle the planner, click on the Mosaic Planner button in Ekos Scheduler or KStars INDI toolbar as illustrated in the screenshot. The planner draws the Mosaic Panel directly unto the sky map. It is recommended to enable HiPS overlay for the best experience. The planner is composed of four stages:
1. **Confirm Equipment**: Ekos attempts to load equipment settings from INDI. If unsuccessful, you need to enter your equipment settings including your telescope focal length in addition to camera’s width, height, and pixel dimensions. The settings are saved for future sessions.

![Confirm Equipment](image)

2. **Adjust Grid**: Select the mosaic panel dimension and overlap percentage. The Mosaic Panel is updated accordingly on the sky map. Adjust the Position Angle to match the desired mosaic orientation in the sky. If the Position Angle is different from your camera’s usual orientation, you may need to rotate the camera either manually or via a mechanized rotator when the scheduler jobs are executed. Tile transparency is automatically calculated by default but may be turned off and adjusted manually. To compute the mosaic field from the number of tiles, click the **Cover FOV** button. The mosaic panel can be centered in the sky map by clicking on the **Recenter** button.

![Adjust Grid](image)
A large overlap will make frame stitching easier during post-processing, but it requires more panes to cover the desired extent. However, if you already know the minimal amount of sub-frames your rejection algorithm will use during post-processing, you may want to increase the overlap to attain that amount on the areas covered by multiple panes. For instance, a 4x4 mosaic grid with 75% overlap has 16 sub-frames covering the central intersection, which is enough for Winsorized Sigma rejection. Although the resulting stack does not have the same height on all parts of the final frame, this method gives you control on signal-to-noise ratio and allows you to provide context to your target while exposing a relatively low number of captures.

The large number drawn in the corner of each grid pane represents the order in which panes will be captured. The default S-shaped choice (west-east then alternating high-low/low-high moves), ensures minimal movement of the mount during observation. Uncheck **Minimum mount move** to revert to west-east/high-low movement only. The coordinates of each pane are rendered in their center as degrees, minutes and seconds. Finally, the angle each pane rotates from the center of the mosaic is displayed at the bottom. If your field of view is large, or if your mosaic is located close to a celestial pole, you may observe that rendered panes start rotating visibly due their horizontal position or high declination. Use the **overlap** to ensure panes cover the desired frame extents properly.

3. **Adjust Grid**: Adjust Grid center by manually entering the J2000 center or by dragging the center of the mosaic on the sky map.
4. **Create Jobs**: The final step is to select the sequence file and directory to store the images. Target field may be automatically filled but may be changed as desired. Select the steps each scheduler job should execute in sequence (Track -> Focus -> Align -> Guide -> Capture), and adjust the frequency of automatic alignment and focus routines that must be executed during the mosaic operation. For example, if **Align Every** is set to 2 Scheduler Jobs, then the first job will run the astrometry alignment, while the second job will skip it. When the third job is executed, alignment is performed again and so forth.

If you want the different mosaic tile jobs to alternate, then fill in the group name with an identifier that all the tile jobs will share, and select a repeating completion condition.

Click **Create Jobs** to generate mosaic scheduler jobs and add them to the schedule queue. You can further edit the jobs individually, as you would normal Scheduler jobs.

![Mosaic Planner — KStars](image)

Adjust Grid center by manually entering the J2000 center or by dragging the center of the mosaic on the sky map.
5.11 Analyze

5.11.1 Introduction

The Analyze Module records and displays what happened in an imaging session. That is, it does not control any if your imaging, but rather reviews what occurred. Sessions are stored in an analyze folder, a sister folder to the main logging folder. The .analyze files written there can be loaded into the Analyze tab to be viewed. Analyze also can display data from the current imaging session.

There are two main graphs, Timeline and Stats. They are coordinated—they always display the same time interval from the Ekos session, though the x-axis of the Timeline shows seconds elapsed from the start of the log, and Stats shows clock time. The x-axis can be zoomed in and out with the +/- buttons, as well as with standard keyboard shortcuts (e.g. zoom-in == Ctrl+-) The x-axis can be panned with the scroll bar as well as with the left and right arrow keys. You can view your current imaging session, or review old sessions by loading .analyze files using the Input dropdown. Checking Full Width displays all the data, and Latest displays the most recent data (you can control the width by zooming).

The three main displays can be hidden to make more room for the other displays. There are checkboxes to the left of the section titles (Timeline, Statistics, and Details) that enable and hide the displays.

5.11.2 Timeline

Timeline shows the major Ekos processes, and when they were active. For instance, the Capture line shows when images were taken (wither green for RGB or color-coded by the filter) and when imaging was aborted (shown as red sections). Clicking on a capture section gives information about that image, and double clicking on one brings up the image taken then in a fitsviewer, if it is available.
If you have moved your captured images, you can set alternate directory in the input menu to a directory which is the base of part of the original file path.

Clicking on a Focus segment shows focus session information and displays up the position vs HFR measurements from that session. Clicking on a Guider segment shows a drift plot from that session, (if it’s guiding) and the session’s RMS statistics. Other timelines show status information when clicked.

5.11.3 Statistics

A variety of statistics can be displayed on the Statistics graph. There are too many for all to be shown in a readable way, so select among them with the checkboxes. A reasonable way to start might be to use rms, snr (using the internal guider with SEP Multistar), and hfr (if you have auto-compute HFR in the FITS options). Experiment with others.

The left axis shown is initially appropriate only for RA/DEC error, drift, RMS error, RA/DEC pulses, and HFR, plotted in arc-seconds and defaulting to a range of -2 to 5 arc-seconds. However, clicking on one of the boxes below the Statistics graph (that shows a statistic’s value) will set that statistic’s range as the range shown on the left-axis. Double clicking on that box will bring up a menu allowing you to adjust the statistic’s plotted y-range (e.g. setting it to auto, explicitly typing in the range, setting it back to its default value, and also changing the color of that statistic’s plot).

The statistic shown on the left axis can also be scaled (awkwardly) using the mouse wheel. It can be panned by dragging the mouse up or down over the left axis’ numbers. Clicking anywhere inside the Statistics graph fills in the values of the displayed statistics. Checking the latest box causes the most recent values (from a live session) to be the statistics displayed. This graph is zoomed and panned horizontally in coordination with the timeline.

5.12 Ekos Tutorials

5.12.1 Viewer

StellarMate is shipped with a VNC Server. This enables you to access the whole StellarMate desktop remotely. To connect to VNC, you can either use a Desktop/Mobile VNC Client, or simply via any browser.

The VNC address is: https://stellarmate_hostname:6080/vnc.html

Where stellarmate_hostname is the actual hostname (or IP address) of your unit and 6080 is the port. If you do not know the unit hostname, you can find the hostname in your StellarMate App.

You can use Real VNC which is available on all platforms to access stellarmate.

Once you access StellarMate, you can use it like any full-fledged computer. The default username is stellarmate and the default password is smate.
Chapter 6

FITS Viewer

FITS, or Flexible Image Transport System, is the standard format for representing images and data in Astronomy. The KStars FITS Viewer is a tool to view those images. It is not designed for editing of FITS Images.

The FITS Viewer can be automatically invoked for images received from the camera. It can also be invoked directly from the main KStars menu. To open a FITS file, select the File → Open Image... menu item, or press Ctrl+O.

The above diagram illustrates the FITS Viewer main work area and window. There is also a hidden area that can be exposed by moving the mouse over the 6 small dots on the left side (about center of the image vertically) and pressing and holding the mouse, sliding it over to the right a bit.
6.1 Main Controls

The various controls and displays for the FITS Viewer are shown below. The tool provides basic functions for image display. While the tool adhere to the FITS standard, it does not support all possible FITS features:

- Support for only one image per file.
- Support for only 2D and 3D data. 1D data are discarded.

The FITS Viewer window is divided into the following regions:

1. Main Menu
   - File
     - Standard Open, Save, and Save As.
     - FITS Header: Display FITS header table data.
     - Debayer: Covert RAW image to RGB.
   - Edit
     - Undo: Undo last action.
     - Redo: Redo last action.
     - Copy: Copy image to clipboard.
   - View
     - Zoom Controls: Zoom in, Zoom out, standard Zoom.
     - Filters: Auto Stretch, Contrast, High Pass, Rotate, Flip.
     - Mark Stars: Detect and mark stars in the image.
     - Show Clipping: Display in red which stars have pixels that appear to be clipped.

2. Main Toolbar
   - Open File.
   - Save File: Save FITS data. Any filters applied to the image will be saved.
• Save File As.
• Undo last action.
• Redo last action.
• Zoom In: Zoom in up to a maximum of 400%. For large images this operation can be very memory intensive. Turn on Limited Resource Mode to save memory.
• Zoom Out.
• View in Actual Size.
• Zoom to fit.
• Rotate Right.
• Rotate Left.
• Flip Horizontal.
• Flip Vertical.
• Show Cross Hairs: Toggles crosshairs in the center of the image.
• Show Pixel Gridlines: Toggles pixel grid.
• Mark Stars: Detect and mark stars in the image.
• Show Clipping: Display in red which stars have pixels that appear to be clipped.
• Show Equatorial Gridlines: Toggles Equatorial Grid if FITS contains a valid WCS header.
• Show Objects in Image: Identifies objects such as stars, galaxies, and nebulae within the image.
• Center Telescope: Toggle Center Telescope mode. When active and if the image contains a valid WCS header, clicking anywhere in the image triggers the telescope slewing to the clicked point.
• Histogram: Toggle histogram view in the side panel.
• Statistics: Toggle FITS Statistic view in the side panel.
• Auto Stretch: Apply Auto Stretch filter to the image.
• Toggle Selection Rectangle: Toggle selection rectangle for statistics of a region of interest.

3. Side Panel: The side panel can be opened by dragging the separator to the right. When dragged to the left, the side panel can also be closed.

• Statistics: Displays image statistics including Minimum, Maximum, Average, and Median values.
• Plate Solving: A tool plate-solve the loaded image. This is useful to debug plate-solving issues.
• Histogram: Displays image histogram with controls to adjust the minimum and maximum values for each channel. Both linear and logarithmic scalings are available to apply to the image. This is somewhat redundant with the below-image histogram and may be removed in the future.
• FITS Header: Displays a table for FITS header keywords, values, and comments.
• Recent Images: Displays recently opened images. Clicking on any image will load it.

4. Image Display Area.

• Mouse: Hovering over the image will update the status bar values accordingly.
• Mouse: Hovering over the image will move a cursor in the histogram display below the image, if that histogram is activated.
• Control key: Holding down the control key and then moving the mouse will show a magnified portion of the image.
• Statistics of region of interest
  Provides simple statistics average mean, average standard deviation and average median of the selected region by the user in a tooltip.

The user can either set the selection region by **Shift-Left Click** dragging (when the selection statistics is activated) or by choosing an entry from the drop down menu of the Toggle Selection Rectangle button. In addition to this, the user can translate the region by simple **Left Click** drag of the mouse. The statistics of the region are shown as a tooltip once the cursor is brought over the selection region. For smaller images, the statistics are updated instantly, and for larger images, the statistics are updated once the user releases the **Left Click** button after modification of the region.
5. Stretching Controls

Near the bottom of the window are controls for stretching the image and displaying its histogram. They are described below from left to right.

- Enable Stretching: On the very left of this display is a button that enables or disables stretching.
- Shadow Value: The value below which pixels are displayed as black can be manually entered (scale is 0 to 1.0, even for integer pixel values).
- Midtones Value: The midtones value which controls the brightness of the image can be manually entered (scale is 0 to 1.0, even for integer pixel values).
- Highlights Value: The value above which pixels are displayed as white can be manually entered (scale is 0 to 1.0, even for integer pixel values).
- Show Histogram: A button that displays or hides the image histogram is to the right of the highlights number box.
- Auto Stretch: A button (magic wand icon) that will automatically create a pleasing stretch is found on the right. It is disabled if the stretch is already at the automatically computed value.

In addition, there are sliders that can be used to adjust the Shadow, Midtones and Highlights values. Adjusting them will change the values displayed.

The histogram, if it is enabled, may be zoomed by using the mouse’s scroll wheel, and panned by dragging with the mouse. A cursor in the histogram shows the position of the pixel in the image under the mouse.

6. Status Bar

From right to left, the following status indicators are available:

- Loading Indicator: The LED becomes yellow when an image is getting loaded and turns green after loading is successfully done. If there are problems with loading the image, it turns red.
- Resolution: Image resolution in pixels. 4656x3520 in the screenshot above.
- Zoom Percentage. 13% above.
- Cartesian Coordinates: Displays and updates the current mouse position as you hover over the image. X:769 Y:3508 above.
- Pixel Value: Value of the pixel under the mouse. 1,792 above.
- Equatorial Coordinates: If the image contains a valid WCS header, the J2000 Right Ascension (RA) and declination (DE) values are displayed. 13h 14’ 22” 42 37’ 35” above.
- Image Stats: Displays the HFR, Eccentricity and number of stars if computed. HFR:1.96 Ecc:0.43 143 stars above.
- Clipped Stars: If Show Clipping is activated in the main toolbar, it displays the number of possibly clipped pixels. Clip:403 above.

In addition to image display, the viewer can process World-Coordinate-System (WCS) header if present within the FITS file and provides useful information regarding the objects found within the image, equatorial grid overlay, popup menu, and the ability to slew the mount (if connected) to any point within the image.

Several filters can be applied to enhance the image include auto stretch and high contrast. Depending on the image size, these operations can take a few seconds to complete. The bottom
status bar displays the current pixel value and current X & Y coordinates of the mouse pointer within the image. Furthermore, it includes the current zoom level and the image resolution.

When loading a bayered image, the viewer can automatically debayer the image if Auto Debayer is checked in the FITS Settings. The debayering operation fetches the bayer pattern (e.g. RGGB) from the FITS header. If none exists, you can alter the debayering algorithm and pattern from the File menu or by using the Ctrl-D shortcut.

Since operations such as auto debayering and auto WCS are computationally expensive and stress the processor on low-powered embedded devices, you can toggle their behavior in KStars Settings FITS page.

Hovering over any option shall display a detailed tooltip that explains its function.

6.2 Features

Histogram
Displays multi-channel FITS histogram. The user can rescale the image by optionally defining an upper and lower limit for the cutoff region. The rescaling operation (linear, logarithmic, or square-root) may then be applied to the region enclosed by the upper and lower limits.

**FITS Header**
Displays a read-only table listing FITS header keywords and values.

**Statistics**
Provides simple statistics for minimum and maximum pixel values and their respective locations. FITS depth, dimension, mean, and standard deviation.
6.3 FITS Viewer Solver

The FITS Viewer Solver is used to plate-solve the image loaded in the FITS Viewer’s tab. It only works with the internal StellarSolver. You get the RA and DEC coordinates for the center of the image, the image’s scale, the angle of rotation, and the number of stars detected in the image. Its main use case is debugging plate-solving issues in Ekos, though the information displayed can be generally useful. The controls and displays are described below.

- **Solve Button.** Pressing this button starts plate solving. When the system is plate solving, the button becomes an abort button.

- **Scale:** Checking the Use Scale checkbox constrains the solver to use approximately the pixel or image scale given. The scale is entered in the box and the units for the scale can be chosen from image width in degrees, image width in arc-minutes, and arc-seconds per pixel. When a solve successfully completes, it replaces the value in the box with solution’s scale.

- **Position:** Checking the Use Position checkbox constrains the solver to search near the RA and DEC coordinates given. The extent of the search is given by the user in the Radius box in degrees. Note that RA is input in hours-minutes-seconds, e.g. 13h, and DEC is input in degrees-minutes-seconds, e.g. 85. When a solve successfully completes, it replaces the value in the RA and DEC boxes with solution’s coordinates. In addition it fills in the Angle field with the solutions angle value in degrees.

- **Use SkyMap Position:** There is a button just below the Use Position checkbox that fills in RA and DEC boxes with the current center of the SkyMap display.

- **Profile:** The Profile menu selects which StellarSolver preset, among those used in the Ekos Align module, should be used for plate solving. This is further discussed below.

- **Solution:** The Solution section will display the number of stars found and the time taken to solve. The solution values for RA, DEC, Scale and Angle are displayed in those boxes above.

- **Image:** For any image where stars were detected, if the Mark Stars button is activated above the image display, then the detected stars are circled in red.
Using this tool the user can try and debug solving issues as follows.

- He/she might have the KStars -> Settings -> Developer -> Save Failed Align Images checkbox enabled.
- Then a difficult image (for whom alignment failed) could be located and loaded into the fitsviewer.
- The image could be inspected to see if there were obvious visual issues.
- Clicking Solve in this tool for that image would show how many stars were detected, and the user could then decide if it is a star detection issue and experiment with adjusting the profile or star-detection parameters.
- The user could manually upload the image to astrometry.net to get scale and position values (or just see if it is a problematic image).
- The user could experiment with Use Position and Use Scale, using accurate values for those constraints (or disabling them) to see if those were the problem, or adjust the parameters in the align profile being used.

To inspect or modify the profile, the user would open the align tab in Ekos, go to the Options menu, select the StellarSolver Options tab, make sure the right Options profile is selected, and click the pencil to view or edit that profile.

### 6.4 Embedded FITS Viewer

In Ekos Focus, Guide, and Align modules, captured images are displayed in the embedded FITS Viewer. The embedded viewer includes a floating bar that can be used to perform several functions:
• Zoom Out
• Zoom In
• Default Zoom
• Zoom To Fit
• Toggle Cross Hairs
• Toggle Pixel Gridlines
• Toggle Detected Stars: Highlight detected stars with red circles.
• Star Profile: View detailed 3D star profile.

The floating bar is automatically hidden once the mouse leaves the embedded viewer area. You can use the mouse to pan and zoom just like the standalone FITS Viewer. The green tracking box can be used to select a specific star or region within the image, for example, to select a guide star.

6.5 3D Star Profile & Data Visualization Tool

The 3D data visualization tool can plot 3D graphs of the selected region of the image. This is particularly useful for astrophotographers who want to visualize the profile of a star they are considering focusing or guiding on. For scientists, it enables them to examine a cross-section of the data to understand the relative brightness of different objects in the image. Additionally, it empowers imagers who want to visually see what is going on in their data collection in a new way.

To use the new feature, the user needs to select the View Star Profile icon in one of the Ekos Module Views, or in the FITS Viewer. Then, the region selected in the green tracking box will show up in the 3D graph as shown above. The user will then have one of the following toolbars at the bottom.

![Diagram of 3D Star Profile & Data Visualization Tool]
At the far left, the sample size combo box will let the user select the size of the image crop shown in the graph. This option is only available in the **Summary Screen**, the **Align Module**, and the FITS Viewer. The second combo box lets the user control whether they are selecting an individual item, or a row, or a column of pixels. The slice button will be enabled if the user selects **Row** or **Column**. It will put the graph in slice mode so that the user can see a cross-section view of the image. Third, is a checkbox that will open up two sliders that will let the user drag the slider to change the selection. This is extremely useful in the slide mode to change the selected point and to move the cross section around the graph. It is also useful in the normal view when in **Explore Mode** so that the user can zoom around the image examining the pixels.

Then the user has the **Zoom To** combo box, which the user can use to zoom the graph to different preset locations. Next is the combo box that lets the user select the color scheme of the graph. Then are the HFR and the Peak checkboxes, which will both turn on the HFR and Peak labels on each found star in the image, but will also display one of them at the bottom of the screen. And finally comes the Scaling checkbox, which enables the **Scaling Side Panel**. There are three sliders in that panel, one to control the minimum value displayed on the graph or ‘black point’, one to control the maximum value displayed in the graph or the ‘white point’, and a third that is disabled by default that lets the user control the cutoff value for data displayed on the graph.
This third slider is very useful to get really big peaks out of the way so you can study the finer details in the image. There is a checkbox at the top to enable/disable the cutoff slider. And finally at the bottom of the sliders is the **Auto scale** button. This will auto scale the sliders as you sample different areas in the image. It will not only optimize the display of the data but will also affect the minimum and maximum points of the slider. If you disable auto scale, then as you sample different parts of the image, they will be displayed at the same scale. A particularly useful way to use this is to select an area of your image using auto scale, tweak the min, max, and cutoff sliders to your liking, and then turn off the auto scale feature to explore other areas of the graph.
Chapter 7

KStars Tools

KStars comes with a number of tools that allow you to explore some more advanced aspects of astronomy and the night sky.

- Object Details
- Astrocalculator
- Altitude vs. Time Plotter
- What’s up Tonight?
- Simulate Eyepiece View
- Script Builder
- Solar System Viewer
- Jupiter Moons Tool
- Observation Planner
7.1 Object Details Window

The Object Details Window presents advanced data available about a specific object in the sky. To access this tool, right-click on any object, and select the Details... item from the popup menu.

The window is divided into a number of tabs. In the General tab, we present basic data about the current object. This includes names and catalog designations, object type, and magnitude (brightness). On the Position tab are the object’s Equatorial and Horizontal coordinates, as well as its rise, set and transit times.

In the Links tab, you can manage the internet links associated with this object. The Image and Information links associated with the object are listed. These are the links that appear in the popup menu when the object is right-clicked. You can add custom links to the object with the Add Link... button. This will open a window in which you fill in the URL and link text for the new link (you can also test the URL in the web browser from this window). Every time you add a custom URL to a certain object, you are able to choose the resource type using the Resource Type button. Keep in mind that the custom link can easily point to a file on your local disk, so you can use this feature to index your personal astronomical images or observing logs.

You can also modify or remove any link using the Edit Link... and Remove Link... buttons.

The Advanced tab (not available for all objects) allows you to query professional astronomical databases on the internet for information regarding the current object. To use these databases, double click on the desired database in the list to see the results of your query in a web browser window. The query is made using the primary name of the object you clicked on to open the Details Dialog. The following databases are available for querying:

- **Set of Identifications, Measurements, and Bibliography for Astronomical Data (SIMBAD):** SIMBAD is similar to NED, except it provides data about all kinds of objects, not just galaxies.

- **SkyView:** Provides images from All-Sky surveys that have been performed in dozens of different parts of the spectrum, from Gamma Rays to the Radio. The KStars interface will retrieve an image from any of these surveys, centered on the selected object.

- **High Energy Astrophysical Archive (HEASARC):** Here you can retrieve data about the current object from a number of ‘High-energy’ observatories, which covers the Ultraviolet, X-ray and Gamma Ray portions of the electromagnetic spectrum.
• **NASA/IPAC Extragalactic Database (NED):** NED provides encapsulated data and bibliographic links about extragalactic objects. You should only use NED if your target is extragalactic; i.e. if it is itself a galaxy.

• **NASA Astrophysical Data System (ADS):** This incredible bibliographic database encompass the entire body of literature published in international peer-review Journals about astronomy and astrophysics. The database is divided into four general subject areas (Astronomy and Astrophysics, Astrophysics Preprints, Instrumentation, and Physics and Geophysics). Each of these has three sub-nodes that query the database in different ways. ‘Keyword search’ will return articles which listed the object’s name as a keyword. ‘Title word search’ will return articles which included the object name in their Title, and the ‘Title & Keyword search’ uses both options together.

• **Multimission Archive at Space Telescope (MAST):** The [Space Telescope Science Institute](https://www.stsci.edu) provides access to the entire collection of images and spectra taken with the Hubble Space Telescope, as well as several other space-based observatories.

Finally, in the **Log** tab, you can type in some text that will remain associated with this object’s **Details** window. You could use this to attach personal observing notes, for example. Your notes will be saved, such that you can easily read or use them next time when you will use KStars.

### 7.2 The Astrocalculator

The KStars Astrocalculator provides several modules that give you direct access to algorithms used by the program. The modules are organized by subject:

**Time Calculators**

• Julian Day
• Sidereal Time
• Almanac
• Equinoxes and Solstices

**Coordinate Converters**

• Equatorial/Galactic Coordinates
• Apparent Coordinates
• Horizontal Coordinates
• Ecliptic Coordinates
• Angular Distance
• Geodetic Coordinates

**Solar System**

• Planets Coordinates
7.2.1 Julian Day module

This module converts between the calendar **Date and time**, the **Julian day**, and the **Modified julian day**. The Modified Julian Day is simply equal to the Julian Day - 2,400,000.5.

To use the module, enter one of the three dates and the corresponding values for the other two date systems will be displayed. You can also set the Date and time to now, by pressing the **Now** button.

There is a batch mode for this module. To use it, simply generate an input file whose lines each contain a number of values for the input parameter: 'Date and time', 'Julian day' or 'Modified Julian day'. Then specify the input and output filenames, and press the **Compute** button to generate the output file. The output file will contain values for the other two complementary parameters. For example, if your input file contains a set of **Date and time**: values, then each line of the output file will contain values for **Julian day**: and **Modified julian day**:. You can read the output directly in KStars by pressing the **View output...** button.

**Tip**

**Exercise:**

What calendar date does MJD = 0.0 correspond to?
7.2.2 Sidereal Time module

This module converts between Universal Time and Local Sidereal Time. First, select a geographic location and a date for the calculation. Then the corresponding value for the other Time will be displayed.

There is a batch mode for this module. To use it, simply generate an input file whose lines each contain values for the input parameter: Compute sidereal time or Compute standard time from to left dropdown box. You can choose to set the Date: and Location: in the current window, or you can tell KStars to read these values from the Input file: Then specify the input and output filenames, and press the Compute button to generate the output file. The output file will contains values for the complementary parameter. For example, if your input file contains a set of ‘standard time’ values, then each line of the output file will contain values for ‘sidereal time’. You can read the output directly in KStars by pressing the View output... button.
7.2.3  **Day Duration module**

This module computes the length of day as well as sunrise, sun-transit (noon), and sunset times for any calendar date, for any location on Earth. First select the desired geographic coordinates and date, then the data is computed and displayed.

7.2.4  **Equinoxes and Solstices module**

The Equinoxes and Solstices module calculates the date and time of an equinox or solstice for a
given year. You specify the year and the date and time of the events (Vernal Equinox, Summer Solstice, Autumnal Equinox, or Winter Solstice) are displayed.

There is a batch mode for this module. To use it, simply generate an input file whose lines each contain a year for which the Equinox and Solstice data will be computed. Then specify the input and output filenames, and press the Compute button to generate the output file. Each line in the output file contains the input year and the date of each event. You can also read the output directly in KStars by pressing the View output... button.

7.2.5 Equatorial/Galactic Coordinates module

This module converts from Equatorial coordinates to Galactic coordinates, and vice versa. Fill in the coordinate values in either the Galactic coordinates or Equatorial coordinates (J2000) section. Alternatively set the equatorial coordinates by selecting an object using the Find Object dialog. Then the complementary coordinates will be filled in.

The module contains a batch mode for converting several coordinate pairs at once. You must construct an input file in which each line contains two values: the input coordinate pairs (either Equatorial or Galactic). Then specify which coordinates you are using as input, and identify the input and output filenames. Finally, press the Run button to generate the output file, which will contain the converted coordinates (Equatorial or Galactic; the complement of what you chose as the input values).
The Apparent Coordinates module converts the catalog coordinates of a point in the sky to its apparent coordinates for any date. The coordinates of objects in the sky are not fixed, because of precession, nutation and aberration. This module takes these effects into account.

To use the module, first enter the desired target date and time in the Target Time & Date section. Then, enter the catalog coordinates in the Catalog Coordinates section. Alternatively you can set the catalog coordinates by selecting an object using the Find Object dialog. You can also specify the catalog’s epoch here (usually 2000.0 for modern object catalogs). Then the object’s coordinates for the target date will be displayed in the Apparent coordinates: section.
### 7.2.7 Horizontal Coordinates module

This module converts from **Equatorial coordinates** to **Horizontal coordinates**. First, select the date, time, and geographic coordinates for the calculation. Then, fill in the equatorial coordinates to be converted or use the **Find Object** dialog in the **Equatorial Coordinates (J2000)** section. The corresponding Horizontal coordinates will be presented in the **Horizontal Coordinates** section.

### 7.2.8 Ecliptic Coordinates module

This module converts from **Equatorial coordinates** to **Ecliptic coordinates**. The **Equatorial Coordinates (J2000)** section allows you to input the equatorial coordinates, while the **Ecliptic Coordinates** section displays the converted coordinates.
This module converts between Equatorial coordinates and Ecliptic coordinates. First, select Date and time. Then, fill in the coordinate values in either the Ecliptic Coordinates or Equatorial Coordinates section. Alternatively set the equatorial coordinates by selecting an object using the Find Object dialog. Then the complementary coordinates will be filled in.

7.2.9 Angular Distance module

The Angular Distance tool is used to measure the angle between any two points on the sky. You simply specify the Equatorial coordinates of the desired pair of points, and then obtain the angle between the two points.

There is also a Batch mode for this module. In batch mode, you specify an input filename which contains a number of parameters (up to four) on each line: the initial right ascension (RA), initial declination (Dec), final right ascension and final declination. By default, each line should contain four numbers signifying the RA and Dec values for pairs of points. Alternatively, you can specify a single value for any of these four coordinates in the calculator panel (the corresponding values in the input file should be skipped if they are specified in the calculator).

Once you have specified the input filename and an output filename, simply press the Run button to generate the output file.
The normal geographic coordinate system assumes that the Earth is a perfect sphere. This is nearly true, so for most purposes geographic coordinates are fine. If very high precision is required, then we must take the true shape of the Earth into account. The Earth is an ellipsoid; the distance around the equator is about 0.3% longer than a Great Circle that passes through the poles. The Geodetic Coordinate system takes this ellipsoidal shape into account, and expresses the position on the Earth’s surface in Cartesian coordinates (X, Y and Z) or in Geographic coordinates (Longitude, Latitude and Elevation).

To use the module, first select which coordinates you will use as input in the Select Input Coordinates section: Cartesian or Geographic radio buttons. Then select an ellipsoid model and fill in the input coordinates in either the Cartesian Coordinates section or the Geographic Coordinates section. When you press the Convert button, the corresponding coordinates will be filled in.

The module contains a batch mode for converting several coordinate values at once. You must construct an input file in which each line contains up to three numbers: the input coordinate values (either Cartesian or Geographic). Then specify which coordinates you are using as input, and identify the input and output filenames. Finally, press the Run button to generate the output file, which will contain the converted coordinates (Cartesian or Geographic; the complement of what you chose as the input values).
7.2.11 Planet Coordinates module

The Planet Coordinates module computes positional data for any major solar system body, for any time and date and any geographic location. Simply select from the Solar system body: drop-down list, and specify the desired date, time, and geographic coordinates (these values are preset to the current KStars settings). Then the Equatorial, Horizontal, and Ecliptic coordinates of the body are computed and displayed.

There is a batch mode for this module. You must construct an input file in which each line specifies values for the input parameters (solar system body, date, time, longitude, and latitude). You may choose to specify a constant value for some of the parameters in the calculator window (these parameters should be skipped in the input file). You may also specify which of the output parameters (Equatorial, Horizontal, Heliocentric ecliptic and Geocentric ecliptic coordinates) should be calculated. Finally, specify the input and output filenames, and press the Run button to generate the output file with the computed values.
7.3 Altitude vs. Time Tool

This tool plots the altitude of any objects as a function of time, for any date and location on Earth. The top section is a graphical plot of altitude angle on the vertical axis, and time on the horizontal axis. The time is shown both as standard local time along the bottom, and sidereal time along the top. The bottom half of the graph is shaded green to indicate that points in this region are below the horizon.

There are a few ways to add curves to the plot. The simplest way to add the curve of an existing object is to simply type its name in the Name: input field, and press Enter, or the Plot button. If the text you enter is found in the object database, the object’s curve is added to the graph. You can also press the Find Object... button to open the Find Object Window to select an object from the list of known objects. If you want to add a point that does not exist in the object database, simply enter a name for the point, and then fill in the coordinates in the RA: and Dec: input fields. Then press the Plot button to add the curve for your custom object to the plot (note that you have to pick a name that does not already exist in the object database for this to work).

When you add an object to the plot, its altitude vs. time curve is plotted with a thick white line, and its name is added to the listbox at the lower right. Any objects that were already present are plotted with a thinner red curve. You can choose which object is plotted with the thick white curve by highlighting its name in the listbox.

These curves show the objects’ Altitude (angle above the horizon) as a function of time. When a curve passes from the lower half to the upper half, the object has risen; when it falls back to the lower half, it has set. For example, in the screenshot, the minor planet Quaoar is setting at around 15:00 local time, and is rising at about 04:00 local time.

The plot can be easily zoomed and panned using the mouse. The zooming level can be adjusted using the mouse scroll wheel. When the plot is zoomed out, the zooming level will be automatically limited to a default minimum value, such as the axes’ ranges are able to cover the entire plot (i.e. on vertical axis, the maximum altitude value should touch the top edge of the plot frame). The same principle is applied when the plot is panned using the mouse movement. For panning the plot, all you need to do is to click on the point of the plot you want to pan and then drag the mouse on your desired direction: left, right, up or down.

Another useful feature that Altvstime tool provides is its ability to compute and mark the Rise/Set/Transit times. This can be accomplished by a simple press of one of the Rise, Set or
**Transit** buttons. When one of these buttons is pressed, a filled colored circle will be marked on the curve. The color used for Rise, Set and Transit dots are: red for Rise, blue for Set and green for Transit time. For a more intuitive way of using these buttons, they are marked with the color of their specific dots. This way, the user can easily understand the plot and make the association between a certain color and its significance.

Altvstime tool provides an easy way to find out the altitude of a sky-object at a certain moment of time using the **Compute** button. After you select the object from the Objects list and set the moment of time, the altitude can be computed by pressing the **Compute** button. But this is not the only way you can find out the altitude. Another method is to hover with mouse above one curve and thus, a tooltip containing the Local Time, Local Sidereal Time and Altitude will come up. This way, you can read the information in real time.

The Altitude of an object depends on both where you are on Earth, and on the Date. By default, the Tool adopts the Location and Date from the current KStars settings. You can change these parameters in the **Date & Location** Tab. To change the Location, you can press the **Choose City...** button to open the Set Geographic Location Window, or enter Longitude and Latitude values manually in the input fields, and press the **Update** button. To change the Date, use the spin and combo boxes, then press **Update**. Note that any curves you had already plotted will be automatically updated when you change the Date and/or Location.

---

**Tip**

**Exercise:**

Plot the Sun's Altitude curve. Make sure the geographic location is not near the equator. Change the Date to some time in June, and then again to sometime in January. You can see easily why we have seasons; in the winter, the Sun is above the horizon for less time (the days are shorter), and its altitude is never very high.
7.4 Simulate Eyepiece View

On the left hand side is the sky map shot from KStars. On the right hand side is the POSS (DSS) image of the same region. The orientation in the above example has been adjusted to match the view through a Dobsonian telescope at the location and time of the simulation in KStars.

This tool simulates how an object looks through your eyepiece. In addition to rendering the eyepiece field, KStars can also fetch and overlay the DSS imagery. Additionally, if you are using a Dobsonian telescope, you can rotate the field of view to match the eyepiece view.

To use this feature, first define your eyepieces’ fields of view using the FOV Symbol editor.

Then there are two ways to invoke the feature:

- In Sky Map, right click on the desired object and click Simulate eyepiece view in the popup menu.
- In observation planner, right click an object and click Simulate eyepiece view in the popup menu.

When the tool is first invoked, it will prompt a dialog to select the desired FOV to render the view. To compare the rendered view against a real sky image, click the Fetch DSS image button to download a DSS image. You can manually adjust the view to match your eyepiece using the rotation slider, the Invert view and Flip view check boxes. Alternatively, you can use a pre-calculated amount of rotation by using one item of the Preset dropdown box that is tailored for different optical systems.
Arp84 eyepiece view with ticks enabled indicating how the chart must be oriented to match the eyepiece view through a Dobsonian at a given time (the generated data is for location McDonald Observatory Texas, and the date is 14th Dec 2016).

To export the view to a file, click Export button. Export enables adding ticks for printed charts as shown above and save the image.

### 7.5 What’s up Tonight? Tool

- **Almanac**
  - Sunrise: 5:37:29 AM EEST on Tuesday, July 5, 2016
  - Night duration: 8:34:00 AM EEST hours
  - New moon (0%)

- **Select a category:**
  - Planets
  - Stars
  - Nebulae
  - Galaxies
  - Star Clusters
  - Constellations
  - Asteroids
  - Comets

- **Matching objects:**
  - Mars
  - Jupiter
  - Saturn

- **Additional**:
  - Center Object
  - Object Details
  - Add to List
The ‘What’s up Tonight?’ (WUT) tool displays a list of objects that will be visible at night from any location, on any date. By default, the Date and Location are taken from the current settings in the main window, but you can change either value using the Change Date... and Change Location... buttons at the top of the WUT window.

The WUT tool also displays a short almanac of data for the selected date: the rise and set times for the Sun and moon, the duration of the night, and the Moon’s illumination fraction.

Below the almanac is where the object information is displayed. The objects are organized into type categories. Select an object type in the box labeled Select a category:, and all objects of that type which are above the horizon on the selected night will be displayed in the box labeled Matching objects: For example, in the screenshot, the Planets category has been selected, and three planets which are up on the selected night are displayed (Mars, Jupiter and Saturn). When an object in the list is selected, its rise, set and transit times are displayed in the lower-right panel (i.e. Mars rises at 17:13, transits at 21:46 and sets at 02:16). In addition, you can press the Object Details... button to open the Object Details window for that object.

By default, the WUT will display objects which are above the horizon between sunset and midnight (i.e. ‘in the evening’). You can choose to show objects which are up between midnight and dawn (‘in the morning’), or between dusk and dawn (‘any time tonight’) using the combobox near the top of the window. You can also choose to see only those objects that are brighter than a magnitude by setting a minimum magnitude using the Show objects brighter than magnitude: spinbox. You may center the selected object in the Sky Map or add it to Wish List by pressing the Center Object or Add to List button.

7.6 The Script Builder Tool

KDE applications can be controlled externally from another program, from a console prompt, or from a shell script using the Inter-process communication protocol (D-Bus). KStars takes advantage of this feature to allow rather complex behaviors to be scripted and played back at any time. This can be used, for example, to create a classroom demo to illustrate an astronomical concept.

The problem with D-Bus scripts is, writing them is a bit like programming, and can seem a daunting task to those who do not have programming experience. The Script Builder Tool provides a GUI point-and-click interface for constructing KStars D-Bus scripts, making it very easy to create complex scripts.

7.6.1 Introduction to the Script Builder

Before explaining how to use the Script Builder, I provide a very brief introduction to all of the GUI components; for more information, use the “What’s This?” function.
The Script Builder is shown in the above screenshot. The box on the left is the **Current Script box**; it shows the list of commands that comprise the current working script. The box on the right is the **Function Browser**; it displays the list of all available script functions. Below the Function Browser, there is a small panel which will display short documentation about the script function highlighted in the Function Browser. The panel below the Current Script box is the **Function Arguments panel**; when a function is highlighted in the Current Script box, this panel will contain items for specifying values for any arguments that the highlighted function requires.

Along the top of the window, there is a row of buttons which operate on the script as a whole. From left to right, they are: **New Script**, **Open Script**..., **Save Script**, **Save Script As**..., and **Test Script**. The function of these buttons should be obvious, except perhaps the last button. Pressing **Test Script** will attempt to run the current script in the main KStars window. You should move the Script Builder window out of the way before pressing this, so you can see the results.

In the center of the window, there is a column of buttons which operate on individual script functions. From top to bottom, they are: **Add Function**, **Remove Function**, **Copy Function**, **Move Up**, and **Move Down**. **Add Function** adds the currently-highlighted function in the Function Browser to the Current Script box (you can also add a function by double-clicking on it). The rest of the buttons operate on the function highlighted in the Current Script box, either removing it, duplicating it, or changing its position in the current script.

### 7.6.2 Using the Script Builder

In order to illustrate using the Script Builder, we present a small tutorial example where we make a script that tracks the Moon while the clock runs at an accelerated rate.

If we are going to track the Moon, we will need to point the display at it first. The `lookToward` function is used to do this. Highlight this function in the Function Browser, and note the documentation displayed in the panel below the Browser. Press the **Add Function** button to add this function to the Current Script box. The Function Arguments panel will now contain a combobox labeled 'Dir', short for direction. This is the direction in which the display should be pointed. The combobox contains only the cardinal compass points, not the Moon or any other objects. You can either enter 'Moon' in the box manually, or press the **Object**... button to use the **Find Object**... window to select the Moon from the list of named objects. Note that, as usual, centering on
an object automatically engages object-tracking mode, so there is no need to add the setTracking function after lookToward.

Now that we have taken care of pointing at the Moon, we next want to make time pass at an accelerated rate. Use the setClockScale function for this. Add it to the script by double-clicking on it in the Function Browser. The Function Arguments panel contains a timestep spinbox for setting the desired time step for the simulation clock. Change the timestep to 3 hours.

OK, we have pointed at the Moon and accelerated the clock. Now we just want the script to wait for several seconds while the display tracks on the Moon. Add the waitFor function to the script, and use the Function Arguments panel to specify that it should wait for 20 seconds before continuing.

To finish up, let us reset the clock’s timestep to the normal value of 1 second. Add another instance of setClockScale, and set its value to 1 sec.

Actually, we are not quite done yet. We should probably make sure that the display is using Equatorial coordinates before the script tracks the Moon with an accelerated time step. Otherwise, if the display is using Horizontal coordinates, it will rotate very quickly through large angles as the Moon rises and sets. This can be very confusing, and is avoided by setting the View Option UseAltAz to ‘false’. To change any View Option, use the changeViewOption function. Add this function to the script, and examine the Function Arguments panel. There is a combobox which contains the list of all options which can be adjusted by changeViewOption. Since we know we want the UseAltAz option, we could simply select it from the combobox. However, the list is quite long, and there is no explanation of what each item is for. It therefore may be easier to press the Browse Tree... button, which will open a window containing a tree view of the available options, organized by topic. In addition, each item has a short explanation of what the option does, and the data type of the option’s value. We find UseAltAz under the Skymap Options category. Just highlight this item and press OK, and it will be selected in the combobox of the Function Arguments panel. Finally, make its value ‘false’ or ‘0’.

One more step: changing UseAltAz at the end of the script does us no good; we need this to be changed before anything else happens. So, make sure this function is highlighted in the Current Script box, and press the Move Up button until it is the first function.

Now that we have finished the script, we should save it to disk. Press the Save Script button. This will first open a window in which you can provide a name for the script, and fill in your name as the author. Enter ‘Tracking the Moon’ for a name, and your name as the author, and press OK. Next, you will see the standard KDE Save File dialog. Specify a filename for the script and press OK to save the script. Note that if your filename does not end with ‘.kstars’, this suffix will be automatically attached. If you are curious, you can examine the script file with any text editor.

Now that we have a completed script, we can run it in a couple of ways. From a console prompt, you can simply execute the script as long as an instance of KStars is currently running. Alternatively, you can execute the script from within KStars using the File → Run Script... menu item.
This tool displays a model of our solar system as seen from above. The Sun is drawn as a yellow dot in the center of the plot, and the orbits of the planets are drawn as ellipses with the correct shapes and orientations. The current position of each planet along its orbit is drawn as a colored dot, along with a name label. The display can be zoomed in and out with the + and - keys, and the display can be recentered with the arrow keys, or by double-clicking anywhere in the window with the mouse. You can also center on a planet with the 0–9 keys (0 is the Sun; 9 is Pluto). If you center on a planet, it will be tracked as time passes in the tool.

The Solar System Viewer has its own clock, independent of the clock in the main KStars window. There is a timestep control widget here, similar to the one in the main window’s toolbar. However, this control defaults to a timestep of 1 day (so that the motions of the planets can be seen), and it starts out with the clock paused when the tool is opened. You may set the date to now by pressing the Today button.

NOTE
The current model used for Pluto’s orbit is only good for dates within about 100 years of the present date. If you let the Solar System clock advance beyond this range, you will see Pluto behave very strangely! We are aware of this issue, and will try to improve Pluto’s orbit model soon.
7.8 Jupiter Moons Tool

This tool displays the positions of Jupiter’s four largest moons (Io, Europa, Ganymede, and Callisto) relative to Jupiter, as a function of time. Time is plotted vertically; the units are days and ‘time=0.0’ corresponds to the current simulation time. The horizontal axis displays the angular offset from Jupiter’s position, in arcminutes. The offset is measured along the direction of Jupiter’s equator. Each moon’s position as a function of time traces a sinusoidal path in the plot, as the moon orbits around Jupiter. Each track is assigned a different color to distinguish it from the others; the name labels at the top of the window indicate the color used by each moon (i.e. red for Io, yellow for Europa, green for Callisto and blue for Ganymede).

The plot can be manipulated with the keyboard. The time axis can be expanded or compressed using the + and - keys. The time displayed at the center of the window can be changed with the [ and ] keys.

7.9 Observation Planner

Since KDE SC 4.4, Prakash Mohan’s GSoC work has been released in KStars. KStars now has an awesome observation planner to plan your observation sessions. The execute session option allows you to log information about objects as you observe them. Alternately, you may also write a short log in the session planner itself. We wish you a lot of fun planning your observations with KStars!

You can even add some pictures to the objects. The image list is a Google image search list. To add image to an object just press Find Image button on the right and then find an image that you like. If you do not have an Internet connection you can open an image from your hard drive. Note that images that will be used are going to be cropped to 600x600 pixels.

The first way of doing this is by pressing Ctrl+2 or Ctrl+L to open the Observation List, then press the Add Object button.
The Download all Images button does a search for the SDSS images and displays the DSS image if the requested RA/Dec is out of the SDSS footprint.

This is an SDSS image of a galaxy
The KStars Handbook

This is an DSS image of the same galaxy

The Delete all Images button does the opposite. It deletes all downloaded images.

The image for the galaxy is now deleted

You can add more objects by pressing the Find Object button. It will open the Find Object tool which provides two accurate methods for sorting out the items, depending on what criteria you want to use. You can filter the list by objects type: Any, Stars, Solar System, Clusters (Globular and Open), Nebulae (Gaseous and Planetary), Galaxies, Comets, Asteroids, Constellations, Supernovae or Satellites. You can also filter the objects list by name. Enter the name of desired
object in the **Filter by name** text box.

Inside Observation Planner window you can see the ‘Altitude vs Time’ widget (AltvsTime), which shows you how the altitude of a selected object varies over time.

Below the AltvsTime widget, there is a text box in that you can add observing notes for current sky object.

Note that the Wish List is not the Session Plan. In the Wish List you can add objects that you wish to observe at some point. From there you can add them to the Session Plan.

You can see the pop-up window that comes after right-clicking on an object.

![Add objects to Session Plan window](image)

**Add objects to Session Plan window**

Here is the second way of adding objects in your Observation Plan, using the Observing List Wizard. You just need to press the fourth button on the top-left corner of the Observation Planner window.

Despite looking differently this way is basically the same as the first one. Although that it could be a bit more detailed. Here you can see the same categories of objects.
You can choose where these objects to be on the sky. There are four options available for you:
All over the sky (which is the default option), by constellation and in a region (rectangular or circular).
You can choose the date for the observation and the place you are going to observe from.

You can choose the threshold of magnitude for the objects to be shown. In astronomy, absolute magnitude (also known as absolute visual magnitude when measured in the standard V photometric band) measures a celestial object’s intrinsic brightness.
You can save your observation plan. And it will save it with a `.obslist` extension.

You can also access the **WUT** (What’s up tonight), which could be of a great assistance to you. It can give you ideas what to observe on a date, time and place that you specify using the configuration buttons int the top-right corner of the **What's up tonight** window.
Another way of adding objects to your observation plan is using the newly introduced **Batch Add** will open up a text box where you can type many objects to add in one shot to the observation planner. Any objects not in the KStars database already will be resolved using SIMBAD Astronomical Database (provided this has been enabled in the Settings) and added to the database. The entire process of adding objects is slow and may take a while, and you can watch the progress in the Status Bar. Any objects that could not be found are then listed in an error message, so you can identify and fix the errors. Usually this may be because SIMBAD expects a different way of specifying the object (e.g. Sim 147 instead of Simeis 147). This new feature allows you to easily scrape data from observing lists on the web etc. and add them to your workflow in KStars.

This is how the **Execution Session** Window look. It can be opened by pressing **Ctrl+2**. In it you can also see some information about the selected object and you are able to add observing notes.
The KStars Handbook

**First Execute Session window**

By pressing the **Next Page** button you will access the second page of Session Plan. Here you are able to see information not about your object, but about your equipment.

**Second Execute Session window**

Pressing the **Next Target** button will cause the Execute Session to open the first window about the next object.
Chapter 8

Command-Line mode for Image Generation

You can use KStars to generate an image of the sky without actually launching the GUI portion of the program. To use this feature, start KStars from a command prompt using arguments to specify the filename for the image, as well as the desired image dimensions:

```
```

If no filename is specified, it generates a file named `kstars.png`. It will attempt to generate an image that matches the extension of your filename. The following extensions are recognized: ‘png’, ‘jpg’, ‘jpeg’, ‘gif’, ‘pnm’, and ‘bmp’. If the filename extension is not recognized, it defaults to the PNG image type.

Likewise, if the image width and height are not specified, they default to 640 and 480, respectively.

By default, KStars will read in the options values stored in your `$KDEHOME/share/config/kstars` file to determine where the image will be centered, and how it is rendered. This means you need to run KStars in normal GUI mode, and exit the program when it is set up with the desired options for the generated images. This is not very flexible, so we also provide the ability to execute a KStars D-Bus script to set the scene before generating the image. The filename you specify as the script argument should be a valid KStars D-Bus script, such as one created with the Script Builder Tool. The script can be used to set where the image is pointing, set the geographic location, set the time and date, change the Zoom level, and adjust other view options. Some of the D-Bus functions make no sense in non-GUI mode (such as `waitForKey()`); if these functions are encountered while parsing the script, they are simply ignored.

By default, KStars will use the system CPU time and date for generating the image. Alternatively, you may specify a time and date with the ‘--date’ argument. You can also use this argument for specifying the startup date in normal GUI mode.
Chapter 9

Astronomical Device Control with INDI

KStars provides an interface to configure and control astronomical instruments via the INDI protocol. The INDI protocol supports a variety of astronomical instruments such as CCD cameras and focusers. For an up to date list of supported devices, please visit INDI supported devices page.

9.1 INDI Setup

KStars can control local and remote devices seamlessly via the INDI server/client architecture. INDI devices may be run in three different modes:

1. **Local**: The local mode is the most common and is used to control local device (i.e. a device attached to your machine).

2. **Server**: The server mode establishes an INDI server for a particular device and waits for connections from remote clients. You cannot operate server devices, you can only start and shut them down.

3. **Client**: The client mode is used to connect to remote INDI servers running INDI devices. You can control remote devices seamlessly like local devices.

You can run local device, establish INDI servers, and connect to remote clients from the **Tools → Devices → Device Manager...** menu item.

Here is a screenshot of the **Device Manager** window:
You can run devices by browsing the device tree, selecting a specific device, and then clicking on the Run Service button. You can select the operation mode, either local or server as defined above. The port number is randomly generated between the range from 7624 to 10,000. To specify a port, click on the port column next to the desired driver. KStars allows multiple drivers to run under one INDI server, and hence one port. Select multiple drivers then press Run Service button.

To control remote devices, refer to the remote device control section.

9.2 Telescope Setup

Most telescopes are equipped with RS232 interface for remote control. Connect the RS232 jack in your telescope to your computer’s Serial/USB port. Traditionally, the RS232 connects to the serial port of your computer, but since many new laptops abandoned the serial port in favor of USB/FireWire ports, you might need to obtain a Serial to USB adaptor to use with new laptops.

After connecting your telescope to the Serial/USB port, turn your telescope on. It is highly recommended that you download and install the latest firmware for your telescope controller.

The telescope needs to be aligned before it can be used properly. Align your telescope (one or two stars alignment) as illustrated in your telescope manual.

KStars needs to verify time and location settings before connecting to the telescope. This insures proper tracking and synchronization between the telescope and KStars. The following steps will enable you to connect to a device that is connected to your computer. To connect and control remote devices, please refer to remote device control section.

You can use the Telescope Setup Wizard and it will verify all the required information in the process. It can automatically scan ports for attached telescopes. You can run the wizard by selecting the Devices → Telescope Wizard menu item.

Alternatively, you can connect to a local telescope by performing the following steps:

1. Set your geographical location. Open the Set Geographic Location window by selecting the Settings → Geographic... menu item, or by pressing the Globe icon in the toolbar, or by pressing Ctrl+G.
2. Set your local time and date. You can change to any time or date by selecting Time → Set Time... menu item, or by pressing the Time icon in the toolbar. The Set Time window uses a standard KDE Date Picker widget. If you ever need to reset the clock back to the current time, just select the Time → Set Time to Now menu item.

3. Click on the Tools → Devices → Device Manager... menu item.

4. Under the Device column, select your telescope model.

5. Click on the Run Service button.

6. Click Close to leave the Device Manager Dialog.

**Frequent Settings**

You do not need to set the geographic location and time every time you connect to a telescope. Only adjust the settings as needed.

You are now ready to use the device features, KStars conveniently provides two interchangeable GUI interfaces for controlling telescopes:

**Controlling your telescope**

1. **Sky map Control**: For each device you run in the Device Manager, a corresponding entry will show up in popup menu that allows you to control the properties of the device. You can issue commands like Slew, Sync, and Track directly from the sky map.

   Here is a screenshot of the popup menu with an active LX200 Classic device:

2. **INDI Control Panel**: The panel offers the user with all the features supported by a device. The panel is divided into three main sections:

   - **Device tabs**: Each additional active device occupies a tab in the INDI panel. Multiple devices can run simultaneously without affecting the operation of other devices.
- Property views on the **Main Control** and **Options** tabs: Properties are the key element in INDI architecture. Each device defines a set of properties to communicate with the client. The current position of the telescope is an example of a property. Semantically similar properties are usually contained in logical blocks or groupings.

- **Log viewer**: Devices report their status and acknowledge commands by sending INDI messages. Each device has its own log view. A device usually sends messages to its device driver only, but a device is permitted to send a generic message when appropriate.

You are not restricted on using one interface over another as they can be both used simultaneously. Actions from the **Sky map** are automatically reflected in the **INDI Control Panel** and vice versa.

To connect to your telescope, you can either select **Connect** from your device popup menu or alternatively, you can press **Connect** under your device tab in the **INDI Control Panel**.

> **IMPORTANT**
> By default, KStars will try to connect to the `/dev/ttyS0` port. To change the connection port, select the **Tools → Devices → INDI Control Panel...** menu item and change the port under your device tab.

KStars automatically updates the telescope’s longitude, latitude, and time based on current settings in KStars. You can enable/disable these using the **INDI** page from the **Settings → Configure KStars...** menu item. Using the **INDI** page you can configure KStars to display or not INDI status messages in the status bar. By default INDI server port numbers have values between the range from 7624 to 9000, but you can easily change the range using the **From:** and **To:** text boxes from the **Server Port** section.

If KStars communicates successfully with the telescope, it will retrieve the current RA and DEC from the telescope and will display a crosshair on the sky map indicating the telescope position. You can hide the crosshair that marks telescope position using **INDI** page from the **Settings → Configure KStars...** menu item.
**Synchronizing Your Telescope**

If you aligned your telescope and the last alignment star was, for example, Vega, then the crosshair should be centered around Vega. If the crosshair was off target, then you can right-click Vega from the sky map and select **Sync** from your telescope menu. This action will instruct the telescope to synchronize its internal coordinates to match those of Vega, and the telescope’s crosshair should now be centered around Vega.

This is it: your telescope is ready to explore the heavens!

**WARNING**

Never use the telescope to look at the sun. Looking at the sun might cause irreversible damage to your eyes and your equipment.

### 9.3 CCD and Video-Capture Setup

You can run CCD and Video Capture devices from the **Tools → Devices → Device Manager**... menu item. Like all INDI devices, some of the device controls will be accessible from the skymap. The device can be controlled fully from the **INDI Control Panel**... item.

The standard format for image capture is FITS. Once an image is captured and downloaded, it will be automatically displayed in the KStars **FITS Viewer**.

### 9.4 Configure INDI

The **INDI** page allows you to modify Client side INDI specific options. To access it, select the **INDI** page from **Settings → Configure KStars**... menu item. The window is divided into several main categories: General, Device Updates, Display and Server Port:

- **General**
  - **INDI server**: Specify the binary of installed INDI server in your system. By default, KStars uses ‘/usr/bin/indiserver’ binary.
  - **INDI drivers XML directory**: Specify the XML directory where INDI drivers are located in your system. By default, KStars uses ‘/usr/share/indi’ directory.
  - **Default FITS directory**: Specify the directory where all captured FITS images will be saved to. If no directory is specified, images will be stored in $HOME.

- **Time & Location Updates**
  - **KStars updates all devices**: KStars is the master source for time and location settings. All INDI devices time and locations settings are synchronized to KStars settings.
  - **Mount updates KStars**: Mount handset is the master source of time and location settings. KStars time and location settings are synchronized with controller settings.
  - **GPS updates KStars**: GPS driver is the master source of time and location settings. KStars time and location settings are synchronized with GPS settings.
  - **Time**: Synchronize KStars date and time automatically from the update source.
  - **Location**: Synchronize KStars location settings from the update source.

- **Display**
- **Telescope crosshair**: When checked, KStars displays the telescope’s target crosshair on the sky map. The crosshair is displayed upon a successful connection to the telescope and its location is updated periodically. The telescope’s name is displayed next to the crosshair. KStars displays one crosshair per each connected telescope. To change the color of the telescope’s crosshair, open the Configure - KStars window. Select the Colors page, and then change the color of the Target Indicator item to the desired color.

- **Independent window**: Make FITS Viewer window independent.

- **Message notifications**: Show INDI messages as desktop notifications instead of dialogs.

- **Server Port**
  - Specify range of ports that INDI Server will bind to when starting new drivers.

### 9.5 INDI Concepts

The main key concept in INDI is that devices have the ability to describe themselves. This is accomplished by using XML to describe a generic hierarchy that can represent both canonical and non-canonical devices. In INDI, all **devices** may contain one or more **properties**. Any **property** may contain one or more **elements**. There are four types of INDI properties:

- Text property.
- Number property.
- Switch property (Represented in GUI by buttons and checkboxes).
- Light property (Represented in GUI by colored LEDs).

For example, all INDI devices share the CONNECTION standard switch property. The CONNECTION property has two elements: CONNECT and DISCONNECT switches. KStars parses the generic XML description of properties and builds a GUI representation suitable for direct human interaction.

The INDI control panel offers many device properties not accessible from the sky map. The properties offered differ from one device to another. Nevertheless, all properties share common features that constrains how they are displayed and used:

- **Permission**: All properties can either be read-only, write-only, or read and write enabled. An example of a read-write property is the telescope’s Right Ascension. You can enter a new Right Ascension and the telescope, based on current settings, will either slew or sync to the new input. Furthermore, when the telescope slews, its Right Ascension gets updated and sent back to the client.

- **State**: Prefixed to each property is a state indicator (round LED). Each property has a state and an associated color code:

<table>
<thead>
<tr>
<th>State</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle</td>
<td>Gray</td>
<td>Device is performing no action with respect to this property</td>
</tr>
<tr>
<td>Ok</td>
<td>Green</td>
<td>Last operation performed on this property was successful and active</td>
</tr>
<tr>
<td>Busy</td>
<td>Yellow</td>
<td>The property is performing an action</td>
</tr>
<tr>
<td>Alert</td>
<td>Red 211</td>
<td>The property is in critical condition and needs immediate attention</td>
</tr>
</tbody>
</table>

Table 9.1: INDI State color code
The device driver updates the property state in real-time when necessary. For example, if the telescope is in the process of slewing to a target, then the RA/DEC properties will be signaled as **Busy**. When the slew process is completed successfully, the properties will be signaled as **Ok**.

- **Context:** Numerical properties can accept and process numbers in two formats: decimal and sexagesimal. The sexagesimal format is convenient when expressing time or equatorial/geographical coordinates. You can use any format at your convenience. For example, all the following numbers are equal:
  - -156.40
  - -156:24:00
  - -156:24

- **Time:** The standard time for all INDI-related communications is Universal Time UTC specified as YYYY-MM-DDTHH:MM:SS in accord with ISO 8601. KStars communicates the correct UTC time with device drivers automatically. You can enable/disable automatic time updates from the **INDI** page in the settings dialog.

### 9.6 Remote Device Control

KStars provides a simple yet powerful layer for remote device control. A detailed description of the layer is described in the INDI **white paper**.

You need to configure both the server and client machines for remote control:

1. **Server:** To prepare a device for remote control, follow the same steps in the local/server setup. When you start a device service in the **Device Manager**, a port number is displayed under the Port column. In addition to the port number, you also need the hostname or IP address of your server.

2. **Client:** Select the **Tools → Devices → Device Manager...** menu item and you can add, modify, or delete hosts into **Client** tab. Add a host by clicking on the **Add** button. Enter the hostname/IP address of the server in the **Host:** field, and enter the port number obtained from the server machine in step 1.
After you add a host, right click on the host to Connect or Disconnect. If a connection is established, you can control the telescope from the Sky map or INDI Control Panel exactly as described in the local/server section. It is as easy at that.

### 9.6.1 Running an INDI server from the command line

While KStars allows you to easily deploy an INDI server; you can launch an INDI server from the command line.

Since INDI is an independent backend component, you can run an INDI server on a host without KStars. INDI can be compiled separately to run on remote hosts. Furthermore, device drivers log messages to stderr and that can be helpful in a debugging situation. The syntax for INDI server is as following:

```
$ indiserver [options] driver [driver ...]
```

<table>
<thead>
<tr>
<th>Options:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-l d</td>
<td>Log driver messages to &lt;d&gt;/YYYY-MM-DD.islog</td>
</tr>
<tr>
<td>-m m</td>
<td>Kill client if gets more than this many MB behind, default 128.</td>
</tr>
<tr>
<td>-d m</td>
<td>Drop streaming blobs if client gets more than this many MB behind, default 5.0 to disable.</td>
</tr>
<tr>
<td>-p p</td>
<td>Alternate IP port, default 7624.</td>
</tr>
<tr>
<td>-r r</td>
<td>Maximum driver restarts on error, default 10.</td>
</tr>
<tr>
<td>-f path</td>
<td>Path to fifo for dynamic startup and shutdown of drivers.</td>
</tr>
<tr>
<td>-v</td>
<td>Show key events, no traffic.</td>
</tr>
<tr>
<td>-vv</td>
<td>-v + key message content.</td>
</tr>
<tr>
<td>-vvv</td>
<td>-vv + complete xml.</td>
</tr>
<tr>
<td>driver</td>
<td>Executable or [device]@host[:port]</td>
</tr>
</tbody>
</table>

For example, if you want to start an INDI server running an LX200 GPS driver and listening to connections on port 8000, you would run the following command:

```
$ indiserver -p 8000 lx200gps
```
9.6.2 Secure Remote Operation

Suppose we want to run an indiserver with INDI drivers on a remote host, `remote_host`, and connect them to KStars running on the local machine.

From the local machine log onto the remote host, `remote_host`, by typing:

```
$ ssh -L local_port:remote_host:remote_port
```

This binds the `local_port` on the local machine to the `remote_port` on the remote host. After logging in, run indiserver on the remote host:

```
$ indiserver -p remote_port [driver...]
```

Back on the local machine, start KStars then open the Device Manager and add a host under the Client tab. The host should be the local host (usually 127.0.0.1) and the port number should be the `local_port` used in the steps above. Right-click on the host and select Connect from the popup menu. KStars will connect to the remote INDI server securely. The host information will be saved for future sessions.

9.7 INDI Frequently Asked Questions

Q: What is INDI?

A: INDI is the Instrument-Neutral-Distributed-Interface control protocol developed by Elwood C. Downey of ClearSky Institute. KStars employs device drivers that are compatible with the INDI protocol. INDI has many advantages including loose coupling between hardware devices and software drivers. Clients that use the device drivers (like KStars) are completely unaware of the device capabilities. In run time, KStars communicates with the device drivers and builds a completely dynamical GUI based on services provided by the device. Therefore, new device drivers can be written or updated and KStars can take full advantage of them without any changes on the client side.

Q: Do you plan to support more devices?

A: Yes. We plan to support major CCD cameras and focusers and extend support for more telescopes. If you would like INDI to support a particular device, please send an email to indidevel@lists.sourceforge.net

Q: What operations does KStars provide to control the telescope?

A: It depends on the particular telescope you’re running, but the minimum three operations are **Slew**, **Track**, and **Sync**, which you can issue directly from the sky map. Your telescope must be aligned for those operations to perform correctly. Some telescopes offer you more operations like site management, slew modes, focusing, parking, and more. You can access the telescopes extended features from the Tools → Devices → INDI Control Panel... menu item.

Q: What’s the difference between **Slew**, **Track**, and **Sync** exactly?

A: The command **Slew** orders the telescope to move to a particular target, and once the telescope reaches its target, the telescope keeps tracking that target at a sidereal rate (i.e., the rate at which stars move across the sky). This works well for stars, Messier objects, and about everything outside our solar system. But solar system objects travel differently across the sky and so the telescope must **Track** the objects as they move.

Therefore, you need to issue a track command if you want to track an object with non-sidereal motion. On the other hand, **Sync** is used to synchronize the telescope’s internal coordinates with that of an object you select.

Q: Can I control my telescope remotely?

A: Yes. You can start an INDI server on the machine connected to your telescope and the server will listen to requests from KStars clients. Once you’re connected, you can control your telescope...
directly from the sky map. This procedure is described in detail in the Remote device control section.

Q: When I try to Connect, KStars reports that the telescope is not connected to the serial/USB port. What can I do?
A: This message is triggered when KStars cannot communicate with the telescope. Here are few things you can do:

1. Check that you have both reading and writing permission for the port you are trying to connect to.
2. Check the connection cable, make sure it is in good condition and test it with other applications.
3. Check your telescope power, make sure the power is on and that the telescope is getting enough power.
4. Select the Tools → Devices → INDI Control Panel... menu item and set the correct port in the INDI Control Panel dialog. The default device is /dev/ttyS0
5. Restart KStars and retry again.

Q: KStars reports that the telescope is online and ready, but I cannot find the telescope’s crosshair, where is it?
A: KStars retrieves the telescopes RA and DEC coordinates upon connection. If your alignment was performed correctly, then you should see the crosshair around your target in the Sky Map. However, the RA and DEC coordinates provided by the telescope may be incorrect (even below the horizon) and you need to Sync your telescope to your current target. You can use the right-click menu to center and track the telescope crosshair in the sky map.

Q: The telescope is moving erratically or not moving at all. What can I do?
A: This behavior is mostly due to incorrect settings, please verify the following check list:

1. Is the telescope aligned?
2. Is the telescope alignment mode correct? Use INDI Control Panel to check and change these settings (Alt/Az,Polar, Land).
3. Are the telescope’s time and date settings correct?
4. Are the telescope’s longitude and latitude settings correct?
5. Is the telescope’s UTC offset correct?
6. Are the telescope’s RA and DEC axis locked firmly?
7. Is the telescope’s N/S switch (when applicable) setup correctly for your hemisphere?
8. Is the cable between the telescope and computer in good condition?

If you think all settings are correct but the telescope still moves erratically or not at all, then please send a report to indi-devel@lists.sourceforge.net.
Chapter 10

Questions and Answers

1. What do the different symbols for deep-sky objects mean?
   The symbol indicates the object type:
   - dotted circle: Open Cluster
   - cross-in-circle: Globular Cluster
   - box: Gaseous Nebula
   - diamond: Supernova Remnant
   - circle with outer lines: Planetary Nebula
   - ellipse: Galaxy

2. What do the different colors of Deep-sky objects mean?
   Generally, the different colors indicate to which catalog the object belongs (Messier, NGC or IC). However, some objects have a different color which indicates that there are extra images available in the popup menu (the default ‘extras’ color is red).

3. Why are there so many more U.S. cities than in other countries?
   When we started KStars, we were unable to find a longitude/latitude database that covered the globe equitably. However, the KStars community is rapidly overcoming this problem! We have already received city lists from many users around the world. If you can contribute to this effort, please send us your list of cities and coordinates.

4. How can I add a new custom location to KStars?
   If you would like to use a location that is not on the list, enter the relevant information (longitude, latitude, city name, province name, and country name), then press Add City button. All fields must be filled, except the optional province field. You can also modify the values for an existing city, by simply changing the values in the window, and adding it to the list.

5. I have added a custom location to KStars that I no longer want. How do I remove it from the program?
   You can easily remove a custom location from KStars by selecting it in the cities list and pressing the Remove City button. Note that you can not remove a KStars default city.

6. Why do some objects disappear when I am scrolling the display?
   When the display is in motion, KStars must recompute the screen coordinates of every object in its database, which involves some pretty heavy trigonometry. When scrolling the display (either with the arrow keys or by dragging with the mouse), the display may become slow and jerky, because the computer is having trouble keeping up. By excluding many of the objects, the computational load is greatly reduced, which allows for smoother scrolling. You can turn off this feature in the Configure - KStars window, and you can also configure which objects get hidden.
7. I do not understand all the terms used in KStars. Where can I learn more about the astronomy behind the program?

The KStars Handbook includes the AstroInfo Project; a series of short, hyperlinked articles about astronomical topics that can be explored and illustrated with KStars. AstroInfo is a community effort, like GNUpedia or Everything2. If you’d like to contribute to AstroInfo, please join our mailing list: kstars-devel AT kde.org.

8. I want KStars to start up with a time and date different from my system CPU clock. Is this possible?

Yes; to start KStars with a different time/date, use the --date argument, followed by a date string like ‘4 July 1976 12:30:00’

9. I want KStars to start up with the simulation clock paused. Is this possible?

Yes; to start KStars with the clock paused, simply add the --paused argument to the command line.

10. How accurate/precise is KStars?

KStars is pretty accurate, but it is not (yet) as precise as it can possibly be. The problem with high-precision calculations is that you start having to deal with a large number of complicating factors. If you are not a professional astronomer, you will probably never have a problem with its accuracy or precision.

Here is a list of some of the complicating factors which limit the program’s precision:

- Planet positions are only accurate for dates within 4000 years or so of the current epoch. The planet positions are predicted using a Fourier-like analysis of their orbits, as observed over the past few centuries. We learnt in school that planets follow simple elliptical orbits around the Sun, but this is not strictly true. It would be true only if there was only one planet in the Solar system, and if the Sun and the planet were both point masses. As it is, the planets are constantly tugging on each other, perturbing the orbits slightly, and tidal effects also induce precessional wobbling. In fact, recent analysis suggests that the planets’ orbits may not even be stable in the long term (i.e., millions or billions of years). As a rule of thumb, you can expect the position of a planet to be accurate to a few arcseconds between the dates -2000 and 6000.

Pluto is the exception to this; its position is perhaps ten times less precise than the positions of the other planets. Still, for dates near the present epoch, its position can be trusted to about an arcsecond.

The moon’s position is the most difficult to predict to high precision. This is because its motion is quite perturbed by the Earth. Also, since it is so nearby, even minute effects that would be undetectable in more distant bodies are easily apparent in the moon.

The objects with the worst long-term precision in the program are the comets and asteroids. We use a very simplistic orbital model for the minor planets that does not include third-body perturbations. Therefore, their positions can only be trusted for dates near the present epoch. Even for the present epoch, one can expect positional errors among the minor planets of order 10 arcseconds or more.

11. Why do I have to download an improved NGC/IC catalog and Messier object images? Why not just include them as part of the KStars distribution?

The author of the downloadable NGC/IC catalog has released it with the restriction that it may not be used commercially. For most KStars users, this is not a problem. However, it is technically against the KStars license (the GPL) to restrict usage in this way. We removed the Messier object images from the standard distribution for two reasons: to simply reduce the size of KStars, and also because of similar licensing concerns with a couple of the images. The inline images are significantly compressed to a very low quality from their original form, so I doubt there is a real copyright concern, but I did obtain explicit permission from the images’ authors to use the few images for which there was any question about it (see README.images). Still, just to be absolutely safe, I removed them from the standard distribution, and marked the download archive as being ‘free for non-commercial use’.
12. *I am really enjoying the beautiful images I have downloaded through KStars! I would like to share them with the world; can I publish a calendar featuring these images (or are there any usage restrictions on the images)?*

It depends on the image, but many of the images restrict against commercial usage. The Image Viewer’s statusbar will usually contain information about the image’s copyright holder, and what usage restrictions apply. As a rule of thumb: anything published by NASA is in the public domain (including all HST images). For everything else, you can pretty safely assume that the images may not be used commercially without permission. When in doubt, contact the image’s copyright holder directly.

13. *Can I help contribute to future versions of KStars?*

Yes, definitely! Introduce yourself on our mailing list: kstars-devel AT kde.org. If you want to help with the coding, download the latest KStars Git version of the code and dive right in. There are several README files in the distribution that explain some of the code’s subsystems. If you need ideas of what to work on, see the TODO file. You can submit patches to kstars-devel mailing list, and feel free to post any questions you have about the code there as well.

If you are not into coding, we can still use your help with i18n, docs, AstroInfo articles, URL links, bug reports, and feature requests.
Chapter 11

The AstroInfo Project

Here you can find a collection of short articles that explain various astronomical concepts used in KStars. From coordinate systems to celestial mechanics, you can find answers to your questions here. The articles sometimes also contain exercises that you can perform with KStars to illustrate the concept behind the article.

11.1 AstroInfo: Table of Contents

**The Sky and Coordinate Systems**

- Celestial Coordinate Systems
- Celestial Equator
- Celestial Poles
- Celestial Sphere
- The Ecliptic
- The Equinoxes
- Geographic Coordinates
- Great Circles
- The Horizon
- Hour Angle
- Local Meridian
- Precession
- The Zenith

**Time**

- Epoch
- Julian Day
- Leap Years
11.2 Celestial Coordinate Systems

A basic requirement for studying the heavens is determining where in the sky things are. To specify sky positions, astronomers have developed several coordinate systems. Each uses a coordinate grid projected on the Celestial Sphere, in analogy to the Geographic coordinate system used on the surface of the Earth. The coordinate systems differ only in their choice of the fundamental plane, which divides the sky into two equal hemispheres along a great circle. (the fundamental plane of the geographic system is the Earth’s equator). Each coordinate system is named for its choice of fundamental plane.

11.2.1 The Equatorial Coordinate System

The Equatorial coordinate system is probably the most widely used celestial coordinate system. It is also the most closely related to the Geographic coordinate system, because they use the same fundamental plane, and the same poles. The projection of the Earth’s equator onto the celestial sphere is called the Celestial Equator. Similarly, projecting the geographic Poles onto the celestial sphere defines the North and South Celestial Poles.

However, there is an important difference between the equatorial and geographic coordinate systems: the geographic system is fixed to the Earth; it rotates as the Earth does. The Equatorial
system is fixed to the stars\textsuperscript{1}, so it appears to rotate across the sky with the stars, but of course it is really the Earth rotating under the fixed sky.

The latitudinal (latitude-like) angle of the Equatorial system is called Declination (Dec for short). It measures the angle of an object above or below the Celestial Equator. The longitudinal angle is called the Right Ascension (RA for short). It measures the angle of an object East of the Vernal Equinox. Unlike longitude, Right Ascension is usually measured in hours instead of degrees, because the apparent rotation of the Equatorial coordinate system is closely related to Sidereal Time and Hour Angle. Since a full rotation of the sky takes 24 hours to complete, there are (360 degrees / 24 hours) = 15 degrees in one Hour of Right Ascension.

The equatorial coordinates for deep-sky objects and stars do not vary appreciably over short durations of time, since they are not affected by the diurnal motion (the daily apparent rotation of the sky around the earth). However, note that this takes 1 sidereal day, as against 1 solar day). They are suitable coordinates for making catalogs of stars and deep-sky objects (note that Galactic Coordinates also work well, but are cumbersome to use from an earth point-of-view). However, there are effects that cause the RA and Dec of objects to vary over time, namely Precession and nutation, and proper motion, the latter being even less important. Equatorial coordinates are thus generally specified with an appropriate epoch, to account for precession. Popular epochs include J2000.0 (Julian Year 2000) and B1950.0 (Besselian Year 1950).

11.2.2 The Horizontal Coordinate System

The Horizontal coordinate system uses the observer’s local horizon as the Fundamental Plane. This conveniently divides the sky into the upper hemisphere that you can see, and the lower hemisphere that you can’t (because the Earth is in the way). The pole of the upper hemisphere is called the Zenith. The pole of the lower hemisphere is called the nadir. The angle of an object above or below the horizon is called the Altitude (Alt for short). The angle of an object around the horizon (measured from the North point, toward the East) is called the Azimuth. The Horizontal Coordinate System is sometimes also called the Alt/Az Coordinate System.

The Horizontal Coordinate System is fixed to the Earth, not the Stars. Therefore, the Altitude and Azimuth of an object changes with time, as the object appears to drift across the sky. In addition, because the Horizontal system is defined by your local horizon, the same object viewed from different locations on Earth at the same time will have different values of Altitude and Azimuth. Horizontal coordinates are very useful for determining the Rise and Set times of an object in the sky. When an object has Altitude=0 degrees, it is either Rising (if its Azimuth is < 180 degrees) or Setting (if its Azimuth is > 180 degrees).

11.2.3 The Ecliptic Coordinate System

The Ecliptic coordinate system uses the Ecliptic for its Fundamental Plane. The Ecliptic is the path that the Sun appears to follow across the sky over the course of a year. It is also the projection of the Earth’s orbital plane onto the Celestial Sphere. The latitudinal angle is called the Ecliptic Latitude, and the longitudinal angle is called the Ecliptic Longitude. Like Right Ascension in the Equatorial system, the zeropoint of the Ecliptic Longitude is the Vernal Equinox.

What do you think such a coordinate system would be useful for? If you guessed charting solar system objects, you are right! Each of the planets (except Pluto) orbits the Sun in roughly the same plane, so they always appear to be somewhere near the Ecliptic (i.e., they always have small ecliptic latitudes).

\textsuperscript{1} Actually, the equatorial coordinates are not quite fixed to the stars. See precession. Also, if Hour Angle is used in place of Right Ascension, then the Equatorial system is fixed to the Earth, not to the stars.
11.2.4 The Galactic Coordinate System

The Galactic coordinate system uses the Milky Way as its Fundamental Plane. The latitudinal angle is called the Galactic Latitude, and the longitudinal angle is called the Galactic Longitude. This coordinate system is useful for studying the Galaxy itself. For example, you might want to know how the density of stars changes as a function of Galactic Latitude, to how much the disk of the Milky Way is flattened.

11.3 The Celestial Equator

The Celestial Equator is an imaginary great circle on the celestial sphere. The celestial equator is the fundamental plane of the Equatorial Coordinate System, so it is defined as the locus of points with Declination of zero degrees. It is also the projection of the Earth’s equator onto the sky.

The Celestial Equator and the Ecliptic are set at an angle of 23.5 degrees in the sky. The points where they intersect are the Vernal and Autumnal Equinoxes.

11.4 The Celestial Poles

The sky appears to drift overhead from east to west, completing a full circuit around the sky in 24 (Sidereal) hours. This phenomenon is due to the spinning of the Earth on its axis. The Earth's spin axis intersects the Celestial Sphere at two points. These points are the Celestial Poles. As the Earth spins; they remain fixed in the sky, and all other points seem to rotate around them. The celestial poles are also the poles of the Equatorial Coordinate System, meaning they have Declinations of +90 degrees and -90 degrees (for the North and South celestial poles, respectively).

The North Celestial Pole currently has nearly the same coordinates as the bright star Polaris (which is Latin for ‘Pole Star’). This makes Polaris useful for navigation: not only is it always above the North point of the horizon, but its Altitude angle is always (nearly) equal to the observer’s Geographic Latitude (however, Polaris can only be seen from locations in the Northern hemisphere).

The fact that Polaris is near the pole is purely a coincidence. In fact, because of Precession, Polaris is only near the pole for a small fraction of the time.

Tip
Exercises:
Use the Find Object window (Ctrl+F) to locate Polaris. Notice that its Declination is almost (but not exactly) +90 degrees. Compare the Altitude reading when focused on Polaris to your location’s geographic latitude. They are always within one degree of each other. They are not exactly the same because Polaris isn’t exactly at the Pole. (you can point exactly at the pole by switching to Equatorial coordinates, and pressing the up-arrow key until the sky stops scrolling).
Use the Time Step spinbox in the toolbar to accelerate time to a step of 100 seconds. You can see the entire sky appears to rotate around Polaris, while Polaris itself remains nearly stationary.
We said that the celestial pole is the pole of the Equatorial coordinate system. What do you think is the pole of the horizontal (Altitude/Azimuth) coordinate system? (The Zenith).

11.5 The Celestial Sphere

The celestial sphere is an imaginary sphere of gigantic radius, centered on the Earth. All objects which can be seen in the sky can be thought of as lying on the surface of this sphere.
Of course, we know that the objects in the sky are not on the surface of a sphere centered on the Earth, so why bother with such a construct? Everything we see in the sky is so very far away, that their distances are impossible to gauge just by looking at them. Since their distances are indeterminate, you only need to know the direction toward the object to locate it in the sky. In this sense, the celestial sphere model is a very practical model for mapping the sky.

The directions toward various objects in the sky can be quantified by constructing a Celestial Coordinate System.

### 11.6 The Ecliptic

The ecliptic is an imaginary Great Circle on the Celestial Sphere along which the Sun appears to move over the course of a year. Of course, it is really the Earth’s orbit around the Sun causing the change in the Sun’s apparent direction. The ecliptic is inclined from the Celestial Equator by 23.5 degrees. The two points where the Ecliptic crosses the Celestial Equator are known as the Equinoxes.

Since our solar system is relatively flat, the orbits of the planets are also close to the plane of the ecliptic. In addition, the constellations of the zodiac are located along the ecliptic. This makes the ecliptic a very useful line of reference to anyone attempting to locate the planets or the constellations of the zodiac, since they all literally ‘follow the Sun’.

Because of the 23.5-degree tilt of the Ecliptic, the Altitude of the Sun at noon changes over the course of the year, as it follows the path of the Ecliptic across the sky. This causes the seasons. In the Summer, the Sun is high in the sky at noon, and it remains above the Horizon for more than twelve hours. Whereas, in the winter, the Sun is low in the sky at noon, and remains above the Horizon for less than twelve hours. In addition, sunlight is received at the Earth’s surface at a more direct angle in the Summer, which means that a given area at the surface receives more energy per second in the Summer than in Winter. The differences in day duration and in energy received per unit area lead to the differences in temperature we experience in Summer and Winter.

#### Tip

**Exercises:**

Make sure your location is set to somewhere that is not very near the equator for these experiments.

Open the Configure - KStars window, and switch to Horizontal coordinates, with the Opaque Ground shown. Open the Set Time window (Ctrl+S), and change the Date to sometime in the middle of Summer, and the Time to 12:00 Noon. Back in the Main Window, point toward the Southern Horizon (press S). Note the height of the Sun above the Horizon at Noon in the Summer. Now, change the Date to something in the middle of Winter (but keep the Time at 12:00 Noon). The Sun is now much lower in the Sky. You will also notice that the day durations are different if you open the What’s up Tonight? tool for each date.

### 11.7 The Equinoxes

Most people know the Vernal and Autumnal Equinoxes as calendar dates, signifying the beginning of the Northern hemisphere’s Spring and Autumn, respectively. Did you know that the equinoxes are also positions in the sky?

The Celestial Equator and the Ecliptic are two Great Circles on the Celestial Sphere, set at an angle of 23.5 degrees. The two points where they intersect are called the Equinoxes. The Vernal Equinox has coordinates RA=0.0 hours, Dec=0.0 degrees. The Autumnal Equinox has coordinates RA=12.0 hours, Dec=0.0 degrees.
The Equinoxes are important for marking the seasons. Because they are on the Ecliptic, the Sun passes through each equinox every year. When the Sun passes through the Vernal Equinox (usually on March 21st), it crosses the Celestial Equator from South to North, signifying the end of Winter for the Northern hemisphere. Similarly, when the Sun passes through the Autumnal Equinox (usually on September 21st), it crosses the Celestial Equator from North to South, signifying the end of Winter for the Southern hemisphere.

11.8 Geographic Coordinates

Locations on Earth can be specified using a spherical coordinate system. The geographic ('earth-mapping') coordinate system is aligned with the spin axis of the Earth. It defines two angles measured from the center of the Earth. One angle, called the Latitude, measures the angle between any point and the Equator. The other angle, called the Longitude, measures the angle along the Equator from an arbitrary point on the Earth (Greenwich, England is the accepted zero-longitude point in most modern societies).

By combining these two angles, any location on Earth can be specified. For example, Baltimore, Maryland (USA) has a latitude of 39.3 degrees North, and a longitude of 76.6 degrees West. So, a vector drawn from the center of the Earth to a point 39.3 degrees above the Equator and 76.6 degrees west of Greenwich, England will pass through Baltimore.

The Equator is obviously an important part of this coordinate system; it represents the zeropoint of the latitude angle, and the halfway point between the poles. The Equator is the Fundamental Plane of the geographic coordinate system. All Spherical Coordinate Systems define such a Fundamental Plane.

Lines of constant Latitude are called Parallels. They trace circles on the surface of the Earth, but the only parallel that is a Great Circle is the Equator (Latitude=0 degrees). Lines of constant Longitude are called Meridians. The Meridian passing through Greenwich is the Prime Meridian (longitude=0 degrees). Unlike Parallels, all Meridians are great circles, and Meridians are not parallel: they intersect at the north and south poles.

**Tip**

Exercise:

What is the longitude of the North Pole? Its latitude is 90 degrees North.

This is a trick question. The Longitude is meaningless at the north pole (and the south pole too). It has all longitudes at the same time.

11.9 Great Circles

Consider a sphere, such as the Earth, or the Celestial Sphere. The intersection of any plane with the sphere will result in a circle on the surface of the sphere. If the plane happens to contain the center of the sphere, the intersection circle is a Great Circle. Great circles are the largest circles that can be drawn on a sphere. Also, the shortest path between any two points on a sphere is always along a great circle.

Some examples of great circles on the celestial sphere include: the Horizon, the Celestial Equator, and the Ecliptic.

11.10 The Horizon

The Horizon is the line that separates Earth from Sky. More precisely, it is the line that divides all of the directions you can possibly look into two categories: those which intersect the Earth, and
those which do not. At many locations, the Horizon is obscured by trees, buildings, mountains, etc. However, if you are on a ship at sea, the Horizon is strikingly apparent.

The horizon is the **Fundamental Plane** of the **Horizontal Coordinate System**. In other words, it is the locus of points which have an **Altitude** of zero degrees.

11.11 Hour Angle

As explained in the Sidereal Time article, the **Right Ascension** of an object indicates the Sidereal Time at which it will transit across your Local Meridian. An object’s **Hour Angle** is defined as the difference between the current Local Sidereal Time and the Right Ascension of the object:

\[
HA_{\text{obj}} = LST - RA_{\text{obj}}
\]

Thus, the object’s Hour Angle indicates how much Sidereal Time has passed since the object was on the Local Meridian. It is also the angular distance between the object and the meridian, measured in hours (1 hour = 15 degrees). For example, if an object has an hour angle of 2.5 hours, it transited across the Local Meridian 2.5 hours ago, and is currently 37.5 degrees West of the Meridian. Negative Hour Angles indicate the time until the next transit across the Local Meridian. Of course, an Hour Angle of zero means the object is currently on the Local Meridian.

11.12 The Local Meridian

The Local Meridian is an imaginary **Great Circle** on the **Celestial Sphere** that is perpendicular to the local Horizon. It passes through the North point on the Horizon, through the **Celestial Pole**, up to the **Zenith**, and through the South point on the Horizon.

Because it is fixed to the local Horizon, stars will appear to drift past the Local Meridian as the Earth spins. You can use an object’s **Right Ascension** and the **Local Sidereal Time** to determine when it will cross your Local Meridian (see Hour Angle).

11.13 Precession

**Precession** is the gradual change in the direction of the Earth’s spin axis. The spin axis traces a cone, completing a full circuit in 26,000 years. If you have ever spun a top or a dreidel, the ‘wobbling’ rotation of the top as it spins is precession.

Because the direction of the Earth’s spin axis changes, so does the location of the **Celestial Poles**. The reason for the Earth’s precession is complicated. The Earth is not a perfect sphere, it is a bit flattened, meaning the **Great Circle** of the equator is longer than a ‘meridonal’ great circle that passes through the poles. Also, the Moon and Sun lie outside the Earth’s Equatorial plane. As a result, the gravitational pull of the Moon and Sun on the oblate Earth induces a slight **torque** in addition to a linear force. This torque on the spinning body of the Earth leads to the precessional motion.
Exercise:

Precession is easiest to see by observing the Celestial Pole. To find the pole, first switch to Equatorial Coordinates in the Configure - KStars window, and then hold down the Up arrow key until the display stops scrolling. The declination displayed in the center of the Info Panel should be +90 degrees, and the bright star Polaris should be nearly at the center of the screen. Try slewing with the left and right arrow keys. Notice that the sky appears to rotate around the Pole.

We will now demonstrate Precession by changing the Date to a very remote year, and observing that the location of the Celestial Pole is no longer near Polaris. Open the Set Time window (Ctrl+S), and set the date to the year 8000 (currently, KStars cannot handle dates much more remote than this, but this date is sufficient for our purposes). Notice that the sky display is now centered at a point between the constellations Cygnus and Cepheus. Verify that this is actually the pole by slewing left and right: the sky rotates about this point; in the year 8000, the North celestial pole will no longer be near Polaris.

11.14 The Zenith

The Zenith is the point in the sky where you are looking when you look ‘straight up’ from the ground. More precisely, it is the point on the sky with an Altitude of +90 Degrees; it is the Pole of the Horizontal Coordinate System. Geometrically, it is the point on the Celestial Sphere intersected by a line drawn from the center of the Earth through your location on the Earth’s surface.

The Zenith is, by definition, a point along the Local Meridian.

Exercise:

You can point to the Zenith by pressing Z or by selecting the Pointing → Zenith menu item.

11.15 Epoch

An epoch is a certain instant of time (usually past) used as a reference for time measurement in astronomy. In order to make calculations easier, astronomers usually use the number of days that have passed since a certain moment in time as a way of representing time in astronomical calculations. This arbitrarily chosen “starting point” reference for time is called an epoch.

An epoch is usually cited along with equatorial coordinates in astronomical catalogs, since the equatorial coordinates of sky objects change (although slowly) with time. Printed star charts / atlases are usually marked as being valid for a certain epoch.

The most popular epoch used currently is J2000.0, (the Julian year 2000.0), which (almost exactly) corresponds to 1st January 2000, 12:00 noon UTC. Other epochs include B1900 and B1950.

KStars supports catalogs based on J2000.0 and B1950.0 epochs.

11.16 Julian Day

Julian Days are a way of reckoning the current date by a simple count of the number of days that have passed since some remote, arbitrary date. This number of days is called the Julian Day, abbreviated as JD. The starting point, JD=0, is January 1, 4713 BC (or -4712 January 1, since there was no year '0'). Julian Days are very useful because they make it easy to determine the number of days between two events by simply subtracting their Julian Day numbers. Such a calculation
is difficult for the standard (Gregorian) calendar, because days are grouped into months, which contain a variable number of days, and there is the added complication of Leap Years.

Converting from the standard (Gregorian) calendar to Julian Days and vice versa is best left to a special program written to do this, such as the KStars Astrocalculator. However, for those interested, here is a simple example of a Gregorian to Julian day converter:

\[ JD = D - 32075 + 1461*( Y + 4800 + ( M - 14 ) / 12 ) / 4 + 367*( M - 2 - ( M - 14 ) / 12 * 12 ) / 12 - 3*( ( Y + 4900 + ( M - 14 ) / 12 ) / 100 ) / 4 \]

where D is the day (1-31), M is the Month (1-12), and Y is the year (1801-2099). Note that this formula only works for dates between 1801 and 2099. More remote dates require a more complicated transformation.

An example Julian Day is: JD 2440588, which corresponds to 1 Jan, 1970.

Julian Days can also be used to tell time; the time of day is expressed as a fraction of a full day, with 12:00 noon (not midnight) as the zero point. So, 3:00 pm on 1 Jan 1970 is JD 2440588.125 (since 3:00 pm is 3 hours since noon, and 3/24 = 0.125 day). Note that the Julian Day is always determined from Universal Time, not Local Time.

Astronomers use certain Julian Day values as important reference points, called Epochs. One widely-used epoch is called J2000; it is the Julian Day for 1 Jan, 2000 at 12:00 noon = JD 2451545.0.

Much more information on Julian Days is available on the internet. A good starting point is the U.S. Naval Observatory. If that site is not available when you read this, try searching for ‘Julian Day’ with your favorite search engine.

11.17 Leap Years

The Earth has two major components of motion. First, it spins on its rotational axis; a full spin rotation takes one Day to complete. Second, it orbits around the Sun; a full orbital rotation takes one Year to complete.

There are normally 365 days in one calendar year, but it turns out that a true year (i.e., a full orbit of the Earth around the Sun; also called a tropical year) is a little bit longer than 365 days. In other words, in the time it takes the Earth to complete one orbital circuit, it completes 365.24219 spin rotations. Do not be too surprised by this; there is no reason to expect the spin and orbital motions of the Earth to be synchronized in any way. However, it does make marking calendar time a bit awkward...

What would happen if we simply ignored the extra 0.24219 rotation at the end of the year, and simply defined a calendar year to always be 365.0 days long? The calendar is basically a charting of the Earth’s progress around the Sun. If we ignore the extra bit at the end of each year, then with every passing year, the calendar date lags a little more behind the true position of Earth around the Sun. In just a few decades, the dates of the solstices and equinoxes will have drifted noticeably.

In fact, it used to be that all years were defined to have 365.0 days, and the calendar ‘drifted’ away from the true seasons as a result. In the year 46 BCE, Julius Caeser established the Julian Calendar, which implemented the world’s first leap years: He decreed that every 4th year would be 366 days long, so that a year was 365.25 days long, on average. This basically solved the calendar drift problem.

However, the problem wasn’t completely solved by the Julian calendar, because a tropical year isn’t 365.25 days long; it’s 365.24219 days long. You still have a calendar drift problem, it just takes many centuries to become noticeable. And so, in 1582, Pope Gregory XIII instituted the Gregorian calendar, which was largely the same as the Julian Calendar, with one more trick added for leap years: even Century years (those ending with the digits ‘00’) are only leap years if they are divisible by 400. So, the years 1700, 1800, and 1900 were not leap years (though they would have been under the Julian Calendar), whereas the year 2000 was a leap year. This change makes the average length of a year 365.2425 days. So, there is still a tiny calendar drift, but it amounts to
an error of only 3 days in 10,000 years. The Gregorian calendar is still used as a standard calendar throughout most of the world.

**NOTE**

Fun Trivia: When Pope Gregory instituted the Gregorian Calendar, the Julian Calendar had been followed for over 1500 years, and so the calendar date had already drifted by over a week. Pope Gregory re-synchronized the calendar by simply eliminating 10 days: in 1582, the day after October 4th was October 15th!

### 11.18 Sidereal Time

_Sidereal Time_ literally means ‘star time’. The time we are used to using in our everyday lives is Solar Time. The fundamental unit of Solar Time is a Day: the time it takes the Sun to travel 360 degrees around the sky, due to the rotation of the Earth. Smaller units of Solar Time are just divisions of a Day:

- 1/24 Day = 1 Hour
- 1/60 Hour = 1 Minute
- 1/60 Minute = 1 Second

However, there is a problem with Solar Time. The Earth does not actually spin around 360 degrees in one Solar Day. The Earth is in orbit around the Sun, and over the course of one day, it moves about one Degree along its orbit (360 degrees/365.25 Days for a full orbit = about one Degree per Day). So, in 24 hours, the direction toward the Sun changes by about a Degree. Therefore, the Earth has to spin 361 degrees to make the Sun look like it has traveled 360 degrees around the Sky.

In astronomy, we are concerned with how long it takes the Earth to spin with respect to the ‘fixed’ stars, not the Sun. So, we would like a timescale that removes the complication of Earth’s orbit around the Sun, and just focuses on how long it takes the Earth to spin 360 degrees with respect to the stars. This rotational period is called a _Sidereal Day_. On average, it is 4 minutes shorter than a Solar Day, because of the extra 1 degree the Earth spins in a Solar Day. Rather than defining a Sidereal Day to be 23 hours, 56 minutes, we define Sidereal Hours, Minutes and Seconds that are the same fraction of a Day as their Solar counterparts. Therefore, one Solar Second = 1.00278 Sidereal Seconds.

The Sidereal Time is useful for determining where the stars are at any given time. Sidereal Time divides one full spin of the Earth into 24 Sidereal Hours; similarly, the map of the sky is divided into 24 Hours of _Right Ascension_. This is no coincidence; Local Sidereal Time (LST) indicates the Right Ascension on the sky that is currently crossing the _Local Meridian_. So, if a star has a Right Ascension of 05h 32m 24s, it will be on your meridian at LST=05:32:24. More generally, the difference between an object’s RA and the Local Sidereal Time tells you how far from the Meridian the object is. For example, the same object at LST=06:32:24 (one Sidereal Hour later), will be one Hour of Right Ascension west of your meridian, which is 15 degrees. This angular distance from the meridian is called the object’s _Hour Angle_.

**TIP**

The Local Sidereal Time is displayed by KStars in the _Time Info Box_, with the label ‘ST’ (you have to ‘unshade’ the box by double-clicking it in order to see the sidereal time). Note that the changing sidereal seconds are not synchronized with the changing Local Time and Universal Time seconds. In fact, if you watch the clocks for a while, you will notice that the Sidereal seconds really are slightly shorter than the LT and UT seconds. 

Point to the _Zenith_ (press _Z_ or select the _Pointing_ → _Zenith_ menu item). The Zenith is the point on the sky where you are looking ‘straight up’ from the ground, and it is a point on your _Local Meridian_. Note the Right Ascension of the Zenith: it is exactly the same as your Local Sidereal Time.
11.19 Time Zones

The Earth is round, and it is always half-illuminated by the Sun. However, because the Earth is spinning, the half that is illuminated is always changing. We experience this as the passing of days wherever we are on the Earth’s surface. At any given instant, there are places on the Earth passing from the dark half into the illuminated half (which is seen as dawn on the surface). At the same instant, on the opposite side of the Earth, points are passing from the illuminated half into darkness (which is seen as dusk at those locations). So, at any given time, different places on Earth are experiencing different parts of the day. Thus, Solar time is defined locally, so that the clock time at any location describes the part of the day consistently.

This localization of time is accomplished by dividing the globe into 24 vertical slices called Time Zones. The Local Time is the same within any given zone, but the time in each zone is one Hour earlier than the time in the neighboring Zone to the East. Actually, this is an idealized simplification; real Time Zone boundaries are not straight vertical lines, because they often follow national boundaries and other political considerations.

Note that because the Local Time always increases by an hour when moving between Zones to the East, by the time you move through all 24 Time Zones, you are a full day ahead of where you started. We deal with this paradox by defining the International Date Line, which is a Time Zone boundary in the Pacific Ocean, between Asia and North America. Points just to the East of this line are 24 hours behind the points just to the West of the line. This leads to some interesting phenomena. A direct flight from Australia to California arrives before it departs. Also, the islands of Fiji straddle the International Date Line, so if you have a bad day on the West side of Fiji, you can go over to the East side of Fiji and have a chance to live the same day all over again.

11.20 Universal Time

The time on our clocks is essentially a measurement of the current position of the Sun in the sky, which is different for places at different Longitudes because the Earth is round (see Time Zones).

However, it is sometimes necessary to define a global time, one that is the same for all places on Earth. One way to do this is to pick a place on the Earth, and adopt the Local Time at that place as the Universal Time, abbreviated UT. (The name is a bit of a misnomer, since Universal Time has little to do with the Universe. It would perhaps be better to think of it as global time).

The geographic location chosen to represent Universal Time is Greenwich, England. The choice is arbitrary and historical. Universal Time became an important concept when European ships began to sail the wide open seas, far from any known landmarks. A navigator could reckon the ship’s longitude by comparing the Local Time (as measured from the Sun’s position) to the time back at the home port (as kept by an accurate clock on board the ship). Greenwich was home to England’s Royal Observatory, which was charged with keeping time very accurately, so that ships in port could re-calibrate their clocks before setting sail.

Tip
Exercise:
Set the geographic location to ‘Greenwich, England’ using the Set Location window (Ctrl+G). Note that the Local Time (LT) and the Universal Time (UT) are now the same.

Further Reading: The history behind the construction of the first clock that was accurate and stable enough to be used on ships to keep Universal Time is a fascinating tale, and one told expertly in the book ‘Longitude’, by Dava Sobel.

11.21 Telescopes

Invented in Holland at the beginning of the 17th century, telescopes are the tools used by astronomers and astrophysicists for their observations. With the development of modern science,
telescopes are nowadays used for observing in all ranges of the electromagnetic spectrum, inside and outside Earth’s atmosphere. Telescopes work by collecting light with a large surface area called objective that makes the incoming light to converge. The final image will be viewed by using an eyepiece.

11.21.1 Aperture and Focal Ratio

Telescopes are used in order to collect light from celestial objects and to converge it to a point, named the focal point. They are described by two parameters, aperture and Focal Ratio. The diameter of the light collecting surface is called the aperture of the telescope – the bigger the aperture, the brighter the image. The ratio of the focal length $f$ to the aperture $D$ of a telescope is defined as the focal ratio. This describes the light gathering power of a telescope. ‘Fast’ telescopes have smaller focal ratios, as they obtain brighter images in a smaller exposure time. As the focal ratio gets bigger, the telescope needs more exposure time in order to obtain a bright image, which is why it is ‘slower’. The focal ratio is usually denoted as ‘$f/D$’, where $n$ is the ratio of the focal length to the aperture.

11.21.2 Aberrations

In order to obtain an image, telescopes use lenses or mirrors. Unfortunately, if we use both of them we obtain image distortions known as aberrations. Some aberrations are common for both lenses and mirrors, like astigmatism and curvature of field.

Astigmatism appears when different parts of the lens or mirror make the rays of the incoming light to converge in slightly different locations on the focal plane. When corrected for astigmatism, curvature of field may appear on the surface of the lens/ mirror, which makes the light to converge on a curve rather than on a plane.

Still, there are also lens specific aberrations and mirror specific aberrations. Chromatic aberration is a feature of telescopes that use lenses to converge the light. Mainly, the focal length of a lens is wavelength dependent, which means that the focal point of blue light differs from that of the red light. This results in a blurred image. The effect of chromatic aberration can be diminished by adding correcting lenses into the system. Spherical aberration may also be a problem for lenses, resulting from their shape. Spheroid surfaces will not make the incoming light to converge to a single point, which is why other optical surfaces like paraboloids are preferred. Even by using them we aren’t still out of trouble, as coma aberration appears in this case. It results from the dependence of the focal length on the angle between the direction of the incoming ray and the optical axis of the system. Thus, images of points that lie off the optical axis are elongated, rather than being simple points, as it would be normal.

11.21.3 Magnification

Magnification, the increase in angular size of an object as viewed in a telescope, is described as the ratio of the focal length of the objective to the focal length of the eyepiece. So the greater the focal length of the objective, the greater the magnification. If you want to have a large image then you need a long focal length objective and a short focal length eyepiece.

As an example, if you have a 500 mm objective and a 25 mm eyepiece the resulting magnification will be 500 / 25, which is 20, or 20X.

11.21.4 Field of View

The field of view is the angle covered on the sky by the telescope. The apparent field of view of a telescope is determined only by the eyepiece. It is a specific characteristic of it, usually around 52
degrees. In order to find the true field of view of a telescope, you need to divide the apparent field of view by the magnification. The true field of view is the actual angle covered on the sky by the telescope.

**Tip**

KStars has a tool to find and display (on the virtual sky) a true field of view called the FOV Indicator. Launch it by heading under the Settings → FOV Symbols → Edit FOV Symbols... menu item. Clicking New... will open a dialog with four different tabs: Eyepiece, Camera, Binocular and Radiotelescope. To compute the field of view, select the tab that applies and enter the specifications of the equipment. Finally, clicking Compute FOV will calculate and display the field of view immediately below. KStars can now also display this as a shape of that size on the virtual sky. To do so, enter a name for this particular field of view (such as 20mm eyepiece or DSLR with refractor) and select a shape and color to be displayed. For Eyepiece, use Circle or Semitransparent circle as the shape since an eyepiece's field is round. For Camera, use Square (which is actually a rectangle) assuming the sensor or film is rectangular or square. When using multiple eyepieces and/or telescopes, it is good to distinguish them with different colors. Click OK to close the dialog. To show the shape on the screen, go back under the Settings → FOV Symbols submenu, then select the new menu item with the name of whatever it was given. To disable it again, click the menu item again.

11.21.5 Types of Telescopes

As telescopes are used in observations over the entire electromagnetic spectrum, they are classified in Optical Telescopes, Ultraviolet, Gamma Ray, X-Ray, Infrared and Radio Telescopes. Each one of them has its own, well defined role in obtaining a detailed analysis of a celestial object.

11.21.6 Optical Telescopes

Used for observations in the visible field of view, Optical Telescopes are mainly Refractors and Reflectors, the difference between the two of them being the way of collecting light from a star.

Refracting Telescopes use two lenses in order to create an image, a primary or objective lens, which collects the incoming light, forming an image in the focal plane and the eyepiece, which is acting as a magnifying glass used for observing the final image. The two lenses are situated at opposite ends of a moving tube and the distance between the two of them can be adjusted in order to obtain the final image.

The largest refracting telescope in the world is at the Yerkes Observatory in Williams Bay, Wisconsin. Built in 1897, it has a 1.02-m (40-in) objective and a focal length of 19.36 m.

Reflecting Telescopes, on the other side, use mirrors instead of lenses in order to obtain the final image. By replacing the objective lens with a mirror, we obtain a focal point that lies on the path of the incoming light. An observer situated at this point could see an image, but he would block part of the incoming light. The focal point of the principal mirror is called prime focus, and this is also the name of the first category of reflecting telescopes. Thus, prime focus telescopes use a mirror in order to collect light from a celestial object and by reflection the image of the object may be observed from the prime focus of the telescope. Other types of reflecting telescopes are Newtonian, Cassegrain and Coude.

The Newtonian one uses an additional flat mirror placed in the vicinity of the prime focus, in the path of the reflected light. This results in moving the focal point to a different location, on one of the sides of the telescope, more accessible for observing. Of course, a mirror placed in the path of the reflected light will also block part of the incoming one, but if the ratio of the surface aeries of the primary mirror to the second one is big enough, the amount of the blocked incoming light is negligible.
The Cassegrain telescope is similar to the Newtonian one but this time the secondary mirror reflects light to the bottom of the telescope. There is a hole at the center of the primary mirror that lets the reflected light to go on its way until it converges to the focal point. The secondary mirror needs to be convex, as it is increasing the focal length of the optical system. The primary mirror of a Cassegrain Telescope is a paraboloid. By replacing it with a hyperboloid we obtain a Ritchey-Chretien telescope. The advantage of using a Ritchey-Chretien telescope is that it removes the coma of the classical reflectors.

The Coude type consists of more than one mirror that reflects the light to a special room, the Coude room, which is located below the telescope. The advantages of using a Coude telescope are varied, from obtaining a long focal length useful in different fields of astronomy and astrophysics, like spectroscopy to avoiding the usage of a massive instrument. But there are also disadvantages in using a Coude telescope, because the more mirrors are placed in the system, the less amount of light arrives at the detector. This happens because by using Aluminum mirrors, only 80% of the incident light gets reflected.

Catadioptrics are types of telescopes that use systems of both lenses and mirrors for making the light to converge. The most popular catadioptric is the Schmidt-Cassegrain telescope. It has the advantage of providing a large angle field of view. In order to minimize coma, it uses a primary spheroidal mirror with a thin correcting lens that removes spherical aberrations. The secondary mirror is placed in the center of the correcting lens, reflecting light through a hole made in the primary mirror. Not as famous as the Schmidt-Cassegrain telescope but common though is the Maksutov telescope that also uses a correcting lens with the primary mirror, this time their surfaces being concentric.

11.21.7 Observations in Other Wavelengths

For a detailed analysis of the sky, observations are also carried in other regions of the electromagnetic spectrum. Very popular and efficient are radio telescopes, developed mostly in the last century. A common problem for both radio and optical telescopes is the need for better resolution. We can derive the resolution of a telescope by using Rayleigh criterion, that states the resolving power is equal to the ratio of the incoming wavelength to the diameter of the aperture (times 1.22 for circular apertures). So for a good resolution we need a diameter as big as possible. The biggest radio telescope in the world is the Arecibo telescope from Puerto Rico that uses a huge dish of 305 m diameter. In order to solve the problem for resolutions, astronomers have developed a new technique called interferometry. The basic principal of interferometry is that by observing the same object with two distinct telescopes we can obtain a final image by “connecting” the two initial ones. Nowadays, the most efficient observatory that uses interferometry is the Very Large Array located near Socorro, New Mexico. It uses 27 telescopes placed in a “Y” shape, with 25 m aperture each. There also exists a technique called Very Long Baseline Interferometry (VLBI) that allows astronomers to resolve images over the size of continents. The biggest project of the century in this domain is the building of the Atacama Large Millimeter Array (ALMA), which will be using 66 telescopes placed in the Atacama desert of northern Chile.

11.21.8 Space-Based Observations

Because Earth-based observations are affected by extinction due Earth’s atmosphere, observations carried out in space are more successful. We mention the Hubble Space Telescope (HST) that has a 2.4, f/24 primary mirror, the smoothest mirror ever constructed. The Hubble Space Telescope is placed on a low-orbit around Earth and because of the lack of atmosphere it can observe very faint objects. Another Space Telescope is the James Webb Space Telescope (JWST) which is planned to be launched in 2018. It will have a 6.5m primary mirror and it will orbit around a gravitation stable point on the Sun-Earth line known as the Second Lagrange Point (L2). Here the gravitational attractions due to both Sun and Earth balances the centrifugal force of an object set in motion around the Sun. This point has the special property that if an object is placed here, it is in equilibrium with respect to the Sun-Earth system. The second Lagrange Point lies on the line connecting Sun and Earth, on the other side of the Earth. So a telescope placed here will receive less thermal radiation, which will improve Infrared Observations.
11.22 Blackbody Radiation

A blackbody refers to an opaque object that emits thermal radiation. A perfect blackbody is one that absorbs all incoming light and does not reflect any. At room temperature, such an object would appear to be perfectly black (hence the term blackbody). However, if heated to a high temperature, a blackbody will begin to glow with thermal radiation.

In fact, all objects emit thermal radiation (as long as their temperature is above Absolute Zero, or -273.15 degrees Celsius), but no object emits thermal radiation perfectly; rather, they are better at emitting/absorbing some wavelengths of light than others. These uneven efficiencies make it difficult to study the interaction of light, heat and matter using normal objects.

Fortunately, it is possible to construct a nearly-perfect blackbody. Construct a box made of a thermally conductive material, such as metal. The box should be completely closed on all sides, so that the inside forms a cavity that does not receive light from the surroundings. Then, make a small hole somewhere on the box. The light coming out of this hole will almost perfectly resemble the light from an ideal blackbody, for the temperature of the air inside the box.

At the beginning of the 20th century, scientists Lord Rayleigh, and Max Planck (among others) studied the blackbody radiation using such a device. After much work, Planck was able to empirically describe the intensity of light emitted by a blackbody as a function of wavelength. Furthermore, he was able to describe how this spectrum would change as the temperature changed. Planck’s work on blackbody radiation is one of the areas of physics that led to the foundation of the wonderful science of Quantum Mechanics, but that is unfortunately beyond the scope of this article.

What Planck and the others found was that as the temperature of a blackbody increases, the total amount of light emitted per second increases, and the wavelength of the spectrum’s peak shifts to bluer colors (see Figure 1).

![Figure 1](image-url)

For example, an iron bar becomes orange-red when heated to high temperatures and its color progressively shifts toward blue and white as it is heated further.

In 1893, German physicist Wilhelm Wien quantified the relationship between blackbody temperature and the wavelength of the spectral peak with the following equation:
The KStars Handbook

\[ \lambda_{\text{max}} \cdot T = 0.29 \text{ cm K} \]

where \( T \) is the temperature in Kelvin. Wien’s law (also known as Wien’s displacement law) states that the wavelength of maximum emission from a blackbody is inversely proportional to its temperature. This makes sense; shorter-wavelength (higher-frequency) light corresponds to higher-energy photons, which you would expect from a higher-temperature object.

For example, the sun has an average temperature of 5800 K, so its wavelength of maximum emission is given by:

\[ \lambda_{\text{max}} = \frac{0.29 \text{ cm}}{5800} = 500 \text{ nm} \]

This wavelengths falls in the green region of the visible light spectrum, but the sun’s continuum radiates photons both longer and shorter than lambda(max) and the human eyes perceives the sun’s color as yellow/white.

In 1879, Austrian physicist Stephan Josef Stefan showed that the luminosity, \( L \), of a black body is proportional to the 4th power of its temperature \( T \).

\[ L = A \cdot \alpha \cdot T^4 \]

where \( A \) is the surface area, alpha is a constant of proportionality, and \( T \) is the temperature in Kelvin. That is, if we double the temperature (e.g. 1000 K to 2000 K) then the total energy radiated from a blackbody increase by a factor of \( 2^4 \) or 16.

Five years later, Austrian physicist Ludwig Boltzman derived the same equation and is now known as the Stefan-Boltzman law. If we assume a spherical star with radius \( R \), then the luminosity of such a star is

\[ L = 4\pi R^2 \cdot \alpha \cdot T^4 \]

where \( R \) is the star radius in cm, and the alpha is the Stefan-Boltzman constant, which has the value:

\[ \alpha = 5.670 \cdot 10^{-5} \text{ ergs/s/cm}^2/\text{K}^{-4} \]

11.23 Dark Matter

Scientists are now quite comfortable with the idea that 90% of the mass in the universe is in a form of matter that cannot be seen.

Despite comprehensive maps of the nearby universe that cover the spectrum from radio to gamma rays, we are only able to account of 10% of the mass that must be out there. As Bruce H. Margon, an astronomer at the University of Washington, told the New York Times in 2001: ‘It’s a fairly embarrassing situation to admit that we can’t find 90 percent of the universe.’

The term given this ‘missing mass’ is Dark Matter, and those two words pretty well sum up everything we know about it at this point. We know there is ‘Matter’, because we can see the effects of its gravitational influence. However, the matter emits no detectable electromagnetic radiation at all, hence it is ‘Dark’. There exist several theories to account for the missing mass ranging from exotic subatomic particles, to a population of isolated black holes, to less exotic brown and white dwarfs. The term ‘missing mass’ might be misleading, since the mass itself is not missing, just its light. But what is exactly dark matter and how do we really know it exists, if we cannot see it?

The story began in 1933 when Astronomer Fritz Zwicky was studying the motions of distant and massive clusters of galaxies, specifically the Coma cluster and the Virgo cluster. Zwicky
The KStars Handbook

estimated the mass of each galaxy in the cluster based on their luminosity, and added up all of the galaxy masses to get a total cluster mass. He then made a second, independent estimate of the cluster mass, based on measuring the spread in velocities of the individual galaxies in the cluster. To his surprise, this second dynamical mass estimate was 400 times larger than the estimate based on the galaxy light.

Although the evidence was strong at Zwicky’s time, it was not until the 1970s that scientists began to explore this discrepancy comprehensively. It was at this time that the existence of Dark Matter began to be taken seriously. The existence of such matter would not only resolve the mass deficit in galaxy clusters; it would also have far more reaching consequences for the evolution and fate of the universe itself.

Another phenomenon that suggested the need for dark matter is the rotational curves of Spiral Galaxies. Spiral Galaxies contain a large population of stars that orbit the Galactic center on nearly circular orbits, much like planets orbit a star. Like planetary orbits, stars with larger galactic orbits are expected to have slower orbital speeds (this is just a statement of Kepler’s 3rd Law). Actually, Kepler’s 3rd Law only applies to stars near the perimeter of a Spiral Galaxy, because it assumes the mass enclosed by the orbit to be constant.

However, astronomers have made observations of the orbital speeds of stars in the outer parts of a large number of spiral galaxies, and none of them follow Kepler’s 3rd Law as expected. Instead of falling off at larger radii, the orbital speeds remain remarkably constant. The implication is that the mass enclosed by larger-radius orbits increases, even for stars that are apparently near the edge of the galaxy. While they are near the edge of the luminous part of the galaxy, the galaxy has a mass profile that apparently continues well beyond the regions occupied by stars.

Here is another way to think about it: Consider the stars near the perimeter of a spiral galaxy, with typical observed orbital velocities of 200 kilometers per second. If the galaxy consisted of only the matter that we can see, these stars would very quickly fly off from the galaxy, because their orbital speeds are four times larger than the galaxy’s escape velocity. Since galaxies are not seen to be spinning apart, there must be mass in the galaxy that we are not accounting for when we add up all the parts we can see.

Several theories have surfaced in literature to account for the missing mass such as WIMPs (Weakly Interacting Massive Particles), MACHOs (MAssive Compact Halo Objects), primordial black holes, massive neutrinos, and others; each with their pros and cons. No single theory has yet been accepted by the astronomical community, because we so far lack the means to conclusively test one theory against the other.

Tip
You can see the galaxy clusters that Professor Zwicky studied to discover Dark Matter. Use the KStars Find Object window (Ctrl+F) to center on ‘M 87’ to find the Virgo Cluster, and on ‘NGC 4884’ to find the Coma Cluster. You may have to zoom in to see the galaxies. Note that the Virgo Cluster appears to be much larger on the sky. In reality, Coma is the larger cluster; it only appears smaller because it is further away.

11.24 Flux

The flux is the amount of energy that passes through a unit area each second.

Astronomers use flux to denote the apparent brightness of a celestial body. The apparent brightness is defined as the amount of light received from a star above the earth atmosphere passing through a unit area each second. Therefore, the apparent brightness is simply the flux we receive from a star.

The flux measures the rate of flow of energy that passes through each cm$^2$ (or any unit area) of an object’s surface each second. The detected flux depends on the distance from the source that radiates the energy. This is because the energy has to spread over a volume of space before it reaches us. Let us assume that we have an imaginary balloon that encloses a star. Each dot on
the balloon represents a unit of energy emitted from the star. Initially, the dots in an area of one cm\(^2\) are in close proximity to each other and the flux (energy emitted per square centimeter per second) is high. After a distance \(d\), the volume and surface area of the balloon increased causing the dots to spread away from each. Consequently, the number of dots (or energy) enclosed in one cm\(^2\) has decreased as illustrated in Figure 1.

![Figure 1](image)

**Figure 1**

The flux is inversely proportional to distance by a simple \(r^2\) relation. Therefore, if the distance is doubled, we receive \(1/2^2\) or \(1/4\)th of the original flux. From a fundamental standpoint, the flux is the **luminosity** per unit area:

\[
F = \frac{L}{A} = \frac{L}{4 \cdot \pi \cdot R^2}
\]

where \((4 \cdot \pi \cdot R^2)\) is the surface area of a sphere (or a balloon!) with a radius \(R\). Flux is measured in Watts/m\(^2\)/s or as commonly used by astronomers: Ergs/cm\(^2\)/s. For example, the luminosity of the sun is \(L = 3.90 \cdot 10^{26}\) W. That is, in one second the sun radiates \(3.90 \cdot 10^{26}\) joules of energy into space. Thus, the flux we receive passing through one square centimeter from the sun at a distance of one AU (1.496 \(\times\) 10\(^{13}\) cm) is:

\[
F = \frac{L}{4 \cdot \pi \cdot R^2} = \frac{3.90 \cdot 10^{26}}{4 \cdot \pi \cdot (1.496 \cdot 10^{13})^2} = 0.14\text{ joules/cm}^2\text{/sec}
\]

### 11.25 Luminosity

**Luminosity** is the amount of energy emitted by a star each second.

All stars radiate light over a broad range of frequencies in the electromagnetic spectrum from the low energy radio waves up to the highly energetic gamma rays. A star that emits predominantly
in the ultra-violet region of the spectrum produces a total amount of energy magnitudes larger than that produced in a star that emits principally in the infrared. Therefore, luminosity is a measure of energy emitted by a star over all wavelengths. The relationship between wavelength and energy was quantified by Einstein as $E = h \times v$ where $v$ is the frequency, $h$ is the Planck constant, and $E$ is the photon energy in joules. That is, shorter wavelengths (and thus higher frequencies) correspond to higher energies.

For example, a wavelength of $\lambda = 10$ meter lies in the radio region of the electromagnetic spectrum and has a frequency of $f = c / \lambda = 3 \times 10^8 \text{ m/s} / 10 = 30 \text{ MHz}$ where $c$ is the speed of light. The energy of this photon is $E = h \times v = 6.625 \times 10^{-34} \text{ J s} \times 30 \text{ Mhz} = 1.988 \times 10^{-26} \text{ joules}$.

On the other hand, visible light has much shorter wavelengths and higher frequencies. A photon that has a wavelength of $\lambda = 5 \times 10^{-9}$ meters (a greenish photon) has an energy $E = 3.975 \times 10^{-17}$ joules which is over a billion times higher than the energy of a radio photon. Similarly, a photon of red light (wavelength $\lambda = 700$ nm) has less energy than a photon of violet light (wavelength $\lambda = 400$ nm).

Luminosity depends both on temperature and surface area. This makes sense because a burning log radiates more energy than a match, even though both have the same temperature. Similarly, an iron rod heated to 2000 degrees emits more energy than when it is heated to only 200 degrees.

Luminosity is a very fundamental quantity in Astronomy and Astrophysics. Much of what is learnt about celestial objects comes from analyzing their light. This is because the physical processes that occur inside stars gets recorded and transmitted by light. Luminosity is measured in units of energy per second. Astronomers prefer to use Ergs, rather than Watts, when quantifying luminosity.

### 11.26 Parallax

*Parallax* is the apparent change of an observed object’s position caused by a shift in the observer’s position. As an example, hold your hand in front of you at arm’s length, and observe an object on the other side of the room behind your hand. Now tilt your head to your right shoulder, and your hand will appear on the left side of the distant object. Tilt your head to your left shoulder, and your hand will appear to shift to the right side of the distant object.

Because the Earth is in orbit around the Sun, we observe the sky from a constantly moving position in space. Therefore, we should expect to see an *annual parallax* effect, in which the positions of nearby objects appear to ‘wobble’ back and forth in response to our motion around the Sun. This does in fact happen, but the distances to even the nearest stars are so great that you need to make careful observations with a telescope to detect it.

Modern telescopes allow astronomers to use the annual parallax to measure the distance to nearby stars, using triangulation. The astronomer carefully measures the position of the star on two dates, spaced six months apart. The nearer the star is to the Sun, the larger the apparent shift in its position will be between the two dates.

Over the six-month period, the Earth has moved through half its orbit around the Sun; in this time its position has changed by 2 *Astronomical Units* (abbreviated AU; 1 AU is the distance from the Earth to the Sun, or about 150 million kilometers). This sounds like a really long distance, but even the nearest star to the Sun (alpha Centauri) is about 40 *trillion* kilometers away. Therefore, the annual parallax is very small, typically smaller than one *arcsecond*, which is only 1/3600 of one degree. A convenient distance unit for nearby stars is the *parsec*, which is short for “parallax arcsecond”. One parsec is the distance a star would have if its observed parallax angle was one arcsecond. It is equal to 3.26 light-years, or 31 trillion kilometers.

---

2 The ancient Greek astronomers knew about parallax; because they could not observe an annual parallax in the positions of stars, they concluded that the Earth could not be in motion around the Sun. What they did not realize was that the stars are millions of times further away than the Sun, so the parallax effect is impossible to see with the unaided eye.

3 Astronomers like this unit so much that they now use ‘kiloparsecs’ to measure galaxy-scale distances, and ‘Megaparsecs’ to measure intergalactic distances, even though these distances are much too large to have an actual, observable parallax. Other methods are required to determine these distances.
11.27 Retrograde Motion

*Retrograde Motion* is the orbital motion of a body in a direction opposite that which is normal to spatial bodies within a given system.

When we observe the sky, we expect most objects to appear to move in a particular direction with the passing of time. The apparent motion of most bodies in the sky is from east to west. However it is possible to observe a body moving west to east, such as an artificial satellite or space shuttle that is orbiting eastward. This orbit is considered Retrograde Motion.

Retrograde Motion is most often used in reference to the motion of the outer planets (Mars, Jupiter, Saturn, and so forth). Though these planets appear to move from east to west on a nightly basis in response to the spin of the Earth, they are actually drifting slowly eastward with respect to the stationary stars, which can be observed by noting the position of these planets for several nights in a row. This motion is normal for these planets, however, and not considered Retrograde Motion. However, since the Earth completes its orbit in a shorter period of time than these outer planets, we occasionally overtake an outer planet, like a faster car on a multiple-lane highway. When this occurs, the planet we are passing will first appear to stop its eastward drift, and it will then appear to drift back toward the west. This is Retrograde Motion, since it is in a direction opposite that which is typical for planets. Finally, as the Earth swings past the planet in its orbit, they appear to resume their normal west-to-east drift on successive nights.

This Retrograde Motion of the planets puzzled ancient Greek astronomers, and was one reason why they named these bodies ‘planets’ which in Greek means ‘wanderers’.

11.28 Elliptical Galaxies

Elliptical galaxies are spheroidal concentrations of billions of stars that resemble Globular Clusters on a grand scale. They have very little internal structure; the density of stars declines smoothly from the concentrated center to the diffuse edge, and they can have a broad range of ellipticities (or aspect ratios). They typically contain very little interstellar gas and dust, and no young stellar populations (although there are exceptions to these rules). Edwin Hubble referred to Elliptical galaxies as ‘early-type’ galaxies, because he thought that they evolved to become Spiral Galaxies (which he called ‘late-type’ galaxies). Astronomers actually now believe the opposite is the case (i.e., that Spiral galaxies can turn into Elliptical galaxies), but Hubble’s early- and late-type labels are still used.

Once thought to be a simple galaxy type, ellipticals are now known to be quite complex objects. Part of this complexity is due to their amazing history: ellipticals are thought to be the end product of the merger of two Spiral galaxies. You can view a computer simulation MPEG movie of such a merger at this NASA HST webpage (warning: the file is 3.4 MB).

Elliptical galaxies span a very wide range of sizes and luminosities, from giant Ellipticals hundreds of thousands of light years across and nearly a trillion times brighter than the sun, to dwarf Ellipticals just a bit brighter than the average globular cluster. They are divided to several morphological classes:

**cD galaxies:**

Immense and bright objects that can measure nearly 1 Megaparsec (3 million light years) across. These titans are only found near the centers of large, dense clusters of galaxies, and are likely the result of many galaxy mergers.

**Normal Elliptical galaxies**

Condensed Object with relatively high central surface brightness. They include the giant ellipticals (gE’e), intermediate-luminosity ellipticals (E’s), and compact ellipticals.
Dwarf elliptical galaxies (dE’s)

This class of galaxies is fundamentally different from normal ellipticals. Their diameters on the order of 1 to 10 kiloparsec with surface brightness that is much lower than normal ellipticals, giving them a much more diffuse appearance. They display the same characteristic gradual decline of star density from a relatively dense core out to a diffuse periphery.

Dwarf spheroidal galaxies (dSph’s)

Extreme low-luminosity, low surface-brightness and have only been observed in the vicinity of the Milky Way, and possibly other very nearby galaxy groups, such as the Leo group. Their absolute magnitudes are only -8 to -15 mag. The Draco dwarf spheroidal galaxy has an absolute magnitude of -8.6, making it fainter than the average globular cluster in the Milky Way!

Blue compact dwarf galaxies (BCD’s)

Small galaxies that are unusually blue. They have photometric colors of B-V = 0.0 to 0.30 mag, which is typical for relatively young stars of spectral type A. This suggests that BCDs are currently actively forming stars. These systems also have abundant interstellar gas (unlike other Elliptical galaxies).

**Tip**
You can see examples of Elliptical galaxies in KStars, using the Find Object window (Ctrl+F). Search for NGC 4881, which is the Giant cD galaxy in the Coma cluster of galaxies. M 86 is a normal Elliptical galaxy in the Virgo cluster of galaxies. M 32 is a dwarf Elliptical that is a satellite of our neighbor, the Andromeda galaxy (M 31). M 110 is another satellite of M 31 that is a borderline dwarf spheroidal galaxy (‘borderline’ because it is somewhat brighter than most other dwarf spheroidals).

11.29 Spiral Galaxies

Spiral galaxies are huge collections of billions of stars, most of which are flattened into a disk shape, with a bright, spherical bulge of stars at its center. Within the disk, there are typically bright arms where the youngest, brightest stars are found. These arms wind out from the center in a spiral pattern, giving the galaxies their name. Spiral galaxies look a bit like hurricanes, or like water flowing down a drain. They are some of the most beautiful objects in the sky.

Galaxies are classified using a ‘tuning fork diagram’. The end of the fork classifies elliptical galaxies on a scale from the roundest, which is an E0, to those that appear most flattened, which is rated as E7. The ‘tines’ of the tuning fork are where the two types of spiral galaxies are classified: normal spirals, and ‘barred’ spirals. A barred spiral is one whose nuclear bulge is stretched out into a line, so it literally looks like it has a ‘bar’ of stars in its center.

Both types of spiral galaxies are sub-classified according to the prominence of their central ‘bulge’ of stars, their overall surface brightness, and how tightly their spiral arms are wound. These characteristics are related, so that an Sa galaxy has a large central bulge, a high surface brightness, and tightly-wound spiral arms. An Sb galaxy has a smaller bulge, a dimmer disk, and looser arms than an Sa, and so on through Sc and Sd. Barred galaxies use the same classification scheme, indicated by types SBa, SBb, SBc, and SBd.

There is another class of galaxy called S0, which is morphologically a transitional type between true spirals and ellipticals. Its spiral arms are so tightly wound as to be indistinguishable; S0 galaxies have disks with a uniform brightness. They also have an extremely dominant bulge.

The Milky Way galaxy, which is home to earth and all of the stars in our sky, is a Spiral Galaxy, and is believed to be a barred spiral. The name ‘Milky Way’ refers to a band of very faint stars in the sky. This band is the result of looking in the plane of our galaxy’s disk from our perspective inside it.
Spiral galaxies are very dynamic entities. They are hotbeds of star formation, and contain many young stars in their disks. Their central bulges tend to be made of older stars, and their diffuse halos are made of the very oldest stars in the Universe. Star formation is active in the disks because that is where the gas and dust are most concentrated; gas and dust are the building blocks of star formation.

Modern telescopes have revealed that many Spiral galaxies harbor supermassive black holes at their centers, with masses that can exceed that of a billion Suns. Both elliptical and spiral galaxies are known to contain these exotic objects; in fact many astronomers now believe that all large galaxies contain a supermassive black hole in their nucleus. Our own Milky Way is known to harbor a black hole in its core with a mass millions of times bigger than a star’s mass.

**Tip**
There are many fine examples of spiral galaxies to be found in KStars, and many have beautiful images available in their popup menu. You can find them by using the Find Object window. Here is a list of some spiral galaxies with nice images available:

- M 64, the Black-Eye Galaxy (type Sa)
- M 31, the Andromeda Galaxy (type Sb)
- M 81, Bode’s Galaxy (type Sb)
- M 51, the Whirlpool Galaxy (type Sc)
- NGC 300 (type Sd) [use DSS image link]
- M 83 (type SBa)
- NGC 1530 (type SBb)
- NGC 1073 (type SBc)

### 11.30 Magnitude Scale

2500 years ago, the ancient Greek astronomer Hipparchus classified the brightnesses of visible stars in the sky on a scale from 1 to 6. He called the very brightest stars in the sky ‘first magnitude’, and the very faintest stars he could see ‘sixth magnitude’. Amazingly, two and a half millennia later, Hipparchus’s classification scheme is still widely used by astronomers, although it has since been modernized and quantified.

**Note**
The magnitude scale runs backwards to what you might expect: brighter stars have smaller magnitudes than fainter stars.

The modern magnitude scale is a quantitative measurement of the flux of light coming from a star, with a logarithmic scaling:

\[ m = m_0 - 2.5 \log \left( \frac{F}{F_0} \right) \]

If you do not understand the math, this just says that the magnitude of a given star (m) is different from that of some standard star (m0) by 2.5 times the logarithm of their flux ratio. The 2.5 \*log factor means that if the flux ratio is 100, the difference in magnitudes is 5 mag. So, a 6th magnitude star is 100 times fainter than a 1st magnitude star. The reason Hipparchus’s simple classification translates to a relatively complex function is that the human eye responds logarithmically to light.
The KStars Handbook

There are several different magnitude scales in use, each of which serves a different purpose. The most common is the apparent magnitude scale; this is just the measure of how bright stars (and other objects) look to the human eye. The apparent magnitude scale defines the star Vega to have magnitude 0.0, and assigns magnitudes to all other objects using the above equation, and a measure of the flux ratio of each object to Vega.

It is difficult to understand stars using just the apparent magnitudes. Imagine two stars in the sky with the same apparent magnitude, so they appear to be equally bright. You cannot know just by looking if the two have the same intrinsic brightness; it is possible that one star is intrinsically brighter, but further away. If we knew the distances to the stars (see the parallax article), we could account for their distances and assign Absolute magnitudes which would reflect their true, intrinsic brightness. The absolute magnitude is defined as the apparent magnitude the star would have if observed from a distance of 10 parsecs (1 parsec is 3.26 light-years, or 3.1 x 10^{18} cm). The absolute magnitude (M) can be determined from the apparent magnitude (m) and the distance in parsecs (d) using the formula:

\[ M = m + 5 - 5 \times \log(d) \]  

(note that \( M = m \) when \( d = 10 \)).

The modern magnitude scale is no longer based on the human eye; it is based on photographic plates and photoelectric photometers. With telescopes, we can see objects much fainter than Hipparcous could see with his unaided eyes, so the magnitude scale has been extended beyond 6th magnitude. In fact, the Hubble Space Telescope can image stars nearly as faint as 30th magnitude, which is one trillion times fainter than Vega.

A final note: the magnitude is usually measured through a color filter of some kind, and these magnitudes are denoted by a subscript describing the filter (i.e., \( m_V \) is the magnitude through a 'visual' filter, which is greenish; \( m_B \) is the magnitude through a blue filter; \( m_{pg} \) is the photographic plate magnitude, etc.).

11.31 Stars: An Introductory FAQ

1. What are the stars?
   Stars are gigantic, self-gravitating spheres of (mostly) Hydrogen gas. Stars are also thermonuclear engines; nuclear fusion takes place deep in the cores of stars, where the density is extreme and the temperature reaches tens of millions of degrees Celsius.

2. Is the Sun a star?
   Yes, the Sun is a star. It is the dominant centerpiece of our solar system. Compared to other stars, our Sun is rather ordinary; it appears to be so much bigger and brighter to us because it is millions of times closer than any other star.

3. Why do stars shine?
   The short answer is: star shine because they are very hot. It is really no more complicated than that. Any object heated to thousands of degrees will radiate light, just like stars do.

4. The obvious next question is: why are stars so hot?
   This is a tougher question. The usual answer is that stars get their heat from the thermonuclear fusion reactions in their cores. However, this cannot be the ultimate cause for the stars' heat, because a star must be hot in the first place for nuclear fusion to be triggered. Fusion can only sustain the hot temperature; it cannot make a star hot. A more correct answer is that stars are hot because they have collapsed. Stars form from diffuse gaseous nebulae; as the nebulous gas condenses to form a star, the gravitational potential energy of the material is released, first as kinetic energy, and ultimately as heat as the density increases.

5. Are stars all the same?
   Stars have many things in common: they are all collapsed spheres of hot, dense gas (mostly Hydrogen), and nuclear fusion reactions are occurring at or near the centers of every star in the sky.
However, stars also show a great diversity in some properties. The brightest stars shine almost 100 million times as brightly as the faintest stars. Stars range in surface temperature from only a few thousand degrees to almost 50,000 degrees Celsius. These differences are largely due to differences in mass: massive stars are both hotter and brighter than lower-mass stars. The temperature and Luminosity also depend on the evolutionary state of the star.

6. What is the Main Sequence?

The main sequence is the evolutionary state of a star when it is fusing Hydrogen in its core. This is the first (and longest) stage of a star’s life (not including protostar phases). What happens to a star after it runs out of core Hydrogen is addressed in the stellar evolution article (coming soon).

7. How long do stars last?

The lifetime of a star depends very much on its mass. More massive stars are hotter and shine much more brightly, causing them to consume their nuclear fuel much more rapidly. The largest stars (roughly 100 times as massive as the Sun), will run out of fuel in only a few million years; while the smallest stars (roughly ten percent the mass of the Sun), with their much more frugal consumption rate, will shine on (albeit dimly) for trillions of years. Note that this is much longer than the Universe has yet been in existence.

11.32 Star Colors and Temperatures

Stars appear to be exclusively white at first glance. But if we look carefully, we can notice a range of colors: blue, white, red, and even gold. In the winter constellation of Orion, a beautiful contrast is seen between the red Betelgeuse at Orion’s “armpit” and the blue Bellatrix at the shoulder. What causes stars to exhibit different colors remained a mystery until two centuries ago, when Physicists gained enough understanding of the nature of light and the properties of matter at immensely high temperatures.

Specifically, it was the physics of blackbody radiation that enabled us to understand the variation of stellar colors. Shortly after blackbody radiation was understood, it was noticed that the spectra of stars look extremely similar to blackbody radiation curves of various temperatures, ranging from a few thousand Kelvin to 50,000 Kelvin. The obvious conclusion is that stars are similar to blackbodies, and that the color variation of stars is a direct consequence of their surface temperatures.

Cool stars (i.e., Spectral Type K and M) radiate most of their energy in the red and infrared region of the electromagnetic spectrum and thus appear red, while hot stars (i.e., Spectral Type O and B) emit mostly at blue and ultra-violet wavelengths, making them appear blue or white.

To estimate the surface temperature of a star, we can use the known relationship between the temperature of a blackbody, and the wavelength of light where its spectrum peaks. That is, as you increase the temperature of a blackbody, the peak of its spectrum moves to shorter (bluer) wavelengths of light. This is illustrated in Figure 1 where the intensity of three hypothetical stars is plotted against wavelength. The “rainbow” indicates the range of wavelengths that are visible to the human eye.
This simple method is conceptually correct, but it cannot be used to obtain stellar temperatures accurately, because stars are not perfect blackbodies. The presence of various elements in the star’s atmosphere will cause certain wavelengths of light to be absorbed. Because these absorption lines are not uniformly distributed over the spectrum, they can skew the position of the spectral peak. Moreover, obtaining a usable spectrum of a star is a time-intensive process and is prohibitively inefficient for large samples of stars.

An alternative method utilizes photometry to measure the intensity of light passing through different filters. Each filter allows only a specific part of the spectrum of light to pass through while rejecting all others. A widely used photometric system is called the Johnson UBV system. It employs three bandpass filters: U (“Ultra-violet”), B (“Blue”), and V (“Visible”); each occupying different regions of the electromagnetic spectrum.

The process of UBV photometry involves using light sensitive devices (such as film or CCD cameras) and aiming a telescope at a star to measure the intensity of light that passes through each of the filters individually. This procedure gives three apparent brightnesses or fluxes (amount of energy per cm$^2$ per second) designated by Fu, Fb, and Fv. The ratio of fluxes Fu/Fb and Fb/Fv is a quantitative measure of the star’s "color", and these ratios can be used to establish a temperature scale for stars. Generally speaking, the larger the Fu/Fb and Fb/Fv ratios of a star, the hotter its surface temperature.

For example, the star Bellatrix in Orion has Fb/Fv = 1.22, indicating that it is brighter through the B filter than through the V filter. Furthermore, its Fu/Fb ratio is 2.22, so it is brightest through the U filter. This indicates that the star must be very hot indeed, since the position of its spectral peak must be somewhere in the range of the U filter, or at an even shorter wavelength. The surface temperature of Bellatrix (as determined from comparing its spectrum to detailed models that account for its absorption lines) is about 25,000 Kelvin.

We can repeat this analysis for the star Betelgeuse. Its Fb/Fv and Fu/Fb ratios are 0.15 and 0.18, respectively, so it is brightest in V and dimmest in U. So, the spectral peak of Betelgeuse must be somewhere in the range of the V filter, or at an even longer wavelength. The surface temperature of Betelgeuse is only 2,400 Kelvin.

Astronomers prefer to express star colors in terms of a difference in magnitudes, rather than a ratio of fluxes. Therefore, going back to blue Bellatrix we have a color index equal to

$$B - V = -2.5 \log \left( \frac{Fb}{Fv} \right) = -2.5 \log (1.22) = -0.22.$$  

Similarly, the color index for red Betelgeuse is
B - V = -2.5 \log \left( \frac{F_b}{F_v} \right) = -2.5 \log (0.18) = 1.85

The color indices, like the magnitude scale, run backward. **Hot and blue** stars have smaller and negative values of B-V than the cooler and redder stars.

An Astronomer can then use the color indices for a star, after correcting for reddening and interstellar extinction, to obtain an accurate temperature of that star. The relationship between B-V and temperature is illustrated in Figure 2.

The Sun with surface temperature of 5,800 K has a B-V index of 0.62.

### 11.33 Cosmic Distance Ladder

The cosmic distance ladder refers to the succession of different methods that astronomers use to measure distances to objects in the sky. Some methods, like **parallax**, work well for only nearby objects. Other methods, like using the **cosmological redshift**, work only for very distance galaxies. Thus, there are several methods, each with its own limited validity, and hence the name.

#### 11.33.1 Direct measurements

The bottom of the ladder consists of objects whose distances can be directly measured, like the moon (see **Lunar Laser Ranging**). The same technique, using radio waves, is applied to find distances to planets as well.

For nearby stars, measuring the **parallax** is possible and yields the distance to the star.

#### 11.33.2 Standard candles

“Standard candles” are objects whose intrinsic brightnesses we can know for sure. The apparent **magnitude**, which is easy to measure, tells us how bright an object appears, not how bright it
actually is. Distant objects appear less brighter, because their light gets spread out over a larger area.

In accordance with the inverse square law for light intensities, the amount of light we receive from an object drops with the distance squared. Thus, we may compute the distance to an object if we know both how bright it actually is (absolute magnitude; ’M’) and how bright it appears to us on earth (apparent magnitude; ’m’). We may define the distance modulus as follows:

\[
\text{Distance Modulus} = M - m = 5 \log_{10} d - 5
\]

Here ‘d’ is the distance measured in parsecs.

For these special standard candle objects, we have some other way of knowing their intrinsic brightness, and thereby can calculate their distance.

Common "standard candles" used in astronomy are:

- Cepheid Variables: A kind of periodic variable star, whose variation period is related to the luminosity
- RR Lyrae Variables: Another such periodic variable star with a well-known period-luminosity relationship
- Type-Ia supernovae: These supernovae have a very well-defined luminosity as a result of the physics that governs them and hence serve as standard-candles

11.3.3 Other methods

There are many other methods. Some of them rely on the physics of stars, such as the relationship between luminosity and color for various types of stars (this is usually represented on a Hertzsprung-Russel Diagram). Some of them work for star clusters, such as the Moving cluster method and the main-sequence fitting method. The Tully-Fisher relation that relates the brightness of a spiral galaxy to its rotation can be used to find the distance modulus, since the rotation of a galaxy is easy to measure using Doppler shift. Distances to distant galaxies may be found by measuring the Cosmological redshift, which is the redshift of light from distance galaxies that results from the expansion of the universe.

For further information, consult Wikipedia on Cosmic Distance Ladder
Chapter 12

Credits and License

KStars
Program copyright 2001-2021 The KStars Team mutlaqja@ikarustech.com
The KStars Team:

• Jason Harris kstars@30doradus.org
• Jasem Mutlaq mutlaqja@ku.edu
• Pablo de Vicente pviceitea@wanadoo.es
• Heiko Evermann heiko@evermann.de
• Thomas Kabelmann tk78@gmx.de
• Mark Hollomon mhh@mindspring.com
• Carsten Niehaus cniehaus@kde.org
• James Bowlin bowlin@mindspring.com
• Alexey Khudyakov alexey.skladnoy@gmail.com
• Mederic Boquien mboquien@free.fr
• Akarsh Simha akarsh.simha@kdemail.net
• Jerome Sonrier jsid@emor3j.fr.eu.org
• Prakash Mohan prakash.mohan@kdemail.net
• Victor Carbune victor.carbune@kdemail.net
• Henry de Valence hdevalence@gmail.com
• Samikshan Bairagya samikshan.bairagya@kdemail.net
• Rafa Kulaga rl.kulaga@gmail.com
• Rishab Arora ra.rishab@gmail.com
• Valentin Boettcher hiro@protagon.space

Data Sources:

• Object catalogs and planet position tables: NASA Astronomical Data Center
• Detailed credit information for all of the images used in the program is presented in the file README.images

References:

• ‘Practical Astronomy With Your Calculator’ by Peter Duffet-Smith
• ‘Astronomical Algorithms’ by Jean Meeus

Special thanks: To the KDE and Qt™ developers for providing the world with a peerless set of free API libraries. To the KDevelop team, for their excellent IDE, which made developing KStars so much easier and more fun. To everyone on the KDevelop message board, the KDE mailing lists, and on irc.kde.org, for answering our frequent questions. Thank you to Anne-Marie Mahfouf, for inviting KStars to join the KDE-Edu module. Finally, thanks to everyone who has submitted bug reports and other feedback. Thank you, everyone.

Documentation copyright 2001-2021 Jason Harris and the KStars Team kstars-devel AT kde.org
This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed under the terms of the GNU General Public License.
Chapter 13

Index

A
Altitude, see Horizontal Coordinates
Animated Slewing, 44
Astronomical Unit, see Parallax
Atmospheric Refraction, 44
Azimuth, see Horizontal Coordinates

B
Blackbody Radiation, see Star Colors and Temperatures

C
Catalogs, 24
   Deep-Sky Catalogs, 25
   Star catalogs, 25
Catalogs page
   Short overview, 24
CCD Video Control
   Setup, 210
Celestial Coordinate Systems
   Ecliptic Coordinates, see Ecliptic
   Equatorial Coordinates, see Celestial Equator
   Galactic Coordinates, 222
   Horizontal Coordinates, see Horizon Overview, 220
Celestial Equator, see Equatorial Coordinates
Celestial Poles, see Equatorial Coordinates
Celestial Sphere, see Celestial Coordinate Systems
Color Schemes
   Customizing, 23, 40
   Selecting, 46
Commands
   Keyboard, 63
   Menu, 52
      Keyboard Shortcuts, 64
   Mouse, 66
Configure
   INDI, 210
   Configure KStars window, 22
      Advanced page, 23, 44
      Catalogs page, 23
      Colors page, 23, 40
      Developer page, 45
      FITS page, 41
      Guides page, 23, 36
   Image Overlays page, 23, 38
   Satellites page, 23, 34
   Solar System page, 23, 33
   Supernovae page, 23, 35
   Terrain page, 23, 37
   Xplanet page, 23
Cosmic Distance Ladder, 244

D
Dark Matter, 234
Date and Time
   Extended range of dates, 22
   Setting, 22
   The simulation clock, 22
Declination, see Equatorial Coordinates
Deep-Sky Catalogs
   Adding/Editing Objects, 30
   Catalog Color Editor, 29
   Catalog Details Dialog, 29
   Database, 26
   Database System, 26
   GUI, 26

E
Ecliptic, see Ecliptic Coordinates
Ekos, 67
Elliptical Galaxies, 238
Epoch, 226
Equinoxes, see Celestial Equator

F
Field-of-View Symbols
   Customizing, 46
   Defining New, 47
   Description, 46
Find Object Tool, 17
FITS Viewer, 164
Flux, see Luminosity

G
Geographic Coordinate System, 224
Geographic Location Tool
   Custom locations, 22
   Filtering, 21
Great Circles, see Celestial Sphere

H
Horizon, see Horizontal Coordinates
Hour Angle, see Local Meridian

Image Overlays
  Customizing, 23
Image-dump Mode, 205
INDI
  Setup, 206, 207
INDI Control Overview, 206
Info Boxes
  Customizing, 45
  Shading, 45

Julian Day, 226

Latitude, see Geographic Coordinate System
Leap Years, 227
Local Meridian, see Hour Angle
Longitude, see Geographic Coordinate System
Luminosity, see Flux

Magnitude Scale, see Flux
Main sequence, 242
Milky Way, 222

Navigation Controls
  Basics, 15
  Keyboard, 63
  Mouse, 66

Objects in the Sky
  Centering, 66
  Details, 177
  Finding by Name, 17
  Hiding, 44
  Identifying, 66
  Internet Links, see Popup Menu
    Customizing, 177
  Invoking Popup Menu for, 66
  Keyboard Actions, 19, 65
  Labeling
    Automatic, 44
    Overview, 16
    Tracking, 19
Orbit Trails
  Attached to centered object, 19

Parallax, 237
Parsec, see Parallax
Planner, 196
Popup Menu
  Description, 61
  Example, 16
  Precession, 225

Retrograde Motion, 238
Right Ascension, see Equatorial Coordinates

Setup Wizard, 14
Sidereal Time, see Hour Angle
Sky culture, 23
Spiral Galaxies, 239
Star Colors and Temperatures, see Blackbody Radiation
Stars, 241

Telescope Control
  Concepts, 211
  FAQ, 214
  Remote Devices, 212
Telescopes, 229–232
Terrain image
  Customizing, 23
Time Zones, 229
Toolbars
  Customizing, 45
Tools, 176
  Altitude vs. Time Tool, 188
  Astrocaculator, 178
  Angular Distance module, 185
  Apparent Coordinates module, 183
  Day Duration module, 181
  Ecliptic Coordinates module, 184
  Equatorial/Galactic Coordinates module, 182
  Equinoxes and Solstices module, 181
  Geodetic Coordinates module, 186
  Horizontal Coordinates module, 184
  Julian Day module, 179
  Planet Coordinates module, 187
  Sidereal Time module, 180
Ekos
  Align, 135
  Analyze, 162
  Capture, 76
  Focus, 92
  Guide, 126
  Logs, 75
  Profile Editor, 74
  Profile Wizard, 71
  Scheduler, 150
  Setup, 68
  Tutorials, 163
  User Interface, 69
Jupiter Moons Tool, 196
Object Details Window, 177
Script Builder, 192
Simulate Eyepiece View, 190
Solar System Viewer, 195
What’s up Tonight? Tool, 191

Universal Time, see Time Zones

Universal Time, see Time Zones

V
Views
  HiPS Progressive Overlay, 50

Z
Zenith, see Horizontal Coordinates